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3 ‘ 1. Présentation

Configuration du systeme
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4 | 1.Présentation

Localisation et fonctions des pieces

(0té gauche et coté avant

9. Antenne Wi-Fi

O O~NOUID W N —

1. Crochet pour métre a ruban

Le crochet pour metre a ruban se trouve au
méme niveau que le capteur d'image. Pour
mesurer la distance entre le caméscope et le
sujet de maniere précise, utilisez ce crochet
comme point de référence. Vous pouvez fixer
I'extrémité d'un métre a ruban au crochet pour
mesurer la distance a partir du sujet.

2. Fiche du viseur (page 19)
3. Fente d'aération

[Remarque]
Ne couvrez pas la fente d'aération.

4. Commutateur de sélection TC IN/OUT
(page 35,122)

5. Connecteur de la télécommande de grip
(page 20)

10. Témoin d’'enregistrement/de signalisation
(avant) (page 34)

Clignote lorsque la capacité restante de la

batterie ou du support est faible.

11. Commutateur FOCUS (page 37)

12. Capteur d'image

13. Touche PUSH AUTO FOCUS (page 41)
14. Contacts de signal de I'objectif

[Remarque]
Ne touchez pas directement avec vos mains.

15. Touche WB SET (réglage de I'équilibre des
blancs) (page 46)

16. Bouton de déblocage de l'objectif
(page 22)

6. N (Marque N) (page 61)

e Mettez en contact un smartphone équipé de
la fonction NFC avec I'unité pour établir une
connexion sans fil.

Certains smartphones compatibles avec les
systémes de paiement sans fil ne prennent
pas forcément en charge la technologie
NFC. Pour plus de détails, reportez-vous au
manuel d'utilisation du smartphone.

La technologie NFC (Near Field
Communication) est un protocole de
communication international pour la
communication sans fil entre des objets
proches.

7. Fixation de télécommande de grip
(page 20)

8. Bouton de déblocage de la
télécommande de grip (page 20)
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1. Présentation : Localisation et fonctions des pieces

(C6té droit (avant/haut/bas)

14 15|17
16 18

1. Touche de balise de plan (page 53,
7)

2. Commutateur HOLD (page 104)

3. Touche d'enregistrement START/STOP
(page 34)
Appuyez sur la touche d'enregistrement

19

START/STOP pour démarrer I'enregistrement.

La LED s'allume en rouge lors de
I'enregistrement.

4.
5.

Molette ND VARIABLE (page 44)

Commutateur ND PRESET/VARIABLE
(page 44)

. Touches haut/bas ND FILTER POSITION

(page 44)

7. Indicateur ND CLEAR (page 44)

8. Touche ND VARIABLE AUTO (page 44)
Appuyez sur la touche ND VARIABLE AUTO
pour démarrer I'ajustement automatique de
la densité du filtre ND. La LED s'allume en vert
lors de I'activation.

9. Molette multifonction (page 49)
Lorsque vous visualisez I'image sur le viseur,
appuyez pour afficher et actionner le menu
direct .

Lorsqu’un menu est affiché sur le viseur,
tournez la molette pour déplacer le curseur
vers le haut/bas et sélectionner des éléments
ou des réglages de menu. Appuyez pour
appliquer I'élément sélectionné.

Lorsque le menu n’est pas affiché, vous
pouvez aussi utiliser la molette comme
molette personnalisable.

10. Touche de fonction IRIS (page 43)
11. Touche CANCEL/BACK (page 70)
12. Touche THUMBNAIL (page 69)

13. Touche MENU (page 14, 74)

Appuyez sur la touche MENU pour afficher
I'écran d'état. Maintenez la touche MENU
enfoncée pour afficher I'écran de menu
complet. Appuyez sur la touche durant
I'affichage de I'écran d'état ou de I'écran
de menu complet pour revenir a I'affichage
d’écran précédent.

14. Touche de fonction ISO/GAIN (page 43)

15. Commutateur ISO/GAIN (sélection du
gain) (page 43)

16. Touche de fonction WHT BAL (équilibre
des blancs) (page 46)

17. Commutateur WHT BAL (sélection de
mémoire d'équilibre des blancs)
(page 46)

18. Touche de fonction SHUTTER (page 44)

19. Prise casque (page 34)
20.Commutateur POWER (page 34)
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C6té arriére droit et logement pour carte

15. Témoin d'accés B (page 26)

1. Antenne Wi-Fi
2. Molette AUDIO LEVEL (CH1) (page 47)

3. Commutateur CH1 (AUTO/MAN)
(page 47)

4. Touches ASSIGN (personnalisables)1a3
(page 49)

5. Microphone interne (page 47)
Microphone de narration pour
I'enregistrement du son d’ambiance.
[Conseil]

Ce microphone est désactivé lorsque la poignée est
fixée et le microphone interne de la poignée devient
actif (page 7).

6. Touche DISPLAY (page 11)

]
gl 1)
13
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7. Haut-parleur intégré (page 34)
8. Indicateur POWER (page 34)

9. Touche SLOT SELECT (sélection du
logement de carte mémoire (A)/(B))
(page 34)

10. Commutateur CH2 (AUTO/MAN)
(page 47)

11. Molette AUDIO LEVEL (CH2) (page 47)
12. Témoin d'accés A (page 26)

13. Logement de carte CFexpress Type A/SD
(A) (page 26)

14. Logement de carte CFexpress Type A/SD
(B) (page 26)
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Poignée, arriére et bloc de connecteur

1. Commutateur HOLD de la poignée
(page 104)

Il vous permet de désactiver le

fonctionnement des commandes de la

poignée.

[Conseil]

Peut également étre réglé pour la touche

d'enregistrement START/STOP de la poignée

uniquement.

2. Touche d'enregistrement START/STOP de
la poignée

3. Microphone interne de la poignée

4. Griffe a interfaces multiples
< Multi
I interface Shoe
Pour plus de détails sur les accessoires pris
en charge par la griffe a interfaces multiples,

prenez contact avec votre représentant
commercial.

5. Molette personnalisable de la poignée
(page 49)

6. Levier de zoom sur la poignée
(page 105)

7. Touches ASSIGN (personnalisables) 7 & 8
(page 49)

8. Sélecteur multiple (touches 8 voies D-pad
et de mise en application)

9. Griffe pour accessoire (page 7)

10. Orifices de vis de fixation d'accessoire
(174 po)

Compatible avec les vis 1/4-20 UNC (longueur

de 6 mm ou moins).

[Remarque]
L'utilisation de vis de plus de 6 mm de long peut
endommager les piéces extérieures.

11. Témoin d’enregistrement/de signalisation
(arriére) (page 34)

12. Touche BATT RELEASE (page 17)
13. Entrée d'air

[Remarque]
Ne couvrez pas I'entrée dair.

14. Fixation du pack batterie (page 17)
15. Connecteur USB-C (page 64)

16. Connecteur INPUT2 (entrée audio 2)
(page 47)

17. Connecteur INPUT1 (entrée audio 1)
(page 47)

18. Commutateur INPUT2 (LINE/MIC/
MIC+48V) (page 47)

19. Commutateur INPUT1 (LINE/MIC/
MIC+48V) (page 47)

20.0rifices de vis pour dispositifs externes
Compatibles avec les vis M3 (longueur de
4 mm ou moins).

[Remarque]
L'utilisation de vis de plus de 4 mm de long peut
endommager la surface extérieure.

21. Connecteur HDMI OUT (page 121)
22.Connecteur SDI OUT (page 121)

23.Connecteur TC IN/TC OUT (entrée/sortie
de code temporel) (page 122)

24.Connecteur REMOTE

Permet la connexion a l'accessoire a prise
LANC a usage général.

25. Connecteur USB/Multi (page 123)

26.Connecteur DC-IN (prise CC standard)
(page 18)

Fixation de la griffe pour accessoire

1 Soulevez I'avant de la plaque a ressort de
la griffe et poussez la plaque a ressort
dans la direction opposée a la fleche
gravée sur la plaque.

Plaque a ressort de la griffe
g
"
\ >
\ ‘§
1
Griffe pour accessoire

2 Positionnez la griffe pour accessoire sur le
dispositif de montage de griffe pour
accessoire, en alignant les saillies de la
griffe sur les points correspondants du
dispositif de montage, puis serrez les
quatre vis.
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3 Insérez la plaque a ressort de la griffe
dans la direction de la fleche, de maniére
a ce que la partie en forme de U
s'enclenche au fond de la griffe pour
accessoire.

Griffe pour accessoire

?@X\:

Plaque a
ressort de la
griffe

Retrait de la griffe pour accessoire

Retirez la plaque a ressort de la griffe comme
indiqué a I'étape 1 de « Fixation de la griffe
pour accessoire », desserrez les quatre vis et
retirez la griffe pour accessoire.

Fixation de la poignée

Positionnez la poignée de maniere a ce que
le connecteur de poignée et les orifices de

vis soient alignés, enfoncez et tournez les vis
de fixation de la poignée dans le sens des
aiguilles d’'une montre pour fixer la poignée a
I'appareil.

Vous pouvez également serrer les deux vis de
fixation de la poignée en les tournant dans le
sens des aiguilles d'une montre a l'aide d'une
clé hexagonale (4 mm).

[Remarque]

Assurez-vous que les deux vis de fixation de la poignée
sont fermement serrées avant d'utiliser la poignée. La
poignée risque de se détacher du caméscope si les vis
ne sont pas bien serrées.

Retrait de la poignée

Procédez au retrait en faisant I'inverse de la
procédure de fixation.

Fixation du capuchon protecteur du
connecteur de la poignée (fourni)
Lorsque vous utilisez le caméscope sans la

poignée, protégez le connecteur en utilisant le
capuchon protecteur fourni.

[Conseil]
Lorsque vous fixez la poignée, rangez le capuchon
protecteur fourni en bas de la poignée.

Protection des bornes du connecteur

Fixez le cache sur les connecteurs non utilisés
pour protéger les bornes du connecteur.

COté supérieur

L o 9
2 g [[© © o‘ 2
o [= ©
1 Es

e

¥;ﬁ

1. Connecteur de poignée

2. Orifices de vis de fixation d'accessoire
(174 po)

Compatible avec les vis 1/4-20 UNC (longueur

de 6 mm ou moins).

[Remarque]

L'utilisation de vis de plus de 6 mm de long peut
endommager les pieces extérieures.
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(oté inférieur

Viseur

Télécommande de grip

000000

O

;
-

1. Orifices de vis pour trépied (1/4 de pouce,
3/8 de pouce)

Compatibles avec les vis 1/4-20 UNC et les vis

3/8-16 UNC. Fixez a un trépied (option, vis de

5,5 mm ou moins).

2. Sortie d'air

[Remarque]
Ne couvrez pas la sortie d'air.

Pour plus de détails sur la fixation du viseur
(fourni), consultez page 19.

1. Touche PEAKING

2. Touche ZEBRA

3. Touche ASSIGN (personnalisable) 9
(page 49)

4. Panneau tactile

Les opérations tactiles peuvent étre
désactivées a l'aide d'une touche
personnalisable ou a I'aide du menu
(page 10).

5. Commutateur MIRROR

Pour plus de détails sur la fixation de la
télécommande de grip (fournie),
consultez page 20.

1. Levier de zoom

2. Touche ASSIGN (personnalisable) 4
(page 49)

3. Molette personnalisable du grip

(page 49)

4. Touche ASSIGN (personnalisable) 6

(page 49)

5. Levier de rotation du grip (page 21)
6. Touche d'enregistrement START/STOP

7. Sélecteur multiple (touches 8 voies D-pad

et de mise en application)

8. Touche ASSIGN (personnalisable) 5
(page 49)
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Utilisation du panneau tactile

Précautions d'utilisation du
panneau tactile

Le viseur de I'appareil est un écran tactile, que
vous actionnez directement en le touchant
avec le doigt.
Le panneau tactile est congu pour étre
touché légérement avec votre doigt.
N'appuyez pas sur le panneau avec force et
ne le touchez pas avec des objets pointus
ou tranchants (clou, stylo a bille, épingle,
etc.).
Le panneau tactile risque de ne pas
répondre s'il est touché dans les
circonstances suivantes. Notez également
que cela risque de provoquer un
dysfonctionnement.
® Fonctionnement en utilisant le bout des
ongles
e Fonctionnement alors que d'autres
objets touchent la surface
® Fonctionnement avec une feuille ou un
autocollant de protection
e Fonctionnement avec des gouttelettes
d’eau ou de la condensation sur I'écran
e Fonctionnement en utilisant des doigts
mouillés ou moites

Gestes propres au panneau tactile

Configuration du panneau tactile

Toucher

Touchez Iégérement un élément, tel qu'une
icone ou un élément de menu, avec votre
doigt, puis retirezimmédiatement votre doigt.

Faire glisser

Touchez I'écran et faites glisser votre doigt
jusqu'a la position souhaitée de I'écran, puis
retirez votre doigt.

Saisir en glissant/Balayer
Touchez I'écran et saisissez en glissant/

balayez rapidement votre doigt vers le haut, le

bas, la gauche ou la droite.

[Conseil]
Si le contenu de I'affichage continue au-dela des bords
de I'écran, vous pouvez le faire glisser ou le faire défiler.

Les opérations du panneau tactile peuvent
étre activées/désactivées a I'aide de Touch
Operation (page 104) dans le menu
Technical.
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1. Présentation

Affichage de I'écran

Pendant la prise de vue (enregistrement/veille) et la lecture, I'état du caméscope et ses réglages
sont superposés sur I'image affichée dans le viseur.

Vous pouvez afficher/masquer ces informations en utilisant la touche DISPLAY. Méme masquées,
elles s'affichent lorsque vous effectuez des opérations de menu direct (page 49).

Vous pouvez également choisir d'afficher/masquer chaque élément de maniére indépendante

(page 98).

Informations affichées sur I'écran pendant la prise de vue

19

1. Indicateur d'état du réseau (page 13)
Affiche I'état de connexion au réseau sous
forme d'icone.

2. Indicateur de téléchargement/indicateur
de fichiers restants (page 66)

3. Indicateur de zone de mise au point
(page 38)

Affiche la zone de mise au point pour la mise

au point automatique.

4. Mode d'enregistrement, fente A/B,
indicateur d'intervalle d'enregistrement
Interval Rec (page 50)

Affichage Signification
@®Rec Enregistrement
Stby Veille d’enregistrement

5. Indicateur de profondeur de champ

20 212223 24 2526 27 28 29

6. Indicateur du mode Imager Scan
(page 25)

Un repére [ s'affiche en cas d'incohérence

entre la taille du cercle d'image de I'objectif

et le réglage en vigueur pour le mode Imager

Scan de taille d'image.

Lorsque Imager Scan Mode est réglé sur FF,

un repére « C » s'affiche dans les modes ou

I'angle de vue est plus étroit (recadré).

Le recadrage survient dans les modes

suivants.

e Lorsque le format d'enregistrement est
3840x%2160 et que la fréquence d'images de
S&Q Motion est de 100 fps ou 120 fps

e Lorsque Codec est réglé sur RAW ou RAW &
XAVC-| et que le format de sortie RAW est
de 3840x2160

7. Indicateur d'état de fonctionnement de la
sortie RAW (page 60)
Affiche I'état de sortie du signal RAW.

8. Indicateur d'état de la série UWP-D
(page 13)

Affiche I'intensité du signal de niveau RF sous

forme d'icone lorsqu’un appareil de série

UWP-D est connecté a la griffe Ml configurée

pour le transfert audio numérique.

9. Indicateur de fréquence d'images de
prise de vue en ralenti et accéléré
(page 50)

10. Indicateur de capacité restante de la
batterie/de tension DC IN (page 17)

11. Indicateur de mode de mise au point
(page 41)

Signification Affichage
Mode Focus Hold Focus Hold
Mode MF MF
Mode AF AF

Mode AF de suivi en temps réel

Détection des visages/yeux AF (AF/&3/0nly/s¢/

Icéne de détection des =]
visages/yeux

Icone de détection des Only
visages/yeux AF

Icdne de visage de suivi %
enregistré

Icéne de pause AF) M

1) Saffiche pendant I'opération AF lorsque I'opération
AF ne peut pas continuer et s‘arréte temporairement.
L'icéne disparait lorsque la cause de I'arrét de
I'opération AF est résolue et que I'opération AF
reprend.

12. Indicateur de position de mise au point
Affiche la position de mise au point.

13. Indicateur de position de zoom

(page 36)
Affiche la position du zoom dans une plage
de 0 (grand angle) a 99 (téléobjectif) (si un
objectif prenant en charge I'affichage du
réglage de zoom est fixé).

Vous pouvez régler I'affichage sur un
indicateur a barre ou sur un indicateur de
distance de mise au point (page 106).
Les éléments suivants sont ajoutés a
I'affichage lorsque Clear Image Zoom est
activé.

Affichage Signification
R Clear Image Zoom est activé
Valeur Lors de I'utilisation de Clear

d'agrandissement Image Zoom

14. Indicateur de mode de stabilisation
d'image

15. Indicateur du statut Rec Control de sortie
SDI/sortie HDMI (page 121)

Affiche le statut de sortie du signal de controle

REC.

16. Indicateur de mise au point (page 37)

17. Indicateur de capacité restante du
support

Affichage Signification

@ Montage en cours/état de
montage (support A)

EIB Montage en cours/état de
montage (support B)

ErF’ Montage en cours/état de
montage (support B)"

ErF’ Etat de montage (non

enregistrable) (support B)"2
(clignotement)

1) Enregistrement des données proxy uniquement
2) Erreur de support, support plein ou toute autre erreur

survenue au début ou pendant I'enregistrement.

Licone @ s'affiche si la carte mémoire est
protégée en écriture.
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18. Indicateur du mode de balance des
blancs

Affichage Signification

Mode automatique

Mode automatique en pause

Mode prédéfini

Mode de mémoire A

Affichage Signification

M Mode de préréglage M

L Mode de préréglage L

L Mode d'ajustement
provisoire

Mode de contrdle du

bokeh (page 53)

Mode de mémoire B

19. Indicateur de verrouillage externe du
code temporel/affichage des données
temporelles (page 34)

Affiche « EXT-LK » en cas de verrouillage sur le

code temporel d'un dispositif externe.

20.Indicateur de filtre ND (page 44)

Affichage Signification

@ Mode automatique

Mode de contréle du bokeh
(page 53)

21. Indicateur de fichier de scéne
(page 56)

22.Indicateur de diaphragme

Affiche la position du diaphragme (valeur F) (si
un objectif prenant en charge I'affichage du
réglage du diaphragme est fix¢).

23.Indicateur d'avertissement du niveau de
vidéo

24.Indicateur de gain (page 43)

En mode de prise de vue Custom (page 24),

il affiche la valeur de gain ou la valeur ISO. En

mode de prise de vue Flexible ISO, il affiche la

valeur ISO.

En mode de prise de vue Cine El/Cine El Quick

(page 24), il affiche la valeur El.

Affichage Signification
@ Mode automatique
H Mode de préréglage H

25. Affichage des noms de plans (page 96)
Affiche le nom du plan en cours
d’enregistrement ou a enregistrer ensuite.
26.Indicateur d'obturateur (page 44)

27. Indicateur du mode AE/niveau AE
(page 43)

28.Indicateur de niveau a bulle

Affiche le niveau horizontal en incréments de
*1° 4 £15°.

29.Vumétre audio

Affiche le niveau audio de CH1 a CH4.

30.Moniteur de signal vidéo (page 52)
Affiche une forme d'onde, un vecteurscope et
un histogramme.

La ligne orange indique la valeur définie du
niveau zébré.

En mode de prise de vue Log (page 24),

le type de LUT cible du moniteur s’affiche en
haut de I'écran.

31. Indicateur de sensibilité de base/
indicateur I1SO de base (page 43)

En mode de prise de vue Custom (page 24),

il affiche la sensibilité de base réglée a l'aide

de Base ISO/Sensitivity sur I'écran d'état Main

ou de ISO/Gain/El >Base Sensitivity dans le

menu Shooting du menu complet.

En mode de prise de vue Flexible ISO/Cine

El (page 24), il affiche la sensibilité I1SO de

base réglée a l'aide de Base ISO/Sensitivity sur

I'écran d'état Main ou de ISO/Gain/El >Base

ISO dans le menu Shooting du menu complet.

En mode de prise de vue Cine El Quick

(page 24), il affiche la sensibilité I1SO de

base réglée automatiquement en lien avec @
et Exposure Index.

32.Indicateur d'aide pour I'affichage
gamma/indicateur Base Look

En mode de prise de vue Custom (page 24),

il affiche I'état d'aide pour I'affichage

gamma. Vous pouvez activer/désactiver la

fonction d'aide pour I'affichage gamma en

affectant Gamma Display Assist a une touche

personnalisable (page 49).

En modes de prise de vue Log (page 24), il

affiche le réglage Base Look (page 92).

33.Indicateur vidéo pour I'enregistrement
(page 56)

Affiche le signal vidéo pour I'enregistrement

sur les cartes mémoire. En mode de prise de

vue Custom (page 24), il affiche le réglage

Base Look.

En modes de prise de vue Log (page 24), il

affiche le réglage Color Gamut (page 86).

34.Indicateur d'état proxy

Affichage Signification

Proxy Enregistrement proxy activé

Prosxy Enregistrement proxy

Proxy Ree Enregistrement proxy non

(clignotement) prét

PxChunk Enregistrement proxy par
fragments activé

PxChunk Ree Enregistrement proxy par
fragments

PxChunk Ree Enregistrement proxy par

(clignotement) fragments non prét

35.Indicateur de format d’enregistrement
(codec) (page 85)

Affiche le nom du format pour

I'enregistrement sur des cartes mémoire.

36.Indicateur de format d’enregistrement
(fréquence d'images et méthode de
balayage)

37. Indicateur du format d’enregistrement
(taille d'image) (page 85)

Affiche la taille d'image pour I'enregistrement

sur des cartes mémoire.

38.Touche d'arrét AF de suivi en temps réel
(page 42)
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Informations affichées sur I'écran pendant la lecture

Affichage d'ic6ne

Les informations suivantes sont superposées sur I'image de lecture.

4

1 2 3

5 6 7 8

(Cassston )

=3

10

Indicateur d'état du réseau

Indicateur de téléchargement/indicateur

de fichiers restants

Numeéro de plan/nombre total de plans

. Indicateur d'état de la lecture

Indicateur de format de lecture
(fréquence d’'images et méthode de
balayage)

. Indicateur de format de lecture (taille

d'image)

Indicateur de capacité restante de la
batterie/de tension DC IN

8. Indicateur de format de lecture (codec)

9.

Indicateur de support

Licone @ s'affiche si la carte mémoire est
protégée en écriture.

10. Affichage de données temporelles

11. Affichage des noms de plans

12 13 14

12. Indicateur d'aide pour I'affichage gamma
En mode de prise de vue Custom (page 24),

il affiche I'état d'aide pour I'affichage gamma.
En modes de prise de vue Log, il affiche le
réglage Monitor LUT appliqué.

13. Vumetre audio
Affiche le niveau audio de lecture.

14. Indicateur vidéo pour I'enregistrement

Affichage d'icones de connexion au réseau

Mode réseau Etat de connexion Icéne
Mode de point d'accés Fonctionnement en tant que point
d'accés
Erreur de fonctionnement du point A&
d'accés
Mode de station Connexion Wi-Fi 2A A D
L'icéne change selon I'intensité du
signal (4 incréments)
Wi-Fi déconnecté (y compris pendant )
I'établissement d'une connexion)
Erreur de connexion Wi-Fi »

Raccordement modem USB  Raccordement modem USB connecté

Or

Raccordement modem USB déconnecté u-r

Erreur du raccordement modem USB

O

Affichage de I'icone de la série UWP-D

Etat de I'émetteur Etat de réception Icone
Hors tension Pas de réception w
Etat de transmission normal Réception en cours w de:ﬂ
Do —

(niveau de réception

(4 incréments))
S P W
Etat silencieux Réception en cours el

(silencieux)

Etat d'avertissement de la capacité Réception en cours

restante de la batterie

w
k= (Icone clignotante)

Etat d'avertissement de la capacité Réception en cours
restante de la batterie et de silencieux

W ||
MR (1cone clignotante)
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Ecran d'état

Vous pouvez vérifier les réglages et I'état du
caméscope sur I'écran d'état. Les réglages des
éléments marqués d'un astérisque (*) peuvent
étre modifiés.

L'écran d'état prend en charge les opérations
tactiles.

Pour afficher I'écran d'état

e Appuyez sur la touche MENU.

[Conseil]

Vous pouvez afficher/masquer chaque écran d'état a

I'aide de Menu Page On/Off (page 105) dans le menu
Technical.

Pour commuter I'écran d'état

e Tournez la molette multifonction.

e Poussez le sélecteur multiple vers le haut/
bas

e Balayez I'écran d'état vers le haut/le bas.

Pour masquer I'écran d'état
e Appuyez sur la touche MENU.

Pour modifier un réglage

Lorsque I'écran d'état est affiché, appuyez

sur la molette multifonction ou le sélecteur
multiple pour permettre la sélection d'un
élément de configuration dans une page.
Sélectionnez un numéro de page et appuyez
pour changer de page.

Vous pouvez également sélectionner des
éléments directement a I'aide d’une opération
tactile.

[Remarque]

Vous pouvez désactiver les modifications a partir de
I'écran d'état en réglant Menu Settings >User Menu Only

(page 105) dans le menu Technical du menu complet
sur On.

Ecran d'état Main

Affiche les principales fonctions de la caméra
et I'espace disponible sur le support.

Ecran d'état Camera

Affiche I'état de nombreux préréglages de la
caméra.

Elément affiché Description

Elément affiché Description

S&Q Frame Rate* Réglages de prise de vue et
de fréquence d'image en
ralenti et accéléré

Frequency/Scan* Réglages de la fréquence du
systéme et de la méthode

de balayage

Mode de numérisation du
capteur d'image

Imager Scan*

Media Remain Espace libre restant sur le
(A) support dans la fente A

ND Filter Réglage du filtre ND

1SO/Gain/El Réglage d'indice 1SO/Gain/
Exposition

Base ISO/ Réglage I1SO/Sensibilité de

Sensitivity* base

Codec* Réglage de codec pour

I'enregistrement

Media Remain (B) Espace libre restant sur le
support dans la fente B

Scene File* Réglage du fichier de scéne
utilisé et de son identifiant

de fichier

Base Look/LUT*  Réglage Base Look/LUT

Shutter Réglage de la vitesse
d’obturation ou de I'angle

d'obturation

Iris Réglage du diaphragme

Video Format* Taille d'image pour
I'enregistrement sur des
cartes mémoire

RAW Output Taille d'image de la sortie

Format* RAW

White Balance Réglage de la balance des
blancs

White Switch<B> Réglage de la mémoire B de

balance des blancs

White Switch<A> Réglage de la mémoire A de

balance des blancs

White Switch<P> Réglage de blanc prédéfini

Ecran d'état Audio

Affiche le réglage d'entrée, le vumétre audio
et le réglage du moniteur de volume pour
chaque canal.

Elément affiché Description

Etat d'activation/
désactivation du réglage
automatique

CH1 Level
Control

Level Meter Vumétre audio

- Source* Source d'entrée
ND<Preset> Réglages du filtre ND Preset1 N o B 3
a3 Reference* Niveau de référence d'entrée
- . - Wind Réglage du filtre de
1. * )
150/ Ga!n <L> R?glage ISO/Ga!n <L> Filter* réduction du bruit du vent
ISO / Gain'<M>*  Réglage ISO/Gain'<M> du microphone
ISO / Gain'<H>* _ Réglage ISO/Gain’<H> CH2 Level Etat d'activation/
Base 1SO/ Réglage ISO/Sensibilité de Control désactivation du réglage
Sensitivity* base automatique
Zebral* Réglage Zebral On/Off et Level Meter Vumétre audio
niveau Source* Source d'entrée
Zebra2* Réglage Zebra2 On/Off et Reference* Niveau de référence d'entrée
niveau Wind Réglage du filtre de
VF Gamma/ Catégorie et courbe gamma Filter* réduction du bruit du vent
Gamma du microphone
Scene File* Réglage du fichier de scéne CH3  Level Etat dactivation/
utilisé et de son identifiant Control* désactivation du réglage
de fichier automatique
Level Vumétre audio
1) Exposure Index en mode de prise de vue Cine El/Cine Meter*
Bl Quick. Source* Source d'entrée
Reference* Niveau de référence d'entrée
Wind Réglage du filtre de
Filter* réduction du bruit du vent
du microphone
CH4  Level Etat d'activation/
Control* désactivation du réglage
automatique
Level Vumétre audio
Meter*
Source* Source d'entrée
Reference* Niveau de référence d'entrée
Wind Réglage du filtre de
Filter* réduction du bruit du vent

du microphone
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Elément affiché

Description

Elément affiché Description

Elément affiché  Description

Audio Input
Level*

Réglage du niveau d'entrée
audio (volume principal)

HDMI Output CH*

Réglage de canal audio de
sortie HDMI

Volume* Réglage du volume du
casque/haut-parleurs
intégrés

Monitor CH* Réglage de canal de

contrdle

Number’ / Shot?  Suffixe numérique du nom
de plan/Valeurs pour Shot

Number et Camera Position

Gamma Display
Assist*

Réglage d'activation/de
désactivation de Gamma
Display Assist

Ecran d'état Battery

Affiche des informations a propos de la
batterie et de la source DCIN.

Shooting Mode*  Réglages du mode de prise

de vue
RAW Output Taille d'image de la sortie
Format* RAW
Proxy Rec* Réglage d'activation/

désactivation de la fonction

Ecran d'état Assignable Button

Affiche les fonctions attribuées a chacune des
touches attribuables.

d'enregistrement proxy Elément affiché Description
’ . . 1 Fonction attribuée a la
Ecran d'état Pl'OJECt 1) Lorsque Auto Naming est réglé sur Title touche ASSIGN 1
2) Lorsque Auto Naming est réglé sur Cam ID + Reel# - ———
Affiche les réglages de base liés au projet de i 2 Fonction attribuée a la
tournage. Ecran d'état Monitoring touche ASSIGN 2
Elémentaffiché  Descriotion 3 Fonction attribuée a la
i ipti ) . )
- 2 - Affiche les réglages de sortie SDI et HDMI. touche ASSIGN 3
Frequency/Scan* Réglages de la fréquence du - — — 4 Fonction attribuée & la
systéme et de la méthode Elément affiché Description touche ASSIGN 4
de balayage SDI Signal*  Taille d'image de sortie 5 Fonction attribuée a la
Codec* Réglage de codec pour Info. Réglage d'activation/ touche ASSIGN 5
I'enregistrement Disp.* désactivation de l'affichage 6 Fonction attribuée a Ia
Rec Function* Réglage d'activation/ de sortie touche ASSIGN 6
désactivation et réglages Color Réglage de gamme de " PR
principaux de la fonction Gamut*  couleurs/Statut Monitor 7 fonc:or;:;g?\‘u;e ala
d'enregistrement spécial LUT ouc f A
Simul Rec* Réglage et état d'activation/ HDMI Signal*  Taille d'image de sortie 8 :g:z::l:;giu;e ala
de désactivation de la Info. Réglage d‘activation/ s Fonction attribuée 31
fonction denregistrement Disp.*  désactivation de I'affichage onction attribuce a fa
simultané sur 2 fentes de sortie touche ASSIGN 9
Title Prefix" / Partie titre du nom de plan/ Color Réglage de gamme de Focus Hold Fonction attribuée a la
Reel? Valeurs définies pour Reel * : Button touche Focus Hold de
p Gamut couleurs/Statut Monitor o
Number et Camera ID LUT I'objectif
Imager Scan* Mode de numérisation du Stream  Signal Taille d'image de sortie M.U|t| Function Fonction attnvbueeva la
capteur d'image " . Dial molette multifonction
Info. Affichage de sortie (Off . - S
Video Format* Taille d'image pour Disp. (fixe)) Grip Dial Fonlctlon attnbueelba IZ| s
P i molette personnalisable du
Ier\treglstremgnt sur des Color Réglage de gamme de grip P
cartes memoire Gamut*  couleurs/Statut Monitor " - P
Picture Cache Activation/désactivation de LT Handle Dial Fonction attribuée a la
Rec* la fonction d’enregistrement , T molette personnalisable de
he d'i t régl VF Color Réglage d'aide pour la poignée
en cache dimage et feglage Gamut*  I'affichage gamma/Réglage

de la taille du cache

de gamme de couleurs/
Statut Monitor LUT

Base Look/LUT* Réglage Base Look/LUT

Elément affiché Description

Detected Battery Type de batterie

Remaining Capacité restante (%)
Charge Count Nombre de charges
Capacity Capacité restante (Ah)
Voltage Tension de batterie (V)
Manufacture Date de fabrication de la
Date batterie

Video Light Affiche la capacité restante
Remaining de la batterie de la lampe

vidéo.

Power Source Source d'alimentation

Tension de la source
d‘alimentation

Supplied Voltage

Ecran d'état Media

Affiche la capacité restante et la durée
d’enregistrement restante du support
d’enregistrement.

Elément affiché Description

Informations du  Affiche I'icone de support

support A lorsque le support
d’enregistrement est inséré
dans le logement A.

Mesure de la Affiche la capacité restante

capacité restante
du support A

du support d'enregistrement
inséré dans le logement A,
exprimée en pourcentage
sur un graphique en barres.

Affiche une estimation de la
durée d'enregistrement
restante sur le support
d’enregistrement inséré
dans le logement A, en
minutes et sous les
conditions d'enregistrement
actuelles.

Durée
d’enregistrement
restante du
support A
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Utilisation des écrans de réglages tactiles

Elément affiché Description Elément affiché Description
Informations du  Affiche I'icone de support Auto Upload Etat d'activation/
support B lorsque le support (Proxy) désactivation/par fragments
d’enregistrement est inséré de la fonction Auto Upload
dans le logement B. (Proxy)
Mesure de la Affiche la capacité restante Total Transfer Progression du transfert de
capacité restante du support d’enregistrement Progress toutes les taches
du support B inséré dans le logement B, Default Upload ~ Nom du serveur de
exprimée en pourcentage Server destination Auto Upload
sur un graphique en barres. (Proxy)
Durée Affiche une estimation de la Job Status Nombre de taches restantes
d'enregistrement  durée d'enregistrement (Remain / Total) et nombre total de taches
restante du restantg surle SUPPOT‘ . Current File Progression du transfert du
support B d'enregistrement inséré Transfer Progress fichier actuel
dans le logement B, en —
minutes et sous les Current ) ) Nom du fichier en cours de
conditions d'enregistrement Transferring File  transfert
actuelles. Name
Server Address Adresse du serveur de
destination de transfert de
Ecran d'état Network fichiers
Destination Répertoire de destination du
Affiche I'état de connexion au réseau. Directory serveur de destination de

transfert de fichiers

Elément affiché Description

Wireless LAN Réglages du réseau sans fil
et état de connexion

Wired LAN Réglages du réseau LAN
filaire et état de connexion

Modem Réglages du réseau sans fil

et état de connexion du
raccordement modem USB

Ecran d'état File Transfer

Affiche les informations de transfert de
fichiers.

Elément affiché
Auto Upload

Description

Etat d'activation/
désactivation de la fonction
Auto Upload

Disposition de I'écran

Elément

INPUT1

MIC +48V

INPUT2
MIC +48V

Int MIC

Nom d’élément

Touche Set (appliquer)

Marque indiquant le réglage
‘ actuel

MIC +48V

réglage
(cadre orange)

Options de sélection

Fonctionnement
1 Touchez un élément de configuration.

INPUT1
MIC +48V.
INPUT2
MIC +48V.

IntMIC

CH1/CH2

Toucher
Les options de sélection pour la valeur
apparaissent.

2 Faites glisser ou saisissez en glissant un
réglage pour sélectionner la valeur.

CH4 Input Sel

Set

Saisir en glissant

3 Touchez la touche Set ou le curseur de
sélection de la valeur.
La valeur est appliquée, et I'affichage
revient a I'écran précédent.

[Conseils]

e Appuyez sur la touche CANCEL/BACK pour retourner &
la valeur précédente.

Vous pouvez également utiliser la molette
multifonction ou le sélecteur multiple.

Les opérations tactiles peuvent également é&tre
désactivées (page 104).
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Alimentation

Vous pouvez utiliser un pack batterie ou une

alimentation CA a partir d'un adaptateur CA. Utilisation d'un pa(k batterie

Pour des raisons de sécurité, utilisez
uniquement les packs de batteries et les
adaptateurs CA Sony listés ci-dessous.

Pour raccorder un pack batterie, branchez le
pack batterie dans la prise (page 7), en
I'enfoncant le plus loin possible, puis abaissez-
Pack batterie au lithium-ion le pour le verrouiller en place.

Série BP-U

Chargeurs de batterie
BC-CU1 (fourni)
BC-UIA

BC-U2A

Adaptateur CA (fourni)

[ATTENTION]

Ne rangez pas les packs batteries dans des
endroits exposés aux rayons directs du soleil,
aux flammes ou a des températures élevées.

[Remarques]

® Lors du fonctionnement avec une source
d'alimentation CA, utilisez I'adaptateur CA fourni.

* Réglez toujours le commutateur POWER sur la
position Off avant de retirer ou d'installer un pack
batterie ou un adaptateur CA. Si le caméscope est
retiré ou installé avec le commutateur POWER en
position On, il est possible, dans certains cas, qu'il
ne puisse pas démarrer. Si le caméscope ne peut
pas étre démarré, réglez le commutateur POWER
sur la position Off et enlevez le pack batterie ou
I'adaptateur CA de maniére temporaire, puis attendez
environ 30 secondes avant de les installer & nouveau.
(Si I'adaptateur CA est retiré ou installé pendant que
le caméscope fonctionne sur le pack batterie, ou vice
versa, il peut étre retiré ou installé sans probléme
avec le commutateur POWER en position On.)

Pour enlever un pack batterie, maintenez la
touche BATT RELEASE (page 7) enfoncée,
faites glisser le pack batterie vers le haut et
retirez-le de sa fixation.

Touche BATT
RELEASE

[Remarques]

e Avant de raccorder un pack batterie, chargez la
batterie en utilisant le chargeur de batterie BC-CU1,
BC-U1A ou BC-U2A dédié.

e Charger un pack batterie alors qu'il est encore chaud
(par exemple, immédiatement aprés son utilisation)
risque de ne pas le recharger complétement.

Vérification de la capacité restante

En cas de prise de vue/lecture a l'aide
d'un pack batterie, la capacité restante
de la batterie est affichée dans le viseur
(page 11).

Icone Signification

91% a100%

71% a 90%

51% a 70%

A 31% & 50%
4 1% & 30%
] 0% 410%

Le caméscope indique la capacité restante

en calculant I'autonomie du pack batterie si
I'appareil continue de fonctionner selon son
niveau de consommation électrique actuel.

Si le niveau de charge du pack batterie
devient faible

Si le niveau de charge restant de la batterie
tombe au-dessous d'un certain niveau au
cours du fonctionnement (état Low Battery),
un message de batterie faible s'affiche, le
témoin d'enregistrement/de signalisation
commence a clignoter pour vous avertir.

Pour charger le pack batterie avec le
chargeur de batterie fourni (BC-CUT)

1 Connectez I'adaptateur CA (fourni) au
chargeur de batterie et branchez le
cordon d'alimentation (fourni) a une
source d'alimentation CA.

2 Poussez la batterie dedans et glissez-la
dans le sens de la fleche.
Le témoin CHARGE s'allume en orange et
le chargement commence.

o
-y
Témoin CHARGE

~— Adaptateur CA

Si la charge restante de la batterie tombe au-
dessous du niveau auquel le fonctionnement
ne peut pas continuer (état Battery Empty), un

message de batterie vide s'affiche.

Remplacez pack par un pack batterie chargé.

Modification des niveaux
d'avertissement

Par défaut, le niveau Low Battery est réglé
sur10% de la charge de batterie compléte
et le niveau Battery Empty est réglé sur 3%.
Vous pouvez changer les réglages de niveau
d‘avertissement en utilisant Camera Battery
Alarm (page 106) dans le menu Technical du
menu complet.

Cordon d'alimentation

Témoin CHARGE (orange)
Allumé : charge en cours
Clignote : erreur de charge ou température
hors de la plage de fonctionnement
et la charge est mise en pause
e Lorsque la charge est terminée, le témoin
CHARGE du chargeur de batterie s'éteint.
e Utilisez toujours des batteries Sony
d’origine.
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Temps de charge

LA ) , ) Utilisation de I'alimentation CA
Temps approximatif (en minutes) nécessaire

a la recharge d'un pack batterie totalement

déchargé. Le raccordement du caméscope a une source
Pack batterie Temps de recharge d‘alimentation CA vous permet de I'utiliser

compléte sans avoir a vous inquiéter de recharger le
BP-U35 120 minutes pack batterie.

[Remarque]

Si I'adaptateur CA est débranché du chargeur de batterie
et que la batterie est restée branchée au chargeur, elle
commencera a se décharger.

Cordon
d‘alimentation Connecteur DCIN

Adaptateur CA
Connectez I'adaptateur CA au connecteur
DC IN du caméscope et branchez le cordon
d‘alimentation (fourni) & une source
d‘alimentation CA.

Sila tension de sortie de I'adaptateur CA
devient faible

Si la tension de sortie de I'adaptateur CA
tombe au-dessous d'un certain niveau au
cours du fonctionnement (état DC Low
Voltagel), un message vous informant que la
tension de sortie de I'adaptateur CA a chuté
s'affiche, et le témoin d’enregistrement/de
signalisation commence a clignoter.

Si la tension de sortie de I'adaptateur CA
tombe au-dessous du niveau auquel le
fonctionnement ne peut pas continuer (état
DC Low Voltage2), un message vous informant
que la tension de sortie de I'adaptateur CA est
trop faible s'affiche.

Si cela se produit, I'adaptateur CA peut étre
défectueux. Vérifiez I'adaptateur CA, le cas
échéant.

Modification des tensions
d'avertissement

Le niveau DC Low Voltage1 est réglé sur
16,5V et le niveau DC Low Voltage2 est réglé
sur 15,5 V par défaut. Vous pouvez changer
les réglages de niveau d'avertissement en
utilisant Camera DC IN Alarm (page 106)
dans le menu Technical.

Adaptateur CA

® Ne connectez pas et n’utilisez pas un
adaptateur CA dans un espace confiné,
comme par exemple entre un mur et des
meubles.

Connectez I'adaptateur CAala

source d'alimentation CA la plus

proche. Si un probléme se produit

lors du fonctionnement, débranchez
immédiatement le cordon d'alimentation de
la source d'alimentation CA.

Ne court-circuitez pas les pieces métalliques
de la fiche de I'adaptateur CA. Cela
entrainerait un dysfonctionnement.

La batterie ne peut pas étre chargée
lorsqu’elle est fixée au caméscope, méme si
I'adaptateur CA est branché.

Lorsque vous débranchez I'adaptateur CA
de I'appareil, saisissez la fiche et tirez-la tout
droit. Tirer sur le cable pourrait provoquer
un dysfonctionnement.
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Fixation de dispositifs

Fixation d'un microphone (vendu
séparément)

1 Placez le microphone dans le support de
microphone.

2 Branchez le cable du microphone sur le
connecteur INPUT1 ou INPUT2.

INPUTT __IN|

3 Placez le cable du microphone dans le
support de cadble comme indiqué sur le
schéma.

Support de
microphone

Porte-cable

[Conseils]

* Sivous ne pouvez pas fixer le microphone de maniére

sare, utilisez I'espaceur fourni avec le microphone.

* Selon le type d'objectif fixé, la pointe du microphone
peut apparaitre sur I'image du caméscope. Réglez la
position du microphone.

Fixation du viseur

[Remarque]
Fixez/retirez le viseur lorsque le caméscope est hors
tension.

Fixation du viseur a I'avant de la
poignée

1 Insérez I'adaptateur du collier de fixation
du viseur dans la fixation du viseur de la
poignée ((D) et tournez la vis (fournie)
dans le sens des aiguilles d'une montre
pour le fixer en position (®).

Vous pouvez fixer librement I'adaptateur
du collier de fixation par incréments de
45°, mais nous vous conseillons d'opter
pour la position ou le point de fixation se
trouve directement au-dessus de la vis.

Vis
Adaptateur du collier
de fixation du viseur

2 Montez I'attache de viseur sur
I'adaptateur du collier de fixation du
viseur () et tournez la molette de
verrouillage dans le sens des aiguilles
d’une montre pour fixer en position (@).

[Remarque]

Assurez-vous de bien serrer la molette de verrouillage
lorsque vous utilisez un viseur. Le viseur risque de se
détacher si la molette de verrouillage n’est pas bien
serrée.

3 Alignez la marque A sur le caméscope

avec la marque V¥ sur le connecteur du
viseur et insérez le cable.

Assurez-vous que la marque V¥ se trouve
sur le c6té externe avant d'insérer le
connecteur.

4 Placez le cable dans le porte-cable
comme indiqué sur le schéma.

Porte-cable



20

2. Préparatifs : Fixation de dispositifs

Fixation du viseur a l'arriére de la
poignée

Il existe deux points de fixation a l'arriére de
la poignée (D) et deux autres a I'arriére du
caméscope (@) pour fixer un viseur. Fixez

le viseur comme indiqué dans la section

« Fixation du viseur a I'avant de la poignée ».

==

Ajustement de la position du viseur

Inclinez le viseur vers le haut/bas/I'avant/
I'arriére pour ajuster I'angle du viseur.

Vous pouvez utiliser le commutateur MIRROR
pour retourner I'image lorsque vous la
regardez depuis I'avant du caméscope, par
exemple.

[Conseil]

Lorsque vous n'utilisez pas I'appareil ou lorsque vous
le transportez, nous vous conseillons de placer le viseur
dans la position indiquée sur le schéma suivant pour le
protéger.

Retrait du viseur

Desserrez la molette de verrouillage du viseur

et utilisez la procédure inverse de celle utilisée

pour la fixation du viseur.

Fixation du cache du viseur

1 Ouvrez les attaches métalliques sur le
cache du viseur.

2 Fixez I'attache métallique située sur le
haut du cache du viseur au crochet situé
sur le haut du viseur puis fixez I'attache
métallique située en bas du cache du
viseur au crochet situé en bas du viseur.

_.\

B 7
Crochets de fixation Q\]

3 Appuyez sur la plaque de verrouillage
située sous le cache du viseur dans la
direction de la fleche pour verrouiller le
cache du viseur.

Plaque de —
verrouillage

Ouverture du cache du viseur

Tirez la partie centrale inférieure du cache du
viseur vers vous, puis tirez vers le haut pour
ouvrir le cache.

[Remarque]

Lorsque vous déplacez le viseur, empoignez le corps du
viseur, puis déplacez-le. Ne saisissez pas le cache du
viseur.

Retrait du cache du viseur

Retirez le verrou du cache du viseur, puis
retirez le cache du viseur du viseur.

Fixation de la télécommande de
grip

[Remarque]
Fixez/retirez la télécommande de grip lorsque le
caméscope est hors tension.

1 Branchez le cable sur le connecteur de la
télécommande de grip.




21

2. Préparatifs : Fixation de dispositifs

2 Alignez la fixation de la télécommande de
grip du caméscope et le repere d'index
pour monture sur le grip (D), fixez le grip
sur le caméscope et tournez-la lentement
dans le sens contraire des aiguilles d'une
montre (@).

Un clic se fait entendre lors du
verrouillage en place.

Repere d'index

[Remarque]

Si vous ne parvenez pas a fixer correctement, fixez
a nouveau sans exercer une force excessive sur la
télécommande de grip ou le caméscope.

3 Insérez le cable qui a été connecté a
I'étape 2 sous la fente de la
télécommande de grip conformément aux
indications du schéma.

[Remarque]

Sivous ne placez pas le cable sous la fente, la
modification de I'angle de fixation du grip peut exercer
une force excessive sur le cable ou le cable risque de se
coincer dans le mécanisme rotatif.

Ajustement de I'angle de la
télécommande de grip

Vous pouvez régler I'angle de la
télécommande de grip selon la plage indiquée
sur le schéma suivant, en fonction du style de
prise de vue.

Rotation vers I'objectif (90° max.)

Rotation vers l'arriére (83° max.)

Amenez le levier de rotation du grip a la
position indiquée sur le schéma et
tournez le grip tout en appuyant sur le
levier.

Otez le doigt du levier de rotation du grip
a proximité de la position souhaitée.

Déplacez lentement le grip jusqu’a
entendre un clic indiquant qu'il est fixé en
position.

Quand le grip est fixé, remettez le levier
de rotation du grip a sa position d'origine.

[Remarques]

Aprés avoir modifié la position, vérifiez toujours que
le grip est fermement positionné.

Vous ne pouvez pas régler I'angle au-dela de la plage
de réglage. N'exercez pas une force excessive lorsque
vous tournez le grip.

Tenir le grip (méthode recommandée)

Il n'existe aucune régle concernant la maniere
de tenir le grip, mais I'exemple suivant vous
montre une position permettant de I'utiliser
facilement.

Lors de I'utilisation de la touche ASSIGN 5 ou
du sélecteur multiple

CA B
A : actionnez la molette personnalisable du
grip a l'aide de votre index.
B : actionnez le sélecteur multiple et la touche
ASSIGN 5 a l'aide de votre pouce.
C : tenez fermement le grip avec votre majeur,
votre annulaire et votre auriculaire.
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Lors de I'utilisation du zoom

C A

A :actionnez le levier de zoom a l'aide de
votre index et de votre majeur.

B : tenez fermement la dragonne a I'aide de
votre pouce.

C : tenez fermement le grip avec votre
annulaire et votre auriculaire.

Retrait du grip

[Remarque]
Lorsque vous retirez le grip, veillez a placer le
caméscope sur une surface plane, comme un bureau.

1 Débranchez le cable du connecteur de la
télécommande de grip.

2 Maintenez enfoncé le bouton de
déblocage de la télécommande de grip
sur le caméscope, et tournez le grip dans
le sens des aiguilles d'une montre jusqu’a
ce qu'il se détache.

(=)

&

Bouton de déblocage de la télécommande
de grip

[Conseil]

Une rosette peut étre attachée au point d'attache du
grip sur I'unité et au point de fixation correspondant sur
le grip.

Pour plus de détails sur I'achat de rosettes, contactez
votre revendeur Sony.

- COté caméscope : 4-546-932- (en option)

- COté grip : 4-547-089- (en option)

Vis de fixation*

CBté caméscope : 7-627-556- (en option)

Coté grip : 7-627-556- (en option)

Quatre vis sont nécessaires pour chaque rosette (les

orifices de vis sont indiqués par les cercles du schéma

suivant). L'utilisation d'autres vis que celles spécifiées
pourrait endommager les piéces extérieures.

Coté Coté grip
caméscope

Fixation d'un objectif

[ATTENTION]

Ne laissez pas I'objectif orienté en plein soleil.
Les rayons directs du soleil peuvent entrer par
I'objectif, se concentrer dans le caméscope et
provoquer un incendie.

[Remarques]

Fixez/retirez I'objectif lorsque le caméscope est hors
tension.

Un objectif est un composant de précision. Ne
placez pas I'objectif sur une surface avec le coté

de la monture d'objectif tourné vers le bas. Fixez le
capuchon de la monture d'objectif fourni.

[Conseil]

Pour de plus amples informations concernant les
objectifs pouvant étre utilisés avec le caméscope,
contactez votre technicien Sony.

Fixation d'un objectif a monture E

Retirez le capuchon de I'objectif et le
couvercle du caméscope et de l'objectif.

Alignez le repére de monture d'objectif
(blanc) avec le caméscope, insérez
prudemment I'objectif, puis tournez
I'objectif dans le sens des aiguilles d’'une

Un clic se fait entendre lors du
verrouillage en place.

Repéres de monture (blancs)

[Remarque]
N’appuyez pas sur le bouton de déblocage de I'objectif
lorsque vous fixez un objectif.

Fixation d'un objectif a monture A

Pour utiliser un objectif a monture A, fixez un
adaptateur de monture d'objectif (optionnel),
puis fixez I'objectif a monture A.

[Remarque]

Lorsque vous utilisez un objectif & monture A, le
diaphragme se régle manuellement et la mise au point
est paramétrée sur MF.

Retrait d'un objectif

Retirez un objectif en suivant la procédure
suivante.

1 Maintenez le bouton de déblocage de
I'objectif enfoncé et tournez I'objectif
dans le sens contraire des aiguilles d'une
montre tout en soutenant 'objectif.

2 Tirez I'objectif vers I'avant pour I'extraire.

[Remarques]

Lors du retrait d'un objectif, alignez le repére de
monture sur la bague de verrouillage de I'objectif
avec le repére de monture du caméscope.
Saisissez fermement I'objectif & la main pour
empécher qu'il ne tombe.

Si un autre objectif n'est pas immédiatement fixé,
replacez toujours le capuchon de boitier.

Réglages de diaphragme pour les
objectifs dotés d'un commutateur Auto
Iris

® Quand I'objectif Auto Iris est réglé sur
AUTO, le diaphragme est automatiquement
ajusté et peut également étre ajusté
manuellement depuis le caméscope.

e Quand I'objectif Auto Iris est réglé sur
MANUAL, le diaphragme peut uniquement
étre ajusté grace a la bague d'objectif.
L'utilisation du diaphragme depuis le
caméscope n'a aucun effet.
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Réglages de mise au point pour les
objectifs avec commutateur de mise au
point

e Quand le commutateur de mise au point de
I'objectif est réglé sur AF/MF ou AF, la mise
au point est automatiquement ajustée et
peut également étre ajustée manuellement
depuis une télécommande.

Quand le commutateur de mise au point de
I'objectif est réglé sur MF, la mise au point
est ajustée a l'aide de la bague d'objectif et
peut également étre ajustée manuellement
depuis une télécommande.

[Remarque]

Lorsque vous utilisez un objectif a monture A, il se

peut que vous ne puissiez pas utiliser le réglage
manuel depuis une télécommande.

Quand le commutateur de mise au point
de I'objectif est réglé sur Full MF, la mise au
point peut uniquement étre ajustée grace a
la bague d'objectif. L'utilisation de la mise
au point depuis le caméscope n'a aucun
effet.

Fixation a un trépied

Utilisez les orifices de vis du trépied sur le
caméscope lorsque vous fixez un trépied.
Utiliser la monture pour trépied sur I'objectif
pourrait provoquer des dommages.

Objectifs anamorphiques

Lors de la prise de vue avec un objectif
anamorphique, consultez « Réglage de
I'affichage dé-squeeze » (page 54) pour

plus de détails sur la maniére de dé-squeezer
I'image de la sortie HDMI et la maniére de dé-
squeezer I'image dans le viseur de l'appareil.
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Configuration des opérations de base du caméscope

L'écran de réglages initiaux s'affiche dans le
viseur la premiére fois que le caméscope est
mis sous tension ou aprés le déchargement
total de la batterie de secours.

Réglez la date et I'heure de I'horloge interne
en utilisant cet écran.

Time Zone

La fonction Time Zone définit le décalage
horaire par rapport au temps universel.
Changez le réglage si nécessaire.

Réglage de la date et de I'heure

Utilisez le sélecteur multiple (page 7) ou

la molette multifonction (page 5) pour
sélectionner des éléments et des réglages,
puis appuyez sur la touche de mise en
application du sélecteur multiple ou la molette
multifonction pour appliquer les réglages et
lancer le fonctionnement de I'horloge.

Une fois que I'écran de réglages est fermé,
vous pouvez changer la date, I'heure et

le fuseau horaire a l'aide de Clock Set

(page 111) dans le menu Maintenance.

[Remarques]

Si le réglage d'horloge est perdu pour cause de
déchargement complet de la batterie de secours suite
a une longue déconnexion de I'alimentation (pas de
pack batterie et pas de source d'alimentation DC IN),
I'écran de réglages initiaux s‘affiche lors de la mise
sous tension suivante du caméscope.

Pendant que I'écran de réglages initiaux est affiché,
aucune autre opération n'est possible, sauf la

mise hors tension, jusqu’a ce que vous finissiez les
réglages sur cet écran.

Le caméscope posséde une batterie rechargeable
intégrée afin de stocker la date, I'heure et d'autres
réglages, méme lorsque le caméscope est éteint.

Avant la prise de vue, configurez les
opérations de base du caméscope dans I'écran
d'état Project pour les adapter a I'application.

59.94P FF Custom (709)
deo F
XAVC-| 3840x2160P

Off

Off

Mode de prise de vue

Vous pouvez commuter le mode de prise de
vue, entre « Custom » pour créer librement
des images sur place et « prises de vue Log
(Flexible 1SO, Cine El Quick, Cine El) » pour
lequel le caméscope fonctionne comme une
caméra de film, avec des images qui seront
développées en post-production.
Configurez le mode de prise de vue a I'aide de
Shooting Mode (page 15) sur I'écran d'état
Project.

[Conseil]

Vous pouvez également configurer le mode de prise
de vue a l'aide de Base Setting >Shooting Mode
(page 85) dans le menu Project du menu complet.

Custom

En mode de prise de vue Custom, vous pouvez

sélectionner la norme vidéo.

Vous pouvez configurer la norme vidéo a l'aide

de Base Setting >Target Display (page 85)

dans le menu Project du menu complet.

e SDR(BT.709) : prise de vue conforme a la
norme de diffusion HD

® HDR(HLG) : prise de vue conforme a la
norme de diffusion 4K nouvelle génération

Pour plus de détails, consultez page 56.

Modes de prise de vue Log (Cine El, Cine EI Quick, Flexible 1SO)

En modes de prises de vue Log, vous pouvez sélectionner la gamme de couleurs de base

pour les signaux enregistrés et les signaux de sortie. La gamme de couleurs sélectionnée ici

représente la gamme de couleurs de la sortie vidéo lorsque MLUT est réglé sur Off.

Vous pouvez configurer la gamme de couleurs a I'aide de Cine El/Flex.ISO Set >Color Gamut

(page 86) dans le menu Project du menu complet.

e S-Gamut3.Cine/SLog3 : gamme de couleurs facile a ajuster pour le mode de cinéma
numérique (DCI-P3).

e S-Gamut3/SLog3 : large gamme de couleurs Sony qui couvre la gamme de couleurs ITU-R
BT.2020.

Pour plus de détails, consultez « Prise de vue avec réglage d'apparence en post-production »

(page 58).

Il existe trois modes de prise de vue Log : Flexible ISO, Cine El et Cine El Quick.

e Flexible ISO : enregistre le contenu S-Log3 avec des réglages d'exposition reflétant la
sensibilité ISO correspondant a la scéne filmée.

e Cine El/Cine El Quick : enregistre le contenu S-Log3 a une sensibilité de base sélectionnée
(fixe), mais vous permet de modifier la distribution entre les zones claires et les zones sombres
a l'aide de Exposure Index. En mode de prise de vue Cine EI Quick, une sensibilité de base
adaptée au réglage Exposure Index est sélectionnée automatiquement.

[Remarque]

Lors de I'enregistrement en mode Cine El Quick ou Cine El, il est recommandé de maintenir le réglage Exposure Index

constant. Si vous modifiez le réglage Exposure Index, la correction de la luminosité peut étre trés difficile a réaliser en

post-production, ce qui peut rendre impossible la reproduction de I'état dans lequel I'image a été filmée a l'origine.

Les restrictions fonctionnelles pour chaque mode de prise de vue sont indiquées ci-dessous.
Oui : pris en charge
Non : non pris en charge

Elément Custom Prise de vue Log
Flexible ISO Cine El Quick Cine El
1SO/GAIN Oui Oui (IS0 Non Non
uniquement)
AGC Oui Oui Non Non
Base Sensitivity Oui Non Non Non
Base ISO Non Oui Oui (auto) Oui
Exposure Index Non Non Oui Oui
Auto Shutter Oui Oui Non Non
ATW Oui Oui Non Non
LUT On/Off Non Oui Oui Oui
Paint/Look (a I'exclusion de Oui Non Non Non
Base Look)
Codecs incluant RAW Non Oui Oui Oui
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Fréquence du systéme

Codec

Configurez la fréquence du systéme a l'aide
de Frequency/Scan (page 15) sur I'écran

d'état Project. Le caméscope peut redémarrer
automatiquement aprés avoir commuté, selon
la valeur sélectionnée.

[Conseil]

Vous pouvez également configurer la fréquence du
systéme a I'aide de Rec Format >Frequency (page 85)
dans le menu Project du menu complet.

[Remarque]
Vous ne pouvez pas commuter la fréquence du systéme
pendant I'enregistrement ou la lecture.

Mode de numérisation par
imageur

Vous pouvez régler la taille d'image effective

et la résolution du capteur d'image.

Configurez le mode de numérisation a l'aide

de Imager Scan (page 15) sur I'écran d'état

Project.

e FF : taille plein format.

e S35 : taille Super 35 mm.

[Conseil]

Vous pouvez également configurer le mode de

numérisation a I'aide de Rec Format >Imager Scan Mode

(page 85) dans le menu Project du menu complet.

[Remarques]

e \ous ne pouvez pas commuter le mode Imager Scan
pendant I'enregistrement ou la lecture.

e Lorsqu'il est réglé sur S35, le format vidéo est limité a
1920x1080.

Configurez le codec a l'aide de Codec
(page 15) sur I'écran d'état Project.

[Conseil]

Vous pouvez également configurer le codec a I'aide de
Rec Format >Codec (page 85) dans le menu Project

du menu complet.

[Remarque]
Vous ne pouvez pas commuter le codec pendant
I'enregistrement ou la lecture.

Format vidéo

Vous pouvez régler le format vidéo pour
I'enregistrement. Configurez le format vidéo a
I'aide de Video Format (page 15) sur I'écran
d'état Project.

[Conseil]

Vous pouvez également configurer le format vidéo a
I'aide de Rec Format >Video Format (page 85) dans le
menu Project du menu complet.

[Remarques]

* Vous ne pouvez pas commuter le format vidéo
pendant I'enregistrement ou la lecture.

Des restrictions peuvent s'appliquer au signal des
connecteurs SDI OUT et HDMI OUT, selon le réglage
du format vidéo.
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Utilisation de cartes mémoire

Ce caméscope permet d'effectuer des enregistrements audio et vidéo sur des cartes mémoire
CFexpress Type A (disponibles séparément) ou des cartes mémoire SDXC (disponibles
séparément) insérées dans les logements pour carte. Les cartes mémoire sont également
utilisées pour I'enregistrement proxy et stocker/charger des réglages, ainsi que lors de la mise a
niveau (mise a jour du logiciel).

A propos des cartes mémoire CFexpress Type A

Utilisez les cartes mémoire* Sony CFexpress Type A répertoriées dans « Support recommandé »
(page 27) dans le caméscope.

Pour plus de détails sur le fonctionnement avec des supports provenant d’autres fabricants,
reportez-vous au mode d'emploi du support ou consultez les informations du fabricant.

* Désignées sous le nom de « cartes CFexpress » dans ce document.

A propos des cartes mémoire SDXC

Utilisez les cartes mémoire* SDXC répertoriées dans « Support recommandé » (page 27) dans

le caméscope.
* Désignées sous le nom de « cartes SD » dans ce document.
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Support recommandé

Les conditions de fonctionnement garanti varient en fonction des réglages Rec Format et Recording.

Oui : Fonctionnement pris en charge
Non : Le fonctionnement normal n'est pas garanti

Format d'enregistrement CFexpress SDXC
Type A

VPG400 Class10 u1 u3 VsC VSsC VsC VSC
V10 V30 V60 Voo
RAW Out & 4096x2160 Mode normal 59.94P Oui Non Non Non Non Non Non Oui
XAVC-| Class300 50P Oui Non Non Non Non Non Non Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
24P Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Oui Oui
3840x2160 Mode normal 59.94P Oui Non Non Non Non Non Non Oui
Class300 50P Oui Non Non Non Non Non Non Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Oui Oui
S&Q (60fps ou moins) 59.94P Oui Non Non Non Non Non Non Oui
50P Oui Non Non Non Non Non Non Oui
29.97P Oui Non Non Non Non Non Non Oui
25P Oui Non Non Non Non Non Non Oui
23.98P Oui Non Non Non Non Non Non Oui
S&Q (100fps, 120fps) 59.94P Oui Non Non Non Non Non Non Non
50P Oui Non Non Non Non Non Non Non
29.97P Oui Non Non Non Non Non Non Non
25P Oui Non Non Non Non Non Non Non
23.98P Oui Non Non Non Non Non Non Non
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Format d'enregistrement CFexpress SDXC
Type A

VPG400 Class10 u1 u3 VsC VSsC VsC VSsC
V10 V30 V60 Vo0
XAVC-| 4096x2160 Mode normal 59.94P Oui Non Non Non Non Non Non Oui
Class300 50P Oui Non Non Non Non Non Non Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
24pP Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Oui Oui
S&Q (60fps ou moins) 59.94P Oui Non Non Non Non Non Non Oui
50P Oui Non Non Non Non Non Non Oui
29.97P Oui Non Non Non Non Non Non Oui
25P Oui Non Non Non Non Non Non Oui
24P Oui Non Non Non Non Non Non Oui
23.98P Oui Non Non Non Non Non Non Oui
3840x2160 Mode normal 59.94P Oui Non Non Non Non Non Non Oui
Class300 50P Oui Non Non Non Non Non Non Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Oui Oui
S&Q (60fps ou moins) 59.94P Oui Non Non Non Non Non Non Oui
50P Oui Non Non Non Non Non Non Oui
29.97P Oui Non Non Non Non Non Non Oui
25P Oui Non Non Non Non Non Non Oui
23.98P Oui Non Non Non Non Non Non Oui
S&Q (100fps, 120fps) 59.94P Oui Non Non Non Non Non Non Non
50P Oui Non Non Non Non Non Non Non
29.97P Oui Non Non Non Non Non Non Non
25P Oui Non Non Non Non Non Non Non
23.98P Oui Non Non Non Non Non Non Non
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Format d'enregistrement CFexpress SDXC
Type A
VPG400 Class10 u1 u3 VsC VSsC VsC VSsC
V10 V30 V60 Vo0
XAVC-| 1920x1080 Mode normal 59.94P Oui Non Non Non Non Non Oui Oui
Class100 50P Oui Non Non Non Non Non Oui Oui
29.97P Oui Non Non Oui Non Oui Oui Oui
25P Oui Non Non Oui Non Oui Oui Oui
23.98P Oui Non Non Oui Non Oui Oui Oui
S&Q (60fps ou moins) 59.94P Oui Non Non Non Non Non Oui Oui
50P Oui Non Non Non Non Non Oui Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Oui Oui
S&Q (100fps, 120fps) 59.94P Oui Non Non Non Non Non Non Oui
50P Oui Non Non Non Non Non Non Oui
29.97P Oui Non Non Non Non Non Non Oui
25P Oui Non Non Non Non Non Non Oui
23.98P Oui Non Non Non Non Non Non Oui
S&Q (150fps, 180fps) 59.94P Oui Non Non Non Non Non Non Non
50P Oui Non Non Non Non Non Non Non
29.97P Oui Non Non Non Non Non Non Non
25P Oui Non Non Non Non Non Non Non
23.98P Oui Non Non Non Non Non Non Non
S&Q (200fps, 240fps) 59.94P Oui Non Non Non Non Non Non Non
50P Oui Non Non Non Non Non Non Non
29.97P Oui Non Non Non Non Non Non Non
25P Oui Non Non Non Non Non Non Non
23.98P Oui Non Non Non Non Non Non Non
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Format d'enregistrement CFexpress SDXC
Type A

VPG400 Class10 u1 u3 VsC VSsC VsC VSsC
V10 V30 V60 Vo0
XAVC-L 3840%2160 Mode normal 59.94P Oui Non Non Oui Non Oui Oui Oui
420 50P Oui Non Non oui Non Oui Oui Oui
29.97P Oui Non Non Oui Non Oui Oui Oui
25P Oui Non Non Oui Non Oui Oui Oui
23.98P Oui Non Non Oui Non Oui Oui Oui
S&Q (60fps ou moins) 59.94P Oui Non Non Oui Non Oui Oui Oui
50P Oui Non Non Oui Non Oui Oui Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Non Oui
S&Q (100fps, 120fps) 59.94P Oui Non Non Non Non Non Oui Oui
50P Oui Non Non Non Non Non Oui Oui
29.97P Oui Non Non Non Non Non Non Oui
25P Oui Non Non Non Non Non Non Oui
23.98P Oui Non Non Non Non Non Non Non
19201080 Mode normal 59.94P Oui Non Non Oui Non Oui Oui Oui
HD50 50P Oui Non Non Oui Non Oui Oui Oui
29.97P Oui Non Non Oui Non Oui Oui Oui
25P Oui Non Non Oui Non Oui Oui Oui
23.98P Oui Non Non Oui Non Oui Oui Oui
S&Q (60fps ou moins) 59.94P Oui Oui Oui Oui Oui Oui Oui Oui
50P Oui Oui Oui Oui Oui Oui Oui Oui
29.97P Oui Non Non Oui Non Oui Oui Oui
25P Oui Non Non Oui Non Oui Oui Oui
23.98P Oui Non Non Oui Non Oui Oui Oui
S&Q (100fps, 120fps) 59.94P Oui Non Non Oui Non Oui Oui Oui
50P Oui Non Non Oui Non Oui Oui Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Oui Oui
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Format d'enregistrement CFexpress SDXC
Type A

VPG400 Class10 u1 u3 VsC VSsC VsC VSsC
V10 V30 V60 Vo0
XAVC-L 1920x1080 S&Q (150fps, 180fps) 59.94P Oui Non Non Non Non Non Oui Oui
HD50 50P Oui Non Non Non Non Non Oui Oui
29.97P Oui Non Non Non Non Non Non Oui
25P Oui Non Non Non Non Non Non Oui
23.98P Oui Non Non Non Non Non Non Oui
S&Q (200fps, 240fps) 59.94P Oui Non Non Non Non Non Oui Oui
50P Oui Non Non Non Non Non Oui Oui
29.97P Oui Non Non Non Non Non Non Oui
25P Oui Non Non Non Non Non Non Oui
23.98P Oui Non Non Non Non Non Non Oui
1920x1080 Mode normal 59.94P Oui Oui Oui Oui Oui Oui Oui Oui
HD35 50P Oui Oui Oui Oui Oui Oui Oui Oui
29.97P Oui Oui Oui Oui Oui Oui Oui Oui
25P Oui Oui Oui Oui Oui Oui Oui Oui
23.98P Oui Oui Oui Oui Oui Oui Oui Oui
S&Q (60fps ou moins) 59.94P Oui Oui Oui Oui Oui Oui Oui Oui
50P Oui Oui Oui Oui Oui Oui Oui Oui
29.97P Oui Non Non Oui Non Oui Oui Oui
25P Oui Non Non Oui Non Oui Oui Oui
23.98P Oui Non Non Oui Non Oui Oui Oui
S&Q (100fps, 120fps) 59.94P Oui Non Non Oui Non Oui Oui Oui
50P Oui Non Non Oui Non Oui Oui Oui
29.97P Oui Non Non Oui Non Oui Oui Oui
25P Oui Non Non Oui Non Oui Oui Oui
23.98P Oui Non Non Non Non Non Oui Oui
S&Q (150fps, 180fps) 59.94P Oui Non Non Oui Non Oui Oui Oui
50P Oui Non Non Oui Non Oui Oui Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Oui Oui
S&Q (200fps, 240fps) 59.94P Oui Non Non Oui Non Oui Oui Oui
50P Oui Non Non Oui Non Oui Oui Oui
29.97P Oui Non Non Non Non Non Oui Oui
25P Oui Non Non Non Non Non Oui Oui
23.98P Oui Non Non Non Non Non Non Oui
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Insertion d'une carte mémoire

1 Ouvrez le cache du support de la section
de logements pour carte.

2 Insérez une carte mémoire.
® Pour les cartes CFexpress, I'étiquette est
orientée vers la gauche.

[
&
;

—

Etiquette
® Pour les cartes SD, I'étiquette est
orientée vers la droite, avec le coin
biseauté en bas.

Coin biseauté
L'indicateur d'accés (page 6) est
allumé en rouge, puis passe au vert si la
carte est utilisable.

[Remarque]

Si I'indicateur d'accés clignote en rouge en continu
et ne passe pas au vert, éteignez temporairement
le caméscope, puis retirez et réinsérez la carte
mémoire.

3 Fermez le cache du support.

[Remarques]

* La carte mémoire, le logement de carte mémoire et
les données d'images sur la carte mémoire peuvent
étre endommagés si la carte est enfoncée de force
dans le logement dans le mauvais sens.

Lorsque vous enregistrez sur des supports situés
dans les logements de carte CFexpress Type A/SD A
et B, insérez dans ces deux logements des supports
recommandés pour |'utilisation avec le format
d’enregistrement.

Formatage (initialisation) de cartes
mémoire

Ejection d’une carte mémoire

Ouvrez le cache du support de la section de
logements pour carte et appuyez légérement
sur la carte mémoire pour I'éjecter.

[Remarques]

e Sile caméscope est arrété ou la carte mémoire
enlevée pendant que le systéme accede a la carte
mémoire, I'intégrité des données sur la carte ne peut
pas étre garantie. Toutes les données enregistrées
sur la carte peuvent étre supprimées. Assurez-vous
toujours que I'indicateur d’accés est vert ou éteint
avant d'arréter le caméscope ou d’enlever la carte
mémoire.

Si une carte mémoire est retirée immédiatement
apres I'enregistrement, elle peut étre chaude, mais
cela n'indique pas un probleme.

Si une carte mémoire non formatée ou

une carte mémoire formatée selon une
spécification différente est insérée, le message
« Media Needs to be Formatted » s'affiche
dans le viseur.

Formatez la carte en utilisant la procédure
suivante.

1 Sélectionnez Format Media (page 97)
dans le menu TC/Media du menu
complet.

2 Sélectionnez Media(A) (logement A) ou
Media(B) (logement B), puis sélectionnez
la méthode de formatage (Full Format ou
Quick Format).

Un message de confirmation apparait.

e Full Format : initialise complétement le
support, y compris la zone des données
et les informations de gestion des
données.

® Quick Format : initialise uniquement les
informations de gestion des données du
support.

[Remarque]

Si la carte mémoire a formater contient des fichiers

a transférer, un message supplémentaire (exemple

d'affichage : « Un fichier cible de transfert existe »)

apparait sous le message de confirmation. Dans

ce cas, confirmez l'initialisation ou non de la carte

mémoire et exécutez ou annulez I'initialisation.

3 Sélectionnez Execute.
Un message s'affiche pendant le
formatage et le voyant d'acces est allumé
en rouge.
Une fois le formatage terminé, un
message indiquant la fin de I'opération
s'affiche. Appuyez sur la molette
multifonction pour ignorer le message.

[Remarques]

Le formatage d’une carte mémoire efface toutes les
données, y compris les données vidéo et les fichiers
de configuration enregistrés.

Des messages peuvent apparaitre pendant
I'exécution selon la durée du processus de formatage.

En cas d'échec du formatage

Les cartes mémoire non prises en charge par
le caméscope ne peuvent pas étre formatées.
Un message d'avertissement est affiché.
Suivez les instructions pour remplacer la carte
par une carte mémoire prise en charge.

Pour utiliser une carte formatée sur le
caméscope dans la fente d'un autre
dispositif

Effectuez d’abord une copie de sauvegarde

de la carte, puis reformatez la carte dans le
dispositif a utiliser.

Vérification de la durée
d'enregistrement restante

Lors d’une prise de vue (enregistrement/
veille), vous pouvez surveiller la capacité
restante de la carte mémoire dans chacun des
logements a I'aide des indicateurs de capacité
restante du support des logements A/B dans
le viseur (page 11).

Le temps d’'enregistrement restant est calculé
a partir de la capacité restante du support de
chaque logement et du format vidéo actuel
(débit binaire d’enregistrement) et est affiché
en unités de minutes.
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Synchronisation de remplacement de
carte mémoire

e Quand le temps d'enregistrement total
restant sur les deux cartes mémoire
devient inférieur a 5 minutes, le message

« Media Near Full » s'affiche, le témoin
d'enregistrement/de signalisation
commence a clignoter et un signal sonore
(émis a partir de la sortie casque) vous
avertit.

Remplacez les cartes par un support ayant
de I'espace libre.

Si vous continuez d'enregistrer jusqu’a ce
que le temps total d’enregistrement restant
atteigne 0, le message passe a « Media Full »
et I'enregistrement s'arréte.

[Remarque]
Un maximum de 600 plans environ peut étre enregistré
sur une carte mémoire.

Restauration de cartes mémoire

Si, pour quelque raison que ce soit, une erreur
se produit dans une carte mémoire, celle-ci
doit étre restaurée avant I'utilisation.

Lorsque vous insérez une carte mémoire qui
doit étre restaurée, un message apparait sur
I'écran LCD/du viseur pour vous demander si
vous souhaitez effectuer la restauration.

Restauration d'une carte

Tournez la molette multifonction (page 5)
pour sélectionner Execute, puis appuyez sur la
molette multifonction.

Un message et I'état de progression

(%) s'affichent pendant le formatage et
I'indicateur d'accés est allumé en rouge.

A la fin de la restauration, un message
indiquant la fin de I'opération s'affiche.

En cas d'échec de la restauration

Les cartes mémoire sur lesquelles des
erreurs de mémoire se sont produites ne
peuvent pas étre restaurées. Un message
d'avertissement est affiché. Suivez les
instructions pour remplacer la carte
mémoire.

Les cartes mémoire sur lesquelles des
erreurs de mémoire se sont produites
peuvent étre utilisables si vous les
reformatez.

Dans certains cas, certains plans peuvent
étre restaurés et d'autres non. Les plans
restaurés peuvent étre lus normalement.

[Remarques]

Pour la restauration du support enregistré sur ce
caméscope, assurez-vous d'utiliser ce caméscope.

Il se peut qu'un support enregistré avec un dispositif
autre que ce caméscope ou avec un autre cameéscope
d'une version différente (méme du méme modele) ne
soit pas restauré a l'aide de ce caméscope.

Les plans de moins de 2 secondes ne peuvent pas
@étre restaurés.
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Procédure d'opération de base

La prise de vue de base s'effectue a l'aide de
la procédure suivante.

1 Connectez les dispositifs nécessaires et
vérifiez que I'alimentation est branchée.

2 Insérez la/les carte(s) mémoire.

3 Réglez le commutateur POWER sur on.
L'indicateur POWER s'allume et I'image de
la caméra apparait sur le viseur.

4 Appuyez sur la touche d'enregistrement
START/STOP (page 5).
Le témoin d'enregistrement/de
signalisation s'allume et I'enregistrement
commence.

5 Pour arréter I'enregistrement, appuyez a
nouveau sur la touche d’enregistrement
START/STOP.

L'enregistrement s'arréte et le caméscope
passe au mode STBY (veille).

[Remarque]

Si la touche d'enregistrement START/STOP est actionnée
dans les quelques secondes suivant la mise sous
tension du caméscope, le témoin d’enregistrement/

de signalisation s'allume pour indiquer que I'unité est
en état d'enregistrement, mais I'enregistrement sur le
support peut ne pas se déclencher pour les premiéres
secondes, en fonction du format d'enregistrement
sélectionné.

Sélection alternative des cartes
mémoire

Lorsque deux cartes mémoire sont chargées,
appuyez sur la touche SLOT SELECT

(page 6) pour passer d'une carte a l'autre.
L'enregistrement passe automatiqguement

a la seconde carte mémoire juste avant que
la capacité restante sur la premiére carte
atteigne zéro (enregistrement relais). Lorsque
vous basculez d'une carte mémoire a l'autre,
vous pouvez poursuivre I'enregistrement
continu en remplagant la carte mémoire pleine
par une nouvelle.

[Remarques]

Vous ne pouvez pas passer d'une carte mémoire
al'autre en mode de lecture. En outre, la lecture
continue d'un plan situé sur plusieurs supports dans
la fente A et la fente B n'est pas prise en charge.
Lorsqu’une carte mémoire enregistrable est insérée
dans le second logement de carte mémoire et si
seules les données proxy sont enregistrées sur cette
carte, les cartes mémoire ne passeront pas de |'une
alautre.

Plans (données enregistrées)

Quand vous cessez I'enregistrement, la vidéo,
I'audio et les données correspondantes

du début a la fin de I'enregistrement sont
sauvegardés sous forme de « plan » unique
sur une carte mémoire.

Noms de plans

Le nom de chaque plan enregistré avec le
caméscope est attribué automatiquement a
I'aide du format réglé sous Clip Name Format
(page 96) du menu TC/Media du menu
complet.

Durée maximum d'un plan

Jusqu'a 6 heures par plan.

La durée maximum d’un enregistrement
continu est identique a la durée maximum
d’un plan. Si la durée d'enregistrement
dépasse la durée maximum d’'un plan, un
nouveau plan est créé automatiquement et
I'enregistrement se poursuit. Le nouveau plan
apparait comme un plan séparé sur I'écran des
miniatures.

Les plans multiples sont enregistrés
successivement pendant I'enregistrement
relais, mais I'enregistrement s'arréte
automatiquement apres environ 24 heures.

[Remarques]

e N'éjectez pas une carte mémoire pendant que des
données y sont en cours d'enregistrement. Lors de
I'enregistrement, remplacez uniquement les cartes
mémoire des logements pour lesquels I'indicateur
d'accés de logement est éteint.

Quand la capacité restante sur la carte mémoire en
cours d'enregistrement descend au-dessous d'une
minute et qu’une carte mémoire enregistrable est
insérée dans I'autre logement, un message « Will
Switch Slots Soon » saffiche. Le message disparait
apres I'échange de logement de carte mémoire.
L'enregistrement relais peut ne pas fonctionner

si I'enregistrement est lancé alors que la capacité
restante de la carte mémoire est inférieure a une
minute. Pour un enregistrement relais correct,
vérifiez que la capacité restante de la carte mémoire
est supérieure a une minute avant de commencer
I'enregistrement.

La vidéo créée a l'aide de la fonction d'enregistrement
relais du caméscope ne peut pas étre lue sans
probléme sur le caméscope.

Pour combiner la vidéo créée en utilisant la fonction
d'enregistrement relais du caméscope, utilisez le
logiciel « Catalyst Browse ».

Surveillance de l'audio

Vous pouvez surveiller I'audio en cours
d’enregistrement grace au casque.

En connectant un casque sur la prise casque
(page 5), vous pourrez surveiller I'audio

qui est en cours d’enregistrement.

Vous pouvez également surveiller I'audio

lu (page 70) en utilisant le haut-parleur
intégré (page 6) ou le casque.

Vous pouvez régler le volume de l'audio a
surveiller a l'aide de Volume (page 14)

sur I'écran d'état Audio ou de Audio Output
>Volume (page 102) dans le menu Audio du
menu complet.

Vous pouvez sélectionner le canal a surveiller
a l'aide de Monitor CH (page 14) sur I'écran
d'état Audio ou de Audio Output >Monitor CH
(page 102) dans le menu Audio du menu
complet.

Spécification des données
temporelles

Réglage du code temporel

Réglez le code temporel pour enregistrer en
utilisant Timecode (page 95) dans le menu
TC/Media du menu complet.

Réglage des bits utilisateur

Vous pouvez ajouter un nombre hexadécimal
a 8 chiffres a I'image enregistrée en tant que
bits utilisateur. Vous pouvez également régler
les bits utilisateur sur I'heure actuelle. Réglez
a 'aide de Users Bit (page 95) dans le menu
TC/Media.
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Affichage des données temporelles

Réglez le code temporel a afficher a I'aide de
TC Display (page 95) >Display Select dans le
menu TC/Media.

L'activation d'une touche personnalisable
(page 49) a laquelle DURATION/TC/U-BIT

est assigné commute I'affichage entre le code
temporel, les bits d'utilisateur et la durée, dans
I'ordre.

Commutation de I'entrée/sortie de code
temporel

Vous pouvez commuter I'entrée/la sortie de
code temporel en utilisant le commutateur de
sélection TC IN/OUT (page 4).

Pour plus de détails, consultez page 122.

Passage en revue de
I'enregistrement (Rec Review)

Vous pouvez revoir le dernier plan enregistré
sur I'écran (révision d’enregistrement).
[Remarque]

Rec Review n'est pas pris en charge si le format vidéo
est modifié aprés I'enregistrement d’un plan.

Méthode de révision d'enregistrement

Attribuez au préalable Rec Review a I'une des
touches personnalisables.

Quand I'enregistrement est arrété, appuyez
sur la touche personnalisable (page 49) a
laquelle Rec Review est assigné. La lecture du
dernier plan enregistré commence.

Le plan est lu jusqu’a la fin, Rec Review prend
fin et le caméscope revient en mode STBY
(veille).

Pour arréter Rec Review

Pressez la touche personnalisable a laquelle
Rec Review est attribué ou pressez la touche
CANCEL/BACK.

Réglages de la révision
d'enregistrement

Vous pouvez configurer la position de départ
de la lecture sur I'un des paramétres suivants
a l'aide du réglage Rec Review (page 104) du
menu Technical.

e Les 3 derniéres secondes du plan

e Les 10 derniéres secondes du plan

e Début du plan

[Conseil]

Si vous souhaitez examiner un plan spécifique apres
avoir enregistré plusieurs plans, appuyez sur la touche
THUMBNAIL pour afficher I'écran des miniatures et
sélectionnez le plan pour lancer la lecture.
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Réglage du zoom

Vous pouvez régler le zoom selon les
conditions de prise de vue.

Lorsqu‘un objectif zoom motorisé est fixé,

vous pouvez régler le zoom a I'aide du levier

de zoom sur la télécommande de grip ou la

poignée. La vitesse du zoom varie selon la

pression appliquée au levier.

Le caméscope est équipé d'une fonction

de zoom qui utilise un traitement de signal

d'image appelé Clear Image Zoom. Lorsque

Clear Image Zoom est activé, le zoom est pris

en charge méme pour des objectifs a distance

focale fixe (c’est-a-dire a focale fixe). Vous

pouvez aussi l'utiliser pour étendre la plage

au-dela de la plage optique sur un objectif

zoom motorisé.

Le rapport de zoom maximal avec Clear

Image Zoom varie selon la résolution

d’enregistrement.

e Pour la résolution d’enregistrement
QFHD/4K :1,5x

® Pour la résolution d'enregistrement HD : 2x

Sélection du type de zoom

Configurez le type de zoom a I'aide de Zoom
>Zoom Type (page 104) dans le menu
Technical du menu complet.

Le type de zoom peut varier selon le type de
I'objectif utilisé.

Objectif ~ Réglage du Zoom Type

utilisé Optical Zoom  On(Clear Image
Only Zoom)

Zoom a L'utilisation du Clear Image

focale zoom a l'aide du Zoom est pris en

fixe/ levier n'est pas  charge.

Objectifa prise en charge.

zoom

manuel

Objectif ~ Réglage du Zoom Type

utilisé Optical Zoom  On(Clear Image
Only Zoom)

Objectif Zoom optique Zoom optique et

zoom seulement Clear Image

motorisé Zoom sont pris

en charge.
[Remarques]

e Clear Image Zoom n'est pas disponible dans les cas
suivants.
- Lorsque S&Q Motion >Frame Rate (page 83)
dans le menu Shooting du menu complet est de
plus de 60fps
- Lorsque Rec Format >Codec (page 85) du menu
Project du menu complet est configuré sur RAW ou
sur une option incluant RAW.
L'utilisation du commutateur de sélection SERVO/
MANUAL sur un objectif réinitialise 'agrandissement
de Clear Image Zoom sur 1x.
Lorsque la mise au point automatique par pression
(AF-S) est exécutée pendant I'opération Clear Image
Zoom, l'opération AF donne la priorité a la zone située
au centre de I'écran.

Réglage du zoom de la poignée

Configurez le zoom de la poignée a l'aide
de Handle Zoom (page 105) dans le menu
Technical du menu complet.

Réglage du sens de la bague de
zoom

Sur certains objectifs a monture E, le sens

de rotation de la bague de zoom peut étre
inversé.

Configurez le sens de rotation a l'aide de Lens
>Zoom Ring Direction (page 105) dans le
menu Technical du menu complet.
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Réglage de la mise au point

Vous pouvez régler automatiquement ou
manuellement la mise au point, selon les
conditions de prise de vue.

Réglage manuel de la mise au
point (Manual Focus)

Pour ajuster manuellement la mise au point,

réglez le commutateur FOCUS (page 4) sur

« MAN »,

Ceci vous permet d'ajuster manuellement la

mise au point en fonction des conditions de

prise de vue.

La mise au point manuelle est utile pour les

types suivants de sujets.

® Sujets de I'autre c6té d'une fenétre couverte
de gouttelettes d'eau

e Sujets avec un contraste faible par rapport a
I'arriere-plan

e Sujets plus éloignés que les sujets proches

[Conseil]

Vous pouvez aussi utiliser la mise au point automatique

dans les cas suivants lorsque le réglage manuel est la

méthode principale d'utilisation.

e Lorsque la sensibilité de changement de sujet AF est

réglée sur 1(Locked)

Lorsque le commutateur FOCUS est réglé sur la

position « AF »

Lorsque vous utilisez la bague de mise au point (AF

Assist, page 40)

Mise au point a l'aide d'une opération
tactile (Spot Focus)

En mode de mise au point manuelle, vous
pouvez spécifier la position ou vous voulez
régler la mise au point par une opération
tactile.

Pour utiliser la mise au point sur un point,
réglez Focus >Touch Function in MF

(page 83) dans le menu Shooting sur Spot
Focus.

Un repére de mise au point sur un point
s'affiche lorsque vous appuyez sur la position
ol vous voulez régler la mise au point.

AF

[Conseils]

o En mode de mise au point sur un point, vous

pouvez appuyer sur une touche personnalisable
(page 49) attribuée avec Push AF/Push MF pour
arréter temporairement la mise au point sur un point
et activer la mise au point automatique pendant que
la touche est enfoncée. La mise au point repasse en
mode manuel quand vous reldchez la touche.

La fonction mise au point sur un point ne fonctionne
pas si l'objectif est réglé pour la mise au point
manuelle.

La fonction mise au point sur un point ne fonctionne
pas lorsque 1.3x ou 2.0x est sélectionné dans De-
Squeeze (page 98) dans le menu Monitoring du
menu complet.

La position de mise au point sur un point ne peut
pas étre spécifiée pendant que la mise au point est
agrandie ou lorsque Touch Operation (page 104)
dans le menu Technical est réglé sur Off.

Utilisation temporaire de la mise au
point automatique (Push Auto Focus
(AF))

Lorsque Focus >Push AF Mode (page 83)
dans le menu Shooting du menu complet
est réglé sur AF, appuyez sur la touche PUSH
AUTO FOCUS (page 4) pendant la mise

au point manuelle pour effectuer la mise au
point automatiquement alors que la touche
est enfoncée.

La mise au point s'effectue dans la zone de
mise au point définie a I'aide de Focus >Focus
Area (page 83) dans le menu Shooting du
menu complet.

La mise au point repasse en mode manuel
quand vous relachez la touche.

Ceci est utile lorsque vous voulez régler
lentement la mise au point d'un sujet a un
autre lors de la mise au point manuelle.

[Conseil]

La méme opération est possible avec une touche
personnalisable (page 49) a laquelle vous avez
attribué Push AF/Push MF.

[Remarques]

La fonction Push Auto Focus ne fonctionne pas si
I'objectif est réglé pour la mise au point manuelle.

La fonction Push Auto Focus ne fonctionne pas
lorsque 1.3x ou 2.0x est sélectionné dans De-Squeeze
(page 98) dans le menu Monitoring du menu
complet.

Utilisation de la mise au point
automatique a prise de vue unique
(Push Auto Focus (AF-S))

Réglez Focus >Push AF Mode (page 83)

dans le menu Shooting du menu complet

sur Single-shot AF(AF-S), puis réglez la zone
de mise au point a I'aide de Focus >Focus
Area(AF-S) (page 83) dans le menu

Shooting du menu complet.

Appuyez sur la touche PUSH AUTO FOCUS

en mode de mise au point manuelle pour
effectuer automatiquement la mise au point a
vitesse élevée. La mise au point cesse dés que
vous relachez la touche.

L'indicateur de mise au point vous informe sur
I'état de la mise au point.

e On :la mise au point reste sur la position de
mise au point.

Clignotant : pas de mise au point. Puisque
la mise au point n'est pas automatique,
modifiez les réglages de composition et de
mise au point pour réaliser la mise au point.
La mise au point repasse en mode manuel
quand vous relachez la touche.

Cela est utile lorsque vous voulez faire
rapidement la mise au point sur un sujet avant
de lancer une prise de vue.

[Conseils]

e La méme opération est possible avec une touche
personnalisable (page 49) a laquelle vous avez
attribué Push AF/Push MF.

Vous pouvez également attribuer Push AF Mode a
une touche personnalisable (page 49).

Vous pouvez également attribuer Focus Area(AF-S) a
une touche personnalisable (page 49).

Vous pouvez afficher/masquer le cadre de la zone de
mise au point a I'aide de Display On/Off >Focus Area
Ind.(AF-S) (page 98) dans le menu Monitoring du
menu complet.

Pendant I'agrandissement de la mise au point, la mise
au point se régle pour correspondre a la position
d‘affichage agrandie.

[Remarques]

* La fonction Push Auto Focus ne fonctionne pas si
I'objectif est réglé pour la mise au point manuelle.

Le cadre de la zone de mise au point n'est pas
masqué lorsque vous utilisez la touche DISPLAY.
Pendant I'opération Clear Image Zoom, la position du
cadre de Focus Area(AF-S) ne peut pas étre définie.
Pendant I'opération Push AF-S, I'opération AF donne
également la priorité a la partie centrale.

La fonction Push Auto Focus ne fonctionne pas
lorsque 1.3x ou 2.0x est sélectionné dans De-Squeeze
(page 98) dans le menu Monitoring du menu
complet.

Mise au point a l'aide de
I'agrandissement de la vue (Focus
Magpnifier)

Par défaut, la fonction Focus Magnifier x3/x6
est affectée a la touche ASSIGN 4 sur la
télécommande du grip et a la touche ASSIGN 7
sur la poignée (page 49).

Appuyez sur la touche ASSIGN 4 ou la touche
ASSIGN 7 pour faire passer le viseur a I'écran
d’agrandissement de la mise au point, avec

le centre agrandi environ trois fois. Appuyez
de nouveau sur la touche pour augmenter
I'agrandissement jusqu’a environ six fois. Cette
fonction est utile pour vérifier la mise au point.
Appuyez de nouveau sur la touche pour
revenir a I'écran normal.

Vous pouvez déplacer la position a élargir
pendant I'agrandissement de la mise au point
al'aide du sélecteur multiple (page 7).
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Appuyez sur le sélecteur multiple pour revenir
au centre de I'image.

Lorsque vous utilisez la mise au point
automatique par pression (AF) lors de
I'agrandissement de la mise au point, la mise
au point se produit dans la zone de mise au
point définie a I'aide de Focus >Focus Area
(page 83) dans le menu Shooting du menu
complet.

Si vous utilisez la mise au point automatique
par pression (AF-S) pendant I'agrandissement
de la mise au point, la mise au point se régle
pour correspondre a la position d'affichage
agrandie.

[Remarques]

L'image enregistrée ou I'image de sortie SDI/HDMI
n'est pas agrandie lorsque la mise au point est
agrandie.

Pendant I'agrandissement de la mise au point,

la touche MENU et les autres opérations sont
désactivées.

La position agrandie revient au centre de I'écran
lorsque le caméscope est mis hors tension.

Réglage automatique de la mise
au point (Auto Focus)

Le caméscope utilise I'AF a détection de phase
pour une mise au point ultra rapide et I'AF de
contraste pour une mise au point ultra précise.
La combinaison de ces deux méthodes AF
permet une mise au point automatique a
vitesse rapide et haute précision.

Pour ajuster automatiquement la mise

au point, réglez le commutateur FOCUS

(page 4) du caméscope sur « AUTO ».

Si I'objectif est pourvu d'un commutateur

de sélection de mise au point, réglez le
commutateur sur la position « AF/MF » ou

« AF », Si le commutateur est réglé sur la
position « Full MF » ou « MF », la mise au point
de l'objectif ne peut pas étre réalisée depuis le
caméscope (page 23).

[Conseil]

Lorsque vous réglez Focus >AF Assist (page 83) sur
On dans le menu Shooting du menu complet, vous
pouvez encore utiliser la bague de mise au point de
I'objectif pendant la mise au point automatique pour
régler la mise au point.

[Remarques]

Un objectif prenant en charge la mise au point
automatique est requis.

Vous risquez de ne pas obtenir une bonne précision
selon les conditions de prise de vue.

La mise au point ne peut pas étre ajustée
automatiquement sur un objectif & monture A.
La mise au point automatique ne peut pas étre
utilisée lorsque De-Squeeze >Ratio (HDMI/VF)
(page 98) est réglé sur une valeur autre que
Off(1.0x) dans le menu Monitoring.

Réglage de la zone/position de mise au
point automatique (Focus Area)

Vous pouvez régler la zone cible pour la
mise au point automatique en utilisant Focus
>Focus Area (page 83) dans le menu
Shooting du menu complet.

Flexible Spot :

Effectue la mise au point sur une position
spécifique dans I'image.

Lorsque vous sélectionnez ce réglage,
spécifiez la position a I'aide du sélecteur
multiple (page 7).

Vous pouvez revenir a la position centrale en
maintenant enfoncé le sélecteur multiple.

AF
ron
I

Zone:

Recherche automatiquement une position de
mise au point dans la zone spécifiée.

Lorsque vous sélectionnez ce réglage,
spécifiez la position a l'aide du sélecteur
multiple (page 7).

Vous pouvez revenir a la position centrale en
maintenant enfoncé le sélecteur multiple.

AF
- A
L J
Wide :

Recherche un sujet dans un grand angle
de I'image lors de la mise au point. Aucune
image ne s'affiche.

AF

[Conseil]

La méme opération est possible avec une touche
personnalisable (page 49) a laquelle vous avez
attribué Focus Area.

Vous pouvez afficher/masquer le cadre de la zone de
mise au point a I'aide de Display On/Off >Focus Area
Indicator (page 98) dans le menu Monitoring du
menu complet.

[Remarque]
Le cadre de la zone de mise au point n'est pas masqué
lorsque vous utilisez la touche DISPLAY.

Modification rapide de la zone de mise
au point (Focus Setting)

Vous pouvez changer rapidement la
position et la taille de la zone de mise au
point automatique lors de la prise de vue
en attribuant Focus Setting a une touche
personnalisable (page 49).

L'opération varie selon le réglage de la zone
de mise au point.

Lorsque Focus >Focus Area (page 83) du
menu Shooting du menu complet est réglé

sur Flexible Spot ou Zone

Vous pouvez modifier la position de la zone
de mise au point en appuyant sur la touche
personnalisable a laquelle vous avez attribué
Focus Setting et en réglant a I'aide du
sélecteur multiple (page 7).

Vous pouvez restaurer la position de la zone
de mise au point au centre lorsque vous
réglez la position en appuyant sur le sélecteur
multiple.

Vous pouvez modifier la taille de la zone de
mise au point en maintenant enfoncée la
touche personnalisable a laquelle vous avez
attribué Focus Setting.

Apres avoir modifié la taille, définissez la
position de la zone de mise au point en
appuyant sur le sélecteur multiple.

Lorsque vous avez terminé, appuyez sur la
touche personnalisable a laquelle vous avez
attribué Focus Setting pour revenir a I'écran
d'origine.

Lorsque Focus >Focus Area (page 83) du
menu Shooting du menu complet est réglé

sur Wide

Vous pouvez uniquement modifier la taille

de la zone de mise au point en maintenant
enfoncée la touche personnalisable a laquelle
vous avez attribué Focus Setting. Vous pouvez
aussi changer la position en modifiant d'abord
le type sur Flexible Spot ou Zone.

[Conseils]

Lorsque Focus >Push AF Mode (page 83) dans

le menu Shooting du menu complet est réglé sur
Single-shot AF(AF-S) et que le commutateur FOCUS
(page 4) est en position MF, vous pouvez modifier
la position de la zone de mise au point Focus
Area(AF-S) (page 83).

Le cadre de la zone de mise au point est affiché en
orange lorsque la position de la zone de mise au
point peut étre modifiée.
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Déplacement du cadre de la zone de
mise au point a I'aide des opérations
tactiles (zone de mise au point tactile)

Vous pouvez modifier la position de la zone
de mise au point en appuyant sur une touche
personnalisable (page 49) a laquelle vous
avez attribué Focus Setting pour faire passer
I'affichage de la zone de mise au point en
orange, puis la déplacer par opération tactile.
Touchez I'écran pour déplacer la zone de
mise au point, avec la zone de mise au point
centrée sur la position touchée. Faites glisser
sur I'écran pour déplacer la zone de mise

au point a la position tracée par votre doigt
(page 10).

[Conseil]

Vous pouvez activer/désactiver I'opération de mise au
point tactile sur I'écran de prise de vue a l'aide de la
touche personnalisable a laquelle vous avez attribué
Focus Setting.

Toucher n'importe quelle position
oo
L 4

La zone de mise au point se déplace, avec la
zone de mise au point centrée sur la position

touchée.
F a7
LN

Faire glisser pour déplacer la zone de mise au
point, en suivant la position de votre doigt

l

[Remarques]

Si vous touchez une position ou faites glisser la zone

de mise au point vers une position qui dépasse la

plage de réglage, la zone de mise au point est réglée

sur le bord supérieur/inférieur/gauche/droit de la

plage de réglage.

Cette fonction n'est pas disponible dans les

circonstances suivantes.

- Lorsque Touch Operation (page 104) dans le
menu Technical du menu complet est réglé sur Off

- Lorsque la zone de mise au point est affichée en
gris ou n'est pas affichée du tout

Mise au point sur un sujet éloigné

y = N
[Wwm

[

Ajustement de I'action de mise au point
automatique (vitesse de transition AF, —
sensibilité de changement de sujet AF)

Pendant la modification :
1(Slow) : la mise au point est

Vitesse de transition AF
lente

Vous pouvez régler la vitesse d'entrainement
de la mise au point pour les cas ou le sujet
change a l'aide de Focus >AF Transition Speed
(page 83) dans le menu Shooting du menu
complet.

Lors d'un réglage sur une vitesse basse, la
mise au point se déplace en douceur lorsque
le sujet a mettre au point change, ce qui
permet de prendre de magnifiques images.
Lors d'un réglage sur une vitesse élevée, la
mise au point change rapidement de sujet.

La mise au point passe immédiatement sur le
sujet entrant dans le cadre, rendant ce réglage
idéal pour la prise de vue documentaire
nécessitant une mise au point rapide.

7(Fast) : la mise au point est
rapide

v

Mise au point sur un sujet proche

)
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Sensibilité de changement de sujet AF

Vous pouvez régler la sensibilité de
changement de sujet a I'aide de Focus >AF
Subj. Shift Sens. (page 83) dans le menu
Shooting du menu complet.

Lors d'un réglage sur une faible sensibilité, la
mise au point ne change pas immédiatement
méme si un autre sujet passe devant le

sujet de la mise au point. Lors d'un réglage
sur une sensibilité élevée, la mise au point
change pour donner la priorité au sujet en
mouvement au premier plan.

[Conseil]

Si AF Speed/Sens. est attribué a une touche
personnalisable, les barres de niveau pour I'ajustement
des valeurs s'affichent dans I'ordre suivant a chaque fois
que vous appuyez sur la touche, ce qui vous permet de
modifier la vitesse de transition AF et les réglages de
sensibilité de changement de sujet AF.

Vitesse de transition AF — Sensibilité de changement
de sujet AF — Pas d'affichage ...

AF Subj. Shift Sens. : 1(Locked On)

Mise au point lente sur un autre sujet

AF Subj. Shift Sens. : 5(Responsive)

i

Mise au point rapide sur un autre sujet

Modification manuelle de la cible de
mise au point (AF Assist)

Lorsque vous réglez Focus >AF Assist

(page 83) sur On dans le menu Shooting du

menu complet, vous pouvez encore utiliser la

bague de mise au point de I'objectif pendant

la mise au point automatique pour régler la

mise au point sur un sujet.

Lorsque vous arrétez d'utiliser la bague de

mise au point, la mise au point automatique

continue de se faire sur le sujet mis au point

a l'aide de la bague de mise au point (état

d‘assistance AF).

Apres avoir utilisé la bague de mise au point,

il est 1égérement plus difficile de déplacer

la mise au point sur un autre sujet, quel que

soit le réglage Focus >AF Subj. Shift Sens.

(page 83) dans le menu Shooting du menu

complet.

L'état d'assistance AF est annulé par ce qui

suit.

e Lorsque le sujet mis au point a l'aide de la
bague de mise au point n'est plus visible

e Lors du passage a la mise au point manuelle

e Lorsque I'AF de suivi en temps réel est
démarré

[Conseils]

e L'état d'assistance AF peut étre annulé rapidement

en utilisant une touche personnalisable (page 49)

attribuée avec Push AF/Push MF.

L'AF de suivi en temps réel s'arréte lorsque la bague

de mise au point est actionnée.

En mode Face/Eye Only AF, la mise au point

automatique se fait sur le visage le plus proche de la

position de la bague de mise au point.
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Utilisation temporaire de la mise au
point manuelle (Push Manual Focus)
Appuyez sur la touche PUSH AUTO FOCUS

(page 4) en mode de mise au point
automatique pour changer manuellement la

mise au point lorsque la touche est enfoncée.

La mise au point repasse en mode
automatique quand vous reldchez la touche.
Ceci vous permet d'arréter temporairement la
mise au point automatique et de l'effectuer
manuellement lorsqu’un élément n'étant pas
le sujet de la prise de vue passe devant le
sujet.

[Conseil]

La méme opération est possible avec une touche
personnalisable (page 49) a laquelle vous avez
attribué Push AF/Push MF.

Suivi a l'aide de la détection des
visages/yeux (Face/Eye Detection
AF)

Le caméscope peut détecter les visages et les
yeux des personnes en tant que cible a suivre
et ensuite ajuster la mise au point sur les
visages et les yeux au sein de la zone de mise
au point.

Cette fonction est uniqguement disponible
lorsque le mode de mise au point est le mode
AF ou pendant la mise au point automatique
par pression.

Lorsque des visages sont détectés, des

cadres de détection des visages/yeux gris
sont affichés. Lorsque la mise au point
automatique est possible, les cadres
deviennent blancs et le suivi démarre. Lorsque
des yeux sont détectés et que la mise au point
est ajustée, le cadre de détection des visages/
yeux s'affiche sur les yeux. Lorsque plusieurs
personnes sont détectées, le sujet principal
est déterminé de maniere automatique.
[Conseils]

Lorsque vous réglez la zone de mise au point sur
Zone ou Flexible Spot et que les visages ou les yeux
chevauchent la zone de mise au point spécifiée, les
cadres de détection des visages/yeux deviennent
blancs et le caméscope effectue la mise au point sur
ces visages/yeux.

Lorsque vous utilisez la mise au point automatique
par pression (AF-S), les cadres de détection des
visages/yeux pour les visages/yeux ciblés par la mise
au point deviennent verts.

Réglez la fonction de détection des visages/
yeux AF a l'aide de Focus >Face/Eye Detection
AF (page 83) dans le menu Shooting.

Face/Eye Only AF :

La caméra détecte les visages/yeux des sujets
(personnes), et la mise au point et le suivi se
font uniquement sur leurs visages/yeux. Tant
qu'aucun visage ou ceil n'est détecté, I'AF est
temporairement arrété et I'icone [ (pause

AF) (page 11) s'affiche. Ce mode est utile
lorsque souhaitez réaliser une mise au point
automatique et un suivi uniqguement sur les
visages/yeux.

Face/Eye Priority AF :

La caméra détecte les visages/yeux des sujets
(personnes) et la mise au point/le suivi se

fait en priorité sur les visages/yeux. Si aucun
visage ou ceil n'est détecté, la mise au point
repasse en mode AF (réglage par défaut).

Off:
La fonction de détection des visages/yeux AF
est désactivée.

[Remarques]

Durant la mise au point automatique par pression,
Face/Eye Priority AF est activé méme si Face/Eye Only
AF est actuellement sélectionné.

Lorsque le commutateur FOCUS est réglé sur MAN,

la fonction de détection des visages/yeux AF est
désactivée (sauf pendant I'opération de mise au point
automatique par pression).

Si vous mettez le caméscope hors tension alors que
Face/Eye Only AF est sélectionné, le mode passe
automatiquement a Face/Eye Priority AF lorsque le
caméscope est ensuite mis sous tension.

Masquer les cadres de détection des
visages/yeux

Vous pouvez afficher/masquer les cadres
de détection des visages/yeux a l'aide de
Display On/Off >Face/Eye Detection Frame
(page 98) dans le menu Monitoring du
menu complet.

[Remarque]

Les cadres verts de détection des visages/yeux
s'affichent pour les visages et les yeux ciblés par la mise
au point a I'aide de la mise au point automatique par
pression (AF-S). lls ne sont pas masqués par I'utilisation
de la touche DISPLAY ni quand vous réglez Face/Eye
Detection Frame sur Off.

Commutation de I'opération de
détection des visages/yeux AF a l'aide
d'une touche personnalisable

Attribuez Face/Eye Detection AF a une touche
personnalisable (page 49). Vous pouvez

alors commuter I'opération de détection des
visages/yeux AF dans |'ordre Face/Eye Priority
AF, Face/Eye Only AF, et Off a chaque pression
de la touche.

Réglage a l'aide du menu direct

Vous pouvez également sélectionner
I'opération de détection des visages/yeux AF
a l'aide du menu direct (page 49).
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Suivi d'un sujet spécifié (Realtime
Tracking AF)

Vous pouvez maintenir la mise au point sur un
sujet en spécifiant le sujet par une opération
tactile ou en sélectionnant un cadre de
détection des visages.

Lorsqu‘un sujet est sélectionné, un cadre de
suivi blanc s'affiche et le suivi démarre.

[Conseils]

* Le suivi se produit dans la zone d'image entiére,
indépendamment du réglage de la zone de mise au
point.

Lorsque Focus >Touch Function in MF (page 83)
dans le menu Shooting est réglé sur Tracking AF,
I'AF de suivi en temps réel est pris en charge méme
lorsque le mode de mise au point est le mode MF.

Les actions suivantes se produisent pour

la cible de suivi, en fonction du mode de
fonctionnement AF de détection des visages/
yeux.

Face/Eye Only AF, Face/Eye Priority AF :

A utiliser pour la mise au point et le suivi d'un
sujet spécifié.

Si la cible de suivi est une personne et un
visage/des yeux sont détectés, la caméra
effectue la mise au point sur ce visage/ces
yeux.

Lorsque le visages/les yeux d'une cible de
suivi sont détectés, le visage de la cible

de suivi est enregistré. Une fois qu'il est
enregistré, une icdne ¢ (visage de suivi
enregistré) (page 11) s'affiche.

[Remarque]

Si I'AF de suivi est démarré lors de la mise au point
manuelle, le visage de la cible de suivi n'est pas
enregistré.

Off:

Mise au point et suivi du sujet spécifié.

La détection des visages/yeux ne se produit
pas, méme si la cible de suivi est une
personne.

[Remarque]

La fonction Realtime Tracking AF ne fonctionne pas si
I'objectif est réglé pour la mise au point manuelle.

Démarrage de I'AF de suivi en temps
réel

Lorsqu'un sujet spécifique est spécifié comme
cible de suivi, le suivi de cette cible démarre.

Spécification par une opération tactile
Appuyez sur le sujet ciblé a suivre dans I'un
des états suivants :

e Lorsque le mode de mise au point est

le mode MF ou lors de la mise au point
manuelle par pression, et lorsque Focus
>Touch Function in MF (page 83) dans le
menu Shooting est réglé sur Tracking AF
Lorsque le mode de mise au point est le
mode AF ou pendant la mise au point
automatique (AF) par pression

[Remarque]

La spécification d'une cible par une opération
tactile n'est pas disponible lorsque Touch Operation
(page 104) dans le menu Technical est réglé sur Off.

Spécification par la sélection d'un cadre de
détection des visages

Déplacez le curseur de sélection de visage
(soulignement orange) sur le sujet cible

a suivre a l'aide du sélecteur multiple
(page 7) et appuyez sur le sélecteur
multiple.

Cadres de détection
d‘autres visages (gris) Cadre de suivi

Curseur de sélection de visage (orange)

[Conseils]

Vous pouvez également changer de cible a suivre lors
de I'AF de suivi en temps réel.

Si une touche personnalisable (page 49) attribuée
avec la fonction Focus Magnifier est enfoncée lors de
I'AF de suivi en temps réel, I'état de suivi est conservé
et la mise au point est agrandie. Cependant, vous

ne pouvez pas spécifier de cible a suivre lors de
I'agrandissement de la mise au point.

[Remarque]

Lors de la mise au point manuelle, le suivi ne peut pas
étre démarré par la sélection de cadre de détection des
visages.

Arrét de I'AF de suivi en temps réel

Arrét par une opération tactile

Appuyez sur la touche IOF% (arrét de I'AF de
suivi en temps réel) affichée en haut a gauche
du panneau tactile.

[Conseils]

L'AF de suivi en temps réel s'arrétera dans les cas

suivants :

- Lorsque le commutateur FOCUS ou la commande
AUTO/MAN sur I'objectif est commuté

- Lorsque le mode de mise au point est modifié

- Lorsque I'aide pour la mise au point automatique

est exécutée

Lorsque le réglage de la zone de mise au point ou

I'action de I'AF de détection des visages/yeux est

modifié

- Lorsqu’une touche personnalisable attribuée avec
Push AF/Push MF est enfoncée

- Lorsque la cible de suivi n'est pas comprise dans
I'écran de prise de vue ou que le sujet est flou
pendant quelques secondes

Lorsqu’un visage de suivi est enregistré (lorsque

I'icdne « €% » (visage de suivi enregistré) s'affiche),

I'AF de suivi en temps réel reprend lorsque le visage

de suivi enregistré entre dans la zone d'image. Pour

effacer le visage de suivi, arrétez I'AF de suivi en

temps réel comme indiqué ci-dessus.
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Réglage de la luminosité
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Vous pouvez régler la luminosité en réglant le
diaphragme, le gain, la vitesse d'obturateur,
ainsi qu’en réglant le niveau de luminosité a
I'aide des filtres ND. Vous pouvez également
procéder a des réglages automatiques.

Le niveau cible pour le réglage automatique
de la luminosité se regle a I'aide de Auto
Exposure (page 80) >Level dans le menu
Shooting du menu complet. Vous pouvez
également attribuer Auto Exposure Level a
une touche personnalisable ou a une molette
personnalisable (page 49).

[Remarques]

* Le gain ne peut pas étre réglé en mode de prise de
vue Cine El/Cine El Quick. La sensibilité de base est
fixée. De méme, la luminosité ne peut pas étre ajustée
automatiquement en utilisant la vitesse d'obturation.
L'ajustement automatique de la luminosité a I'aide du
diaphragme et du filtre ND est pris en charge.

Depuis la version de logiciel 4.0, le réglage
automatique de la luminosité fonctionne de sorte
que I'image soit correctement exposée avec le LUT
appliqué.

Sélection de la sensibilité de base

Vous avez le choix entre deux types de
sensibilité de base sur le caméscope.

En mode de prise de vue Custom, vous pouvez
régler la sensibilité de base sur High ou Low

a l'aide de Base ISO/Sensitivity sur I'écran
d'état Main (page 14) ou sur I'écran d'état
Camera (page 14), ou de I1SO/Gain/El >Base
Sensitivity (page 79) dans le menu Shooting
du menu complet.

En mode de prise de vue Cine El/Flexible I1SO,
vous pouvez régler I'ISO de base sur ISO 12800
ou ISO 800 a l'aide de Base ISO/Sensitivity sur
I'écran d'état Main (page 14) ou sur I'écran
d'état Camera (page 14), ou de ISO/Gain/El
>Base ISO (page 79) dans le menu Shooting
du menu complet.

En mode de prise de vue Cine El Quick, une
sensibilité de base ISO 12800 ou ISO 800
adaptée au réglage Exposure Index est
sélectionnée automatiquement.

Il est recommandé de sélectionner Low ou

1SO 800 dans des conditions d'éclairage
normales et de sélectionner High ou ISO 12800
dans des conditions d'éclairage faibles.

* Pouvant également étre configurés sur I'écran d'état.

[Conseil]
Vous pouvez également attribuer Base ISO/Sensitivity a
une touche personnalisable (page 49).

Réglage du diaphragme

Vous pouvez régler le diaphragme pour régler
la luminosité.

Réglage automatique du diaphragme

Cette fonction régle la luminosité en fonction
du sujet. Un objectif prenant en charge le
diaphragme automatique est requis.

1 Si un objectif avec commutateur Auto Iris
est fixé, placez le commutateur sur AUTO.

2 Maintenez enfoncée la touche de fonction
IRIS (E) pour afficher le menu direct
(page 49) et sélectionnez Auto.

[Conseil]
Vous pouvez également attribuer Auto Iris a une
touche personnalisable (page 49).

[Remarque]
Le diaphragme peut étre ajusté automatiquement
sur un objectif monté en A.

Réglage manuel du diaphragme

1 Maintenez enfoncée la touche de fonction
IRIS (E) pour afficher le menu direct
(page 49) et sélectionnez Manual.

2 Appuyez sur la touche de fonction IRIS (E)
pour afficher la valeur du diaphragme sur
un arriére-plan blanc.

3 Tournez la molette multifonction pour
régler la valeur.

[Conseils]

e Vous pouvez aussi utiliser la molette
multifonction comme molette IRIS (page 49)

en affectant la fonction IRIS & la molette
multifonction.

Vous pouvez également affecter la fonction IRIS
a une molette personnalisable (page 49).

Réglage automatique temporaire

Appuyez sur la touche personnalisable

(page 49) a laquelle la fonction Push Auto

Iris est affectée pour régler automatiquement
le diaphragme de fagon temporaire lorsque la
touche est enfoncée.

Le diaphragme revient au réglage précédent
quand vous relachez la touche.

[Remarques]

e Quand le commutateur Auto Iris de I'objectif est réglé
sur MANUAL, les fonctions Auto Iris et Push Auto

Iris du caméscope n‘ont aucun effet. Les réglages
manuels de diaphragme sur le caméscope ne
fonctionnent également pas.

Push Auto Iris ne peut pas étre exécuté lorsque Iris >
Bokeh Control (page 80) dans le menu Shooting

est réglé sur On.

Réglage du gain

En mode de prise de vue Custom/Flexible
ISO, vous pouvez régler le gain pour régler la
luminosité.

Réglage automatique du gain

Maintenez enfoncée la touche de fonction
ISO/GAIN (H) pour afficher le menu direct
(page 49) et sélectionnez Auto.

[Conseils]

e \ous pouvez aussi effectuer la méme action en
réglant Auto Exposure (page 80) >AGC sur On dans
le menu Shooting.

Vous pouvez également attribuer AGC a une touche
personnalisable (page 49).

Réglage manuel du gain

Vous pouvez surveiller le gain lorsque vous
souhaitez ajuster I'exposition tout en utilisant
un réglage de diaphragme fixe ou lorsque
vous souhaitez éviter que le gain n'augmente
a cause de 'AGC.

1 Maintenez enfoncée la touche de fonction
ISO/GAIN (H) pour afficher le menu direct
(page 49) et sélectionnez Manual.

2 Réglez le commutateur ISO/GAIN (1) sur H,
MoulL.
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[Conseils]

e Vous pouvez modifier la valeur prédéfinie de
chaque position de commutateur a l'aide de 1SO/
Gain<L>/<M>/<H> (page 14) sur I'écran d'état
Camera ou de I1SO/Gain/El >ISO/Gain<H>/<M>/<L>
(page 78) dans le menu Shooting du menu
complet.

Vous pouvez également attribuer Push AGC a une
touche personnalisable et régler AGC sur On de
maniére temporaire en appuyant sur la touche et en
la maintenant enfoncée.

[Remarques]

® Push AGC ne peut pas étre exécuté lorsque Iris
>Bokeh Control (page 80) dans le menu Shooting

du menu complet est réglé sur On.

Push AGC ne peut pas étre exécuté en mode de prise
de vue Cine El/Cine El Quick.

Contréle du gain (réglage précis)

1 Appuyez sur la touche de fonction ISO/
GAIN (H) pour afficher la valeur de gain
sur un arriére-plan blanc.

2 Tournez la molette multifonction pour
régler la valeur.
[Conseil]

Passez sur une valeur de gain préréglée en fonction du
réglage du commutateur ISO/GAIN (1).

Contrdle temporaire du gain (réglage
précis)

Tournez la molette personnalisable

(page 49) a laquelle la fonction 1SO/Gain/

El est attribuée pour ajuster la valeur de gain
définie par le commutateur ISO/GAIN (1).

Cela est utile lorsque vous souhaitez régler
I'exposition d'un seul incrément sans changer
la profondeur de champ.

La valeur de gain réglée est annulée lors de la
commutation du commutateur ISO/GAIN (1),
de la modification de la sensibilité de base,
du réglage d’AGC sur On ou de la mise hors
tension.

[Conseils]

e Vous pouvez aussi affecter cette fonction a la molette
multifonction (page 49).

Vous pouvez également attribuer Push AGC a une
touche personnalisable et régler AGC sur On de
maniére temporaire en appuyant sur la touche et en
la maintenant enfoncée.

[Remarques]

e Push AGC ne peut pas étre exécuté lorsque Iris
>Bokeh Control (page 80) dans le menu Shooting

du menu complet est réglé sur On.

Push AGC ne peut pas étre exécuté en mode de prise
de vue Cine El/Cine EI Quick.

Réglage d'Exposure Index

En mode de prise de vue Cine El/Cine El Quick,
il est considéré que la sortie vidéo avec MLUT
réglé sur Off est enregistrée comme signal
principal. Lorsque vous changez la luminosité
de I'image avec MLUT On pour correspondre
a la valeur El, vous pouvez vérifier le résultat
du réglage de la sensibilité d'exposition qui se
produira pendant la post-production lors de la
prise de vue.

Vous pouvez changer la valeur El en réglant le
commutateur ISO/GAIN (I) sur H, M ou L.

En mode de prise de vue Cine El Quick, vous
pouvez modifier la sensibilité de base en
méme temps que la valeur El.

[Conseil]

Vous pouvez modifier la valeur El de chaque position
de commutateur avec ISO/Gain/El (page 14) dans

le menu d'état Camera ou a l'aide de ISO/Gain/E|
>Exposure Index<H>/<M>/<L> (page 78) dans le

menu Shooting du menu complet.

Réglage précis de I'indice de pose
1 Appuyez sur la touche de fonction ISO/

GAIN (H) pour afficher la valeur El sur un
arriére-plan blanc.

2 Tournez la molette multifonction pour
régler la valeur.
[Conseil]

Passez sur une valeur El préréglée en fonction du
réglage du commutateur ISO/GAIN (1).

Réglage de l'obturateur

Vous pouvez régler I'obturateur pour régler la
luminosité.

Réglage automatique de I'obturateur

Maintenez enfoncée la touche de fonction
SHUTTER (F) pour afficher le menu direct
(page 49) et sélectionnez Auto pour régler
automatiquement la vitesse d’obturation

ou I'angle d'obturation en fonction de la
luminosité de I'image.

[Conseil]

Vous pouvez aussi effectuer la méme action en réglant
Auto Exposure >Auto Shutter (page 81) sur On dans le
menu Shooting du menu complet.

Réglage manuel de I'obturateur

1 Maintenez enfoncée la touche de fonction
SHUTTER (F) pour afficher le menu direct
(page 49) et sélectionnez Speed ou
Angle.

2 Appuyez sur la touche de fonction
SHUTTER (F) pour afficher la valeur de
I'obturateur sur un arriere-plan blanc.

3 Tournez la molette multifonction pour
régler la valeur de l'obturateur.

[Conseils]

e Pour régler la durée d'exposition afin qu'elle
corresponde a I'intervalle d'image, sélectionnez Off
al'étape1.

« Vous pouvez également définir I'angle et régler la
fréquence (page 79).

Réglage du niveau de luminosité
(ND Filter)

Lorsque I'éclairage est trop fort, vous pouvez
régler la luminosité appropriée en changeant
le filtre ND.

Le caméscope comporte deux modes de
filtre ND. Vous pouvez basculer entre les
deux modes en utilisant le commutateur ND
PRESET/VARIABLE.

Réglage en mode prédéfini

Placez le commutateur ND PRESET/VARIABLE
(A) en position PRESET et réglez les touches
haut/bas ND FILTER POSITION (B) sur I'un des
réglages suivants.

Clear : pas de filtre ND

1: transmittance définie par ND Filter >Preset1
(page 79) dans le menu Shooting du menu
complet.

2 : transmittance définie par ND Filter >Preset2
(page 79) dans le menu Shooting du menu
complet.

3 : transmittance définie par ND Filter >Preset3
(page 79) dans le menu Shooting du menu
complet.

Réglage en mode variable

Réglez le commutateur ND PRESET/VARIABLE

(A) en position VARIABLE. Basculez les touches
haut/bas ND FILTER POSITION (B) entre CLEAR
et On.
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Réglage automatique du niveau de luminosité
Vous pouvez régler Auto ND Filter sur On pour
activer I'ajustement d'exposition automatique
a l'aide du filtre ND.

1 Appuyez sur la touche [+] des touches
haut/bas ND FILTER POSITION (B) pour
activer le fonctionnement du filtre ND.

2 Maintenez enfoncée la touche ND
VARIABLE AUTO (C) jusqu’a sélectionner
Auto.

Réglage manuel du niveau de luminosité

1 Appuyez sur la touche [+] des touches
haut/bas ND FILTER POSITION (B) pour
activer le fonctionnement du filtre ND.

2 Maintenez enfoncée la touche ND
VARIABLE AUTO (C) jusqu’a sélectionner
Manual.

3 Tournez la molette ND VARIABLE (D) pour
régler la transmittance du filtre.
[Conseil]

Vous pouvez également affecter la fonction ND Filter a
une molette personnalisable (page 49).

Réglage automatique temporaire

Vous pouvez attribuer Push Auto ND a une
touche personnalisable (page 49), et

régler de maniére temporaire Auto ND Filter
sur On en appuyant sur cette touche et en
la maintenant enfoncée. Auto ND Filter sera
de nouveau réglé sur Off si vous relachez la
touche.

Appuyez sur la touche [+] des touches haut/
bas ND FILTER POSITION (B) pour activer le
fonctionnement du filtre ND.

[Remarques]

Lorsque le filtre ND est basculé sur ou depuis CLEAR
lors de la prise de vue, le cadre de filtre ND s'affiche
sur I'image et le son de fonctionnement est inclus
dans l'audio.

Push Auto ND ne peut pas étre exécuté lorsque Iris
> Bokeh Control (page 80) dans le menu Shooting
est réglé sur On.

[Conseils]

* Vous pouvez régler sur CLEAR en tournant la molette
ND VARIABLE (D) vers le bas depuis ND1/4. Si depuis
CLEAR vous tournez la molette vers le haut, vous
configurez ND1/4. Vous pouvez désactiver cette action
a l'aide de ND Dial >CLEAR with Dial (page 104) dans
le menu Technical du menu complet.

Vous pouvez également attribuer ND Filter Position a
une touche personnalisable (page 49) et appuyer

sur la touche au lieu d'utiliser les touches haut/bas
ND FILTER POSITION pour changer le réglage.

Mode prédéfini : Clear — Preset! — Preset2

— Preset3 — Clear...

Mode variable : Clear — On — Clear...

Vous pouvez également attribuer Auto ND Filter a une
touche personnalisable (page 49) et appuyer sur la
touche pour commuter Auto ND filter entre On et Off.
Lorsque vous filmez un sujet lumineux, une fermeture
trop importante du diaphragme peut provoquer un
flou de diffraction, qui crée une image commengant a
perdre sa netteté (phénomeéne typique des caméras
vidéo). Vous pouvez supprimer cet effet pour obtenir
de meilleurs résultats de prise de vue en utilisant le
filtre ND.
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Réglage pour des couleurs naturelles (équilibre des blancs)
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Vous pouvez sélectionner le mode de réglage
pour vous adapter aux conditions de prise de
vue.

ATW (équilibre des blancs a suivi
automatique)

Cette fonction ajuste I'équilibre des blancs
automatiquement a un niveau approprié.
L'équilibre des blancs est automatiquement
ajusté quand la température de couleur de la
source de lumiére change.

Maintenez enfoncée la touche de fonction
WHT BAL (G) pour afficher le menu direct
(page 49) et sélectionnez ATW.

Vous pouvez sélectionner la vitesse de réglage
(cing incréments) a I'aide de White Setting
>ATW Speed (page 82) dans le menu
Shooting du menu complet.

[Conseil]

Vous pouvez geler le réglage d'équilibre des blancs
actuel en assignant la fonction ATW Hold a une touche
personnalisable (page 49) et en appuyant sur la

touche personnalisable pour mettre temporairement le
mode ATW en pause.

[Remarques]

e ATW ne peut pas étre utilisé en mode de prise de vue

Cine El/Cine EI Quick.

Il peut ne pas étre possible de s'ajuster sur la couleur

appropriée a l'aide d’ATW, en fonction des conditions

d'éclairage et de sujet.

Exemples :

- Quand une couleur unique domine le sujet, comme
par exemple le ciel, la mer, |a terre ou des fleurs.

- Quand la température de couleur est extrémement
élevée ou faible.

Si I'effet approprié ne peut pas étre obtenu parce que

la vitesse de suivi automatique d’ATW est lente ou

pour d‘autres raisons, utilisez I'équilibre des blancs

automatique.

Réglage manuel de I'équilibre des
blancs

1 Lorsque I'équilibre des blancs est réglé sur
le mode ATW, maintenez enfoncée la
touche de fonction WHT BAL (G) pour
afficher le menu direct (page 49) et
sélectionnez W:P, W:A ou W:B.

2 Sélectionnez B, A ou PRESET a l'aide du
commutateur WHT BAL (J).
B : mode de mémoire B
A:mode de mémoire A
PRESET : mode prédéfini
[Conseil]
Vous pouvez activer ATW pour la mémoire B en réglant

White Setting >White Switch<B> (page 82) sur ATW
dans le menu Shooting du menu complet.

Mode de mémoire A/mémoire B

Ce mode ajuste I'équilibre des blancs au
réglage sauvegardé sous la mémoire A ou la
mémoire B, respectivement.

Mode prédéfini

Ce mode ajuste la température de couleur sur
une valeur préréglée (la valeur par défaut est
3200K).

Modification de la valeur prédéfinie par
défaut

En mode prédéfini, vous pouvez modifier
directement une valeur prédéfinie existante.
Maintenez enfoncée la touche de fonction
WHT BAL (G) et sélectionnez I'un des
paramétres suivants dans le menu direct.
Custom : — 3200K, — 4300K, — 5600K,
— 6300K
Prises de vue Log : — 3200K, — 4300K,
— 5500K
[Conseil]
Vous pouvez également attribuer Preset White Select &
une touche personnalisable (page 49) et appuyer sur
la touche pour changer le réglage.
Custom : 3200K — 4300K — 5600K — 6300K
— 3200K...
Prises de vue Log : 3200K — 4300K — 5500K
— 3200K...

Modification de la température de
couleur

1 Appuyez sur la touche de fonction WHT
BAL (G) pour afficher la valeur de la
température de couleur sur un arriere-
plan blanc.

2 Tournez la molette multifonction pour
régler la valeur.

[Conseils]

o En mode prédéfini, vous pouvez régler la valeur par
unités de 100K.

* En mode mémoire, vous pouvez régler la valeur par

incréments de 20K dans une plage de 2000K a 5600K.

Vous pouvez définir les valeurs supérieures a 5600K
a des intervalles égaux a la quantité de changement
de couleur (mired) de 5580K a 5600K. Vous pouvez
aussi régler la valeur de teinte a I'aide de White
(page 81) >Tint dans le menu Shooting du menu
complet.

Utilisation de I'équilibre des blancs
automatique

L'équilibre des blancs a enregistrer dans le
mode de mémoire A/mémoire B est configuré
automatiquement.

1 Sélectionnez le mode de mémoire A ou
de mémoire B.

2 Placez une feuille de papier blanc (ou tout
autre objet) dans un lieu présentant la
méme source et les mémes conditions de
lumiere que le sujet, puis effectuez un
zoom avant sur le papier pour montrer la
zone blanche sur I'écran.

3 Réglez la luminosité.
Ajustez le diaphragme a l'aide de la
procédure dans « Réglage manuel du
diaphragme » (page 43).

4 Appuyez sur la touche WB SET

(page 4).

e Sila balance des blancs automatique
est utilisée en mode mémoire, le
résultat de I'ajustement automatique est
sauvegardé dans la mémoire (A ou B)
sélectionnée a I'étape 1.

e Sila balance des blancs automatique est
exécutée en mode ATW, le résultat est
hérité et le mode ATW reprend lorsque
I'ajustement automatique est terminé.
Ceci est utile lorsque vous souhaitez
ajuster la balance des blancs tres
rapidement, quel que soit le réglage de
la vitesse ATW.

[Remarque]

Si I'ajustement échoue, un message d'erreur s'affiche sur
I'écran pendant environ trois secondes. Si le message
d'erreur persiste aprés plusieurs tentatives de réglage
de I'équilibre des blancs, contactez votre technicien
Sony.
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Réglage de l'audio a enreqistrer

Vous pouvez spécifier I'audio a enregistrer a
|'aide des connecteurs, des commutateurs et
des molettes d'entrée du caméscope.

Connecteurs et commutateurs d'entrée
audio externe

Connecteur INPUT1 (page 7)

Connecteur INPUT2 (page 7)

Griffe a interfaces multiples (page 7)
Commutateur INPUT1 (LINE/MIC/MIC+48V)
(page7)

Commutateur INPUT2 (LINE/MIC/MIC+48V)
(page 7)

Commutateurs permettant de régler le
niveau audio

Commutateur CH1 (AUTO/MAN) (page 6)
Commutateur CH2 (AUTO/MAN) (page 6)
Molette AUDIO LEVEL (CH1) (page 6)
Molette AUDIO LEVEL (CH2) (page 6)

Ecran d'état Audio

INPUT1
MIC +48V
INPUT2
MIC +48V

Int MIC

INPUT1
MIC +48V

T o]
CH1/CH2 [

Sélection du dispositif d'entrée
audio

1

Configurez I'entrée audio a l'aide de CH1/
CH2/CH3/CH4 >Source (page 14) dans
I'écran d'état Audio ou de Audio Input
>CH1 Input Select a CH4 Input Select
(page 101) dans le menu Audio du

menu complet.

Si vous utilisez un microphone ou un
adaptateur XLR connecté a la griffe a
interfaces multiples, spécifiez Shoe CH1 ou
Shoe CH2. Pour plus de détails sur
I'adaptateur XLR, voir « Ajout de
connecteurs d'entrée audio » (page 48).

[Remarques]

* L'audio n'est pas enregistré en mode Interval Rec
ou en mode Slow & Quick Motion.

* Le caméscope comporte un microphone de

narration intégré pour I'enregistrement du

son d’ambiance. Il peut étre utilisé pour la

synchronisation avec d'autres appareils. Dans ce

cas, spécifiez MIC interne.

Seul le microphone interne de la poignée

(page 7) est actif pour I'enregistrement

audio lorsque vous fixez la poignée. Lorsque

la poignée n'est pas fixée, vous pouvez utiliser

le microphone de narration (page 6) pour

I'enregistrement du son d’ambiance.

Lorsque CH1 Input Select et CH2 Input

Select sont réglés sur Internal MIC, le niveau

d'enregistrement audio de CH1 et CH2 est

réglé a l'aide de la molette AUDIO LEVEL(CH1)

(page 6). Lorsque CH3 Input Select et CH4

Input Select sont réglés sur Internal MIC, le niveau

d'enregistrement audio de CH3 et CH4 est réglé a

I'aide de CH3 Input Level (page 101).

2 Sélectionnez la source audio d'entrée.

Réglez les commutateurs INPUT1/INPUT2

(LINE/MIC/MIC+48V) sur les dispositifs
raccordés aux connecteurs INPUT1/
INPUT2, respectivement.

Dispositif raccordé Position de

commutateur

Source audio externe (p. LINE
ex., table de mixage)

Microphone dynamique, MIC
microphone a piles

Microphone a alimentation MIC+48V
fantéme de +48 V

Le fait de sélectionner MIC+48V et de
connecter un microphone qui n'est
pas compatible avec une source de
+48 V peut endommager le dispositif
connecté. Vérifiez le réglage avant de
connecter le dispositif.

Si le bruit est un probléme sur des
connecteurs sur lesquels aucun
dispositif n'est connecté, réglez les
commutateurs INPUT1/INPUT2 (LINE/

MIC/MIC+48V) correspondants sur LINE.

Réglage automatique du niveau
d’enregistrement audio

Réglez les commutateurs CH1/CH2 (AUTO/
MAN) des canaux sur AUTO pour qu'ils
s'ajustent automatiquement.

Pour CH3/CH4, réglez la commande de niveau

audio de I'écran d'état Audio (page 14) ou
Audio Input >CH3 Level Control et CH4 Level
Control sur Auto (page 101) dans le menu
Audio du menu complet.

Réglage manuel du niveau
d'enregistrement audio

Utilisez la procédure suivante pour régler le
niveau d’enregistrement audio pour CH1/CH2.

1 Réglez les commutateurs CH1/CH2
(AUTO/MAN) des canaux sur MAN pour
pouvoir les ajuster manuellement.

2 Pendant la prise de vue ou la veille,
tournez les molettes AUDIO LEVEL (CH1)/
(CH2) des canaux correspondants pour
régler le niveau audio.
® Pour CH3/CH4, réglez la commande
de niveau audio a l'aide de CH3/CH4
(page 14) dans I'écran d'état Audio
ou de Audio Input >CH3 Level Control ou
CH4 Level Control dans le menu Audio
du menu complet sur Manual. Puis,
réglez le niveau d’enregistrement audio
a l'aide de CH3 Input Level ou CH4 Input
Level.

® \ous pouvez régler les niveaux de CH1
a CH4 en tant que groupe. Vous pouvez
ajuster le niveau d'enregistrement en
utilisant la molette personnalisable
(page 49) a laquelle la fonction Audio
Input Level est attribuée, I'écran d'état
Audio ou Audio Input >Audio Input Level
dans le menu Audio du menu complet.

[Conseil]

L'écran d'état Audio est utile pour vérifier le niveau de

I'entrée audio (page 14).

[Remarques]

e Les réglages du niveau d’entrée audio peuvent étre

désactivés, en fonction de la combinaison de réglages

dans le menu Audio. Pour en savoir plus, reportez-

vous au diagramme dans page 141.

Le caméscope prend en charge des combinaisons de

plusieurs réglages. Pour en savoir plus, reportez-vous

au diagramme dans page 141.
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Ajout de connecteurs d’entrée
audio

Vous pouvez connecter simultanément jusqu'a

quatre canaux de dispositifs audio XLR au

caméscope en utilisant un adaptateur XLR-

K2M XLR (non fourni) ou XLR-K3M XLR (non

fourni).

Fixez I'adaptateur XLR a la griffe a interfaces

multiples et réglez CH3 >Source sur Shoe CH1

et CH4 >Source sur Shoe CH2 dans I'écran

d'état Audio (page 14). Ou réglez Audio

Input >CH3 Input Select sur Shoe CH1 et CH4

Input Select sur Shoe CH2 dans le menu Audio

du menu complet.

Les fonctions du caméscope qui se

superposent seront désactivées pour les

canaux sur lesquels I'adaptateur XLR est

sélectionné comme entrée. Utilisez les

commutateurs et les molettes sur I'adaptateur

XLR pour effectuer les réglages.

[Remarques]

® Le caméscope prend en charge l'interface audio
numérique 2 canaux du XLR-K3M.

® Si Audio Input >CH3 Level et CH4 Level dans le menu
Audio sont réglés sur Audio Input Level, Audio Input
Level sur le caméscope sera alors multiplié par le
niveau réglé sur I'adaptateur XLR.
Audio Input Level est également activé lorsque le
commutateur de I'adaptateur XLR est réglé sur AUTO.
Lorsque « Through » est spécifié, I'audio sera
enregistré au niveau réglé avec I'adaptateur XLR
(page 142).
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Fonctions utiles

Utilisation du menu Direct 3 Tournez la molette multifonction pour Fon_(tlons atmb“,ees a chaque touche : sei Cache R
sélectionner un réglage, puis appuyez sur  assignable par défaut icture Cache Rec
la molette multifonction. Touche 1 S&Q Motion o Rgc Review

Vous pouvez vérifier 'état et les réglages du Le menu ou l'arriére-plan blanc disparaft Touche 2 AF Speed/Sens. * Clip Flag OK

caméscope affichés sur I'écran du viseur, ainsi et le nouveau réglage s'affiche avec un Touche 3 Focus Setting . CI!p Flag NG

que sélectionner et modifier directement les curseur orange. Touche 4 Focus Magnifier x3/x6 e Clip Flag Keep

réglages. Appuyez a nouveau sur la touche ) Touche 5 Direct Menu e Color Bars

Les éléments suivants peuvent étre Bierresftnl\;zlrlwiaglsf :f:‘aeg?éee”ztljaaft?grigz; Touche 6 Off e Tally [Front]

i & - e DURATION/TC/U-BIT
configurés. ) 3 secondes sans réaliser d'action pour Touche 7 Focus Magnifier x3/x6 « Displ

e Face/Eye Detection AF fermer menu direct. Touche 8 Direct Menu Ispiay

* SteadyShot consell Touche 9 Video Signal Monitor ® Lensinfo )

* White Mode [- ?/r;sues‘ Sc])uvez aussi configurer les réglages Touche Focus Hold Focus Hold * Video Signal Monitor

* Color Temp dire(ls en maintenant egfoncée ch:(uae des * Marker

" - . . * VF Adjust

e Scene File touches de fonction (page 5). Fonctions attribuables

® ND Filter Position / Auto ND Filter e Lorsque des éléments s'affichent sur un arriére- Off ® VF Mode

e ND Filter Value plan blanc, vous pouvez utiliser la molette e e Gamma Display Assist

o Auto Iris multifonction comme molette personnalisable. Base ISO/Sensitivity o Peaking

. * Vous pouvez aussi utiliser le sélecteur multiple AGC o Zebra

e Iris Value (page 9) pour les opérations de sélection. Push AGC « Volume

* AGC ND Filter Position T il

e Gain Value Auto ND Filter i

e |SO Value Push Auto ND e Touch Operation

e Exposure Index Value Touches/molettes Auto Iris * Handle Zoom

e Auto Shutter / ECS Push Auto Iris e NFC

e Shutter Value personnalisables Bokeh Control * Auto Upload (Proxy)

e Auto Exposure Mode e Direct Menu

Auto E Level Auto Shutter ® User Menu

e Auto Exposure Level

® S&Q Motion Frame Rate Il'y a neuf touches personnalisables (page 6, AutiI_Eer)osure Level * Menu

7,9) sur le caméscope, auxquelles vous Backlight
1 Appuyez sur la molette multifonction ou pouvez attribuer des fonctions. Spotlight

sur une touche personnalisable a laquelle
la fonction Direct Menu est attribuée.
Sur I'écran, vous pouvez uniquement

Vous pouvez également attribuer des
fonctions a la molette multifonction
du caméscope (page 5),a la

Preset White Select
ATW
ATW Hold

Changement de la fonction d'une
molette

Vous pouvez modifier la fonction de la molette
multifonction sur le caméscope, de la molette
personnalisable du grip et de la molette
personnalisable de la poignée.

AF Speed/Sens.

Focus Setting

Focus Area

Focus Area(AF-S)
Face/Eye Detection AF
Push AF Mode

Push AF/Push MF
Focus Hold

Focus Magnifier x3/x6
Focus Magnifier x3
Focus Magnifier x6
S&Q Motion
SteadyShot

sélectionner avec le curseur orange les
éléments pouvant étre configurés a l'aide
du menu direct.

molette personnalisable sur la poignée
(page 7) et la molette personnalisable sur
la télécommande de grip (page 9).

2 Tournez la molette multifonction pour
déplacer le curseur vers I'élément de
menu a régler, puis appuyez sur la
molette multifonction.

Un menu s'affiche ou I'élément s'affiche
sur un arriere-plan blanc.

Changement de la fonction d'une
touche

Pour la molette multifonction, réglez a l'aide
de Multi Function Dial (page 91) >Default
Function dans le menu Project.

Utilisez Assignable Button (page 88) dans le Off est attribué par défaut.
menu Project du menu complet.

Vous pouvez visionner les fonctions
attribuées sur I'écran d'état Assignable Button

(page 15).
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Fonctions attribuables a la molette
multifonction

o Off

e |SO/Gain/El

* RIS

e Auto Exposure Level
e Audio Input Level

[Remarque]
Le réglage est désactivé lorsque le menu est affiché.

Pour la molette personnalisable, réglez avec
Assignable Dial (page 90) dans le menu
Project du menu complet.

IRIS est attribué partout par défaut.

[Conseil]

La molette personnalisable du RM-30BP (option)
applique le réglage Grip/Remote Dial.

Fonctions attribuables a la molette
personnalisable de la poignée/du grip
e Off

® ISO/Gain/El

® ND Filter

* IRIS

e Auto Exposure Level

e Audio Input Level

e Multi Function Dial

Vous pouvez visionner les fonctions
attribuées sur I'écran d'état Assignable Button
(page 15).

Slow & Quick Motion

Quand le format d’enregistrement (page 85) est réglé sur les valeurs suivantes, vous pouvez

spécifier différentes valeurs pour la fréquence d'images de prise de vue et la fréquence d'images

de lecture.
Format d'enregistrement Fréquence
Fréquence du Mode Imager Codec Format vidéo d'images
systeme Scan
59.94/50/29.97/ FF RAW 3840x2160P 1-60, 100, 120
25/23.98 RAW & XAVC-| 3840x2160P 1-60, 100, 120
XAVC-1 4096x2160P 1-60
3840x2160P 1-60, 100, 120
1920x1080P 1-60, 100, 120, 150,
180, 200, 240
XAVC-L 3840x2160P 1-60, 100, 120
1920x1080P 1-60, 100, 120, 150,
180, 200, 240
S35 XAVC-| 1920x1080P 1-60, 100, 120
XAVC-L 1920x1080P 1-60, 100, 120
24 FF XAVC-I 4096x2160P 1-60

Vous pouvez activer/désactiver le mode Slow
& Quick Motion en appuyant sur une touche
personnalisable (page 49) a laquelle la
fonction S&Q Motion est attribuée.

Vous pouvez régler la fréquence d'images
pour la prise de vue en maintenant la touche
enfoncée.

[Conseil]

Vous pouvez également régler le mode a l'aide de S&Q
Frame Rate sur I'écran d'état Main, de Rec Function sur
I'écran d'état Project et de S&Q Motion dans le menu
Shooting du menu complet.

[Remarques]

Le mode Slow & Quick Motion ne peut pas étre réglé
pendant I'enregistrement, la lecture ou pendant
I'affichage de I'écran de miniatures.
L'enregistrement audio n'est pas pris en charge en
mode ralenti et accéléré.

La fonction de diaphragme automatique et la
fonction d'obturation automatique sont désactivées
en mode Slow & Quick Motion.

e La mise au point automatique présente les limites
suivantes en mode Slow & Quick Motion.
- Limites dues au modéle d'objectif, a la fréquence
du systéme et a la fréquence d'images de prise

de vue
Objectif  Fréquence du AF disponible
Sony systeme
Autre que - 7 fps ou plus
SEL16F28 pris en charge
SEL16F28  59.94/29.97/ 30, 60, 120,
23.98 240 fps pris en
charge
50.00/25.00 25, 50,100,
200 fps pris en
charge
24.00 Non pris en
charge

- La fonction de mise au point automatique est
temporairement désactivée si le diaphragme est
réglé sur F18 ou plus.

* Pour plus de détails sur I'utilisation de la sortie RAW,
consultez page 60.

Enregistrement de la vidéo par
intermittence (Interval Rec)

La fonction Interval Rec du caméscope

permet de capturer une vidéo en accéléré

dans la mémoire interne du caméscope. Cette

fonction est un moyen efficace pour la prise

de vue de sujets en mouvement lent.

Lorsque vous commencez |'enregistrement,

le caméscope enregistre automatiquement

un nombre spécifique d'images (Number of

Frames) a intervalles (Interval Time) spécifiés.
Intervalle de prise de vue (Interval Time)

-

Nombre d'images en une prise
(Number of Frames)

Lorsque Interval Rec est activé, la lumiére

de la vidéo HVL-LBPC (en option) s'allume
automatiquement avant le début de
I'enregistrement, ce qui vous permet
d’enregistrer des images sous des conditions
de lumiére stable et de température de
couleur (fonction de pré-éclairage).
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[Remarques]

Il est possible d'utiliser une seule fonction
d'enregistrement spéciale, tel que I'enregistrement en
mode Interval Rec.

Si un autre mode d'enregistrement spécial est activé
alors que Interval Rec est en cours d'utilisation, ce
dernier est automatiquement annulé.

Le mode Interval Rec est automatiquement activé
apres avoir modifié les réglages systéme tel que le
format vidéo.

Les réglages Interval Rec ne peuvent pas étre
modifiés pendant I'enregistrement ou la lecture ou
lorsque I'écran de miniatures s'affiche.

Pour régler Interval Rec

Sélectionnez Rec Function >Interval Rec

sur I'écran d'état Project, et configurez les
réglages Number of Frames et Interval Time.
Si vous utilisez la lampe vidéo HVL-LBPC

(en option), réglez la durée d'intervalle pour
allumer la lampe vidéo avant le démarrage de
I'enregistrement a l'aide de Interval Rec >Pre-
Lighting dans le menu Project, tel que requis.

[Conseil]

Vous pouvez également configurer le mode a l'aide de
Interval Rec (page 87) dans le menu Project du menu
complet.

[Remarques]

Sivous voulez allumer la lampe vidéo avant le début
de I'enregistrement, mettez I'interrupteur de lampe
vidéo sur AUTO. La lampe vidéo s'allume et s'éteint
automatiquement en fonction du réglage de Video
Light Set (page 106) dans le menu Technical.

Si vous mettez I'interrupteur de la lampe vidéo sur
On, la lampe reste toujours allumée (la lumiére vidéo
ne s'allume pas et ne s'éteint pas automatiquement).
Si la lampe vidéo est configurée pour s'éteindre
pendant 5 secondes ou moins, la lampe vidéo ne
s'éteint pas.

Le caméscope quitte le mode Interval Rec
lorsqu'il est mis hors tension mais les réglages
de nombre d’images (Number of Frames), de
durée d'intervalle (Interval Time) et de pré-
éclairage (Pre-Lighting) sont maintenus. Vous
n'aurez pas besoin de les régler de nouveau la
fois suivante lorsque vous effectuez une prise
de vue en mode Interval Rec.

Prise de vue en mode Interval Rec

Appuyez sur la touche d'enregistrement
START/STOP pour démarrer I'enregistrement.
«Int @Rec » et « Int @Stby » s'affichent
alternativement dans le viseur.

Si vous utilisez la fonction de pré-éclairage, la

lampe de la vidéo s‘allume avant le démarrage

de I'enregistrement.

Pour arréter la prise de vue

Arrétez I'enregistrement.

A la fin de la prise de vue, les données vidéo
enregistrées dans la mémoire a ce point sont
enregistrées sur le support.

Pour quitter le mode Interval Rec

Effectuez I'une des actions suivantes.

e Réglez le commutateur POWER sur Off.

e En mode d‘attente d’enregistrement, réglez
Rec Function sur un réglage autre que
Interval Rec sur I'écran d’état Project.

De méme, le mode Interval Rec est

automatiquement relaché lorsque le

caméscope est redémarré.

Limitations pendant I'enregistrement

e L'audio n'est pas enregistré.
e Le passage en revue de I'enregistrement
(Rec Review) n'est pas possible.

Si le caméscope est mis hors tension
pendant I'enregistrement

o Sile commutateur POWER du caméscope
est réglé sur la position Off, I'accés au
support s'effectue pendant plusieurs
secondes pour enregistrer les images
sauvegardées dans la mémoire jusqu’a
ce moment, puis I'appareil se met
automatiquement hors tension.

e Sil'alimentation est coupée car la batterie
est retirée, le cordon d’alimentation CC
débranché ou I'alimentation coupée a partir
de l'adaptateur CA, les données vidéo et
audio prises jusqu’a ce point peuvent étre
perdues (maximum 10 secondes). Faites
attention en remplacgant la batterie.

Enregistrement d'images en cache
(Picture Cache Rec)

La fonction Picture Cache Rec vous permet de
tourner des vidéos a posteriori lorsque vous
démarrez I'enregistrement en maintenant
une mémoire cache interne d’une durée
déterminée lors de la prise de vue.

Réglez Picture Cache Rec sur On dans I'écran
d'état Project, puis réglez la taille du cache.

Réglage Cache Durée de cache

Size (approximative)
Short 5 secondes
Medium 10 secondes

Long 20 secondes

Max Valeur maximale ou
chaque format
d’enregistrement

[Conseils]

La durée du cache peut étre plus courte, selon la
fréquence d'images de prise de vue et le format
d'enregistrement. Vérifiez I'affichage en bas a droite
de I'écran de configuration de la taille du cache.
Vous pouvez également configurer le mode a l'aide
de Picture Cache Rec (page 87) dans le menu

Project du menu complet.

Vous pouvez également commuter Picture Cache Rec
entre On et Off a I'aide d'une touche personnalisable
(page 49).

[Remarques]
e La fonction Picture Cache Rec ne peut pas étre

utilisée en combinaison avec la fonction Interval

Rec, I'enregistrement simultané sur 2 fentes ou
I'enregistrement proxy. Lorsque Picture Cache Rec est
réglé sur On, ces autres fonctions d’enregistrement
sont réglées sur Off de force.

Le mode Picture Cache Rec ne peut pas étre
sélectionné lorsqu’un enregistrement ou Rec Review
est en cours.

Lorsque Picture Cache Rec est réglé sur On, le code
temporel est enregistré en mode Free Run, méme s'il
est réglé sur Regen ou Rec Run (page 95).

Le réglage Output Format ne peut pas étre configuré
en mode Picture Cache Rec. Si cela se produit,
désactivez temporairement Picture Cache Rec, puis
modifiez le réglage.

Démarrage de Picture Cache Rec

Lorsque Picture Cache Rec est sur On,

« @Cache » (@ vert) apparait dans le viseur.
Lorsque vous appuyez sur la touche
d’enregistrement START/STOP,
I'enregistrement démarre et la vidéo

est inscrite sur les cartes mémoire, en
commengcant par la vidéo stockée dans la
mémoire cache.

Pour quitter Picture Cache Rec

Réglez Picture Cache Rec sur Off sur I'écran
d'état Project, ou appuyez sur une touche
personnalisable a laquelle est attribuée la
fonction Picture Cache Rec.

[Remarques]

* Sivous modifiez le format d'enregistrement ou le
look de base, la vidéo dans la mémoire cache stockée
jusqu'a présent est effacée, et la mise en cache
d’une nouvelle vidéo démarre. Ainsi, il est impossible
d'enregistrer des images en mode d'enregistrement
de cache d'image avant le changement de format,
méme si vous commencez immédiatement &
enregistrer aprés avoir changé le format.

Si Picture Cache Rec est réglé sur On ou Off
immédiatement aprés avoir inséré une carte
mémoire, les données de cache peuvent ne pas étre
enregistrées sur la carte.

La vidéo est stockée dans la mémoire cache lorsque
la fonction Picture Cache Rec est réglée sur On. La
vidéo précédant le réglage de la fonction sur On n'est
pas mise en cache.
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La vidéo n'est pas stockée dans la mémoire cache
tant qu‘une carte mémoire est en cours d'acces,
comme lors de la lecture, de la fonction Rec Review
ou de l'affichage de I'écran des miniatures. Il est
impossible d’enregistrer des vidéos en mode
d’enregistrement de cache d'image pendant cet
intervalle.

Pour modifier le réglage

Sélectionnez Simul Rec >Rec Button Set
(page 87) dans le menu Project.

Rec Button Set

Touches et cartes
mémoire

Enregistrement simultané sur les
cartes mémoire A et B (2-slot
Simul Rec)

« Rec Button:[SlotA
SlotB] Handle Rec
Button:[SIotA SlotB] »

Démarrez/arrétez
simultanément
I'enregistrement vers
les cartes mémoire A
et B al'aide de I'une
des touches.

Vous pouvez enregistrer simultanément
sur la carte mémoire A et la carte mémoire
B en réglant Simul Rec (page 15) dans
I'écran d'état Project ou Simul Rec >Setting
(page 87) dans le menu Project du menu
complet sur On.

Enregistrement séparé sur la carte
mémoire A et la carte mémoire B

Vous pouvez démarrer/arréter
I'enregistrement vers chaque carte mémoire
indépendamment a I'aide des touches
d’enregistrement START/STOP sur le
caméscope et la poignée.
Par défaut, les deux touches sont réglées
pour démarrer/arréter simultanément
I'enregistrement vers les deux cartes mémoire
AetB.
® « Rec Button:[SlotA SlotB] Handle Rec
Button:[SlotA SlotB] »
Lorsque les touches sont réglées pour
controler I'enregistrement de différentes
cartes mémoire, le contrdle de démarrage/
arrét d’enregistrement SDI/HDMI Rec Control
(page 88) suit I'état d'enregistrement de la
fente A.

« Rec Button:[SlotA]
Handle Rec Button:
[SlotB] »

La touche
d’enregistrement
START/STOP démarre/
arréte 'enregistrement
vers la carte mémoire
A et la touche
d'enregistrement
START/STOP de la
poignée démarre/
arréte I'enregistrement
vers la carte mémoire
B.

« Rec Button:[SlotB]
Handle Rec
Button:[SlotA] »

La touche
d'enregistrement
START/STOP démarre/
arréte I'enregistrement
vers la carte mémoire
B et la touche
d’enregistrement
START/STOP de la
poignée démarre/
arréte I'enregistrement
vers la carte mémoire
A

[Conseil]

La touche d'enregistrement sur la télécommande du
grip ou la télécommande LANC fonctionne de la méme
maniére que la touche d’enregistrement START/STOP de

I'appareil.

Pour éviter tout fonctionnement
accidentel de la touche d'enregistrement
START/STOP de la poignée

Réglez le commutateur HOLD de la poignée
sur la position HOLD.

[Remarque]

Le commutateur HOLD de la poignée ne fonctionne pas
lorsque HOLD Switch Setting (page 104) >with Rec
Button est réglé sur Off dans le menu Technical du menu
complet. Avec le réglage sur On, réglez Handle HOLD
Switch sur Rec Button Only.

Pour activer le levier de zoom et les touches
autres que la touche d'enregistrement START/
STOP de la poignée, réglez HOLD Switch
Setting >Handle HOLD Switch sur Rec Button
Only.

A propos du nom de fichier

Dans le cas d'un enregistrement simultané
sur 2 fentes, le plan généré portera le méme
nom de plan sur les deux supports. Le nom
de plan sera le méme que le nom de plan lors
de I'enregistrement dans la fente A pendant
I'enregistrement normal.

Moniteur de signal vidéo

Vous pouvez régler le type de signal vidéo

a afficher sur I'écran du viseur sur forme
d’onde, vecteurscope ou histogramme en
utilisant Display On/Off >Video Signal Monitor
(page 99) dans le menu Monitoring.

La ligne orange indique la valeur définie du
niveau zébré.

Vous pouvez également affecter la

fonction Video Signal Monitor a une touche
personnalisable (page 49).

Affichage de la cible du moniteur

En modes de prises de vue Log, les
informations du réglage Color Gamut

(page 24) ou du réglage Monitor LUT

(page 83) s'affichent en haut a droite du
moniteur de signal vidéo pour indiquer la cible
du moniteur.

TeR01280687860128468
ND Glear
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Fonction d'aide pour l'affichage
gamma

En mode de prise de vue Custom (page 24)
lorsque Target Display est réglé sur HDR(HLG),
vous pouvez régler Gamma Display Assist’
sur I'écran d'état Monitoring sur On pour voir
un affichage d'assistance dans le viseur qui
facilite la prise de vue en HDR.
* Vous pouvez également configurer le fonction a I'aide
de Gamma Display Assist >Setting (page 100) dans
le menu Monitoring du menu complet.

Sélection de I'affichage du viseur
lorsque la fonction d'aide pour
I'affichage gamma est activée

Il existe deux méthodes d'affichage prises
en charge pour l'affichage d'images HDR
dans le viseur lorsque la fonction d'aide pour
I'affichage gamma est activée.

Affichage HDR avec un contraste conservé
entre les zones a faible luminance et les zones
a forte luminance

Cette méthode tire parti de I'expressivité

HDR pour afficher I'image dans le viseur sans
provoquer des noirs cassés ou des réhauts
accentués, méme lors de la prise de vue

avec une exposition lumineuse ou sombre.
Cependant, le contraste est Iégérement réduit.
Pour utiliser cette méthode d'affichage, réglez
HDR Setting >VF SDR Preview (page 86) sur
Off dans le menu Project du menu complet.

Affichage SDR par simple conversion de HDR
vers SDR

Cette méthode vous permet de faire
fonctionner la caméra avec la méme sensation
que la SDR conventionnelle.

Vous pouvez ajuster la luminosité de I'image
HDR en réglant la différence de gain entre
HDR et SDR a l'aide de SDR Gain.

Pour utiliser cette méthode d'affichage,
effectuez les configurations selon la procédure
suivante.

1 Réglez HDR Setting >VF SDR Preview
(page 86) sur On dans le menu Project
du menu complet.

2 Ajustez la valeur de gain SDR en mode
HDR a I'aide de HDR Setting >SDR Gain
(page 87) dans le menu Project du
menu complet.

[Conseil]

Lors de la conversion d'une image HDR vers SDR a I'aide
de SR Live Metadata apres la prise de vue, SDR Gain

est appliqué a la conversion de sorte que I'affichage
d’image SDR ait la méme exposition que ce qui était
visualisé dans le viseur au moment de la prise de vue.

Balises de plan

Vous pouvez ajouter une balise de plan OK a
un plan en appuyant sur la touche Clip Flag
(page 5) et en sélectionnant Add OK.

Vous pouvez supprimer une balise de plan
OK en appuyant deux fois sur la touche et en
sélectionnant Delete Clip Flag.

[Conseils]

e \ous pouvez également utiliser une touche
personnalisable a laquelle la fonction de balise de
plan est attribuée pour ajouter des balises de plan
(page 49).

En outre, vous pouvez ajouter une balise de plan

a l'aide de Set Clip Flag (page 103) dans le menu
Thumbnail du menu complet (page 71).

L'écran des miniatures peut étre affiché selon le type
de balise de plan (écran des miniatures de plans
filtré). Pour plus de détails, consultez « Opérations sur
les plans » (page 71).

Compensation de la respiration

Vous pouvez définir si vous souhaitez
effectuer une compensation de respiration
pour l'objectif a I'aide de Lens >Breathing
Compensation (page 106) dans le menu
Technical du menu complet.

Cette fonction corrige le phénomene qui
modifie I'angle de vue lorsque la position de
mise au point varie.

Lorsque la compensation de la respiration est
exécutée, une partie de I'image est recadrée
électroniquement pour maintenir un angle
de vue constant afin que le phénomeéne de
respiration n'apparaisse pas.

[Remarques]

Lorsque la compensation de la respiration est activée,
I'angle de vue et la qualité d'image peuvent étre
légérement modifiés.

Selon I'objectif, il peut &tre impossible de corriger

la modification de I'angle de vue lorsque la
compensation de la respiration est activée.

e La compensation n'est pas possible lorsqu’un objectif
qui ne prend pas en charge la compensation de la
respiration est fixé.

e Cette fonction est réglée sur Off (fixe) dans les cas
suivants.

- Lorsque Lens >Distortion Comp. dans le menu
Technical réglé sur Off

- Lorsque S&Q Motion >Setting dans le menu
Shooting est réglé sur On

- Lorsque Rec Format >Codec dans le menu Project
est réglé sur RAW ou sur une option incluant RAW

Ajustement du bokeh (Fonction de
contréle du bokeh)

Vous pouvez facilement ajuster le degré
de bokeh en liant le filtre ND et le gain a
I'opération du diaphragme.

Activation/désactivation de la fonction
de contrdle du bokeh

Cette fonction ne peut étre activée que lors de
I'ajustement manuel de I'exposition. Réglez le
filtre ND sur le mode Variable, puis réglez le
diaphragme, le gain, I'obturateur et le filtre ND
sur l'ajustement manuel.

Vous pouvez activer/désactiver la fonction

de contréle du bokeh a I'aide de Iris >Bokeh
Control (page 80) dans le menu Shooting

du menu complet.

Lorsque la fonction de contréle du bokeh est
réglée sur On, une icone s'affiche sur les
indicateurs de filtre ND et de gain.

[Conseil]

Vous pouvez également attribuer la fonction Bokeh
Control & une touche personnalisable (page 49) et
commuter la fonction de contréle du bokeh entre On et
Off en utilisant la touche.
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Ajustement du degré de bokeh

1 Réglez la fonction de contréle du bokeh
surOn.

QOuvrez entierement le diaphragme.
3 Réglez le filtre ND sur 1/128.

4 Réglez le gain sur 0 dB et utilisez
I'éclairage pour ajuster I'exposition.

5 Ajustez la mise au point.

6 Ajustez le diaphragme.
Le degré de bokeh change.

[Conseils]

e Lorsque la fonction de contrdle du bokeh est réglée
sur On, le filtre ND et le gain fonctionnent ensemble
pour compenser les changements d’exposition dus a
I'ajustement du diaphragme, ce qui vous permet de
changer le degré de bokeh.

Le contrdle du bokeh est d'abord lié au filtre ND en

réponse a l'opération du diaphragme. Lorsque le filtre

ND ne peut plus étre changé, le gain est lié.

En mode MF, il est recommandé d'ouvrir d'abord le
diaphragme, puis d'ajuster la mise au point.

Si vous utilisez le filtre ND automatique au lieu de
la fonction de contrdle du bokeh, le filtre ND suit le
changement de luminosité du sujet.

Affichage pendant I'opération de liaison
du gain

Lorsque la fonction de contrdle du bokeh est
réglée sur On, le gain peut changer lorsque le
diaphragme est ajusté.

Lorsque la liaison du gain est active et que le
gain change, un message s'affiche en haut
de I'écran et une icbne sur l'indicateur de
gain clignote.

[Remarques]

e Cette fonction est activée uniquement sur les
objectifs a monture E qui peuvent communiquer avec
l'appareil.

L'effet maximal de cette fonction peut étre obtenu
en utilisant la bague de diaphragme d’un objectif a
monture E de Sony.

L'apparence peut varier en fonction de la vitesse de
fonctionnement, de I'objectif, des réglages de prise
de vue et du sujet, et la luminosité peut également
changer. Il est fortement recommandé d'effectuer un
test de la caméra avant la prise de vue.

La luminosité peut changer lorsque le sens de
fonctionnement du diaphragme change, comme par
exemple lors de I'ouverture du diaphragme aprés

sa fermeture ou lors de la fermeture du diaphragme
aprés son ouverture. Dans ce cas, ajustez un peu plus
que nécessaire au préalable, puis revenez un peu en
arriere, vérifiez la luminosité, puis commencez la prise
de vue.

Par exemple, si vous voulez ouvrir le diaphragme a
une ouverture F8 et rendre I'arriére-plan flou, fermez
d'abord le diaphragme au-dela de F8, puis revenez

a F8, vérifiez la luminosité et commencez la prise de
vue.

Effectuez les opérations de contrdle du bokeh
lentement. Si vous devez accélérer I'opération,
essayez d'ajuster progressivement tout en vérifiant les
changements apportés a I'image.

La qualité d'image avec contrdle du bokeh n'est pas
garantie dans toutes les conditions de prise de vue.
La fonction de contrdle du bokeh est réglée sur Off
lorsque I'une des opérations suivantes se produit.
Lorsque le caméscope est mis hors tension
Lorsque le diaphragme, le gain, I'obturateur ou le
filtre ND est réglé sur Auto

- Lorsque le mode de prise de vue est commuté
Lorsque le filtre ND est réglé sur le mode
d’effacement ou mode prédéfini

- Lorsque l'objectif est retiré

Lorsque I'appareil redémarre, par exemple, aprés
une commutation de la fréquence

Réglage de I'affichage dé-squeeze

Vous pouvez filmer avec un objectif
anamorphique pour créer des images au
format cinémascope.

Régler I'affichage de dé-squeeze pour qu'il
corresponde au grossissement de votre
objectif anamorphique vous permet de
produire des images sur la sortie HDMI et sur
I'écran du viseur qui sont ajustées au méme
rapport d'aspect que lorsque vous regardez le
sujet directement.

Vous pouvez régler I'affichage de dé-squeeze
a l'aide de De-Squeeze >Ratio (HDMI/VF)
(page 98) dans le menu Monitoring.
[Remarque]

L'affichage de I'image de sortie HDMI n‘est pas dé-
squeezé pendant la sortie RAW et la sortie du signal SD.
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Enregistrement du proxy

Cette fonction vous permet d’enregistrer des
données proxy a faible résolution en méme
temps que I'enregistrement d’'une vidéo de
données d'origine haute résolution.

Les données proxy peuvent étre subdivisées
en fragments automatiquement dans des
intervalles courts et les fichiers peuvent étre
transférés avant la fin de I'enregistrement.
Pour plus de détails sur les cartes mémoire compatibles,
le formatage des cartes mémoire et la vérification de

la capacité restante, consultez « Utilisation de cartes
mémoire » (page 26).

Configuration avant la prise de
vue

1 Réglez Proxy Rec (page 15) dans I'écran
d'état Project ou Proxy Rec >Setting
(page 87) dans le menu Project du
menu complet sur On.

2 Insérez une carte mémoire dans un
logement de carte CFexpress Type A/SD
(page 6).
® Pour les cartes CFexpress, |'étiquette est
orientée vers la gauche.

® Pour les cartes SD, I'étiquette est
orientée vers la droite, avec le coin
biseauté en bas.

[Remarque]

Proxy Rec ne peut pas étre réglé sur On en méme temps

que S&Q Motion ou Interval Rec. Lorsque Proxy Rec est

réglé sur On, ces autres modes d'enregistrement sont
obligatoirement réglés sur Off.

Enregistrement d'un proxy

Appuyez sur la touche d'enregistrement
START/STOP pour lancer I'enregistrement
lorsque vous avez terminé les réglages
nécessaires pour la prise de vue.

[Remarques]

Si le caméscope est arrété ou la carte mémoire
enlevée pendant que le systéme accéde a la carte
mémoire, I'intégrité des données sur la carte ne peut
pas étre garantie. Toutes les données enregistrées sur
la carte mémoire peuvent étre supprimées. Assurez-
vous toujours que I'indicateur d'accés de la carte
mémoire est éteint avant d'arréter le caméscope ou
d'enlever la carte mémoire.

Assurez-vous que la carte mémoire ne s'éjecte pas
quand vous l'insérez ou la retirez.

Pour quitter, arrétez I'enregistrement.

Réglage de Audio Channel pour
Proxy Recording

Sélectionnez Proxy Rec >Audio Channel
(page 87) dans le menu Project du

menu complet et réglez le canal audio pour
I'enregistrement de données proxy.

Enregistrement et téléchargement
d'un fichier proxy par fragments

Lorsque le réglage de téléchargement
automatique est réglé sur Chunk et qu'un
fichier proxy est enregistré par fragments, le
fichier proxy peut étre téléchargé pendant que
I'enregistrement principal est en cours.

Pour plus de détails sur le téléchargement
d'un fichier proxy enregistré par fragments,
consultez « Téléchargement automatique
des fichiers » (page 67) et « Utilisation de
Creators' App for enterprise » (page 68).

1 Sélectionnez Proxy Rec >Chunk
(page 87) dans le menu Project, puis
sélectionnez I'intervalle d’enregistrement
par fragments.
30s : enregistrez le fichier proxy par
fragments de 30 secondes (réglage par
défaut).
1min : enregistrez le fichier proxy par
fragments de 1 minute.
2min : enregistrez le fichier proxy par
fragments de 2 minutes.

2 Réglez File Transfer >Auto Upload (Proxy)
(page 110) dans le menu Network sur
Chunk.

Le fichier original est enregistré sur le
support dans la fente A et le fichier proxy
est enregistré par fragments sur le
support dans la fente B.

3 Démarrez I'enregistrement proxy.
Le fichier proxy est enregistré par
fragments a l'intervalle spécifié et chaque
fragment est enregistré dans la liste des
taches en tant que tache de transfert.

[Remarques]

e Lorsque Auto Upload (Proxy) n'est pas réglé sur
Chunk, I'enregistrement proxy par fragments ne se
produit pas.

e Le support dans la fente B est dédié a
I'enregistrement de fichiers proxy par fragments,
par conséquent, I'enregistrement relais et
I'enregistrement simultané sur 2 fentes ne sont pas
pris en charge.

A propos du fichier enregistré

L'extension du nom de fichier est « . mp4 ».
Le code temporel est enregistré
simultanément aussi.

Destination de stockage du fichier
enregistré

Le fichier enregistré est stocké dans le
répertoire suivant.

Support Chemin d'accés

d’enregistrement

SDXC /PRIVATE/XDROOT/
GENERAL/PXTMP

CFexpress Type A /XDROOT/GENERAL/
PXTMP

A propos du nom de fichier

Le nom de fichier comprend le nom de

plan enregistré sur la carte mémoire + un
suffixe « SO3 ». Le nom de fichier d'un fichier
proxy enregistré par fragments pour le
téléchargement comprend le nom du fichier
original + un numéro de fragment + un suffixe
«S03 ».

Pour plus de détails sur les noms de plans,
consultez Clip Name Format (page 96) dans
le menu TC/Media du menu complet.
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Prise de vue avec I'apparence souhaitée (Look)

Lorsque le caméscope est réglé sur le mode
de prise de vue Custom (page 24), vous

[Conseils]
e Les préréglages suivants sont configurés par défaut.

pouvez régler le noir, la matrice et d'autres Shooting Mode Custom
parametres pour créer une « apparence » Target Display SDR(BT.709) HDR(HLG)
basée sur I'apparence de base. Fichier descénel1  S-Cinetone  HLG Live
Matrice Fichier de scéne2  Standard HLG Natural
Fichier de scéne 3 Still (Non
enregistré)
Noir Fichier de scéne 4  ITU709 (Non
Apparence L
enregistré)
Apparence de base fichiers descéne5 (Non o (Non -
a6 enregistré) enregistré)

De plus, vous pouvez sélectionner rapidement
une autre apparence en enregistrant
différentes combinaisons de réglages dans
des fichiers de scéne.

Le caméscope est fourni avec six apparences
prédéfinies au total.

Sélection d'une apparence

1 Lorsque I'écran de prise de vue s'affiche,
appuyez sur la molette multifonction.

2 Sélectionnez I'icdne (fichier de scéne).

3 Appuyez sur la molette multifonction.

4 Sélectionnez I'apparence souhaitée dans
le menu et appuyez sur la molette
multifonction.

Vous pouvez aussi sélectionner une apparence a
I'aide de Scene File (page 14) dans I'écran d'état

Main ou de Scene File >Recall (page 92) dans le

menu Paint/Look du menu complet. Vous pouvez
également rappeler une apparence prédéfinie a l'aide
de Scene File >Preset Recall.

Importation d'une apparence de
base souhaitée

Vous pouvez importer un fichier 3D LUT, créé
sur un ordinateur ou un autre appareil, comme
apparence de base depuis une carte mémoire
ou un service Cloud. Jusqu'a 16 fichiers
peuvent étre importés.

e Format de fichier : fichier CUBE (*.cube) pour
un 3D LUT a 17 points ou 33 points créé avec
Catalyst Browse, RAW Viewer ou DaVinci
Resolve* (de Blackmagic Design Pty. Ltd.).

* Vérifié avec Resolve V9.0, V10.0 et V11.0.

e Gamme de couleurs d’entrée/Gamma :

S-Gamut3.Cine/S-Log3 ou S-Gamut3/S-Log3

Importation depuis une carte mémoire

Vous pouvez importer un fichier 3D LUT depuis
une carte mémoire.

1 Sur l'ordinateur ou l'autre appareil,
enregistrez le fichier 3D LUT dans le
dossier spécifié ou sur le support
d’enregistrement.

Support Chemin d'acces
d’enregistre-

ment

SDXC /PRIVATE/SONY/PRO/LUT/
CFexpress /SONY/PRO/LUT/

Type A

2 Insérez le support d’enregistrement sur
lequel les fichiers 3D LUT sont enregistrés
dans le logement de carte CFexpress Type
A/SD (B).

3 Sélectionnez Base Look >Import from
Media(B) (page 92) dans le menu
Paint/Look du menu complet.

4 Sélectionnez une destination
d'importation.

5 Sélectionnez un fichier 3D LUT a importer.
Suivez les instructions qui s'affichent a
I'écran. Le caméscope gere un fichier 3D
LUT comme une apparence de base.

6 Sélectionnez le fichier 3D LUT importé a
I'aide de Base Look >Select (page 92)
dans le menu Paint/Look du menu
complet.

7 Configurez Base Look >Input et Output
(page 92) dans le menu Paint/Look du
menu complet pour qu'il corresponde aux
attributs du fichier 3D LUT importé.

Importation depuis un service Cloud

Vous pouvez importer un fichier 3D LUT depuis
un service Cloud.

1 Connectez-vous a l'appareil depuis
I'application pour smartphone « Creators'
App for enterprise » (page 68).

2 Sélectionnez Base Look >Import from
Cloud(Private) ou Import from
Cloud(Share) (page 92) dans le menu
Paint/Look du menu complet.

3 Sélectionnez une destination
d'importation.

4 Sélectionnez un fichier 3D LUT a importer.
Suivez les instructions qui s'affichent a
I'écran. Le caméscope gere un fichier 3D
LUT comme une apparence de base.
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5 Sélectionnez le fichier 3D LUT importé a
I'aide de Base Look >Select (page 92)
dans le menu Paint/Look du menu
complet.

6 Configurez Base Look >Input et Output
(page 92) dans le menu Paint/Look du
menu complet pour qu'il corresponde aux
attributs du fichier 3D LUT importé.

Réglage pour la sous-exposition

Si vous constatez une tendance a la sous-
exposition lorsque I'exposition automatique
est sélectionnée alors que vous utilisez
I'apparence de base importée, réglez Base
Look >AE Level Offset (page 92) dans le
menu Paint/Look.

[Remarques]

e Limportation d'un fichier 3D LUT n‘affecte pas
I'image. Chargez le fichier 3D LUT importé a I'aide de
Base Look >Select (page 92) dans le menu Paint/
Look du menu complet.

Si vous ne réglez pas correctement Input, vous
n'obtiendrez pas I'apparence appropriée.

Les réglages des éléments de menu Input, Output

et AE Level Offset sont appliqués a I'apparence de
base sélectionnée a I'aide de Select. Si vous importez
plusieurs fichiers 3D LUT, sélectionnez Select pour
chaque fichier 3D LUT, puis configurez Input, Output
et AE Level Offset individuellement pour chaque
fichier.

Les réglages Input, Output et AE Level Offset
configurés sont enregistrés pour chaque fichier 3D
LUT.

Les options de sélection d'apparence de base/LUT
pour les fichiers 3D LUT importés sont communes aux
modes SDR(BT.709)/HDR(HLG)/modes de prise de
vue Log, mais la conversion de la gamme de couleurs
et du gamma n’est pas effectuée en fonction de ces
modes.

Les fichiers 3D LUT ne sont pas supprimés lorsque All
Reset >Reset (page 111) est exécuté dans le menu
Maintenance du menu complet.

Personnalisation d'une apparence
(Look)

Enregistrement d'une apparence
(Look)

Suppression d'une apparence de
base

Vous pouvez personnaliser I'apparence en
fonction de I'apparence de base, a I'aide de
Matrix et d'autres éléments de configuration
dans le menu Paint/Look du menu complet.
Pour plus d'informations sur chaque élément
de configuration, consultez page 92.
Raccordez votre caméscope a un téléviseur ou
a un moniteur, puis réglez la qualité d'image
tout en observant I'image sur le téléviseur ou
le moniteur.

[Remarque]

Lorsque vous importez un fichier 3D LUT et I'appliquez a
I'image, I'apparence souhaitée définie dans le fichier 3D
LUT n’est pas obtenue si Matrix et des réglages autres
que les réglages d'apparence de base sont modifiés
dans le menu Paint/Look. Vous pouvez réinitialiser

tous les réglages personnalisés a I'aide de Reset Paint
Settings >Reset without Base Look (page 92) dans le
menu Paint/Look du menu complet.

Vous pouvez enregistrer I'apparence

actuelle en tant que fichier de scéne dans la
mémoire interne a l'aide de Scene File >Store
(page 92) dans le menu Paint/Look du

menu complet.

Vous pouvez enregistrer rapidement a I'aide
d'opérations dans le menu direct depuis
I'écran de prise de vue.

[Remarques]

Si vous sélectionnez une autre apparence sans
enregistrer I'apparence actuelle, I'apparence actuelle
est supprimée.

Les fichiers de scéne ne sont pas supprimés lorsque
All Reset >Reset (page 111) est exécuté dans le
menu Maintenance du menu complet.

[Conseil]

Vous pouvez écraser les fichiers de scéne prédéfinis.
Pour restaurer un fichier de scéne prédéfini, chargez
I'apparence a restaurer a l'aide de Scene File >Preset
Recall (page 92) dans le menu Paint/Look du menu
complet, puis enregistrez le fichier de scéne a l'aide de
Scene File >Store.

Suppression d’une apparence
enregistrée

Vous pouvez supprimer un fichier de scéne
enregistré dans la mémoire interne a l'aide de
Scene File >Delete (page 92) dans le menu
Paint/Look du menu complet.

[Conseil]

Lorsque vous supprimez une apparence, elle n‘apparait
plus dans le menu direct.

Vous pouvez supprimer un fichier 3D LUT
importé a I'aide de Base Look >Delete
(page 92) dans le menu Paint/Look du
menu complet.

Vous pouvez supprimer tous les fichiers 3D
LUT importés a l'aide de Base Look >Delete
All (page 92) dans le menu Paint/Look du
menu complet.

[Remarques]

Avant de supprimer, vérifiez que I'apparence de
base n'est pas utilisée par un fichier de scene. Si
vous supprimez une apparence de base en cours
d'utilisation, 'apparence des fichiers de scéne
correspondants sera incorrecte.

Les fichiers 3D LUT importés ne sont pas supprimés
lorsque vous sélectionnez All Reset >Reset

(page 111) dans le menu Maintenance du menu
complet.

Une apparence de base supprimée ne peut plus étre
utilisée comme LUT en modes de prise de vue Log
(page 58).
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Prise de vue avec réglage d'apparence en post-production

En sélectionnant le mode de prise de vue Log
et en enregistrant les gradations sous forme
de distribution uniforme des zones sombres
aux zones lumineuses, vous pouvez effectuer
des réglages précis, par exemple restaurer
localement les gradations des zones sombres
et des zones lumineuses, en post-production.
Toutefois, lorsque vous visionnez les images
enregistrées sur un moniteur classique,
le contraste d’ensemble est faible, ce qui
complique les réglages de mise au point et
d’exposition.
Vous pouvez appliquer un LUT a la cible de
moniteur sur le caméscope pour faciliter
divers réglages lors de la prise de vue. Vous
pouvez aussi appliquer un LUT a la vidéo de
lecture pour vérifier le résultat final.
Les LUT sont appliqués par les systémes
suivants. Cependant, vous ne pouvez
appliquer qu'un seul LUT.
e Sortie SDI et sortie HDMI
® Images du viseur et proxy, streaming
e Vidéos enregistrées sur un support
d’enregistrement

Application d'un LUT a I'image du
viseur
1 Appuyez sur la touche MENU pour afficher

I'écran d'état Monitoring.

2 Sélectionnez la colonne Gamut/Gamma
dans la rangée VF.

Info.Disp. [

sDI 1920x1080P(LvI A) |/Off [563 'SLog3

HOMI | 1920x1080P On SG3C/SLog3

Stream Off [MLUT

F MLUT

B: Gamma Dis
Of

3 Sélectionnez On ou Off.

[Remarques]

e Le réglage LUT On/Off de VF est également appliqué
au fichier proxy et a la vidéo en continu.

e Lassistance a 'affichage gamma est disponible lors
de l'utilisation de la loupe de mise au point.

[Conseils]

Vous pouvez aussi régler a I'aide de LUT On/Off >VF/
Proxy/Stream (page 83) dans le menu Shooting du
menu complet.

Vous pouvez configurer SDI/HDMI de la méme
maniére que VF.

Pour une vidéo sur un support d'enregistrement,
vous pouvez régler a I'aide de LUT On/Off >Internal
Rec (page 84) dans le menu Shooting du menu
complet.

Modification d'un LUT

1 Appuyez sur la touche MENU pour afficher
I'écran d'état Monitoring.

2 Sélectionnez le champ Base Look/LUT.

080P(LvI A)

1920x1080P

[MLUT

MLUT

Gamma Di

3 Sélectionnez le LUT a appliquer dans la
liste des apparences de base.

[Conseils]

e Lappareil propose s709, 709(800%) et S-Log3 comme
LUT prédéfinis.

* Vous pouvez aussi importer et appliquer un fichier
3D LUT. Pour plus de détails, consultez « Importation
d'une apparence de base souhaitée » (page 56)
et « Suppression d'une apparence de base »

(page 57).

e L'apparence de base peut également étre réglée a
I'aide de Base Look >Select (page 92) dans le menu
Paint/Look du menu complet.

Modification de la distribution de
zones sombres et lumineuses
dans une vidéo enregistrée

En mode de prise de vue Cine El/Cine El Quick,
vous pouvez modifier la distribution des
zones sombres et des zones lumineuses si,
par exemple, vous souhaitez donner la priorité
aux teintes des zones sombres par rapport
aux zones lumineuses, en changeant Exposure
Index dans la sensibilité de base.

1 Appliquez un LUT a I'image du viseur
(page 58).

2 Appuyez sur la touche MENU pour afficher
I'écran d'état Camera.

3 Configurez les champs L/M/H de
Exposure Index.
Les réglages individuels sont attribués
aux positions L/M/H du commutateur
ISO/GAIN (page 5).

4 Sélectionnez la valeur Exposure Index a
appliquer a l'aide du commutateur ISO/
GAIN.

5 Réglez I'exposition de I'image du viseur
selon les besoins.

[Remarque]

L'assistance a I'affichage gamma est disponible lors de
Iutilisation de la loupe de mise au point. Le réglage
Exposure Index n'est pas appliqué a l'assistance
d‘affichage gamma.

[Conseils]

« Vous pouvez régler I'exposition a I'aide de SO/
Gain/El >Exposure Index (page 78) dans le menu
Shooting du menu complet.

La deuxiéme valeur numérique du réglage indique
combien d'incréments d'informations de luminosité
sont attribués aux zones lumineuses (luminosité
supérieure a 18 % de gris). Les zones plus lumineuses
que cela sont surexposées.

Exemple : dans « 400EI/5.0E » des incréments de 5,0
sont attribués au c6té lumineux.

Vous pouvez également vous servir de ceci comme
d’un guide pour vérifier la teinte des zones sombres
et lumineuses pendant la prise de vue. Par exemple,
si la position M est la sensibilité de base, si la position
L est de moins 2 incréments et la position H de plus
2 incréments, vous pouvez vérifier en commutant le
commutateur ISO/GAIN. N'oubliez pas de revenir en
position M aprés avoir vérifié I'exposition.

Enregistrement d'un fichier 3D
LUT en tant que métadonnées

Vous pouvez enregistrer un fichier 3D LUT
(fichier CUBE) qui est appliqué a I'image du
moniteur lors de la prise de vue en tant que
métadonnées pour le plan.

Pour activer cette fonction, réglez Cine EI/Flex.
ISO Set >Embed LUT File (page 86) sur On
dans le menu Project du menu complet.

Le fichier 3D LUT (fichier CUBE) sélectionné
au début de I'enregistrement est enregistré
en tant que métadonnées. Cependant,
I'enregistrement en tant que métadonnées
n'est pas possible dans les circonstances
suivantes.

Lorsqu'un fichier 3D LUT (fichier ayant

la marque « ! » avant le nom de fichier
lorsque Base Look est sélectionné) est
importé a I'aide d'une version précédente
sélectionnée

Lorsqu'un fichier 3D LUT pouvant étre
enregistré est sélectionné, mais que les
données LUT a utiliser sont modifiées et que
I'enregistrement démarre immédiatement
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e Lorsque LUT On/Off >Internal Rec
(page 84) est réglé sur MLUT On dans le
menu Shooting du menu complet

[Remarque]

Un seul élément de métadonnées peut étre enregistré
par plan.
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Enregistrement d'une vidéo au format RAW

Vous pouvez enregistrer la sortie du signal
vidéo RAW du connecteur SDI OUT ou du
connecteur du HDMI OUT du caméscope sur
un enregistreur externe pris en charge.

Enregistrement depuis le
connecteur SDI OUT

1 Branchez un enregistreur RAW externe sur
le connecteur SDI OUT du caméscope.

2 Réglez le mode de prise de vue a l'aide de
I'écran d'état Project (page 15) ou de
Base Setting >Shooting Mode (page 85)
dans le menu Project du menu complet
sur Cine EI

3 Réglez le mode de numérisation (FF
uniquement) a I'aide de Imager Scan sur
I'écran d'état Project ou de Rec Format
>lmager Scan Mode (page 85) dans le
menu Project du menu complet.

4 Réglez le codec a l'aide de I'écran d'état
Project ou de Rec Format >Codec
(page 85) dans le menu Project du
menu complet sur un codec incluant RAW.
La sélection de RAW & XAVC-I permet
d'enregistrer simultanément la vidéo sur
I'enregistreur RAW externe et la vidéo sur
les cartes mémoire dans le caméscope.

5 Réglez la résolution a I'aide de I'écran
d’état Project ou de Rec Format >RAW
Output Format (page 85) dans le menu
Project du menu complet.

6 Vérifiez que I'enregistreur externe est
activé, puis appuyez sur la touche
d’enregistrement START/STOP sur le
caméscope.

[Remarque]

Lorsque I'enregistrement est démarré sur un
enregistreur externe sans utiliser la touche
d’enregistrement START/STOP sur le caméscope,
il est possible que les plans ne soient pas
correctement enregistrés.

Les formats de sortie RAW pris en charge sont
indiqués ci-dessous.

Fréquence Codec RAW Output
du Format
systeme
59.94/ RAW 4096x2160
50/ 3840x2160
29.97/ RAW & XAVC-l  4096x2160
53/98 3840x2160
24 RAW 4096x2160
RAW & XAVC-I 4096x2160

Enregistrement depuis le
connecteur HDMI OUT

3 Réglez le mode de numérisation (FF
uniquement) a l'aide de Imager Scan sur
I'écran d'état Project ou de Rec Format
>Imager Scan Mode (page 85) dans le
menu Project du menu complet.

4 Réglez le codec a I'aide de I'écran d'état
Project ou de Rec Format >Codec
(page 85) dans le menu Project du
menu complet sur RAW(HDMI).
La sélection de RAW(HDMI) & XAVC-1
permet d’enregistrer simultanément la
vidéo sur I'enregistreur RAW externe et la
vidéo sur les cartes mémoire dans le
caméscope.

5 Vérifiez que I'enregistreur externe est
activé, puis appuyez sur la touche
d’enregistrement START/STOP sur le
caméscope.

[Remarque]

Lorsque I'enregistrement est démarré sur un

enregistreur externe sans utiliser la touche

d'enregistrement START/STOP sur le caméscope, il

est possible que les plans ne soient pas correctement

enregistrés.

Les formats de sortie RAW pris en charge sont
indiqués ci-dessous.

1 Branchez un enregistreur RAW externe sur
le connecteur HDMI OUT du caméscope.

2 Réglez le mode de prise de vue a l'aide de
I'écran d'état Project (page 15) ou de
Base Setting >Shooting Mode (page 85)
dans le menu Project du menu complet
sur Cine El.

Fréquence Codec RAW Output
du Format
systéme

59.94/ RAW(HDMI) 4240x2392
50/ RAW(HDMI) &  4240x2392
29.91/ XAVC-|

25/

23.98

Indicateur de I'état
d'enregistrement

Lorsque vous réglez Display On/Off

(page 98) >RAW Output Control Status

sur On dans le menu Monitoring du menu
complet, I'état d’enregistrement RAW est
indiqué par une icéne qui s'affiche sur I'écran
du viseur.

[Remarque]

Le signal de contrdle d'enregistrement est émis par le
connecteur SDI OUT du caméscope, mais il n'est pas
possible d'obtenir I'état de I'enregistreur externe. En
conséquence, le caméscope pourrait indiquer qu'un
enregistrement vidéo RAW est en cours alors que
I'enregistreur externe n'enregistre pas réellement.
Vérifiez I'indicateur sur I'enregistreur externe pour
connaitre |'état de fonctionnement réel.

[Conseil]
La valeur de réglage de RAW Output Format est
également affichée.

Enregistrement en ralenti et
accéléré

Si S&Q Motion >Setting dans le menu
Shooting est réglé sur On, la vidéo RAW est
enregistrée en mode Slow & Quick Motion.
Pour plus de détails sur la fréquence d'images
prises en charge pour la prise de vue,
consultez page 50.

[Remarque]

L'enregistrement en ralenti et accéléré a partir du
connecteur HDMI OUT n'est pas pris en charge.
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Connexion a d'autres dispositifs via le LAN

Le caméscope peut se connecter a des
smartphones, des tablettes et d'autres
dispositifs a I'aide d'une connexion LAN.
L'établissement d'une connexion LAN entre
un dispositif et le caméscope vous permet
d'effectuer les opérations suivantes a l'aide de
I'application « Content Browser Mobile ».

® Surveillance vidéo

Vous pouvez surveiller I'image de la caméra
ou de vidéo de lecture du caméscope a
I'aide de I'application « Content Browser
Mobile » sur un dispositif.

Télécommande

Vous pouvez contrdler le caméscope a
partir d'un smartphone ou d'une tablette

connectés au caméscope via un réseau LAN.

Transfert de fichiers

Vous pouvez transférer un fichier proxy
(basse résolution) ou un fichier original
(haute résolution) enregistré sur une carte
mémoire du caméscope vers le serveur via
un réseau LAN.

[Remarque]

La surveillance de la vidéo n’est pas prise en charge
avec les réglages suivants.

- Mode Slow & Quick Motion

- Fréquence du systéme de 24

- Mode Interval Rec

Application « Content Browser Mobile »

Vous pouvez utiliser le caméscope a

distance sur I'écran du dispositif pendant la
surveillance de la vidéo depuis le caméscope,
puis configurer les réglages du caméscope

a I'aide de I'application « Content Browser
Mobile ».

Pour plus de détails sur I'application « Content Browser

Mobile », contactez un représentant commercial ou un
technicien Sony.

Configuration du nom d'utilisateur
et du mot de passe

Connexion a l'aide du mode de
point d'accés de LAN sans fil

Configurez le nom d'utilisateur et le mot de
passe du caméscope pour utiliser la fonction
réseau.

1 Configurez Access Authentication >User

Name (page 107) dans le menu Network
du menu complet.

2 Réglez Access Authentication >Input
Password (page 107) dans le menu
Network du menu complet.

[Conseils]

* Vous pouvez également générer un mot de passe

automatiquement. Exécutez Generate Password
au lieu de Input Password.

Le nom d'utilisateur et le mot de passe peuvent
étre affichés sous forme de texte et de code QR a
I'aide de Show Settings.

[Remarque]
Veillez a ce que le code QR et le mot de passe ne
puissent pas étre vus par d'autres personnes.

Le caméscope sert de point d'accés et se
connecte a un dispositif via un réseau local
sans fil.

Smartphone/tablette

Connexion a un dispositif compatible
NFC par simple contact

Les dispositifs prenant en charge la
technologie NFC peuvent étre connectés
(connexion une touche) a I'aide de la NFC.

1 Ouvrez [Settings] sur le dispositif,
sélectionnez [More], et cochez la case
NFC.

=1 [ o)

2 Mettez le caméscope sous tension.

3 Activez la fonction NFC.

Maintenez pressée (pendant 3 secondes)
une touche personnalisable a laquelle la
fonction NFC est affectée ou sélectionnez
Wireless LAN >NFC dans le menu Network
pour activer le mode de connexion NFC.
La fonction NFC est uniquement
disponible tant que N apparait sur I'écran.

Touchez le caméscope avec le dispositif.
Le dispositif se connecte au caméscope et
« Content Browser Mobile » démarre.

[Remarques]

e Désactivez le mode de veille et le verrouillage
d'écran a I'avance.

* Touchez et maintenez le dispositif immobile
jusqu'a ce que I'application « Content Browser
Mobile » démarre (14 2 secondes).
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Connexion a un dispositif compatible
WPS

Les dispositifs qui prennent en charge le WPS
peuvent étre connectés a l'aide du WPS.

1 Sélectionnez Wireless LAN >Setting
>Access Point Mode dans le menu
Network du menu complet.

2 Sélectionnez Wireless LAN >WPS >Execute
dans le menu Network du menu complet.

3 Quvrez les réglages réseau ou les
réglages Wi-Fi sur le dispositif et activez le
Wi-Fi.

4 Sélectionnez le SSID du caméscope dans
la liste des SSID sous Wi-Fi Network sur le
dispositif, puis sélectionnez WPS Push
Button sous Option pour connecter le
dispositif.

[Remarques]

* Laméthode de fonctionnement différe selon le
dispositif.

e Pour le SSID et le mot de passe du caméscope,
vérifiez AP Mode Settings >Camera SSID &
Password (page 107) dans le menu Network du
menu complet.

5 Connectez-vous en utilisant I'application
Content Browser Mobile.
[Conseil]
Vous pouvez vérifier les informations requises
pour la connexion a |'appareil a I'aide de Access
Authentication >Show Settings (page 107) dans le
menu Network du menu complet.

Connexion par saisie d'un SSID et d'un
mot de passe sur un dispositif
Vous pouvez connecter le caméscope a un

dispositif, en saisissant le SSID et le mot de
passe de l'appareil sur un dispositif.

1

Sélectionnez Wireless LAN >Setting
>Access Point Mode dans le menu
Network du menu complet.

Ouvrez les réglages réseau ou les
réglages Wi-Fi sur le dispositif et activez le
Wi-Fi.

Connectez le dispositif au caméscope en
sélectionnant le SSID du caméscope dans
la liste des SSID sous Wi-Fi Network et en
saisissant le mot de passe.

Pour le SSID et le mot de passe du
caméscope, vérifiez AP Mode Settings
>Camera SSID & Password (page 107)
dans le menu Network.

[Remarque]

La méthode de fonctionnement différe selon le
dispositif.

Connectez-vous en utilisant I'application
Content Browser Mobile.

[Conseil]

Vous pouvez vérifier les informations requises
pour la connexion a l'appareil a I'aide de Access
Authentication >Show Settings (page 107) dans le
menu Network du menu complet.

Connexion a l'aide du mode de
station de LAN sans fil

Le caméscope se connecte a un point d'accés
existant du réseau local sans fil en tant

que client. Le caméscope et le dispositif se
connectent via le point d'accés.

Les 10 derniers points d'acces ou une
connexion s'est produite sont affichés dans
I'historique.

L'historique de connexion est sauvegardé
dans un fichier ALL file mais les mots de passe
d‘acces ne sont pas enregistrés. La saisie d'un
mot de passe sera requise a la prochaine
connexion aprés le chargement du fichier ALL.

Smartphone/  Ordinateur

tablette

Point d'acces

Connexion a un point d'accés a l'aide de
la fonction WPS

Si le point d'acces est compatible avec la
fonction WPS, vous pouvez vous connecter au
point d'acces avec des réglages simples.

1 Activez le point d'accés.
2 Mettez le caméscope sous tension.

3 Sélectionnez Wireless LAN >Setting
>Station Mode dans le menu Network du
menu complet.

4 Sélectionnez ST Mode Settings >Camera
Remote Control (page 108) >Enable
dans le menu Network du menu complet.

5 Sélectionnez Wireless LAN >WPS >Execute
dans le menu Network du menu complet.

6 Appuyez sur la touche WPS du point
d'accés.
Pour les détails sur le fonctionnement de
la touche WPS, consultez le mode
d’emploi du point d'acces.
Une fois la connexion réussie, I'icone
d'indicateur d'état du réseau affiche une
puissance de 1 ou plus sur I'écran du
viseur.
[Remarque]

Si la connexion échoue, recommencez toutes les
étapes a partir de I'étape 1.

7 Connectez le dispositif au point d'acces.
Pour plus de détails sur la connexion,
consultez le mode d'emploi du dispositif.

8 Lancez I'application « Content Browser
Mobile » sur un dispositif et sélectionnez
I'appareil.
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[Conseil]

Vous pouvez vérifier les informations requises
pour la connexion a l'appareil a I'aide de Access
Authentication >Show Settings (page 107) dans le
menu Network du menu complet.

Connexion a l'aide de la fonction de
détection automatique de point d'acces

1

Effectuez les étapes 1a 3 dans
« Connexion a un point d'acces a l'aide de
la fonction WPS » (page 62).

Sélectionnez ST Mode Settings >Scan
Networks (page 108) >Execute dans le
menu Network du menu complet.

Le caméscope lance la détection des
destinations réseau.

Les destinations possibles ayant été
détectées s'affichent sous forme de liste.

Sélectionnez une destination dans la liste.
L'écran des détails du réseau (point
d'accés) apparait. La connexion choisie est
affichée dans le SSID.

Sélectionnez Password et saisissez le mot
de passe du point d'accés a connecter sur
I'écran de saisie du mot de passe.

La sélection d'un SSID dans I'historique de
connexion configure automatiquement
les réglages, y compris le mot de passe.
Réglez le mot de passe pour revenir a
I'écran des détails du réseau (point
d'accés).

Configurez les réglages de connexion
suivants.

* DHCP

Définissez le réglage DHCP.

Lorsque vous réglez sur On, I'adresse
IP est automatiquement assignée au
caméscope.

Pour assigner manuellement I'adresse IP
au caméscope, réglez sur Off.

IP Address

Permet de saisir I'adresse IP de |'unité.
Ce réglage n'est disponible que si DHCP
est réglé sur Off.

Subnet Mask

Permet de saisir le masque de sous-
réseau de |'unité.

Ce réglage n'est disponible que si DHCP
est réglé sur Off.

Gateway

Permet de saisir la passerelle pour le
point d'accés.

Ce réglage n'est disponible que si DHCP
est réglé sur Off.

DNS Auto

Permet de régler s'il faut acquérir
automatiquement ou non le DNS.

Avec ce réglage sur On, I'adresse

du serveur DNS est acquise
automatiquement. Ce réglage n'est
disponible que si DHCP est réglé sur On.
Primary DNS Server

Saisissez le serveur DNS principal du
point d'accés.

Ce réglage n'est disponible que si DNS
Auto est réglé sur Off.

Secondary DNS Server

Saisissez le serveur DNS secondaire du
point d'accés.

Ce réglage n'est disponible que si DNS
Auto est réglé sur Off.

Lorsque vous avez terminé, sélectionnez
Connect pour vous connecter au point
d'accés.

Connectez le dispositif au point d'accés.
Pour plus de détails sur la connexion,
consultez le mode d'emploi du dispositif.

8 Lancez l'application « Content Browser

Mobile » sur un dispositif et sélectionnez
I'appareil.

[Conseil]

Vous pouvez vérifier les informations requises

pour la connexion a l'appareil a I'aide de Access

Authentication >Show Settings (page 107) dans le

menu Network du menu complet.

Connexion manuelle en saisissant les
informations du point d'accés

1

Effectuez les étapes 1a 3 dans
« Connexion a un point d'acces a l'aide de
la fonction WPS » (page 62).

Sélectionnez ST Mode Settings >Manual
Register (page 109) >Execute dans le
menu Network du menu complet.
L'écran des détails du réseau (point
d’accés) apparait momentanément.

Configurez les réglages de connexion
suivants.

e SSID

Saisissez le SSID pour le point d'accés de
connexion.

Security

Sélectionnez la méthode de cryptage.
Password

Saisissez le mot de passe du point
d‘accés de connexion.

DHCP

Définissez le réglage DHCP.

Lorsque vous réglez sur On, I'adresse

IP est automatiquement assignée au
caméscope.

Pour assigner manuellement I'adresse IP
au caméscope, réglez sur Off.

IP Address

Permet de saisir I'adresse IP de |'unité.
Ce réglage n’est disponible que si DHCP
est réglé sur Off.

4

® Subnet Mask

Permet de saisir le masque de sous-
réseau de I'unité.

Ce réglage n'est disponible que si DHCP
est réglé sur Off.

Gateway

Permet de saisir I'adresse de passerelle.
Ce réglage n'est disponible que si DHCP
est réglé sur Off.

DNS Auto

Permet de régler s'il faut acquérir
automatiquement ou non le DNS.

Avec ce réglage sur On, I'adresse

du serveur DNS est acquise
automatiquement. Ce réglage n'est
disponible que si DHCP est réglé sur On.
Primary DNS Server

Saisissez |'adresse du serveur DNS
principal.

Ce réglage n'est disponible que si DNS
Auto est réglé sur Off.

Secondary DNS Server

Saisissez |'adresse du serveur DNS
secondaire.

Ce réglage n'est disponible que si DNS
Auto est réglé sur Off.

Lorsque vous avez terminé, sélectionnez
Connect pour vous connecter au point
d'accés.

Connectez le dispositif au point d'acces.
Pour plus de détails sur la connexion,
consultez le mode d'emploi du dispositif.

Lancez l'application « Content Browser
Mobile » sur un dispositif et sélectionnez
I'appareil.
[Conseil]
Vous pouvez vérifier les informations requises
pour la connexion a 'appareil a I'aide de Access
Authentication >Show Settings (page 107) dans le
menu Network du menu complet.
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Connexion a Internet

Vous pouvez connecter le caméscope a
Internet a l'aide d'un raccordement modem
USB, d'un LAN filaire ou d'un LAN sans fil.
Réglez le nom d'utilisateur et le mot de passe
du caméscope au préalable (page 61).

Connexion a l'aide d'un
raccordement modem USB

Vous pouvez connecter I'unité a un
smartphone via un cable USB, puis connecter
a Internet a I'aide du smartphone.

Configuration de la communication
smartphone

Activez la communication par raccordement
modem sur le smartphone.

Pour plus de détails, reportez-vous au manuel
d'utilisation du smartphone.

Fixation d'un smartphone au caméscope

Connectez un cable USB au connecteur USB-C
(page 7) du caméscope, puis connectez le
smartphone.

[Remarques]

Fixez/retirez le smartphone lorsque le caméscope est
hors tension.

Le raccordement modem USB ne peut pas étre utilisé
si le smartphone est connecté via un concentrateur
USB.

Vous ne pouvez pas utiliser le raccordement modem
USB si un ordinateur est relié au connecteur USB/
Multi (page 7).

Connexion a un réseau

1 Mettez le caméscope sous tension.

2 Réglez Modem >Setting (page 109) dans
le menu Network du menu complet sur
On.

Activation d'opération depuis un
smartphone

Vous pouvez contrdler le caméscope a
distance a l'aide de l'application Content
Browser Mobile sur un smartphone connecté a
I'aide d'un cable USB.

1 Réglez Modem >Camera Remote Control
(page 109) sur Enable dans le menu
Network du menu complet.

2 Lancez l'application « Content Browser
Mobile » sur un smartphone et
sélectionnez I'appareil.

[Conseil]

Vous pouvez vérifier les informations requises pour
la connexion a I'appareil a partir de I'application
Content Browser Mobile a 'aide de Access
Authentication >Show Settings (page 107) dans le
menu Network du menu complet.

Smartphone/
tablette

Ordinateur

Connexion a l'aide mode de
station de LAN sans fil (mode
Wi-Fi Station)

Vous pouvez connecter le caméscope a
Internet en mode de station Wi-Fi a I'aide d'un
routeur Wi-Fi en option ou par raccordement
au Wi-Fi avec un smartphone.
Connectez-vous au routeur Wi-Fi ou au
dispositif comme indiqué dans « Connexion

a l'aide du mode de station de LAN sans fil »
(page 62).

Routeur Wi-Fi

Smartphone/
tablette

Internet

@

Internet

Connexion a l'aide d'un cable LAN

Vous pouvez vous connecter a Internet en
connectant le connecteur LAN filaire d'un
adaptateur LAN filaire (option) relié au
connecteur USB-C (page 7) du caméscope
a un routeur Wi-Fi (en option) a l'aide d'un
cable LAN.

Smartphone/ Ordinateur

tablette

.%—
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Connexions a l'aide d'un cable LAN et
réglages du LAN filaire

1

Fixez un adaptateur LAN filaire sur le
connecteur USB-C du caméscope.

Connectez le connecteur LAN filaire de
I'adaptateur LAN filaire a un routeur Wi-Fi
a l'aide d'un cable LAN.

Mettez le caméscope sous tension.

Réglez Wired LAN >Setting (page 109)
dans le menu Network du menu complet
surOn.

Configurez les réglages de connexion a
l'aide de Wired LAN >Detail Settings
(page 109) dans le menu Network.

e DHCP

Définissez le réglage DHCP.

Lorsque vous réglez sur On, I'adresse

IP est automatiquement assignée au
caméscope.

Pour assigner manuellement I'adresse IP
au caméscope, réglez sur Off.

IP Address

Permet de saisir I'adresse IP de |'unité.
Ce réglage n'est disponible que si DHCP
est réglé sur Off.

Subnet Mask

Permet de saisir le masque de sous-
réseau de l'unité.

Ce réglage n'est disponible que si DHCP
est réglé sur Off.

Gateway

Permet de saisir I'adresse de passerelle.
Ce réglage n'est disponible que si DHCP
est réglé sur Off.

6

* DNS Auto

Permet de régler s'il faut acquérir
automatiquement ou non le DNS.
Avec ce réglage sur On, l'adresse

du serveur DNS est acquise
automatiquement. Ce réglage n'est
disponible que si DHCP est réglé sur On.
Primary DNS Server

Saisissez |'adresse du serveur DNS
principal.

Ce réglage n'est disponible que si DNS
Auto est réglé sur Off.

Secondary DNS Server

Saisissez I'adresse du serveur DNS
secondaire.

Ce réglage n'est disponible que si DNS
Auto est réglé sur Off.

Lorsque vous avez terminé, sélectionnez
Set pour appliquer les réglages.

[Remarques]

Sélectionnez toujours Set aprés avoir modifié les

réglages de connexion. Les réglages ne sont pas
appliqués si Set n'est pas sélectionné.

Utilisez un adaptateur LAN filaire USB Type C. Nous

vous conseillons d'utiliser un adaptateur compatible
Gigabit Ethernet. Toutefois, le fonctionnement n'est
pas garanti avec tous les appareils.

Vous ne pouvez pas utiliser d'adaptateur LAN filaire
USB (option) si un ordinateur est relié au connecteur
USB/Multi (page 7).

La fonction de communication Wi-Fi intégrée peut

étre affectée, selon le modéle de I'adaptateur LAN
filaire (en option).

Activation du fonctionnement a partir
d’un smartphone via un LAN filaire

Pour utiliser le caméscope a distance a l'aide
de l'application Content Browser Mobile sur
un smartphone via Wi-Fi a I'aide d'un routeur
connecté par LAN filaire, réglez Wired LAN
>Camera Remote Control (page 109) dans le
menu Network du menu complet sur Enable.
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Téléchargement de fichiers

Vous pouvez télécharger un fichier proxy ou
un fichier original enregistré sur le caméscope
Vvers un serveur sur Internet ou un serveur sur
un réseau local via un smartphone ou un point
d'acces.

Préparatifs

Connexion a un réseau

Connectez le caméscope a Internet ou au
réseau local comme indiqué dans « Connexion
a Internet » (page 64) ou « Connexion a
d‘autres dispositifs via le LAN » (page 61).

Enregistrement d’une destination de
transfert de fichier

Enregistrez au préalable le serveur pour le
téléchargement.

1 Sélectionnez File Transfer >Server
Settings1 (ou Server Settings2, Server
Settings3) dans le menu Network du
menu complet.

L'écran de configuration de la destination
de transfert s'affiche.

2 Réglez chaque élément sur I'écran de
configuration de la destination de
transfert.

Display Name

Saisissez le nom du serveur a afficher
dans la liste de destinations de transfert.
Service

Affiche le type de serveur.

«FTP »: serveur FTP

Host Name

Saisissez l'adresse du serveur.

Port

Saisissez le numéro de port du serveur
pour effectuer la connexion.

User Name

Saisissez le nom d'utilisateur.
Password

Saisissez le mot de passe.

Passive Mode

Activez/désactivez le mode passivité.
Destination Directory

Saisissez le nom de répertoire sur le
serveur de destination.

[Remarques]
Les fichiers originaux sont téléchargés dans
le dossier « Main » dans le répertoire spécifié
comme destination de transfert.
Lors de la modification, « O » indique des
caractéres ne pouvant pas étre modifiés. Le
fonctionnement correct n'est pas garanti lors de
la modification d'un nom de répertoire contenant
ces caracteres.
Si la modification est nécessaire, supprimez tous
les caractéres et saisissez a nouveau une valeur.
Si des caractéres non valides sur le serveur de
destination sont saisis dans Destination Directory,
les fichiers seront transférés dans le répertoire
original de I'utilisateur. Les caractéres non valides
varient en fonction du serveur.
Using Secure Protocol
Indiquez si vous exécutez ou non le
téléchargement sur FTP sécurisé.
Root Certificate
Chargez/effacez un certificat.
® Load
Sélectionnez Set a I'étape 3 pour
importer un certificat CA.
Le certificat a charger doit étre au format PEM
avec le nom de fichier « certification.pem », et
doit étre écrit dans le répertoire racine de la
carte mémoire insérée dans le logement de carte
CFexpress Type A/SD (B).
Clear
Sélectionnez Set a I'étape 3 pour effacer
un certificat CA.
* None
Vous ne pouvez ni charger ni effacer un
certificat.

[Remarques]
Réglez I'horloge du caméscope sur I'heure
correcte avant d'importer un certificat CA.
Lors de I'enregistrement en XAVC-1 4096x2160P/
3840%2160P 59.94/50P, Load ne peut pas étre
sélectionné.
En état de tension faible, Load/Clear ne peut pas
étre sélectionné pour un certificat CA.
Root Certificate Status
Affiche I'état de chargement du certificat.
Reset
Réinitialisez les réglages de Server
Settings aux réglages par défaut.

Lorsque vous avez terminé, sélectionnez
Set pour appliquer les réglages.
Sélectionnez toujours Set apres avoir
modifié les réglages. Les réglages ne sont
pas appliqués si Set n'est pas sélectionné.

Sélection d'un fichier et
téléchargement

Vous pouvez sélectionner des fichiers proxy
ou des fichiers originaux enregistrés sur des
cartes mémoire pour le transfert vers un
serveur.

[Remarque]

Les fichiers proxy enregistrés par fragments sont

des fichiers dédiés au téléchargement automatique.

Ils ne peuvent pas étre sélectionnés et téléchargés
manuellement.

Téléchargement d'un fichier proxy sur
une carte mémoire a partir d'un écran
de miniatures

1 Connectez le caméscope et le dispositif a
I'aide d'une connexion LAN (page 61).

2 Sélectionnez Transfer Clip (Proxy) >Select
Clip dans le menu Thumbnail du menu
complet.

L'affichage passe du menu complet a
I'écran des miniatures.

Les plans peuvent étre transférés de
I'écran des miniatures ou de I'écran des
miniatures de plans filtrés.

3 Sélectionnez le plan a transférer et
appuyez sur la touche MENU.
Un écran de confirmation de transfert
apparait.

4 Sélectionnez Execute.
Le fichier proxy correspondant au fichier
sélectionné est enregistré comme tache
de transfert et le chargement commence.
Si I'enregistrement de la tache de transfert
réussit, I'écran des résultats du transfert
s'affiche.
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5 Sélectionnez OK.

Pour télécharger tous les fichiers
Sélectionnez All Clips au lieu de Select Clip
a I'étape 2 pour transférer les fichiers proxy
correspondant a tous les fichiers.

[Remarque]
Jusqu’a 200 fichiers peuvent étre transférés.

Téléchargement d'un fichier original sur
une carte mémoire a partir d'un écran
de miniatures

[Remarque]
Les fichiers originaux sont téléchargés dans le dossier
« Main » dans le répertoire spécifié comme destination
de transfert.

1 Connectez le caméscope et le dispositif a
I'aide d'une connexion LAN (page 61).

2 Sélectionnez Transfer Clip >Select Clip
dans le menu Thumbnail du menu
complet.

L'affichage passe du menu complet a
I'écran des miniatures.

Les plans peuvent étre transférés de
I'écran des miniatures ou de I'écran des
miniatures de plans filtrés.

3 Sélectionnez le plan a transférer et
appuyez sur la touche MENU.
Un écran de confirmation de transfert
apparait.

4 Sélectionnez Execute.
Le fichier sélectionné est enregistré
comme tache de transfert et le
chargement commence.
Si I'enregistrement de la tache de transfert
réussit, I'écran des résultats du transfert
s'affiche.

5 Sélectionnez OK.

Pour télécharger tous les fichiers
Sélectionnez All Clips au lieu de Select Clip a
I'étape 2 pour transférer tous les fichiers.

[Remarque]
Jusqu'a 200 fichiers peuvent étre transférés.

Vérification du transfert de fichiers

Vous pouvez vérifier I'état du transfert de
fichier en sélectionnant File Transfer >View Job
List (page 110) dans le menu Network du

menu complet.

Vous pouvez aussi vérifier I'état du transfert de
fichier depuis I'écran de I'application Content
Browser Mobile.

[Conseil]

Si File Transfer >Auto Upload (page 110) ou Auto
Upload (Proxy) (page 110) dans le menu Network du
menu complet est réglé sur On et qu‘une connexion
réseau existe, les fichiers originaux et proxy sont
automatiquement téléchargés sur le serveur spécifié
al'aide de Default Upload Server (page 110) a la fin
de I'enregistrement. Si les fichiers originaux et proxy
sont tous deux configurés pour le téléchargement
automatique, le téléchargement automatique des
fichiers proxy est prioritaire.

[Remarques]

e Un maximum de 200 taches de transfert peuvent étre
enregistrées.

La liste des taches est conservée lorsque le
caméscope est mis hors tension, mais vous pouvez
perdre jusqu‘a 10 minutes d'informations de
progression récente si le pack batterie est retiré ou si
le caméscope est mis hors tension sans avoir placé au
préalable le commutateur POWER sur STANDBY.

Les taches ajoutées aprés I'état de tension faible de
la batterie ne sont pas enregistrées dans la liste des
taches.

Si une erreur se produit lors du transfert de fichiers,
le transfert d’un plan ayant le méme nom qu‘un plan
transféré peut ne pas se poursuivre en fonction des
paramétres et de I'état du serveur de destination du
transfert. Si cela se produit, vérifiez les parameétres et
Iétat du serveur de destination du transfert.

Téléchargement automatique des
fichiers

Téléchargement a I'aide d'un FTP
sécurisé

Téléchargement automatique d'un
fichier original

Les fichiers originaux peuvent étre
téléchargés sur le serveur spécifié a la fin de
I'enregistrement. Pour activer cette fonction,
réglez File Transfer >Auto Upload (page 110)
sur On dans le menu Network du menu
complet.

Téléchargement automatique d'un
fichier proxy

Les fichiers proxy peuvent étre téléchargés sur
le serveur spécifié a la fin de I'enregistrement.
Pour activer cette fonction, réglez File Transfer
>Auto Upload (Proxy) (page 110) sur On dans
le menu Network du menu complet.

Ou bien, lorsque Auto Upload (Proxy) est réglé
sur Chunk, vous pouvez enregistrer un fichier
proxy par fragments, puis télécharger les
fragments sur un serveur spécifié pendant que
I'enregistrement continue. Le téléchargement
d’un fichier proxy enregistré par fragments est
prioritaire sur les autres taches de transfert de
fichiers.

Pour plus de détails sur la configuration,
consultez « Enregistrement et téléchargement
d'un fichier proxy par fragments »

(page 55).

Vous pouvez télécharger des fichiers cryptés
a l'aide de FTPS en mode Explicit (FTPES) pour
la connexion avec le serveur de fichiers de
destination.

Réglage d'un transfert FTP sécurisé

Pour un transfert FTP sécurisé, réglez Using
Secure Protocol dans les réglages du serveur
du fichier de destination sur ON et importez
un certificat.

Pour plus de détails sur la configuration,
consultez « Enregistrement d'une destination
de transfert de fichier » (page 66).
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Utilisation de Creators' App for enterprise

Vous pouvez facilement transférer des fichiers

sur le service Cloud C3 Portal en reliant

I'appareil a I'application pour smartphone

« Creators' App for enterprise ».

D’abord, créez un compte C3 Portal et

installez Creators' App for enterprise sur un

smartphone.

Pour plus de détails sur la création d'un

compte de service Cloud C3 Portal, contactez

I'administrateur de votre organisation.

[Remarques]

* Le service peut ne pas étre disponible, en fonction de
la région ol1 vous vivez.

* Pour plus de détails sur I'utilisation de Creators' App
for enterprise, reportez-vous au Manuel d‘aide de
Creators' App for enterprise.

Téléchargement des fichiers sur (3
Portal

1 Sélectionnez Setup for Mobile App >Setup

(page 107) dans le menu Network.

Un écran de confirmation apparait pour

les éléments qui seront automatiquement

mis a jour.

Les réglages suivants dans le menu

Network sont sélectionnés

automatiquement.

e Wired LAN >Setting : Off

e Modem >Setting : On

* Modem >Camera Remote Control :
Enable

e Access Authentication >Input Password :
(Généré automatiquement si non
spécifié)

2 Vérifiez les réglages et sélectionnez OK.
La configuration démarre. Un message
« Now changing » apparait pendant la
configuration.

4

5

Lorsque la configuration est terminée,
I'écran suivant apparait dans le viseur.

Setup for Mobile App

000000

Fingerprint | TS

Les informations suivantes pour
I'authentification d’acces sont affichées.
Nom d’utilisateur, mot de passe,
empreinte digitale, nom du modéle de
caméscope, numéro de série

[Conseil]
Cet écran n'est pas émis dans la sortie vidéo.

[Remarque]

Veillez a ce que le mot de passe ne puisse pas étre
visualisé et que I'image du code QR ne puisse pas
étre copiée par d'autres personnes.

Lancez Creators' App for enterprise sur le
smartphone et connectez-vous au service
Cloud.

Connectez le smartphone via un cable
USB au connecteur USB-C de I'appareil.

Activez le raccordement modem USB sur
I'écran du smartphone.

Pour plus de détails sur la configuration,
consultez « Connexion a l'aide d'un
raccordement modem USB » (page 64).
L'opération différe en fonction de votre
smartphone. Reportez-vous au manuel
d’utilisation du smartphone.

Scannez le code QR dans le viseur
conformément aux instructions sur I'écran
de Creators' App for enterprise.

Les informations de configuration du
transfert de fichiers sont envoyées du

smartphone a I'appareil et le message
suivant apparait.

Network File received.
Load File?

_Gancal OK

7 Sélectionnez OK.
Les informations de configuration
commencent a charger.
Lorsque la configuration est chargée avec
succes, un message « Network File
loaded. » apparait.

[Remarques]

Creators' App for enterprise écrase le réglage File
Transfer (page 110) dans le menu Network de
I'appareil.

Root Certificate ne peut pas étre réglé
automatiquement. Configurez-le manuellement.

Téléchargement d'un fichier original

Réglez File Transfer >Auto Upload (page 110)
dans le menu Network sur On pour activer le
téléchargement des fichiers originaux sur C3
Portal.

Chaque fois qu’un enregistrement se termine,
le fichier est téléchargé sur I'emplacement
associé a votre compte C3 Portal.

Téléchargement d'un fichier proxy

Réglez File Transfer >Auto Upload (Proxy)
(page 110) dans le menu Network sur On

pour activer le téléchargement de fichiers
proxy sur C3 Portal.

Chaque fois qu’un enregistrement se termine,
le fichier est téléchargé sur I'emplacement
associé a votre compte C3 Portal.

Lorsque Auto Upload (Proxy) est réglé sur
Chunk, le fichier proxy est divisé en fragments
et téléchargé a intervalles réguliers depuis

le démarrage de I'enregistrement. Pour plus
de détails sur la configuration, consultez

« Enregistrement et téléchargement d'un
fichier proxy par fragments » (page 55).

Téléchargement de fichiers arbitraires

Consultez « Sélection d'un fichier et
téléchargement » (page 66).

[Conseils]

e Les fichiers envoyés par I'appareil sont mis en cache
dans Creators' App for enterprise et transférés dans
C3 Portal. L'affichage d'état du transfert de fichiers sur
I'appareil indique I'état de transfert de Creators' App
for enterprise.

Lorsque le transfert de fichiers de I'appareil sur
Creators' App for enterprise sur le smartphone est
terminé, vous pouvez mettre I'appareil hors tension,
mais notez que le transfert de fichiers depuis le
téléphone peut encore continuer. Soyez attentif a la
charge restante de la batterie sur le smartphone.

Autres fonctions qui utilisent (3
Portal

Gestion des fichiers 3D LUT

Vous pouvez importer des fichiers 3D LUT
stockés dans C3 Portal vers l'appareil.
Consultez « Importation depuis un service
Cloud » (page 56).

Gestion de fichiers ALL

Vous pouvez enregistrer un fichier ALL créé
par I'appareil dans C3 Portal et charger

un fichier ALL depuis C3 Portal. Consultez

« Enregistrement d'un fichier ALL sur un
service Cloud » (page 119) et « Chargement
d'un fichier ALL depuis un service Cloud »
(page 120).
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Ecran de miniatures

Lorsque vous appuyez sur la touche THUMBNAIL (page 5), les plans enregistrés sur la carte mémoire s'affichent sous forme de miniatures a I'écran.
Vous pouvez sélectionner un plan dans I'écran de miniatures et démarrer la lecture de ce plan. L'image de lecture peut étre affichée sur le viseur et sur un moniteur externe.
Appuyer a nouveau sur la touche THUMBNAIL ferme I'écran de miniatures et revient a I'image de caméra.

[Remarque]
Seuls les plans enregistrés au format d’enregistrement actuellement sélectionné sont affichés dans I'écran de miniatures. Si un plan enregistré que vous vous attendiez a voir n'est pas affiché, vérifiez le format d'enregistrement. Gardez ceci &
I'esprit avant de formater (initialiser) le support.

Disposition de I'écran

Les informations du plan a la position du curseur sont affichées au bas de I'écran.

Indicateur de la carte mémoire actuellement sélectionnée
(Une icdne de verrou s'affiche si la carte est protégée.)

Numeéro de plan/Nombre total de plans

Curseur (jaune)

TCR00:00:00:12 TCR00:00:00:15  TCR 00:00:00:34

.

1 : ji = \

TCR00:00:04:45 TCR00:00:04:57  TCR 00:00:05:21

2 — (i (27 Jin 2014 1220 SN

3 4 5
1. Miniature (image d’index) 2. Nom de plan 4. Informations d’enregistrement spécial
Affiche I'image d'index d'un plan. Lorsqu'un Affiche le nom du plan sélectionné. Affiche le mode d'enregistrement uniquement

plan est enregistré, sa premiére image est
automatiquement définie comme image

si le plan a été enregistré a I'aide d'un mode

3. Format vidéo pour I'enregistrement ) . -
d’enregistrement spécial.

d'in(_:iex. . . A,flﬂdl.e I:nfdl:)rmat de fichier du plan Pour les plans en ralenti et accéléré, la
Les informations du plan/de I'image sont selectionne. fréquence d'images est affichée a droite.
affichées sous la miniature. Vous pouvez i

changer les informations affichées en utilisant 5. Durée du plan

Customize View (page 103) >Thumbnail
Caption dans le menu Thumbnail du menu
complet.

6. Date de création
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Lecture de plans

Lecture de plans enregistrés

Lorsque le caméscope est en mode de veille
d'enregistrement (Stby), vous pouvez lire les
plans enregistrés.

1 Insérez la carte mémoire a lire.
2 Appuyez sur la touche THUMBNAIL.

3 Utilisez le sélecteur multiple (page 7)
ou la molette multifonction (page 5)
pour déplacer le curseur vers la miniature
du plan que vous souhaitez lire.

4 Appuyez sur la touche de mise en
application du sélecteur multiple ou la
molette multifonction.

La lecture commence au début du plan
sélectionné.

Vous pouvez contrdler la lecture en appuyant

sur I'une des touches suivantes.

Appuyez sur la touche de mise en application
du sélecteur multiple ou la molette
multifonction :

La lecture se met en pause.
Appuyez de nouveau sur la molette pour
revenir a la lecture normale.

Appuyez sur les touches gauche/droite du
sélecteur multiple :

Passe au début du plan ou au plan
précédent/suivant.

Maintenez les touches gauche/droite du
sélecteur multiple enfoncées :

Lecture accélérée arriere/avant.
Revient en lecture normale lorsque vous
reldchez la touche.

Touche CANCEL/BACK :

Arréte la lecture et revient en mode de
veille d'enregistrement.

[Remarques]

Il peut y avoir une interruption temporaire de I'image
ou une image fixe entre les plans. Vous ne pouvez
pas utiliser le caméscope durant cette période.
Lorsque vous sélectionnez un plan dans I'écran de
miniatures et commencez la lecture, il peut y avoir
une interruption temporaire de I'image au début du
plan. Pour voir le début du plan sans interruption,
mettez le caméscope en mode de lecture, mettez

la lecture en pause, utilisez la touche gauche du
sélecteur multiple pour revenir au début du plan et
redémarrez la lecture.

[Conseil]

Lors de la lecture d'un plan enregistré en mode de
prise de vue Log, la valeur El et le LUT utilisés lors

de I'enregistrement du plan sont appliqués. Le LUT

a appliquer est déterminé & partir des informations
contenues dans le fichier 3D LUT enregistré en tant que
métadonnées.

Sile plan a été enregistré avec Cine EI/Flex.ISO Set
>Embed LUT File (page 86) dans le menu Project du
menu complet réglé sur On lors de la prise de vue, ce
LUT s"applique pour la lecture si le fichier 3D LUT utilisé
lors de la prise de vue est installé sur I'appareil.

Si le plan a été enregistré avec Cine EI/Flex.ISO Set
>Embed LUT File (page 86) dans le menu Project

du menu complet réglé sur Off lors de la prise de

vue, le LUT sélectionné a I'aide de Base Look >Select
(page 92) dans le menu Paint/Look du menu complet
s'applique pour la lecture.

Le méme LUT s"applique si le fichier 3D LUT utilisé lors
de la prise de vue n'est pas installé sur I'appareil.
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Opérations sur les plans

Sur I'écran de miniatures, vous pouvez utiliser
des plans ou vérifier les propriétés d'un plan
en utilisant le menu Thumbnail du menu
complet.

Le menu Thumbnail (page 103) apparait
lorsque vous maintenez la touche MENU
enfoncée et sélectionnez Thumbnail.

Opérations sur le menu de
miniatures

Avec le sélecteur multiple (page 7)

ou la molette multifonction (page 5),
sélectionnez une fonction, puis appuyez sur
la touche de mise en application du sélecteur
multiple ou sur la molette multifonction.
Appuyez sur la touche CANCEL/BACK

(page 5) pour retourner a I'écran

précédent.

[Remarque]

Certains éléments ne peuvent pas étre sélectionnés,
selon I'état lorsque le menu a été affiché.

Eléments de menu destinés aux
opérations sur les plans

[Conseils]

Date Time :

e Display Clip Properties
e Set Clip Flag

e Lock/Unlock Clip

e Delete Clip

e Transfer Clip

e Transfer Clip (Proxy)

e Filter Clips

e Customize View

Pour plus de détails concernant les éléments
de menu d'opérations sur les plans, voir le
menu Thumbnail (page 103).

Affichage des propriétés de plan

Sélectionnez Display Clip Properties

(page 103) dans le menu de miniatures pour
afficher I'écran de propriétés de plan.
Appuyez sur les touches gauche/droite

du sélecteur multiple pour passer au plan
précédent/suivant.

Ajout de balises de plan

Vous pouvez ajouter des balises (repéres OK,
NG ou KP) aux plans pour filtrer I'affichage des
plans en fonction des balises.

Sélectionnez la miniature du plan auquel
ajouter une balise de plan, puis sélectionnez
la balise de plan a l'aide de Set Clip Flag

(page 103) dans le menu Thumbnail du

menu complet.

Réglage Balise de plan ajoutée
Add OK OK
Add NG NG
Add KEEP KP

Vous pouvez également utiliser une touche
personnalisable a laquelle la fonction de balise de
plan est attribuée pour ajouter des balises de plan

Affiche la date et I'heure a laquelle le plan
a été créé et modifié pour la derniére fois.

(page 49). Time Code :
© Vous pouvez ajouter une balise de plan OK Affiche le code temporel.
(page 53) a la miniature du plan sélectionné en Duration :

appuyant sur la touche Clip Flag (page 5). Affiche la durée du plan.

Sequential Number :
Affiche un numéro séquentiel sur chaque
miniature.

Affichage de I'écran de miniatures de
plans filtré

Sélectionnez Filter Clips (page 103) dans

le menu Thumbnail du menu complet et
sélectionnez un type de balise de plan pour
afficher uniquement les plans qui possédent
la balise spécifiée.

Pour afficher tous les plans, sélectionnez All.
[Conseil]

Vous pouvez également commuter les filtres dans
I'ordre a l'aide de la touche DISPLAY.

Suppression de plans

Vous pouvez supprimer des plans de cartes
mémoire.
Sélectionnez Delete Clip >Select Clip ou All
Clips dans le menu Thumbnail du menu
complet.
Select Clip :
Supprime le plan sélectionné. Il est
possible de sélectionner plusieurs plans.
All Clips :
Supprime tous les plans affichés.

Modification des informations affichées
sur I'écran de miniatures

Vous pouvez modifier les informations de
plans/images affichées sous la miniature.
Sélectionnez Customize View >Thumbnail
Caption dans le menu Thumbnail du menu
complet et sélectionnez les informations a
afficher.
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Configuration et hiérarchie du menu complet

Maintenez la touche MENU enfoncée pour
afficher le menu complet dans le viseur et
spécifier divers éléments pour la prise de
vue, I'enregistrement et la lecture (le menu
peut également étre affiché sur un moniteur
externe). Le menu complet se compose des
menus suivants.

Configuration du menu

Menu User
Contient des éléments de menu
configurés par I'utilisateur depuis le menu
Edit User.
Menu Edit User
Contient des éléments de menu pour
éditer le menu User.
Menu Shooting
Contient des réglages liés a la prise de
vue.
Menu Project
Contient des réglages de base du projet.
Menu Paint/Look
Contient des réglages liés a la qualité
d'image.
Menu TC/Media
Contient des réglages liés aux codes

temporels et au support d’enregistrement.

Menu Monitoring
Contient des réglages liés a la sortie vidéo
et a l'affichage du viseur.
Menu Audio
Contient des réglages liés a I'audio.
Menu Thumbnail
Contient des réglages liés a I'affichage de
miniatures.
Menu Technical
Contient des réglages liés aux éléments
techniques.
Menu Network
Contient des réglages liés aux réseaux.
Menu Maintenance
Contient des réglages liés aux appareils,
par exemple I'horloge et la langue.

Hiérarchie du menu complet Project Base Setting Monitoring Output On/Off
Rec Format Output Format
0 Base Setti _Cine EI/Flex.ISO Set De-Squeeze
S,er ase -etting HDR Setting Output Display
(réglages par Focus - -
défaut) - Simul Rec Display On/Off
S&Q Motion
LUT On/Off Proxy Rec Marker
p l; Interval Rec VF Setting
leu Rec Picture Cache Rec Gamma Display Assist
| rt‘”‘y Ie; SDI/HDMI Rec Control Peaking
W Assignable Button Zebra
Asspnab% Assignable Dial Audio Audio Input
% Multi Function Dial Audio Output
% User File Thumbnail Display Clip Properties
All File " e o
Clip Name F All File SetClipFlag
'p Name (‘)rmat Paint/Look Scene File Lock/Unlock Clip
Format Media e
VF Sett Baselook Delete Clip
T Reset Paint Settings TransferClip
€ora Black Transfer Clip (Proxy)
Zoom T
Y Setti Knee Filter Clips
Edit User M A(‘jengjt ettings Detail Customize View
ftiser Menu C em R Matrix Technical Color Bars
hooti ISUOS;Zm'IZfEI eset Multi Matrix ND Dial
ooting ND F'I:m TC/Media Timecode Tally
sh tl er TC Display HOLD Switch Setting
i utter Users Bit Touch Operation
:St : HDMI TC Out Rec Review
Wuh'(t) Xposure Clip Name Format Zoom
Wh!te setti Update Media Handle Zoom
e e Format Media Menu Settings
=€ e Menu Page On/Off
Focus -
- Fan Control
S&Q Motion
LUT On/Off Lens
—N se S - Video Light Set
oise Suppression APR

Flicker Reduce
SteadyShot

Camera Battery Alarm

Camera DCIN Alarm
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Network

Access Authentication

Wireless LAN
AP Mode Settings

ST Mode Settings

Wired LAN
Modem

File Transfer
Network Reset

Maintenance

Language
Clock Set

All Reset
Hours Meter
Version
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Opérations du menu complet

Maintenez la touche MENU enfoncée pour
afficher le menu complet dans le viseur et
spécifier divers réglages détaillés (le menu
peut également étre affiché sur un moniteur
externe).

Commandes de menu

Touche MENU (page 5)
Appuyez longuement pour afficher le
menu complet. Appuyez a nouveau
lorsque le menu complet est affiché pour
le masquer.

Sélecteur multiple (touches 8 voies D-pad et

de mise en application) (page 7)
Appuyez sur les touches 8 voies D-pad
pour déplacer le curseur vers le haut/le
bas/la gauche/la droite et sélectionner
des éléments ou des réglages de menu.
Appuyez sur la touche de mise en
application du sélecteur multiple pour
appliquer I'élément sélectionné.

Molette multifonction (page 5)
Tournez la molette multifonction pour
déplacer le curseur vers le haut/bas et
sélectionner des éléments ou des
réglages de menu.
Appuyez sur la molette multifonction pour
appliquer I'élément sélectionné.

Touche CANCEL/BACK (page 5)
Appuyez pour revenir au menu précédent.
Toute modification incompléte est
annulée.

[Remarques]

e Le menu complet ne peut pas étre actionné en mode

de loupe de mise au point (page 37).
e Certains éléments ne peuvent pas étre sélectionnés,
selon I'état lorsque le menu a été affiché.

Réglage d'éléments de menu

Saisie d'une chaine de caracteres

Appuyez sur les touches 8 voies D-pad

ou tournez la molette multifonction pour
déplacer le curseur vers I'élément de menu a
régler, puis appuyez sur la touche de mise en
application ou la molette multifonction pour
sélectionner I'élément.

La zone de sélection d'élément de menu
affiche jusqu’a huit lignes. Si les options
disponibles pour un élément ne peuvent
pas étre affichées en méme temps, faites
défiler I'affichage en déplacant le curseur
vers le haut/bas.

Pour les sous-éléments avec une grande
plage de réglages (par exemple -99 a +99),
la zone des réglages n'est pas affichée. Le
parametre actuel est mis en surbrillance
pour indiquer que la valeur peut étre
changée.

Le fait de sélectionner [Execute] pour une
fonction permet d’exécuter la fonction
correspondante.

Le fait de sélectionner un élément qui
nécessite confirmation avant exécution
cache temporairement le menu et affiche
un message de confirmation. Vérifiez le
message, puis sélectionnez I'exécution ou
I'annulation de la fonction.

Quand vous sélectionnez un élément, tel
qu'un nom de fichier, qui exige la saisie de
caracteres, I'écran de saisie de caractéres
s'affiche.

1

All File:File 1D
Kurokawa_Scene 001 a

[e ABC[® abc [e 123 [e 15 |

BocdefghijklIim

noopaqr st

2 3

UV wxyz

Appuyez sur les touches 8 voies D-pad ou
tournez la molette multifonction pour
sélectionner un type de caractére, puis
appliquez le réglage.

ABC : lettres majuscules

abc : lettres minuscules

123: caractéres numériques

1#$ : caractéres spéciaux

Sélectionnez un caractere dans le type de
caractere sélectionné, puis appliquez le
réglage.
Le curseur passe au champ suivant.
Space : permet de saisir un espace au
niveau du curseur.
«—/— : permet de déplacer le curseur.
BS : permet de supprimer le caractére a
gauche du curseur (espacement
arriére).

Lorsque vous avez terminé, sélectionnez
[Done] et appliquez le réglage.

La chaine de caracteres est confirmée et
I'écran de saisie de caractéres disparait.

Verrouillage et déverrouillage du
menu

Vous pouvez verrouiller le menu complet de
sorte que seul le menu User s'affiche.

Dans cet état, vous ne pouvez pas modifier les
réglages a l'aide des écrans d'état.

Verrouillage du menu

1
2

4

Maintenez la molette multifonction
enfoncée et maintenez la touche MENU.

Sélectionnez Menu Settings >User Menu
with Lock dans le menu Technical.
[Remarque]

Lorsque vous maintenez enfoncée uniquement

la touche MENU pour afficher le menu complet
normal, User Menu Only s'affiche sous Menu
Settings dans le menu Technical. Maintenez la
molette multifonction enfoncée et maintenez la
touche MENU pour afficher User Menu with Lock.

Réglez sur On et appuyez sur la touche de
mise en application ou la molette
multifonction.

L'affichage de I'écran du viseur bascule
sur I'écran de saisie du numéro de code.

Saisissez un numéro arbitraire.

Saisissez un numéro a 4 chiffres compris
entre 0000 et 9999. La valeur par défaut
est 0000.

Saisissez un numéro et appuyez sur la
touche de mise en application ou la
molette multifonction pour déplacer le
curseur sur le chiffre suivant.

Une fois tous les chiffres saisis, déplacez
le curseur sur SET.

Appuyez sur la touche de mise en
application ou la molette multifonction.
La saisie s'applique.
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Un message de confirmation apparait, et
I'écran bascule sur I'affichage du menu
User.

Déverrouillage du menu

1 Maintenez la molette multifonction
enfoncée et maintenez la touche MENU.

2 Sélectionnez Menu Settings >User Menu
with Lock dans le menu User.
[Remarque]
Lorsque vous maintenez enfoncée uniquement
la touche MENU pour afficher le menu complet
normal, User Menu Only s’affiche sous Menu
Settings dans le menu Technical. Maintenez la
molette multifonction enfoncée et maintenez la
touche MENU pour afficher User Menu with Lock.

3 Réglez sur Off et appuyez sur la touche de
mise en application ou la molette
multifonction.

L'affichage de I'écran du viseur bascule
sur I'écran de saisie du numéro de code.

4 Saisissez le numéro de code utilisé pour
verrouiller le menu.
Saisissez un numéro et appuyez sur la
touche de mise en application ou la
molette multifonction pour déplacer le
curseur sur le chiffre suivant.
Une fois tous les chiffres saisis, déplacez
le curseur sur Set.

5 Appuyez sur la touche de mise en
application ou la molette multifonction.
La saisie s'applique.
Si le numéro de code saisi correspond au
numéro de code utilisé pour verrouiller le
menu, le menu se déverrouille et s'affiche.
[Remarques]
* Sile numéro de code saisi ne correspond pas au
numéro de code utilisé pour verrouiller le menu, le
menu n'est pas déverrouillé.

o |l est recommandé de prendre note du numéro

de code et le laisser a proximité, au cas ot vous
I'oublieriez. Si vous oubliez votre numéro de code,
contactez votre représentant du service a la clientéle
Sony.

Si le menu est verrouillé avant I'enregistrement des
éléments du menu complet depuis le tableau suivant
dans le menu User, ces fonctions ne pourront pas étre
affectées aux touches personnalisables.

Si ces fonctions ont déja été affectées aux touches
attribuables, le réglage affecté est forcément
désactivé lorsque le menu est verrouillé.

Elément du menu
complet

Sélection de la
touche
personnalisable

Elément du menu
complet

Sélection de la
touche
personnalisable

Shooting >Focus >
Push AF Mode

Push AF Mode

Network >Wireless LAN
>NFC

NFC

Shooting >5&Q Motion  S&Q Motion Network >File Transfer ~ Auto Upload (Proxy)
>Setting >Auto Upload (Proxy)
Shooting >SteadyShot  SteadyShot User User Menu

>Setting

Elément du menu
complet

Sélection de la
touche
personnalisable

Project >Picture Cache
Rec >Setting

Picture Cache Rec

Shooting >ISO/Gain/El
>Base Sensitivity,
Shooting >ISO/Gain/El
>Base ISO

Base ISO/Sensitivity

Shooting >Auto
Exposure >AGC

AGC

Auto ND Filter

Shooting >Iris >Bokeh
Control

Bokeh Control

Shooting >Auto
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto
Exposure >Level

Auto Exposure Level

Shooting >Auto Backlight
Exposure >Mode
Shooting >Auto Spotlight

Exposure >Mode

Shooting >White >
Preset White

Preset White Select

Shooting >Focus >
AF Transition Speed,
Shooting >Focus >
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus >
Focus Area

Focus Area

Shooting >Focus >
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus >
Face/Eye Detection AF

Face/Eye Detection
AF

Technical >Rec Review  Rec Review
>Setting

Thumbnail >Set Clip Clip Flag OK
Flag >Add OK

Thumbnail >Set Clip Clip Flag NG
Flag >Add NG

Thumbnail >Set Clip Clip Flag Keep
Flag >Add KEEP

Technical >Color Bars Color Bars
>Setting

Monitoring >Display Lens Info
On/Off >Lens Info

Monitoring >Display Video Signal
On/Off >Video Signal Monitor
Monitor

Monitoring >Marker Marker
>Setting

Monitoring >VF Setting VF Mode

>Color Mode

Monitoring >Gamma
Display Assist >Setting

Gamma Display
Assist

Monitoring >Peaking Peaking
>Setting

Monitoring >Zebra Zebra
>Setting

Audio >Audio Output Volume

>Volume

Technical >Touch
Operation >Setting

Touch Operation

Technical >Handle
Zoom >Setting

Handle Zoom
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Menu User

Cette section décrit la fonction et les réglages des éléments de chaque menu.

User

Elément Description

Base Setting Elément Project >Base Setting
Focus Elément Shooting >Focus

S&Q Motion Elément Shooting >S&Q Motion
LUT On/Off Elément Shooting >LUT On/Off
Simul Rec Elément Project >Simul Rec

Proxy Rec Elément Project >Proxy Rec

Interval Rec Elément Project >Interval Rec
Assignable Button Elément Project >Assignable Button
Assignable Dial Elément Project >Assignable Dial
Multi Function Dial Elément Project >Multi Function Dial
All File Elément Project >All File

Clip Name Format Elément TC/Media >Clip Name Format
Format Media Elément TC/Media >Format Media
VF Setting Elément Monitoring >VF Setting
Zebra Elément Monitoring >Zebra

Zoom Elément Technical >Zoom

Menu Settings Elément Technical >Menu Settings
Edit User Menu Affiche I'écran de menu Edit User.
[Remarque]

Vous pouvez ajouter et supprimer des éléments de menu dans le menu User a I'aide du menu Edit User. Jusqu'a
20 éléments peuvent étre configurés.
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Menu Edit User

Le menu Edit User est affiché au niveau supérieur quand Edit User Menu est sélectionné dans le

menu User.

Edit User

Elément Réglage de sous-éléments Description

Add Item Ajoute un élément de menu au
Ajouter un élément au menu User.

menu User

Customize Reset
Réinitialiser les
éléments dans le menu

Restaure les éléments de menu
enregistrés dans le menu User aux
réglages par défaut.

Supprime I'élément de menu
enregistré du menu User.

Réorganise les éléments de menu
enregistrés du menu User.

User
Elément de menu Delete
sélectionné pendant
I'édition Move
Edit Sub Item

Edite (enregistrer/supprimer) les
sous-éléments de menu enregistrés
dans le menu User.
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Menu Shooting

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Shooting >ISO/Gain/El
Définit les réglages de gain.

Shooting >ISO/Gain/El
Définit les réglages de gain.

Elément

Réglage de sous-éléments

Description

Mode

1S0/dB

Sélectionne le mode de réglage du gain.

[Remarque]
En modes de prise de vue Log, ce réglage est
défini sur 1SO (fixe).

ISO/Gain<H>

Pour plus de détails sur les réglages,
consultez « Réglages et valeurs par défaut
d'ISO/Gain » (page 112).

Regle la valeur prédéfinie de gain <H>.

[Remarque]
Cette fonction ne peut pas étre configurée en
mode de prise de vue Cine El/Cine EI Quick.

ISO/Gain<M>

Pour plus de détails sur les réglages,
consultez « Réglages et valeurs par défaut
d'ISO/Gain » (page 112).

Régle la valeur prédéfinie de gain <M>.

[Remarque]
Cette fonction ne peut pas étre configurée en
mode de prise de vue Cine El/Cine EI Quick.

ISO/Gain<L>

Pour plus de détails sur les réglages,
consultez « Réglages et valeurs par défaut
d'ISO/Gain » (page 112).

Régle la valeur prédéfinie de gain <L>.

[Remarque]
Cette fonction ne peut pas étre configurée en
mode de prise de vue Cine EI/Cine EI Quick.

Elément Réglage de sous-éléments Description
Exposure Cine El Régle la valeur d'indice de pose <H>.
Index<H> Lorsque Base ISO est réglé sur ISO 800 :

200EI / 4.0E
250El / 4.3E
320El / 4.7E
400El / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000E! / 6.3E
1250El / 6.7E
1600E! / 7.0E
2000E!I / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Lorsque Base ISO est réglé sur ISO
12800 :
3200EI / 4.0E
4000El / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7TE
51200E! / 8.0E

Activé uniquement en mode de prise de
vue Cine EI/Cine El Quick.
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Shooting >ISO/Gain/El
Définit les réglages de gain.

Shooting >ISO/Gain/El
Définit les réglages de gain.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Exposure Cine El Quick Regle la valeur d'indice de pose <H>. Exposure (Mémes réglages qu'Exposure Index<H>)  Régle la valeur d'indice de pose <L>.
Index<H> 200El / 4.0E Activé uniquement en mode de prise de Index<L> Cine El
250El / 4.3E vue Cine EI/Cine El Quick. Lorsque Base ISO est réglé sur ISO 800 :
320El / 4.7E 800EI / 6.0E
400EI / 5.0E Lorsque Base ISO est réglé sur ISO
500EI / 5.3E 12800 :
640El / 5.7E 12800EI / 6.0E
800EI / 6.0E Cine El Quick
1000E! / 6.3E 800EI / 6.0E
1250E1 / 6.7E Shockless On / Off Active/désactive la fonction Shockless
1600EI / 7.0E Gain gain.
2000EI /7.3 Base High / Low Régle la sensibilité de base pour le mode
ggggg: ; ZZ)EE Sensitivity de prise de vue Custom.
4000E! / 4‘.3E Base ISO 1SO 12800 / ISO 800 Reégle la sen.sibilité ISO de base p.our le
5000E! / 4.7E mpde de prise de vue mode Flexible ISO/
6400EI / 5.0 Cine El.
8000EI / 5.3E [Remarque]
10000EI / 5.7E Cette fonction ne peut pas étre configurée
1280081/ 6.08 L2 Soninind 150 do base ot configurée
16000EI / 6.3 automatiquement en lien avec Exposure Index.
20000EI / 6.7E
25600EI / 7.0E Shooting >ND Filter
32000EI / 7.3E Regle les valeurs prédéfinies pour le filtre ND.
40000EI / 7.7E Elément Réglage de sous-éléments Description
5120081 / 8.0 Preset1 1/4/1/8 /1/16 /1/32 /1/64 /1/128 Régle la valeur prédéfinie 1 pour le filtre
Exposure (Mémes réglages qu’Exposure Index<H>)  Reégle la valeur d'indice de pose <M>. ND.
Index<M>  CineEl Preset2 1/4 /1/8 /1/16 /1732 / 1/64 / 17128 Regle la valeur prédéfinie 2 pour le filtre
Lorsque Base ISO est réglé sur ISO 800 : — ND
1000EI / 6.3E — —— -
Lorsque Base ISO est réglé sur ISO Preset3 1/4/1/8/1/16 /1/32/ 1/64 / 1/128 Régle la valeur prédéfinie 3 pour le filtre
12800 : ND.
16000EI / 6.3E Shooting >Shutter
Cine El Quick Régle le fonctionnement de I'obturateur électronique.
800EI / 6.0E

Elément Réglage de sous-éléments Description
Mode Speed / Angle Sélectionne le mode de fonctionnement

de I'obturateur électronique.

Utilisé pour filmer de maniére nette des
sujets se déplagant rapidement.
Sélectionne le mode pour régler la
vitesse d'obturateur en secondes (Speed)
ou comme angle d’'obturateur (Angle).
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Shooting >Shutter
Régle le fonctionnement de I'obturateur électronique.

Shooting >Shutter
Régle le fonctionnement de I'obturateur électronique.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Shutter On / Off Définit si, lorsque le mode Speed est ECS On/Off  On/ Off Permet d'activer/de désactiver la
Speed sélectionné, la durée d'exposition suit la fonction d'atténuation de balayage
On/Off valeur de Shutter Speed ou est réglée étendue.

pour I'exposition totale. ECS 23.99 4 8000 Reégle la fréquence d’ECS quand Mode
Shutter 64F 41/8000 Régle la vitesse d'obturateur quand Frequency Les réglages disponibles varient en est réglé sur ECS.
Speed Les réglages disponibles varient en Mode est réglé sur Speed. fonction de la fréquence du systéme du

fonction de la fréquence du systéme du
format d'enregistrement sélectionné.
59.94P :
64F / 32F /16F / 8F / 7F / 6F / 5F / 4F /
3F/2F/1/50/1/60 /1/100 /1/120 /
17125 /1/250 /1/500 /7 1/1000 /
1/2000 / 174000 / 1/8000
50P :
64F / 32F / 16F / 8F / 7TF / 6F / 5F / 4F /
3F/2F/1/50/1/60 /1/100 / 1/120 /
17125 /1/250 /1/500 /7 1/1000 /
1/2000 / 174000 / 1/8000
29.97P :
64F / 32F / 16F / 8F / 7TF / 6F / 5F / 4F /
3F/2F/1/30/1/40/1/50/1/60 /
1/100 /17120 /17125 /1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
25P :
64F / 32F /16F / 8F / 7F / 6F / 5F / 4F /
3F/2F/1/25/1/33/1/50/1/60 /
1/100 /1/120 /1/125 /1/250 / 1/500 /
171000 /172000 / 1/4000 / 1/8000
24P/23.98P :
64F / 32F /16F / 8F / 7F / 6F / 5F / 4F /
3F/2F/1/24/1/32/1/48 /1/50 /
1/60 /1796 /1/100 / 1/120 / 1/125 /
1/250 /17500 7 1/1000 / 1/2000 /
174000 / 1/8000

format d’enregistrement sélectionné.
Les valeurs par défaut sont données
ci-dessous.

59.94P : 60.00

25P :25.02
24P :24.02

Shooting >Iris

Définit les réglages de la fonction de contréle du bokeh.

Elément Réglage de sous-éléments Description
Bokeh On / Off Active/désactive la fonction de contréle
Control du bokeh.

Shooting >Auto Exposure

Définit les réglages d'ajustement de I'exposition automatique.

Shutter Angle

64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F / 2F /360.0° / 300.0° /

270.0° / 240.0° / 216.0° / 210.0° /
180.0° /172.8° /150.0° / 144.0° /
120.0°/90.0° / 86.4° / 72.0° / 45.0° /
30.0°/22.5°/11.25° / 5.6°

Régle I'angle d'obturateur quand Mode
est réglé sur Angle.

Elément Réglage de sous-éléments Description
Level +3.0/+2.75/+2.5/+2.25/+2.0/ .75/ Régle le niveau de luminosité pour
+1.5/+1.25/+1.0 / +0.75 / +0.5 / +0.25 / I'exposition détectée de maniére
*0/-025/-05/-075/-1.0/-125/ automatique.
-15/-175/-20/-225/-25/-275/
-3.0
Mode Backlight / Standard / Spotlight Régle le mode de fonctionnement du
réglage d'exposition automatique.
Backlight :
Mode Backlight (mode qui atténue
I'obscurité d’un sujet lorsque le sujet
est rétroéclairé)
Standard :
Mode Standard
Spotlight :
Mode Spotlight (mode qui atténue
les blancs écrétés lorsque le sujet est
éclairé par la lumiére d'un spot)
Speed -99 a +99 (x0) Régle la vitesse de réglage du réglage

d'exposition automatique.
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Shooting >Auto Exposure

Définit les réglages d'ajustement de I'exposition automatique.

Shooting >Auto Exposure

Définit les réglages d'ajustement de I'exposition automatique.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
AGC On / Off Active/désactive la fonction AGC Detect 1/2/3/4/5/6/Custom Régle la plage d'intégrateur de lumiere
(commande de gain automatique). Window pour I'ajustement automatique de
I'exposition en fonction de la luminosité
[Remarque] du sujet. (Non disponible en cas de
Ceci est réglé sur Off (fixe) en mode de prise de réglage manuel de la pose)
vue Cine El/Cine El Quick. Detect On / Off Active/désactive I'indication de la plage
AGC Limit Pour plus de détails sur les réglages, Régle le gain maximum de la fonction Window d'intégrateur de lumiére.
consultez « Réglages et valeurs par défaut  AGC. Indication
de AGC Limit » (page 115). R Custom 40 4999 (500) Permet de régler la largeur de la plage
[ emarqug] N o Width d'intégrateur de lumiére.
Cette fonction ne peut pas étre configurée en - -
mode de prise de vue Cine El/Cine El Quick. Custom 70 a 999 (500) Permet de régler la hauteur de la plage
Height d'intégrateur de lumiere.
AGCPoint  F2.8/F4/F56 Regle la valeur F-stop du diaphragme I 9 . grateur e .
ou démarre I'opération de commande de Custom H -479 a +479 (20) Permet de reglerrla position horl_zyntale
. N . Position de la plage d'intégrateur de lumiére.
gain automatique lorsque la fonction - - — -
AGC est réglée sur On. Custom V -464 a +464 (x0) Permet de’_regler la position ygrtlcale de
Position la plage d'intégrateur de lumiére.

[Remarque]
Cette fonction ne peut pas étre configurée en
mode de prise de vue Cine El/Cine El Quick.

Shooting >White

Définit les réglages de I'équilibre des blancs.

Auto Shutter  On /7 Off

Active/désactive la fonction de
commande d’obturateur automatique.
[Remarque]

Ceci est réglé sur Off (fixe) en mode de prise de
vue Cine El/Cine El Quick.

Elément Réglage de sous-éléments

Description

Preset White  2000K a 15000K (3200K)

Regle la valeur prédéfinie de I'équilibre
des blancs.

A.SHT Limit ~ 1/100 /17150 /1/200 / 1/250 / 1/2000

Regle la vitesse d'obturateur la plus
rapide de la fonction d’obturateur
automatique.

[Remarque]

Cette fonction ne peut pas étre configurée en
mode de prise de vue Cine El/Cine EI Quick.

ColorTemp ~ 2000K a 15000K (3200K)
<A>

Regle la température de couleur de
I'équilibre des blancs stockée dans la
mémoire A.

[Remarque]

Comme Color Temp est écrété a 2000K et
15000K pendant I'opération R/B Gain, il n'est
pas possible d'afficher la valeur correcte de
Color Temp pour la valeur R/B Gain.

A.SHT Point  F5.6/F8/F11/F16

Régle la valeur F-stop du diaphragme la
ou démarre I'opération de commande
d’obturateur automatique.

[Remarque]

Cette fonction ne peut pas étre configurée en
mode de prise de vue Cine El/Cine EI Quick.

Tint<A> -99 4 +99 (0)

Permet de régler la valeur de teinte de la
balance des blancs stockée dans la
mémoire des blancs A.

[Remarque]

Comme Tint est écrété a +99 pendant
I'opération R/B Gain, il n‘est pas possible
d'afficher la valeur correcte de Tint pour la
valeur R/B Gain.

Clip High on / Off
light

Active/désactive la fonction qui ignore
les zones les plus lumineuses pour
fournir une réponse plus plate avec une
luminance élevée.

R Gain <A> -99.0 & +99.0 (x0.0)

Régle la valeur de gain R de I'équilibre
des blancs stockée dans la mémoire A.

BGain<A>  -99.0 a+99.0 (£0.0)

Régle la valeur de gain B de I'équilibre
des blancs stockée dans la mémoire A.
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Shooting >White
Définit les réglages de I'équilibre des blancs.

Shooting >White Setting
Définit les réglages de balance des blancs.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Color Temp 2000K a 15000K (3200K) Régle la température de couleur de Filter White On / Off Active/désactive la fonction de réglage
<B> I'équilibre des blancs stockée dans la Memory de la zone de mémoire d'équilibre des
meémoire B. blancs pour chaque filtre ND.
[Remarque] On : régle la mémoire d'équilibre des
Comme Color Temp est écrété & 2000K et blancs pour chaque filtre ND.
15000K pendant I'opération R/B Gain, il n'est
pas possible d'afficher la valeur correcte de [Conseil]
Color Temp pour la valeur R/B Gain. En mode prédéfini, quatre réglages
Tint<B> -99 a +99 (x0) Permet de régler la valeur de teinte de la existent (CLEAR/1/2/3). En mode variable,
balance des blancs stockée dans la deux réglages existent (CLEAR/On).
mémoire des blancs B. Off : regle la mémoire d'équilibre des
blancs commune a tous les filtres ND.
[Remarque]
Comme Tint est écrété a 99 pendant Shooting >Offset White
I'opération R/B Gain, il n'est bl A q Ty fiF
d?apﬁeir;'e?r"a Va‘eu‘?'z(’)‘,,ggz d":iiﬁ?;i;u,ﬁa Définit les réglages de correction de I'équilibre des blancs.
valeur R/B Gain. Elément Réglage de sous-éléments Description
R Gain <B> -99.0 4 +99.0 (x0.0) Regle la valeur dg gainRdel gqul_llbre Offset White  On / Off Choisit d'ajouter (On) ou non (Off) une
des blancs stockée dans la mémoire B. . RO
- N N - PP <A> valeur de décalage a I'équilibre des
B Gain <B> -99.0 4 +99.0 (x0.0) Régle la valeur de gain B de I'équilibre blancs dans la mémoire A.
des blancs stockée dans la mémoire B. )
. . " [Remarque]
Shooting >White Setting Ceci est réglé sur OFF (fixe) en modes de prise
Définit les réglages de balance des blancs. de vue Log.
Elément Réglage de sous-éléments Description Offset Color  -99 a +99 (x0) Régle la correction de température de
Shockless off/1/2/3 Régle la vitesse de réaction d'équilibre Temp<A> Zoulelur a ?]OUFEI': I equlgtg?fdeisvs:j?cs
White des blancs en cas de commutation du ans lamemoire A quan set White
mode d'équilibre des blancs. <A> est réglé sur On.
Off : commute instantanément. Offset -99 4 +99 (0) Régle la correction de valeur Tint a
1a3:plus I? \;gleur islt e{evee, plus la Tint<A> ajouter a I'équilibre des blancs dans la
commutation est fente. mémoire A quand Offset White <A> est
ATW Speed  1/2/3/4/5 Regle la vitesse de réaction en mode réglé sur On.
ATW. s PP
1: vitesse de réaction la plus rapide O;fset White  On / Off Permgt de cl'10t>1:fs|r d ajot:ter (dOn) ou de.ne
White Memory / ATW Sélectionne le mode de réglage =5 ?a,s, aquter( ) une valeur de correct.lon
. P P . a I'équilibre des blancs dans la mémoire
Switch<B> d'équilibre des blancs sélectionné quand B
le commutateur WHT BAL est réglé sur B. .
Remarque
[Remarque]
quel Ceci est réglé sur OFF (fixe) en modes de prise
Ceci est réglé sur Memory (fixe) en mode de de vue Log
prise de vue Cine El/Cine El Quick. - - - - -
Offset Color  -99 a +99 (+0) Régle la correction de température de
Temp<B> couleur a ajouter a I'équilibre des blancs

dans la mémoire B quand Offset White
<B> est réglé sur On.
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Shooting >Offset White
Définit les réglages de correction de I'équilibre des blancs.

Shooting >Focus
Définit les réglages de mise au point.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Offset -99 a +99 (x0) Régle la correction de valeur Tint a Focus Area Flexible Spot Régle la zone cible pour la mise au point
Tint<B> ajouter a I'équilibre des blancs dans la (AF-S) automatique par pression (AF-S).
"]E'HjOifE B quand Offset White <B> est Face/Eye Face/Eye Only AF / Face/Eye Priority AF /  Active/désactive la détection des visages
réglé sur On. Detection AF__ Off AF.
Offset White  On / Off Permet de choisir d'ajouter (On) ou de ne Push AF AF / Single-shot AF(AF-S) Reégle le mode de mise au point
<ATW> pas ajouter (Off) une valeur de correction Mode automatique par pression pendant la
a l'équilibre des blancs ATW. mise au point manuelle.
Offset Color  -99 a +99 (x0) Régle Ia‘co_rrectiorj dg te_mpérature de Touch Tracking AF / Spot Focus Régle I'action qui se produit lorsque vous
Temp<ATW> couleur a ajouter a I'équilibre des blancs Function in appuyez sur le panneau tactile pendant
ATW quand Offset White <ATW> est réglé MF la mise au point manuelle.
sur On. AF Assist On / Off Quand ce réglage est réglé sur On, il est
Offset -99 4 +99 (x0) Regle la correction de valeur Tint a possible de changer temporairement la
Tint<ATW> ajouter a I'équilibre des blancs ATW mise au point automatique et d'effectuer
quand Offset White <ATW> est réglé sur la mise au point manuellement.
Oon.

Shooting >Focus
Définit les réglages de mise au point.

Shooting >S&Q Motion

Définit les réglages du mode Slow & Quick Motion (page 50).

Elément Réglage de sous-éléments

Description

Elément Réglage de sous-éléments Description
AF Transition 1(Slow)/2/3/4/5/6/7(Fast) Permet de régler la vitesse
Speed d’entrainement de la mise au point pour

le changement de sujet lors de la mise
au point automatique.

AF Subj. Shift 1(Locked On)/2/3/ 4/ 5(Responsive] Permet de régler la sensibilité de la mise

Setting On / Off

Active/désactive le mode
d'enregistrement ralenti et accéléré.
Lorsqu'il est activé, les fonctions
suivantes sont désactivées.

® Diaphragme automatique

® Mise au point automatique

Sens. au point en cas de changement de sujet
pendant la mise au point automatique.
Focus Area Wide / Zone / Flexible Spot Régle la zone cible pour la mise au point

automatique et la mise au point

automatique par pression (AF)

(page 38).

Wide :
Recherche un sujet dans un grand
angle de I'image lors de la mise au
point.

Zone :
Recherche automatiquement un
point de mise au point dans la zone
spécifiée.

Flexible Spot :
Effectue la mise au point sur une
position spécifique dans I'image.

Frame Rate 1fps a 60fps / 100fps / 120fps / 150fps /
180fps / 200fps / 240fps

Régle la fréquence d'images pour la prise
de vue au ralenti et accéléré.

[Remarque]

Les réglages disponibles varient en fonction
de la fréquence du systéme, du codec et du
format vidéo sélectionnés.

Shooting >LUT On/Off
Définit les réglages LUT.

Elément Réglage de sous-éléments

Description

SDI/HDMI MLUT On / MLUT Off

Sélectionne I'application ou non de
Monitor LUT aux sorties vidéo SDI et
HDMI.

VF/Proxy/ MLUT On / MLUT Off
Stream

Sélectionne I'application ou non de
Monitor LUT aux sorties vidéo du viseur,
proxy et streaming.
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Shooting >LUT On/Off Shooting >SteadyShot
Définit les réglages LUT. Définit les réglages de stabilisation d'image.
Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Internal Rec  MLUT On / MLUT Off Sélectionne I'application ou non de Setting Active / Standard / Off Regle la fonction de stabilisation
Monitor LUT & la vidéo d'enregistrement d'image.
interne.

[Remarque]
Activé lorsqu’un objectif compatible est fixé.

Shooting >Noise Suppression

Définit les réglages de suppression de bruit.

[Conseil]
Les réglages Setting(Custom) et Level(Custom) sont reflétés dans le réglage Target Display (page 118).
Elément Réglage de sous-éléments Description
Setting On / Off Active/désactive la fonction de
(Custom) suppression de bruit en mode de prise
de vue Custom.
[Remarque]
Cette fonction ne peut pas étre configurée en
modes de prise de vue Log.
Level Low / Mid / High Regle le niveau de suppression de bruit
(Custom) en mode de prise de vue Custom.
[Remarque]
Cette fonction ne peut pas étre configurée en
modes de prise de vue Log.
Setting On / Off Active/désactive la fonction de
(Cine EI/Flex. suppression de bruit en modes de prise
1SO) de vue Log.
[Remarque]
Cette fonction ne peut pas étre configurée en
mode de prise de vue Custom.
Level Low / Mid / High Régle le niveau de suppression de bruit
(Cine EI/Flex. en modes de prise de vue Log.
1SO)

[Remarque]
Cette fonction ne peut pas étre configurée en
mode de prise de vue Custom.

Shooting >Flicker Reduce
Définit les réglages de correction de scintillement.

Elément Réglage de sous-éléments Description

Mode Auto / On / Off Régle le mode de correction de
scintillement.

Frequency 50Hz / 60Hz Régle la fréquence de la source

d'alimentation qui fournit I'éclairage qui
cause le scintillement.
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Menu Project

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Project >Rec Format
Définit les réglages du format d'enregistrement.

Project >Base Setting
Définit les réglages de base.

Elément

Réglage de sous-éléments

Description

Elément Réglage de sous-éléments Description

Shooting Custom / Flexible I1SO / Cine El Quick / Régle le mode de prise de vue

Mode Cine El (page 24).

Target SDR(BT.709) / HDR(HLG) Régle la norme vidéo pour

Display I'enregistrement/la sortie en mode de

prise de vue Custom.

Project >Rec Format
Définit les réglages du format d'enregistrement.

Elément Réglage de sous-éléments Description

Frequency 59.94 /50/29.97/25/ 24 /2398 Sélectionne la fréquence du systeme.

Imager Scan  FF / S35 Sélectionne la taille de I'imageur.

Mode

Codec RAW / RAW & XAVC-1 / RAW(HDMI) / Régle le codec d'enregistrement/de
RAW(HDMI) & XAVC-I / XAVC-1 / XAVC-L lecture de plan.

RAW Output  Les réglages disponibles varient selon les  Regle la taille de I'image de la sortie

Format réglages Frequency et Codec. RAW.

Frequency  Codec Options de
sélection

59.94/ RAW 4096x2160

50/ 3840%2160

29.97/

25/ RAW & 4096x2160

23.98 XAVC 3840%2160
RAW(HDMI)  4240x2392
RAW(HDMI)  4240x2392
& XAVC-|

24 RAW 4096x2160
RAW & 4096x2160

XAVC

[Remarque]

Lorsque Codec est réglé sur RAW & XAVC-l, le
réglage Video Format change en lien avec le
réglage RAW Output Format.

Video Format

Les réglages disponibles varient selon les
réglages Frequency et Codec.

Frequency  Codec Options de
sélection
59.94 RAW/ -
RAW(HDMI)
RAW & 4096x2160P
Xavel 3840x2160P
RAW(HDMI)  3840x2160P
& XAVC-|
XAVC-| 4096x2160P
3840x2160P
1920x1080P
XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
50 RAW/ -
RAW(HDMI)
RAW & 4096x2160P
Xavel 3840x2160P
RAW(HDMI)  3840x2160P
& XAVC-|
XAVC-| 4096x2160P
3840x2160P
1920x1080P
XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35

Régle la taille de I'image et le débit
binaire.
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Project >Rec Format

Définit les réglages du format d'enregistrement.

Project >Rec Format
Définit les réglages du format d'enregistrement.

Elément Réglage de sous-éléments Elément Réglage de sous-éléments Description
Video Format 29.97 RAW/ - Video Format 23.98 RAW/ -
RAW(HDMI) RAW(HDMI)
RAW & 4096x2160P RAW & 4096x2160P
XAVC| 3840x2160P XAVC| 3840x2160P
RAW(HDMI) 3840x2160P RAW(HDMI)  3840x2160P
& XAVC-| & XAVC-|
XAVC-| 4096x2160P XAVC-I 4096x2160P
3840x2160P 3840%2160P
1920x1080P 1920x1080P
XAVC-L 3840x2160P XAVC-L 3840x2160P
1920x1080P 50 1920x1080P 50
1920x1080P 35 1920x1080P 35
25 RAW/ - 24 RAW/ -
RAW(HDMI) RAW(HDMI)
RAW & 4096x2160P RAW & 4096x2160P
XAVC-| 3840x2160P XAVC-|
RAW(HDMI) 3840x2160P RAW(HDMI) ~ 3840x2160P
& XAVC-| & XAVC-|
XAVC-I 4096x2160P XAVC 4096x2160P
3840x2160P Project >Cine EI/Flex.ISO Set
W Régle le mode de prise de vue Log (Cine El, Cine EI Quick, Flexible 1SO).
XAVC-L 3840x2160P Elément Réglage de sous-éléments Description
m Color Gamut S-Gamut3/SL_og3 / Reégle la gamme de couleurs pour les
_ S-Gamut3.Cine/SLog3 modes de prise de vue Log.
1920x1080P 35

Embed LUT ~ On/ Off

Active/désactive I'enregistrement des

File métadonnées du fichier 3D LUT file
(fichier CUBE).
Project >HDR Setting
Régle les réglages du mode HDR.
Elément Réglage de sous-éléments Description
VF SDR On / Off En mode HDR, active/désactive la
Preview fonction qui convertit I'image du viseur

de HDR vers SDR lorsque |'aide pour
I'affichage gamma est activée.
[Conseil]

Avec ce réglage sur On, SDR Gain est appliqué
al'image du viseur.
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Project >Interval Rec
Permet de configurer les réglages du mode d’enregistrement par intervalles (page 50).

Elément Réglage de sous-éléments Description

Project >HDR Setting
Regle les réglages du mode HDR.
Elément Réglage de sous-éléments Description
SDR Gain 0dB a -15dB (-6dB) En mode HDR, régle le réglage SDR Gain

qui est appliqué au viseur lorsque VF SDR

Preview est réglé sur On.

Project >Simul Rec
Permet de configurer les réglages du mode d’enregistrement simultané (page 52).

Number of 1frame / 2frames / 3frames / 6frames /
Frames 9frames / 12frames
Les réglages disponibles varient en
fonction de la fréquence d’images du

Régle le nombre d’'images a enregistrer
par prise en mode d’enregistrement
Interval Rec (lorsque Interval Rec est
réglé sur On).

format vidéo sélectionné.
59.94P/50P :

2frames / 6frames / 12frames

29.97P/25P/24P/23.98P :

1frame / 3frames / 6frames / 9frames

Elément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction
d’enregistrement simultané et définit le
support de destination d’enregistrement.

Rec Button Rec Button:[SlotA SlotB] Handle Rec  Assigne les touches d'enregistrement

Set Button:[SlotA SlotB] / Rec Button:[SlotA] utilisées pour contréler chaque support

Handle Rec Button:[SlotB] / Rec
Button:[SlotB] Handle Rec Button:[SlotA]

d’enregistrement.

Project >Proxy Rec
Permet de configurer les réglages du mode d’enregistrement proxy.

Pre-Lighting Off/2s/5s/10s

Régle le nombre de secondes apres
lesquelles la lampe vidéo s'allume avant
le démarrage de I'enregistrement en
mode d’enregistrement Interval Rec.
[Conseil]

Disponible uniquement lors de I'utilisation du
HVL-LBPC (optionnel).

Project >Picture Cache Rec

Définit les réglages du mode d’enregistrement en cache d'image (page 51).

Elément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode
d'enregistrement proxy.

Audio CH1/CH2 / CH3/CH4 Sélectionne le canal audio pour

Channel enregistrer les données proxy.

Chunk 30s / 1min / 2min Sélectionne l'intervalle d'enregistrement

par fragments pour les fichiers proxy.

Project >Interval Rec
Permet de configurer les réglages du mode d’enregistrement par intervalles (page 50).

Elément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode
d’enregistrement de cache d'image.

Cache Size Short / Medium / Long / Max Regle le temps pour I'accumulation
d’images dans la mémoire de cache
d’image (temps d'enregistrement de
cache d'image).

Cache Rec Affiche le temps pour I'accumulation

Time d'images dans la mémoire de cache

d'image (temps d’enregistrement de
cache d'image).

Elément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode
d’enregistrement & intervalle. (Le réglage
de ce mode sur On met tous les autres
modes spéciaux sur Off.)

Interval Time 1/2/3/4/5/6/7/8/9/10/15/ Régle l'intervalle entre les

20/30/40/50(s)
1/2/3/4/5/6/7/8/9/10/15/20/
30 /40 /50 (min)
1/2/3/4/6/12/24(h)

enregistrements en mode
d'enregistrement Interval Rec (lorsque
Interval Rec est réglé sur On).
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Project >SDI/HDMI Rec Control
Définit les réglages de contréle d'enregistrement SDI/HDMI.

Project >Assignable Button
Régle les attributions de fonction des touches personnalisables.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Permet de configurer le contréle de <1>a<9>, Off / Base 1SO/Sensitivity / AGC / Push Attribue des fonctions aux touches
démarrage/d'arrét d'enregistrement d'un Focus Hold AGC / ND Filter Position / Auto ND Filter /  personnalisables.
dispositif externe via le signal de sortie Button Push Auto ND / Auto Iris / Push Auto Iris /  Base ISO/Sensitivity :

SDI/HDMI.

Off :
Ne pas utiliser la télécommande.

SDI/HDMI Remote I/F :
Controle d'arrét/de démarrage
d’enregistrement d'un dispositif
externe connecté, quand aucun
support n‘est inséré dans le
caméscope. Pas de synchronisation
avec la précision d'images pour le
support du caméscope.

Parallel Rec :
Contréle d'arrét/de démarrage
d'enregistrement d'un dispositif
externe connecté, quand un support
est inséré dans le caméscope.
Synchronisation avec la précision
d'images pour le support du
caméscope.

[Remarque]

Pour le contrle a l'aide du signal de

sortie HDMI, réglez HDMI TC Out >Setting
(page 95) dans le menu TC/Media du menu
complet sur On.

Bokeh Control / Auto Shutter / Auto
Exposure Level / Backlight / Spotlight /
Preset White Select / ATW / ATW Hold / AF
Speed/Sens. / Focus Setting / Focus Area /
Focus Area(AF-S) / Face/Eye Detection AF /
Push AF Mode / Push AF/Push MF / Focus
Hold / Focus Magnifier x3/x6 / Focus
Magnifier x3 / Focus Magnifier x6 / S&Q
Motion / SteadyShot / Rec / Picture Cache
Rec / Rec Review / Clip Flag OK / Clip Flag
NG / Clip Flag Keep / Color Bars / Tally
[Front] / DURATION/TC/U-BIT / Display /
Lens Info / Video Signal Monitor / Marker /
VF Adjust / VF Mode / Gamma Display
Assist / Peaking / Zebra / Volume /
Thumbnail / Touch Operation / Handle
Zoom / NFC / Auto Upload (Proxy) / Direct
Menu / User Menu / Menu

Permet de changer la sensibilité de
base du capteur d'image.
AGC:
Active/désactive la fonction AGC.
Push AGC:
Active la fonction AGC pendant
l'activation de la touche.
ND Filter Position :
Commute entre les filtres ND.
Auto ND Filter :
Active/désactive la fonction Auto ND
Filter.
Push Auto ND :
Active la fonction Auto ND Filter
pendant I'activation de la touche.
Auto Iris :
Active/désactive la fonction de
diaphragme.
Push Auto Iris :
Active la fonction de diaphragme
automatique pendant I'activation de
la touche.
Bokeh Control :
Active/désactive le mode de contréle
du bokeh.
Auto Shutter :
Active/désactive la fonction
d’obturation automatique.
Auto Exposure Level :
Affiche/ferme le menu direct Auto
Exposure Level.
Backlight :
Bascule entre les fonctions Backlight
et Standard.
Spotlight :
Bascule entre les fonctions Spotlight
et Standard.
Preset White Select :
Change la valeur de mode prédéfinie
de I'équilibre des blancs.
ATW :
Active/désactive la fonction ATW.
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Project >Assignable Button

Régle les attributions de fonction des touches personnalisables.

Project >Assignable Button

Régle les attributions de fonction des touches personnalisables.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description

<1>a<9>, ATW Hold : <1>a<9>, Picture Cache Rec :

Focus Hold Met la fonction ATW en pause. Focus Hold Active/désactive le mode

Button AF Speed/Sens. : Button d'enregistrement de cache d'image.

Commute le réglage de la vitesse de
transition AF et le réglage de la
sensibilité de changement de sujet
AF.

Focus Setting :
Permet de régler la zone de mise au
point.

Focus Area :
Permet de régler la zone de mise au
point pour AF et Push AF.

Focus Area(AF-S) :
Permet de régler la zone de mise au
point pour Push AF (AF-S).

Face Eye Detection AF :
Commute les réglages de la
détection des visages/yeux AF.

Push AF Mode :
Commute le réglage du mode Push
AF.

Push AF/Push MF :
En mode de mise au point MF, active
AF tant que la touche est enfoncée.
En mode de mise au point AF, active
MF tant que la touche est enfoncée.

Focus Hold :
En mode de mise au point AF, la mise
au point est fixée tant que la touche
est enfoncée.

Focus Magnifier x3/x6 :

Focus Magnifier x3 :

Focus Magnifier x6 :
Active/désactive la fonction
d’agrandissement de la mise au
point.

S&Q Motion :
Active/désactive le mode ralenti et
accéléré.
Reégle la fréquence d'images de prise
de vue si elle est maintenue
enfoncée.

SteadyShot :
Alterne entre Active, Standard et Off.

Rec:
Démarre/arréte I'enregistrement.

Rec Review :
Active/désactive la fonction Rec
Review.

Clip Flag OK :
Exécute la fonction Add OK.
Appuyez deux fois pour exécuter
Delete Clip Flag.

Clip Flag NG :
Exécute la fonction Add NG.
Appuyez deux fois pour exécuter
Delete Clip Flag.

Clip Flag Keep :
Exécute la fonction Add Keep.
Appuyez deux fois pour exécuter
Delete Clip Flag.

Color Bars :
Active/désactive les barres de
couleur.

Tally [Front] :
Active/désactive la fonction
d'éclairage continu/de clignotement
du témoin d'enregistrement/de
signalisation.

DURATION/TC/U-BIT :
Commute entre Time Code, Users Bit
et Duration.

Display :
Active/désactive les indicateurs de
I'écran.

Lens Info :
Commute I'indicateur de profondeur
de champ.

Video Signal Monitor :
Commute le moniteur de signal vidéo
(tel que le moniteur de forme
d'onde).

Marker :
Active/désactive la fonction de
marqueur.

VF Adjust :
Affiche les barres de niveau pour
I'ajustement de la luminosité de
I'écran du viseur.

VF Mode :
Commute I'affichage du viseur entre
couleur et noir et blanc.
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6. Affichage et réglages de menu : Menu Project

Project >Assignable Button
Régle les attributions de fonction des touches personnalisables.

Project >Assignable Dial
Régle les attributions de fonction de la molette personnalisable et régle la direction de rotation.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
<1>a<9>, Gamma Display Assist : Grip/Remote  Off / 1SO/Gain/El / ND Filter / IRIS / Attribue des fonctions a la molette
Focus Hold Commute la fonction d'aide pour Dial Auto Exposure Level / Audio Input Level /  personnalisable du grip.
Button PeaLﬁ]fgC_hage gamma. Multi Function Dial 1SO/Gain/El :
Active/désactive la fonction de ND ?_JltUSt? e gain ou Bl.
réglage du contour. '\ er:
Zebra - Regle le filtre ND.
Active/désactive la fonction des RIS N .
sébrures Ajuste le diaphragme.
) ) Auto Exposure Level :
Volume :

Ajuste la sortie de niveau audio du
moniteur vers la prise casque et le
haut-parleur intégré.

Thumbnail :

Affiche/ferme I'écran de miniatures.

Touch Operation :

Active/désactive les opérations
tactiles.

Handle Zoom :

Commute le zoom de la poignée.

NFC:

Exécute la fonction NFC.

Auto Upload (Proxy) :
Active/désactive le téléchargement
automatique de fichiers proxy ou
régle le mode Chunk.

Direct Menu :

Affiche/ferme le menu direct.

User Menu :

Affiche/ferme le menu User.

Menu :

Affiche/ferme le menu complet.

Ajuste le niveau d'exposition
automatique.

Audio Input Level :
Régle le niveau d'enregistrement
audio.

Multi Function Dial :
Fonctionne comme une molette
multifonction.

Grip Dial
Direction

Normal / Opposite Regle le sens de rotation de la molette
personnalisable du grip.
Normal : tourne dans le sens normal.

Opposite : tourne dans le sens opposé.

Handle Dial Attribue des fonctions a la molette
personnalisable de la poignée.
ISO/Gain/El :
Ajuste le gain ou EI.
ND Filter :
Regle le filtre ND.
IRIS :
Ajuste le diaphragme.
Auto Exposure Level :
Ajuste le niveau d'exposition
automatique.
Audio Input Level :
Regle le niveau d'enregistrement
audio.
Multi Function Dial :
Fonctionne comme une molette
multifonction.

Off / 1SO/Gain/El / ND Filter / IRIS / Auto
Exposure Level / Audio Input Level / Multi
Function Dial

Handle Dial
Direction

Normal / Opposite Régle le sens de rotation de la molette
personnalisable de la poignée.
Normal : tourne dans le sens normal.

Opposite : tourne dans le sens opposé.
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6. Affichage et réglages de menu : Menu Project

Project >Multi Function Dial
Affecte des fonctions a la molette multifonction.

Project >All File
Définit les réglages liés aux fichiers ALL.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Default Off / IRIS / 1SO/Gain/El / Auto Exposure Affecte la fonction par défaut a la Load from Execute / Cancel Charge les réglages du fichier ALL d'une
Function Level / Audio Input Level molette multifonction. Media(B) carte mémoire insérée dans le logement
IRIS : de carte CFexpress Type A/SD (B).
Ajuste le diaphragme. Execute : fonction Execute.
1SO/Gain/El : Load from Execute / Cancel Charge un fichier ALL téléchargé depuis

Ajuste le gain ou EIl.
Auto Exposure Level :

Cloud(Private)

le service Cloud C3 Portal (privé).
Execute : fonction Execute.

Ajuste le niveau d'exposition

Charge un fichier ALL depuis le service
Cloud C3 Portal (partagé).
Execute : fonction Execute.

Enregistre les réglages du fichier ALL
d’une carte mémoire insérée dans le
logement de carte CFexpress Type A/SD
(B).

Execute : fonction Execute.

Enregistre les réglages du fichier ALL sur
le service Cloud C3 Portal (privé).
Execute : fonction Execute.

Enregistre les réglages du fichier ALL sur
le service Cloud C3 Portal (partagé).
Execute : fonction Execute.

Attribue un nom au fichier.

Définit le chargement ou non des
informations des réglages du menu
Network lorsque Load from Media(B),
Load from Cloud(Private) ou Load from
Cloud(Share) est exécuté.

. Load from Execute / Cancel
automatique. Cloud(Share)
Audio Input Level :
Régle le niveau d’enregistrement
audio. Save to Execute / Cancel
Media(B)
Project >User File
Définit les réglages relatifs aux opérations sur les fichiers utilisateur.
Elément Réglage de sous-éléments Description
Load from Execute / Cancel Charge les réglages du fichier utilisateur Saveto Execute / Cancel
Media(B) d’une carte mémoire insérée dans le Cloud(Private)
logement de carte CFexpress Type A/SD
(B). Save to Execute / Cancel
Execute : fonction Execute. Cloud(Share)
Save to Execute / Cancel Enregistre les réglages du fichier
Media(B) utilisateur d’une carte mémoire insérée File ID
dans le logement de carte CFexpress Load Network On / Off
Type A/SD (B). Data
Execute : fonction Execute.
File ID Affiche un écran pour I'affichage/I'édition
de I'identifiant de fichier des fichiers
utilisateur.
Load On / Off Définit le chargement ou non des
Customize informations personnalisées du menu
Data User lorsque Load from Media(B) est

exécuté.

Load White On / Off
Data

Définit le chargement ou non des
informations de balance des blancs
lorsque Load from Media(B) est exécuté.
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6. Affichage et réglages de menu

Menu Paint/Look

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Paint/Look >Base Look
Définit les réglages liés a I'apparence de base.

Paint/Look >Scene File

Elément Réglage de sous-éléments

Description

Définit les réglages liés aux fichiers de scéne. Import from  Execute / Cancel Importe un fichier d'apparence de base

Media(B) d’une carte mémoire insérée dans le
[Remarque] logement de carte CFexpress Type A/SD
Activé en mode de prise de vue Custom uniquement. (B).

Elément Réglage de sous-éléments Description Execute : fonction Execute.

Recall Charge un fichier de scéne stocké dans la Import from  Execute / Cancel Importe un fichier d'apparence de base
mémoire interne et applique les réglages Cloud(Private) téléchargé depuis le service Cloud C3
en tant que réglages de qualité d'image Portal (privé).
actuels. Execute : fonction Execute.

Store Enregistre I'état de qualité d’image actuel Import from  Execute / Cancel Importe un fichier d'apparence de base
sous forme de fichier de scéne dans la Cloud(Share) téléchargé depuis le service Cloud C3
mémoire interne. Portal (partagé).

Delete Supprime un fichier de scéne stocké dans - Ex'ec.uAte :fonction Execul]e.

Ja mémoire interne. Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3  Définit la gamme d’entrée de I'apparence
N P Ny . o de base sélectionnée.
Preset Recall Lorsque Shooting Mode est réglé sur Applique les réglages de qualité d'image — -
Custom et Target Display est réglé sur prédéfinis (non réinscriptibles) en tant Output BT.709 / HLG Deﬂ’nlt la gamme de couleurs de sortie
SDR(BT.709) : que réglages de qualité d'image actuels. de I'apparence de base sélectionnée.
S-Cinetone / Standard / Still / ITU709 AE Level OEV /1/3EV / 2/3EV /1EV / 4/3EV / Définit la valeur de référence d’exposition
Lorsque Shooting Mode est réglé sur Offset 5/3EV / 2EV de I'apparence de base sélectionnée.

Custom et Target Display est réglé
HDR(HLG) :
HLG Live / HLG Natural

Paint/Look >Base Look
Définit les réglages liés a I'apparence de base.

Paint/Look >Reset Paint Settings

Réinitialise les réglages du menu Paint/Look, a I'exclusion de I'apparence de base.

[Remarque]
Activé en mode de prise de vue Custom uniquement.

Elément Réglage de sous-éléments

Description

Elément Réglage de sous-éléments

Description

Select Lorsque Shooting Mode est réglé sur
Custom et Target Display est réglé sur

SDR(BT.709) :

S-Cinetone / Standard / Still / ITU709 /

User1 a User16
Lorsque Shooting Mode est réglé sur
Custom et Target Display est réglé
HDR(HLG) :
HLG Live / HLG Natural / User1 a
User16
Dans les modes de prises de vue Log :
5709 / 709(800) / S-Log3 / User1 &
User16

Permet de sélectionner une apparence
de base.

Reset without Execute / Cancel
Base Look

Réinitialise les réglages du menu Paint/
Look, a I'exclusion de I'apparence de
base.

Execute : fonction Execute.

Paint/Look >Black
Définit les réglages des noirs.

[Remarque]
Activé en mode de prise de vue Custom uniquement.

Elément Réglage de sous-éléments

Description

Master Black  -99.0 a +99.0 (x0.0)

Régle le niveau de noir maitre.

R Black -99.0 4 +99.0 (£0.0)

Régle le niveau de noir R.

Delete

Supprime l'apparence de base
sélectionnée.

B Black -99.0 4 +99.0 (£0.0)

Régle le niveau de noir B.

Delete All

Supprime toutes les apparences de base.
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Paint/Look >Knee Paint/Look >Detail
Définit les réglages de correction de courbe. Définit les réglages d'ajustement des détails.
[Remarque] [Remarque]
Activé en mode de prise de vue Custom uniquement. Activé en mode de prise de vue Custom uniquement.
Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Setting Lorsque Target Display est réglé sur Active/désactive la fonction de correction High Light 0a4 Régle le niveau des détails des zones de
SDR(BT.709) : de courbe. Detail forte luminance pour le réglage manuel
On/ Off / --- des détails.
- . s [Conseil]
h‘g;?:fg;arget Display est réglé sur Activé uniquement lorsque Base Look >Select Paint/Look >Matrix
: est réglé sur Standard, ITU709, HLG Live ou HLG e e q .
On / Off / -—- Natural. Définit les réglages de correction de matrice.
Auto Knee Lorsque Target Display est réglé sur Active/désactive la fonction de courbe [Rem'arque]
SDR(BT.709) : automatique. Activé en mode de prise de vue Custom uniquement.
on/ Off / --- [Conseil] Elément Réglage de sous-éléments Description
i |l
Lorsque Target Display est réglé sur Activé uniquement lorsque la fonction de User Matrix ~ On / Off Active ou désactive la fonction de
HDR(HLG) : correction de courbe est réglée sur On et que correction de matrice utilisateur.
On/Off / --- ﬁf:;eogo"k >Select est réglé sur Standard ou User Matrix =99 a +99 (+0) Ajuste la saturation de couleur de I'image
- Level entiere.
" o - S o | -
Point 75% &109% (90%) Regle le point de courbe. User Matrix =99 a +99 (x0) Ajuste la nuance de couleur (phase) de
Slope -99 a +99 (x0) Régle la pente de courbe. Phase I'image entiére.
Paint/Look >Detail User Matrix ~ -99 a +99 (x0) Regle une matrice utilisateur R-V définie
Définit les réglages d'ajustement des détails. R-G par I'utilisateur.
User Matrix ~ -99 & +99 (x0) Régle une matrice utilisateur R-B définie
[Remarque] R-B I'utilisat
Activé en mode de prise de vue Custom uniquement. a - - pg?r utifisa eur.v — —
Elément Réglage de sous-éléments Description User Matrix -99 a +99 (x0) RegI’e uﬁe matrice utilisateur V-R définie
- : - - - — G-R par l'utilisateur.
Setting On / Off Active/désactive la fonction de détails. User Matrix ~ -99 a +99 (+0) Régle une matrice utilisateur V-B définie
Level -7 4+7 (x0) Régle le niveau de détail. G-B par I'utilisateur.
Manual On / Off / --- Active/désactive la fonction de réglage User Matrix -99 4 +99 (x0) Régle une matrice utilisateur B-R définie
Setting manuel des détails. B-R par I'utilisateur.
V/HBalance -2 a+2(£0) Regle I'équilibre entre les détails User Matrix ~ -99 a +99 (£0) Régle une matrice utilisateur B-V définie
verticaux (V) et horizontaux (H) pour le B-G par l'utilisateur.
réglage manuel des détails. Paint/Look sMulti Matri
>|
B/W Balance Typel/ Type2 / Type3 / Type4 / Type5 Définit I'équilibre entre les détails de noir an . .09 u ! Matrix . . .
X . Définit les réglages de correction de matrice multiple.
(B) pour les zones de faible luminance et
les détails de blanc (W) pour les zones de [Remarque]
forte luminance pour le réglage manuel Activé en mode de prise de vue Custom uniquement.
des détails. Elément Réglage de sous-éléments Description
Limit 0a7 Reégle le niveau de limite de détails pour Setting On / Off Active/désactive la fonction de correction
le réglage manuel des détails. de matrice multiple.
Crispening 047 Regle le niveau de netteté pour le Reset Execute / Cancel Réinitialise la teinte et la saturation de
réglage manuel des détails. chaque couleur d’axe aux valeurs par

défaut.
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6. Affichage et réglages de menu : Menu Paint/Look

Paint/Look >Multi Matrix

Définit les réglages de correction de matrice multiple.

[Remarque]

Activé en mode de prise de vue Custom uniquement.

Elément Réglage de sous-éléments Description
Axis B/B+/MG-/MG/MG+/R/R+/YL-/ Sélectionne I'axe.
YL/YL+/G-/G/G+/CY/CY+/B-
Hue -99 4 +99 (x0) Régle la teinte de la couleur utilisée pour
la correction de matrice multiple.
Saturation -99 a +99 (x0) Régle la saturation de la couleur utilisée

pour la correction de matrice multiple.
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Menu TC/Media

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

TC/Media >Users Bit
Définit les réglages liés aux bits d'utilisateur.

TC/Media >Timecode
Définit les réglages de code temporel.

Elément Réglage de sous-éléments Description

Elément Réglage de sous-éléments Description

Mode Preset / Regen / Clock Régle le mode de fonctionnement du

code temporel.

Preset :
Commence a fonctionner a partir
d'une valeur préréglée.

Regen :
Commence a fonctionner a partir du
code temporel de la fin du plan
précédent.

Clock :
Utilise I'horloge interne comme code
temporel.

Mode Fix / Time Régle le mode de bit d'utilisateur.

Fix : utilise une valeur fixe arbitraire dans
les bits d'utilisateur.

Time : utilise I'heure, les minutes et les
secondes actuelles dans les bits

d'utilisateur.

Setting Régle les bits d'utilisateur sur une valeur

arbitraire.

TC/Media >HDMI TC Out
Définit les réglages liés a la sortie du code temporel lors de |'utilisation de HDMI.

Elément Réglage de sous-éléments Description

Run Rec Run / Free Run Rec Run : fonctionne uniquement en
cours d'enregistrement.

Free Run : fonctionne en permanence,
quelle que soit I'opération réalisée
par le caméscope.

Setting On / Off Régle s'il faut envoyer le code temporel
vers des dispositifs a d'autres fins a I'aide

de la sortie HDMI.

Setting Régle le code temporel sur une valeur
arbitraire.

SET : regle la valeur.

Reset Execute / Cancel Réinitialise le code temporel sur
00:00:00:00.

Execute : fonction Execute.

TC Format DF / NDF Régle le format de code temporel.
DF : mode temps réel

NDF : mode temps non réel

TC/Media >TC Display
Définit les réglages d'affichage des données temporelles.

Elément Réglage de sous-éléments Description

Display Select Timecode / Users Bit / Duration Commute I'affichage des données

temporelles.
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6. Affichage et réglages de menu : Menu TC/Media

TC/Media >Clip Name Format

Configure les réglages relatifs a I'attribution d'un nom et a la suppression de plan.

TC/Media >Clip Name Format
Configure les réglages relatifs a I'attribution d'un nom et a la suppression de plan.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description

Auto Naming Cam ID + Reel# / Title Sélectionne le format d'attribution de Title Prefix nnn_(nnn correspond aux 3 derniers Régle la partie de titre (4 & 46 caractéres)
nom de plan. chiffres du numéro de série) du nom de plan.
Cam ID + Reel# : Ouvre un écran de saisie de chaine de

Camera ID + Reel Number + Shot

Number + date + chaine aléatoire
Title :

Chaine arbitraire spécifiée par Title

Prefix + numéro de plan

Camera ID Aaz

Régle I'ID de caméra utilisé lors de la
génération de noms de plan.

[Remarque]

Configurable uniquement lorsque Auto Naming
est réglé sur Cam ID + Reel#.

Reel Number 001 a 999

Définit la partie numérique de Reel
Number utilisée lors de la génération de
noms de plan.

[Remarque]

Configurable uniquement lorsque Auto Naming
est réglé sur Cam ID + Reel#.

Camera C/L/R
Position

Définit la partie du premier caractére du
Shot Number utilisé lors de la génération
de noms de plan.

[Remarque]

Configurable uniquement lorsque Auto Naming
est réglé sur Cam ID + Reel#.

caracteres.

Structure de I'écran de saisie des
chaines de caractéres
Zone de sélection de caractere (3 lignes) :
Sélectionne les caracteres a insérer a
la position du curseur de la zone Title
Prefix.
1#$%()+.-.;=@[ ]*_~0123456789
abcdefghijkimnopgrstuvwxyz
ABCDEFGHIKLMNOPQRSTUVWXYZ
Zone d'opération du curseur (1ligne) :
Space : insére une espace a la
position du curseur.
«+— :déplace le curseur vers la
gauche.
— : déplace le curseur vers la droite.
BS : permet de supprimer le caractére
a gauche de la position du curseur.
Zone Title Prefix (1 ligne) :
Zone de saisie du titre.

Pour définir le titre

1. Sélectionnez le caractére a insérer a
la position du curseur de la zone Title
Prefix depuis la zone de sélection des
caractéres a l'aide du sélecteur
multiple (page 7), puis appuyez
sur la touche de mise en application
du sélecteur multiple. (Le caractére
sélectionné est inséré et le curseur se
déplace vers la droite.)

2. Recommencez I'étape 1 pour définir
le titre. (Utilisez BS, selon les besoins.)

3. Aprés avoir défini le titre,
sélectionnez Done pour fermer
I'écran de saisie de caracteres.
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TC/Media >Clip Name Format

Configure les réglages relatifs a I'attribution d'un nom et a la suppression de plan.

Elément Réglage de sous-éléments

Description

Number Set 0001 a 9999

Régle le suffixe numérique a 4 chiffres du
nom de plan.

TC/Media >Update Media

Met a jour le fichier de gestion sur les cartes mémoire.

Elément Réglage de sous-éléments Description

Media(A) Execute / Cancel Met a jour le fichier de gestion sur la
carte mémoire dans le logement A.
Execute : fonction Execute.

Media(B) Execute / Cancel Met a jour le fichier de gestion sur la

carte mémoire dans le logement B.
Execute : fonction Execute.

TC/Media >Format Media
Initialise les cartes mémoire.

Elément Réglage de sous-éléments Description

Media(A) Full Format / Quick Format / Cancel Formate la carte mémoire insérée dans le
logement A.

Media(B) Full Format / Quick Format / Cancel Formate la carte mémoire insérée dans la

logement B.
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6. Affichage et réglages de menu

Menu Monitoring

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Monitoring >Display On/Off
Définit les réglages de I'élément d'affichage.

Monitoring >Output On/Off Elément Réglage de sous-éléments Description
Définit les réglages de sortie vidéo. Network On / Off Sélectionne les éléments a afficher dans
Elément Réglage de sous-éléments Description Status le viseur.
- PR - File Transf On / Off
SDI On / Off Active/désactive la sortie SDI. Sltaelursans e 2n
HDMI On/ Off Active/désactive la sortie HDMI. Rec/Play On / Off
Monitoring >Output Format Status
Définit les réglages du format de sortie. RAW Output  On / Off
Elément Réglage de sous-éléments Description gg:tursl
SDI Pour plus de détails sur les réglageg, Régle la résolution de sortie SDI et HDMI. Tally on / Off
HDMI consultez « Formats de sortie et limites »
(page 126). Battery On / Off
— Remain
Monlt’o.nng >D§-Squeeze Focus Mode  On / Off
Définit les réglages De-Squeeze.
= = = = Focus On / Off
Elément Réglage de sous-éléments Description Position
Ratio (HDMI/  Off(1.0X) / 1.3x / 2.0x Sélectionne le ratio dé-squeeze pour Focus Area On / Off
VF) I'image de sortie HDMI et I'image Indicator
affichée dans le viseur lors de la prise de Focus Area On / Off
vue avec un objectif anamorphique. Ind.(AF-S) o
Monitoring >Output Display Face/Eye On / Off
Définit les réglages de sortie d'affichage de I'écran. Detection
Elément Réglage de sous-éléments Description Frame
— " - Lens Info On / Off
SDI On / Off Définit si le menu, I'état et I'affichage de
I'écran sont intégrés dans le signal de Imager Scan  On / Off
sortie SDI. Mode
HDMI On / Off Définit si le menu, I'état et I'affichage de Rec Format On / Off
I'écran sont intégrés dans le signal de Frame Rate On / Off
sortie HDMI. Zoom On / Off
Position

UWP RF Level On / Off

SteadyShot On / Off
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6. Affichage et réglages de menu : Menu Monitoring

Monitoring >Display On/Off
Définit les réglages de I'élément d'affichage.

Monitoring >Marker
Définit les réglages d‘affichage de repére.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Base Look/ On / Off Setting On / Off Active/désactive I'affichage de tous les
Rec Look repeéres.
SDI/HDMI On / Off Color White / Yellow / Cyan / Green / Magenta / Sélectionne la couleur du signal de
Rec Control Red / Blue repeére.
Monitoring On/ Off Center 1/2/3/4/0ff Sélectionne le repére central.
Look Marker
Proxy Status  On / Off Safety Zone  On/ Off Active/désactive le repére de la zone de
BaselSO/  On/Off sécurité.
Sensitivity Safety Area  80% / 90% / 92.5% / 95% Sélectionne la taille du repere de la zone
Media Status On / Off de sécurité (en tanT que pourcentage de
- - - la taille totale de I'écran).
Video Signal  Off / Waveform / Vector / Histogram " .
Monitor Aspect Line / Mask / Off Sélectionne le type de marqueur de
- Marker format.
Clip Name On / Off : N - - 0
- Aspect Mask  0a15(12) Régle le niveau du signal vidéo en
White On / Off dehors du marqueur.
Balance. Aspect Safety On / Off Active/désactive le repére de la zone de
Scene File On / Off Zone sécurité.
FOC_US On / Off Aspect Safety 80% / 90% / 92.5% / 95% Sélectionne la taille du repére de la zone
Indicator Area de sécurité de format (en tant que
Auto On / Off pourcentage de la taille totale de I'écran).
Exposure Aspect Select 1:1/4:3/13:9/14:9/15:9/16:9/17:9/ Regle le mode en affichant le marqueur
Mode 1.66:1/1.85:1/2.35:1/ 2.39:1 / Custom de format.
Auto On / Off [Remarque]
Exposure Ceci est réglée sur 2.39:1 (fixe) lorsque De-
Level Squeeze >Ratio (HDMI/VF) (page 98) est
Timecode On / Off réglé sur une valeur autre que Off(1.0x) dans le
ND Fi ; S off menu Monitoring.
- ilter 20 Custom Saisissez une valeur arbitraire Régle le rapport d'aspect sur une valeur
Iris On / Off Aspect Ratio  (01.00:01.00) arbitraire.
ISO/Gain/El  On / Off [Remarque]
Shutter on / Off Ce réglage est activé lorsque Aspect Select est
— réglé sur Custom.
Level Gauge On / Off Ny " ” PSP
- Guide Frame  On / Off Active/désactive l'affichage du cadre
Audio Level  On / Off guide.
Meter 100% Marker  On / Off Active/désactive le repére 100%.
Video Level On / Off - - i
Warning - User Box On / Off Active/désactive I'affichage du marqueur
- de cadre utilisateur.
Clip Number  On / Off N N
- User Box 32479 (240) Régle la largeur du marqueur de cadre
Notice On / Off Width utilisateur (distance du centre aux bords
Message gauche et droit).
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Monitoring >Marker
Définit les réglages d‘affichage de repére.

Monitoring >Zebra
Définit les réglages du motif de zébrures.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
User Box 34269 (135) Régle la hauteur du marqueur de cadre Setting Off / Zebral / Zebra2 Sélectionne le type de motif de zébrures
Height utilisateur (distance du centre aux bords (Off, Zebra 1, Zebra 2).

haut et bas).

ZebralLevel 0% a109% (70%)

Définit le niveau d'affichage de Zebra 1.

User Box H -476 & +476 (0) Définit la position horizontale du centre
Position du marqueur de cadre utilisateur.

User Box V -266 a +266 (0) Définit la position verticale du centre du
Position marqueur de cadre utilisateur.

Zebral 2% a 20% (10%)
Aperture
Level

Définit le niveau d’ouverture de Zebra 1.

Monitoring >VF Setting
Définit les réglages du viseur.

Zebra2 Level 0% a109% (100%)

Définit le niveau d'affichage de Zebra 2.

Elément Réglage de sous-éléments

Description

Brightness 1a15(8)

Permet d'ajuster la luminosité de I'image
du viseur.

Color Mode  Color / B&W

Sélectionne le mode d'affichage du
viseur dans le mode E-E/enregistrement.

Monitoring >Gamma Display Assist

Configure les réglages de I'aide pour I'affichage gamma.

Elément Réglage de sous-éléments

Description

Setting On/ Off

Active/désactive la fonction d'aide
d'affichage gamma en mode de prise de
vue Custom lorsque Target Display est
réglé sur HDR(HLG).

[Remarque]
Ceci est réglé sur OFF (fixe) en modes de prise
de vue Log.

Monitoring >Peaking
Définit les réglages du contour.

Elément Réglage de sous-éléments

Description

Setting On / Off

Active/désactive la fonction de réglage
du contour.

Peaking Level High / Mid / Low

Régle le niveau de signal du contour de
couleur.

Color B&W / Red / Yellow / Blue

Sélectionne la couleur du signal de
réglage du contour de couleur.
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6. Affichage et réglages de menu

Menu Audio

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).
Reportez-vous a « Diagrammes bloc » (page 141).

Audio >Audio Input
Définit les réglages d'entrée audio.

Elément Réglage de sous-éléments Description
Audio >Audio Input CH3 Level Auto / Manual Sélectionne le réglage du niveau d'entrée
Définit les réglages d'entrée audio. Control audio ou le réglage manuel pour le canal
Elément Réglage de sous-éléments Description d'enregistrement 3.
CH1 Input INPUT1 / Internal MIC / Shoe CH1 Commute la source d’entrée pour [STE?;E:;]SeIect et CHA Input Select
Select I'enregistrement sur le canal 1. sont tous deux réglés sur Internal MIC, CH4
CH2 Input INPUT1 /7 INPUT2 / Internal MIC / Shoe CH2 Commute la source d'entrée pour est commuté sur automatic/manual en
Select I'enregistrement sur le canal 2. conjonction avec ce réglage.
CH3 Input Off / INPUT1 / Internal MIC / Shoe CH1 Commute la source d’entrée pour CH4 Level Auto / Manual Sélectionne le réglage du niveau d'entrée
Select I'enregistrement sur le canal 3. Control audio ou le réglage manuel pour le canal
CH4 Input Off / INPUT1 / INPUT2 / Internal MIC / Commute la source d'entrée pour d'enregistrement 4.
Select Shoe CH2 I'enregistrement sur le canal 4. [Remarque]
INPUT1 MIC -80dB / -70dB / -60dB / -50dB / -40dB /  Regle le niveau d'enregistrement de Si CH3 Input Sele/ct‘e,t CHAIInput S\e!\lllelﬂ »
Reference -30dB référence pour l'entrée du microphone Zg:g‘::;gte;:l;egutfnu;tgfnrgiualE’HC
XLR a partir d'INPUT1. conjonction avec le réglage CH3 Level Control.
INPUT2 MIC ~ -80dB / -70dB / -60dB / -50dB / -40dB /  Regle le niveau d’enregistrement de CH3 Input 0499 (49) Régle le niveau d’entrée pour
Reference -30dB référence pour I'entrée du microphone Level o I'enregistrement du canal 3.
- X'jR a Partlr d IN_PUTZ' - CH4 Input 0a99(49) Régle le niveau d'entrée pour
Line Input +4dB / 0dB / -3dB / EBUL Sélectionne le niveau d’entrée de Level I'enregistrement du canal 4.
Reference Ir:]f;ﬁ;ce ?:Janld le rn:nzlr'r\lnk'gnutateur INPUT1/ Audio Input 0499 Regle le niveau d'entrée audio.
estiegie su . Level Peut étre utilisé comme volume principal
Reference -20dB / -18dB / -16dB / -12dB / EBUL Sélectionne le niveau d'enregistrement en fonction des réglages de CH1 Level &
Level du signal de tonalité de référence de CH4 Level.
1kHz. Limiter Mode Off / -6dB / -9dB / -12dB / -15dB / -17dB  Sélectionne la caractéristique du limiteur
CH1 Wind On / Off Active/désactive le filtre de réduction pour les forts signaux d'entrée lors du
Filter anti-vent pour I'enregistrement sur le réglage manuel du niveau d'entrée
canal 1. audio.
C>H2 Wind On/ Off Active/désactivg le filt.re de réduction CH1&2 AGC  Mono / Stereo Régle le mode de réglage automatique
Filter anti-vent pour I'enregistrement sur le Mode de niveau pour le canal d'enregistrement
canal 2. 1 et canal 2. Lorsque vous réglez sur
CH3 Wind On/ Off Active/désactive le filtre de réduction Stereo, AGC est relié entre les canaux.
Filter anti-vent pour 'enregistrement sur le CH38&4 AGC  Mono / Stereo Régle le mode de réglage automatique
canal 3. Mode de niveau pour le canal d'enregistrement
CH4 Wind On / Off Active/désactive le filtre de réduction 3 et canal 4. Lorsque vous réglez sur
Filter anti-vent pour I'enregistrement sur le Stereo, AGC est relié entre les canaux.
canal 4. AGCSpec  -6dB/-9dB/ -12dB / -15dB / -17dB Sélectionne la caractéristique AGC.
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Audio >Audio Input
Définit les réglages d'entrée audio.

Audio >Audio Output
Définit les réglages de sortie audio.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
1kHz Tone on  On / Off Active/désactive le signal de tonalité de Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1/ Sélectionne la sortie du canal audio vers
Color Bars référence de 1 kHz lors de I'affichage des CH2 / CH3/ CH4 la prise casque et le haut-parleur intégré.
barres de couleur. [Remarque]
[Remarque] Si l'audio pour plusieurs canaux est réglée sur
Lorsqu'il est activé, le signal de tonalité la sortie simultanée, le niveau de sortie pour
de référence de 1kHz est réglé pour chaque canal est réduit pour la sortie pour
I'enregistrement sur le canal 3 et canal 4, éviter le détourage.
méme si CH3 Input Select et CH4 Input Select Volume 0450 Ajuste la sortie de niveau audio du
sont désactivés. moniteur vers la prise casque et le
CH1 Level Entrée sans adaptateur XLR Régle la combinaison des ajustements haut-parleur intégré.
/-'\udlo Input Level / Side / Level+Side  de nlve’au d emree audio activés pour le Headphone  Mono / Stereo Sélectionne le mode de sortie de la prise
Entrée ayec adaptateur XLR (page 48) canal d'enregistrement 1. out casque : monaural (Mono) ou stéréo
Audio Input Level / Through [Remarque] (Stereo).
«Side » se rapporteké la molettg AUDIO Alarm Level 0a7(4) Ajuste le volume de l'alarme.
LEVEL (CH1) sur le c6té du caméscope.
Lorsque Level+Side est sélectionné, le niveau HDMI Output CH1/CH2 / CH3/CH4 Régle la combinaison des canaux audio
d'enregistrement audio est déterminé par la CH sur la sortie HDMI.
combinaison des réglages Audio Input Level et
dial (page 141).
CH2 Level Entrée sans adaptateur XLR Régle la combinaison des ajustements
Audio Input Level / Side / Level+Side  de niveau d’entrée audio activés pour le
Entrée avec adaptateur XLR (page 48) canal d’enregistrement 2.
Audio Input Level / Through [Remarque]
« Side » se rapporte a la molette AUDIO
LEVEL (CH2) sur le c6té du caméscope.
Lorsque Level+Side est sélectionné, le niveau
d'enregistrement audio est déterminé par la
combinaison des réglages Audio Input Level et
dial (page 141).
CH3 Level Entrée sans adaptateur XLR Régle la combinaison des ajustements
Audio Input Level / CH3 Input Level / de niveau d'entrée audio activés pour le
Level+CH3 Input Level canal d'enregistrement 3.
Entrée avec adaptateur XLR (page 48)
Audio Input Level / Through
CH4 Level Entrée sans adaptateur XLR Régle la combinaison des ajustements

Audio Input Level / CH4 Input Level /
Level+CH4 Input Level

Entrée avec adaptateur XLR (page 48)
Audio Input Level / Through

de niveau d'entrée audio activés pour le
canal d'enregistrement 4.




103

6. Affichage et réglages de menu

Menu Thumbnail

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Thumbnail

Elément Réglage de sous-éléments Description

Display Clip Affiche I'écran de propriétés de plans.
Properties

Thumbnail >Transfer Clip (Proxy)
Transfére des plans proxy.

[Remarque]

Transfer Clip (Proxy) ne peut pas étre configuré s'il ny a pas de mot de passe configuré a I'aide Access

Authentication dans le menu Network.

Thumbnail >Set Clip Flag
Définit les réglages de balise de plan.

Elément Réglage de sous-éléments Description

Select Clip Transfére les plans proxy correspondant
aux plans sélectionnés.

All Clips Transfére les plans proxy correspondant a

tous les plans.

[Remarque]
Jusqu'a 200 plans peuvent étre transférés.

Elément Réglage de sous-éléments Description

Add OK Ajoute une balise OK.

Add NG Ajoute une balise NG.

Add KEEP Ajoute une balise KEEP.
Delete Clip Supprime toutes les balises.
Flag

Thumbnail >Filter Clips
Définit les réglages des plans a afficher.

Thumbnail >Lock/Unlock Clip
Définit les réglages de protection de plan.

Elément Réglage de sous-éléments Description

Select Clip Sélectionne et verrouille/déverrouille un
plan.

Lock All Clips Verrouille tous les plans.

Unlock All Déverrouille tous les plans.

Clips

Thumbnail >Delete Clip
Supprime les plans.

Elément Réglage de sous-éléments Description

oK Affiche uniquement les plans comportant
une balise OK.

NG Affiche uniquement les plans comportant
une balise NG.

KEEP Affiche uniquement les plans comportant
une balise KEEP.

None Affiche uniqguement les plans ne
comportant pas de balise.

All Affiche tous les plans, que des balises

soient présentes ou non.

Thumbnail >Customize View

Elément Réglage de sous-éléments Description Bascule I'affichage de I'écran de miniatures.

Select Clip Supprime le plan sélectionné. Elément Réglage de sous-éléments Description

All Clips Supprime tous les plans. Thumbnail Date Time / Time Code / Duration / Commute I'information affichée sous les
Caption Sequential Number miniatures.

Thumbnail >Transfer Clip
Transfére des plans.

[Remarque]

Transfer Clip ne peut pas étre configuré s'il n'y a pas de mot de passe configuré a l'aide Access Authentication

dans le menu Network.

Elément Réglage de sous-éléments Description
Select Clip Transfert les plans sélectionnés.
All Clips Transfert tous les plans.

[Remarque]
Jusqu'a 200 plans peuvent étre transférés.
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Menu Technical

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Technical >Color Bars
Définit les réglages de barres de couleur.

Technical >HOLD Switch Setting
Définit les réglages du commutateur Hold.

Elément Réglage de sous-éléments Description

Elément Réglage de sous-éléments Description
Setting On / Off Active/désactive les barres de couleur.
Type ARIB /100% / 75% / SMPTE Sélectionne le type de barres de couleur.

Technical >ND Dial
Configure les réglages relatifs aux opérations de la molette ND VARIABLE.

Elément Réglage de sous-éléments Description

CLEAR with On / Off Permet d'autoriser ou d'interdire la
Dial commutation d'état ND (CLEAR <=> On)
en utilisant la molette ND VARIABLE.

Technical >Tally
Configure les réglages du témoin d’enregistrement/de signalisation.

Handle HOLD Normal / Rec Button Only
Switch

Définit si la cible de maintien du
commutateur HOLD de la poignée est
uniquement la touche d'enregistrement
START/STOP de la poignée.
Normal :
Toutes les commandes d'opération
sur la poignée sont des cibles de
I'opération de maintien.
Cependant, la touche
d’enregistrement START/STOP de la
poignée suit le réglage « with Rec
Button ».
Rec Button Only :
Seule la touche d'enregistrement
START/STOP de la poignée est la
cible de I'opération de maintien.

Elément Réglage de sous-éléments Description

Front On / Off Active/désactive le témoin
d’enregistrement/de signalisation (avant).

Rear On / Off Active/désactive le témoin

d’enregistrement/de signalisation (arriére).

Technical >Touch Operation
Définit les réglages relatifs aux opérations tactiles.

Elément Réglage de sous-éléments Description

Technical >HOLD Switch Setting
Définit les réglages du commutateur Hold.

Setting On / Off Active/désactive les opérations tactiles.

Elément

Technical >Rec Review
Définit les réglages du passage en revue de I'enregistrement.

Elément Réglage de sous-éléments Description

Réglage de sous-éléments Description
with Rec On/ Off Regle s'il faut verrouiller le
Button fonctionnement de la touche
d’enregistrement START/STOP.
with Hand On / Off Régle s'il faut verrouiller le
Grip Remote fonctionnement de la télécommande de

grip.

Setting 3s/10s/Clip Sélectionne le temps pour la lecture de
plans venant d'étre enregistrés pour le

passage en revue de I'enregistrement.

Technical >Zoom
Définit les réglages de zoom.

Elément

Réglage de sous-éléments Description
Zoom Type Optical Zoom Only / On(Clear Image Définit le type de zoom.

Zoom) Optical Zoom Only :
Le zoom optique est réglé a l'aide de
I'objectif.

On(Clear Image Zoom) :
Zoom électronique avec aucune ou
peu de détérioration de la qualité de
I'image.
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Technical >Handle Zoom
Définit les réglages de zoom a poignée.

Technical >Menu Page On/Off

Régle les réglages relatifs a I'affichage d'écrans d'état.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Setting Off / Low / High / Variable Régle la vitesse du zoom a poignée. Monitoring On / Off Active/désactive I'affichage de I'écran
High 1a8(8) Régle la vitesse de zoom du levier de d'état Monitoring.
zoom de la poignée lorsque la vitesse de Assignable On / Off Active/désactive I'affichage de I'écran
zoom de la poignée High est Button d'état Assignable Button.
sélectionnée. Battery On / Off Active/désactive I'affichage de I'écran
Low 148(3) Régle la vitesse de zoom du levier de d'état Battery.
zoom de la poignée lorsque la vitesse de Media On / Off Active/désactive I'affichage de I'écran
zoom de la poignée Low est d'état Media.
sélectionnée. Network On / Off Active/désactive I'affichage de I'écran

[Remarque]
Une vitesse de zoom réglée sur une faible
valeur peut provoquer un zoom irrégulier.

d'état Network.

Technical >Menu Settings
Définit les réglages liés au menu.

File Transfer ~ On / Off

Active/désactive I'affichage de I'écran
d'état File Transfer.

Technical >Fan Control

Définit les réglages de mode de commande du ventilateur.

Elément Réglage de sous-éléments

Description

Elément Réglage de sous-éléments Description

User Menu On / Off Configure s'il faut afficher le menu User

Only uniquement (On) ou afficher la liste des
menus (Off) lorsque le caméscope
affiche le menu.

User Menu On / Off Régle le verrouillage ou non de

with Lock I'affichage du menu, affichant le menu

User uniquement.

[Remarque]
En cas d'affichage normal du menu, cet
élément ne s'affiche pas. Pour plus de détails

Setting Auto / Minimum / Off in Rec

Régle le mode de commande du
ventilateur du caméscope.

[Remarque]

Méme lorsque Off in Rec est sélectionné, le
ventilateur fonctionnera si la température
interne du caméscope dépasse une certaine
valeur.

Technical >Lens
Définit les réglages liés aux objectifs.

sur I'affichage du menu, consultez page 74. Elément Réglage de sous-éléments Description
Technical >Menu Page On/Off ZoomRing  Left(W)/Right(T) / Right(W)/Left(T) Régle la direction du fonctionnement de
Régle les réglages relatifs a I'affichage d'écrans d'état. Direction la bague de zoom.
Elément Réglage de sous-éléments Description [Remarque] o
Activé uniquement lors de I'utilisation d'un
Main On / Off Active/désactive I'affichage de I'écran objectif a monture E prenant en charge le
d'état Main. changement de direction de la bague de zoom.
Camera On / Off Active/désactive |'affichage de I'écran Shading Auto / Off Définit la compensation automatique
d'état Camera. Compensation d’'ombrage.
Audio On / Off Active/désactive I'affichage de I'écran Chroma Auto / Off Définit la compensation automatique
d'état Audio. Aberration d'aberrations chromatiques.
Project On / Off Active/désactive I'affichage de I'écran Comp.
d'état Project. Distortion Auto / Off Définit la compensation automatique de

Comp.

distorsion.
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Technical >Lens
Définit les réglages liés aux objectifs.

Technical >Camera Battery Alarm
Définit les réglages d'alarme de basse tension de batterie.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description

Breathing Auto / Off Définit la compensation de la respiration Low Battery 5% /10% /15% / ... / 45% / 50% Régle le niveau de batterie devant rester

Compensation de l'objectif. pour déclencher I'affichage d'une alarme

N n o de basse tension de batterie (par

Distance Meter / Feet Configure les unités d'affichage pour les incréments de 5%).

Display |nf0rmat|ons dobjectif et la position de Battery 3%a7% Régle le niveau de batterie devant rester
mise au point. Empty pour déclencher I'affichage d'une alarme

Zoom Focal Length / Number / Bar Définit le format d'affichage de position de batterie vide.

Position de zoom. Technical >Camera DC IN Alarm

Display

Technical >Video Light Set

Reégle la méthode d'éclairage de la lampe vidéo. Disponible uniquement lors de I'utilisation du

HVL-LBPC (optionnel).

Définit les réglages d'alarme de tension en entrée.

Elément Réglage de sous-éléments

Description

Video Light Power Link / Rec Link / Rec Link + Stby

Set

Regle la méthode de contrdle d'éclairage
pour la lumiére vidéo fixée a la griffe
d'interface multiple.
Power Link :

Allume/éteint la lampe vidéo quand

le caméscope est en marche/a l'arrét.

Rec Link :
Allume/éteint la lampe vidéo quand
le caméscope commence/arréte
I'enregistrement.

Rec Link + Stby :
Allume/met en veille la lampe vidéo
quand le caméscope commence/
arréte I'enregistrement.

Elément Réglage de sous-éléments Description

DC Low 16.0V a19.0V (16.5V) Régle la tension nécessaire pour

Voltagel déclencher I'affichage d'une alarme de
basse tension en entrée DC IN.

DC Low 15.5V a18.5v Régle la tension nécessaire pour

Voltage2 déclencher I'affichage d’une alarme de

tension insuffisante en entrée DCIN.

Technical >APR
Exécute I'APR.

Elément Réglage de sous-éléments

Description

APR Execute / Cancel

Exécute I'APR (restauration automatique
des pixels) pour I'ajustement
automatique du capteur d'images.
Execute : fonction Execute.

[Remarque]

Fixez toujours le capuchon de I'objectif avant
d'exécuter I'APR.
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Menu Network

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Network >Wireless LAN

Définit les réglages liés aux connexions LAN sans fil.

Network >Setup for Mobile App
Exécute |'outil d'aide pour la configuration réseau.

Elément Réglage de sous-éléments

Description

Setup

Démarre I'outil d'aide pour la
configuration réseau.

Network >Access Authentication
Définit les réglages liés a I'authentification d'acces.

Elément Réglage de sous-éléments Description

NFC Execute / Cancel Etablit une connexion a l'aide d'un NFC
(Near Field Communication).
Execute : fonction Execute.

MAC Address Affiche I'adresse MAC de I'interface LAN

sans fil du caméscope.

Network >AP Mode Settings

Définit les réglages liés aux connexions du mode de point d'acces.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description

User Name Regle le nom dutilisateur pour Channel Auto(5GHz) / Auto / CH1/ CH2 / Définit le canal LAN sans fil.
lauthentification d'accés. CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / Auto(5GHz) est uniquement disponible

Input Régle le mot de passe pour CH10 / CH11 avec le modéle ILME-FX6V/VK.

Password I'authentification d'acces. Camera SSID Affiche le SSID et le mot de passe du
[Remarque] & Password caméscope.
?;g;‘;;‘:z;"fe‘leé'ff’n?ré“;’:&“d? . Regenerate  Execute / Cancel Crée un nouveau mot de passe.
une chaine de caractl‘e:e: sufﬂsamnﬁem Ionvgue, Password Execute : fonction Execute.
difficile & deviner par les autres, et de le stocker IP Address Affiche I'adresse IP du caméscope en
en toute sécurité. mode de point d'acces.

Generate Execute / Cancel Génére automatiquement un mot de Subnet Mask Affiche le masque de sous-réseau du

Password passe pour l'authentification d'accés. caméscope en mode de point d'acces.
Execute : fonction Execute.

Show Affiche les informations pour

Settings I'authentification d'accés.

Affiche le nom d'utilisateur, le mot de
passe, I'empreinte digitale, le numéro de
série et le nom du modele sous forme de
texte et de code QR.

[Remarque]

Veillez & ce que le mot de passe ne puisse pas
étre visualisé et que I'image du code QR ne
puisse pas étre copiée par d'autres personnes.

Network >Wireless LAN

Définit les réglages liés aux connexions LAN sans fil.

Elément Réglage de sous-éléments Description

Setting Access Point Mode / Station Mode / Off Sélectionne le mode d'utilisation de la
connexion au réseau local sans fil.

WPS Execute / Cancel Etablit une connexion & I'aide d’un WPS

(Wi-Fi Protected Setup).
Execute : fonction Execute.
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Network >ST Mode Settings

Définit les réglages liés aux connexions du mode de station.

Network >ST Mode Settings

Définit les réglages liés aux connexions du mode de station.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Camera Enable / Disable Régle si la télécommande doit étre Scan Détecte les réseaux LAN sans fil (points
Remote activée depuis un dispositif connecté au Networks d'accés) et affiche une liste.
Control caméscope par LAN sans fil en mode de Sélectionnez une destination depuis la
station. liste pour la connexion.
Connected Affiche le réseau LAN sans fil connecté SSID Affiche le SSID du point d'acces pour la
Network (point d'accés). connexion.
SSID Affiche le SSID du point d'accés pour la Security Affiche le type de sécurité du point
connexion. d'accés pour la connexion.
Security Affiche le type de sécurité du point Password Saisissez le mot de passe du point
d'accés pour la connexion. d'accés pour la connexion.
Password Affiche le mot de passe du point d'acces DHCP Active/désactive DHCP.
pour la connexion. On / Off
Lorsque Security est réglé sur WEP ou IP Address Saisissez 'adresse IP du caméscope
WPA : ****f** o lorsque DHCP est réglé sur Off.
Lmq{’e Security est réglé sur None : Subnet Mask Saisissez le masque de sous-réseau du
(vide) caméscope lorsque DHCP est réglé sur
DHCP Affiche I'état d'activation/désactivation Off.
du DHCP. Gateway Saisissez la passerelle par défaut du
IP Address Affiche I'adresse IP du caméscope caméscope lorsque DHCP est réglé sur
lorsque DHCP est réglé sur Off. Off.
Subnet Mask Affiche le masque de sous-réseau du DNS Auto Active/désactive la fonction d'acquisition
caméscope lorsque DHCP est réglé sur On / Off automatique de DNS.

Off.

Gateway Affiche la passerelle par défaut du
caméscope lorsque DHCP est réglé sur
Off.

DNS Auto Affiche I'état d'activation/désactivation

d’acquisition du DNS.

Primary DNS Server

Affiche le serveur DNS principal du
caméscope lorsque DNS Auto est réglé
sur Off.

Primary DNS Server

Saisissez le serveur DNS principal du
caméscope lorsque DNS Auto est réglé
sur Off.

Secondary DNS Server

Saisissez le serveur DNS secondaire du
caméscope lorsque DNS Auto est réglé
sur Off.

Secondary DNS Server

Affiche le serveur DNS secondaire du
caméscope lorsque DNS Auto est réglé
sur Off.
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Network >ST Mode Settings

Définit les réglages liés aux connexions du mode de station.

Network >Wired LAN

Définit les réglages liés aux connexions LAN filaires.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description
Manual Enregistre les réglages pour la connexion Setting On / Off Active/désactive la fonction du LAN
Register manuelle a un point d'acces. filaire.
SSID Saisissez le SSID du point d'acces pour la Camera Enable / Disable Régle si la télécommande doit étre
connexion. Remote activée depuis un dispositif connecté au
Security Configurez le type de sécurité du point Control caméscope par LAN filaire.
None / WEP / WPA d'accés pour la connexion. Sélectionnez Detail Configure les propriétés de la connexion
WPA si le type de sécurité du point Settings par LAN filaire.
d'accés de destination est WPA ou WPA2. DHCP Active/désactive DHCP.
Password Saisissez le mot de passe du point On / Off
d'accés pour la connexion. IP Address Saisissez I'adresse IP du caméscope
DHCP Active/désactive DHCP. lorsque DHCP est réglé sur Off.
On / Off Subnet Mask Saisissez le masque de sous-réseau du
IP Address Saisissez I'adresse IP du caméscope caméscope lorsque DHCP est réglé sur

lorsque DHCP est réglé sur Off.

Subnet Mask

Saisissez le masque de sous-réseau du
caméscope lorsque DHCP est réglé sur
Off.

Gateway Saisissez la passerelle par défaut du
caméscope lorsque DHCP est réglé sur
Off.
DNS Auto Active/désactive la fonction d’acquisition
On / Off automatique de DNS.

Primary DNS Server

Saisissez le serveur DNS principal lorsque
DNS Auto est réglé sur Off.

Off.

Gateway Saisissez la passerelle par défaut du
caméscope lorsque DHCP est réglé sur
Off.
DNS Auto Active/désactive la fonction d'acquisition
On / Off automatique de DNS.

Primary DNS Server

Saisissez le serveur DNS principal lorsque
DNS Auto est réglé sur Off.

Secondary DNS Server

Saisissez le serveur DNS secondaire
lorsque DNS Auto est réglé sur Off.

Secondary DNS Server

Saisissez le serveur DNS secondaire
lorsque DNS Auto est réglé sur Off.

Network >Modem

Définit les réglages liés au raccordement modem USB.

Elément Réglage de sous-éléments Description

Setting On / Off Active/désactive la connexion au
smartphone.

Camera Enable / Disable Définit la permission pour la

Remote télécommande via le raccordement

Control modem USB en utilisant une application

de smartphone, telle que CBM (Content
Browser Mobile) ou Creators' App for
enterprise.

Device Name

Affiche le nom de dispositif du
smartphone.

IP Address

Affiche I'adresse IP du smartphone.

Subnet Mask

Affiche le masque de sous-réseau du
smartphone.
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Network >File Transfer

Définit les réglages liés aux transferts de fichiers.

Network >File Transfer

Définit les réglages liés aux transferts de fichiers.

Elément Réglage de sous-éléments Description Elément Réglage de sous-éléments Description

Auto Upload  On / Off Active/désactive le téléchargement Server Display Name Régle le nom d'affichage indiqué dans le
automatique des fichiers originaux. Settings1 menu de configuration de destination de
[Remarque] transfert.
Lorsque Simul Rec >Setting (page 87) dans Service Permet d'afficher le type de serveur.
le menu Project est réglé sur On, les plans FTP
enregistrés sur le support dans la fente B ne Host Name Régle le nom d’héte du serveur de

sont pas téléchargés automatiquement.

Auto Upload  On/ Off / Chunk
(Proxy)

On:
Active le téléchargement
automatique des fichiers proxy.
Off :
Désactive le téléchargement
automatique des fichiers proxy.
Chunk :
Télécharge un fichier proxy enregistré
par fragments automatiquement.

[Remarque]

Lorsque Simul Rec >Setting (page 87) dans

le menu Project est réglé sur On, les plans
enregistrés sur le support dans la fente B

ne sont pas téléchargés automatiquement.
Chunk est également grisé et ne peut pas étre
sélectionné.

Default
Upload
Server

Sélectionne le serveur de téléchargement
pour les fichiers. Le serveur sélectionné
ici devient la destination de
téléchargement automatique pour les
fichiers originaux et proxy ainsi que la
destination de téléchargement pour les
fichiers a partir de I'écran des miniatures.
Affiche le nom d‘affichage configuré
dans Server Settings 1a 3.

Clear Execute / Cancel
Completed
Jobs

Supprime de la liste les taches de
transfert terminées.
Execute : fonction Execute.

destination de transfert.

Port (1 4 65535 (21))

Régle le numéro de port du serveur de
destination de transfert.

User Name Régle le nom d'utilisateur pour
l'authentification de la connexion au
serveur de destination de transfert.

Password Régle le mot de passe d'authentification

de la connexion au serveur de
destination de transfert.

Passive Mode
On / Off

Active/désactive le mode PASV.

Destination Directory

Saisissez le nom du répertoire de
destination de transfert.

Using Secure Protocol
On / Off

Régle I'utilisation (On) ou non (Off) d'un
transfert FTP sécurisé (Mode FTPS
Explicit : FTPES).

Root Certificate
Load / Clear / None

Charge un certificat racine pour un
transfert FTP sécurisé et supprime les
réglages.

Root Certificate Status
Loaded / No Certificate

Affiche I'état de chargement du certificat
racine pour un transfert FTP sécurisé.

Reset
Execute / Cancel

Réinitialise les réglages de Server
Settings aux réglages par défaut.
Execute : fonction Execute.

Clear All Jobs  Execute / Cancel

Supprime de la liste toutes les taches de
transfert.
Execute : fonction Execute.

Server Identique a Server Settings1.
Settings2
Server Identique a Server Settings1.
Settings3

View Job List

Affiche la liste des taches de transfert.

Network >Network Reset
Réinitialise les réglages de réseau.

Elément

Réglage de sous-éléments

Description

Reset

Execute / Cancel

Réinitialise les réglages de réseau.
Execute : fonction Execute.
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Menu Maintenance

Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Maintenance >All Reset

Réinitialise les réglages aux valeurs par défaut.

Maintenance >Language
Régle la langue d'affichage.

Elément Réglage de sous-éléments

Description

Elément Réglage de sous-éléments

Description

Select

Régle la langue d'affichage.
SET : regle la langue.

Reset without Execute / Cancel
Network

Réinitialise les réglages du menu, a
I'exception des réglages du menu
Network, a I'état d'usine par défaut.

Maintenance >Clock Set
Définit les réglages de I'horloge interne.

Maintenance >Hours Meter

Affiche la durée de fonctionnement cumulée.

Elément Réglage de sous-éléments

Description

Time Zone UTC -12:00 a UTC +14:00

Régle le décalage horaire par rapport au
temps universel, par incréments de 30
minutes.

Elément Réglage de sous-éléments Description
Hours Affiche les heures d’utilisation cumulées
(System) (ne peut pas étre réinitialisé).

Hours(Reset)

Affiche les heures d'utilisation cumulées
(peut étre réinitialisé).

Date Mode YYMMDD / MMDDYY / DDMMYY

Sélectionne le format d'affichage pour
les dates.

YYMMDD : année, mois, jour
MMDDYY : mois, jour, année
DDMMYY : jour, mois, année

Reset Execute / Cancel

Réinitialise I'affichage de Hours(Reset) a
0.
Execute : fonction Execute.

Maintenance >Version
Affiche les informations de version.

12h/24h 12h / 24h

Sélectionne le format d'affichage de
I'horloge.

12h : mode 12 heures

24h : mode 24 heures

Elément Réglage de sous-éléments Description
Version VXXX Affiche la version du logiciel du
Number caméscope.

Date

Régle la date actuelle.
SET : régle la valeur.

Time

Régle I'heure actuelle.
SET : regle la valeur.

Version Up Execute / Cancel

Met a jour le caméscope.”

Execute : fonction Execute.

* Cette fonction met le logiciel du caméscope
ajour.

Maintenance >All Reset
Réinitialise les réglages aux valeurs par défaut.

Lens Version = Vxx
Number

Affiche le numéro de version du logiciel
d’'un objectif a monture E.

Elément Réglage de sous-éléments

Description

Reset Execute / Cancel

Réinitialise tous les réglages a leurs
valeurs par défaut.
Execute : fonction Execute.

[Remarque]

Un fichier 3D LUT importé a I'aide de Base
Look >Import from Media(B), Import from
Cloud(Private) ou Import from Cloud(Share)
(page 92) dans le menu Paint/Look ne peut
pas étre supprimé. Pour supprimer tous les
fichiers 3D LUT importés, sélectionnez Base
Look >Delete All dans le menu Paint/Look
(page 92).
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Réglages et valeurs par défaut du menu Shooting

Réglages et valeurs par défaut d'1SO/Gain

surlignées en gris.

La plage des réglages et valeurs par défaut ISO/Gain (page 78) varie selon les réglages Mode, Target Display, Base Look >Select, Base Sensitivity et Base 1SO. Les options disponibles sont

Lorsque Mode est réglé sur 1SO

Custom
Target Display

Base Look >Select

SDR(BT.709)

HDR(HLG)

Base Sensitivity

S-Cinetone / Standard / ITU709 / Still

HLG Live / HLG Natural

SDR(BT.709) et HDR(HLG) ordinaires

User1 a User16

1SO 320

Low High

1SO/Gain<L> défaut

Low

High

Low

High

1SO 400

1SO 500

1SO 640

1SO 800

1SO/Gain<M> défaut

150 1000

1SO/Gain<L> défaut

1SO/Gain<L> défaut

150 1250

1SO/Gain<H> défaut

1SO 1600

1SO 2000

1SO/Gain<M> défaut

1SO/Gain<M> défaut

1SO 2500

1SO 3200

1SO 4000

1SO/Gain<H> défaut

1SO/Gain<H> défaut

1SO 5000

1SO 6400

1SO/Gain<L> défaut

1SO 8000

1SO 10000

1SO/Gain<M> défaut

1S0 12800

150 16000

1SO/Gain<L> défaut

1SO/Gain<L> défaut

1SO 20000

1SO 25600

1SO/Gain<H> défaut

1SO 32000

1SO/Gain<M> défaut

1SO 40000

1SO/Gain<M> défaut

1SO 51200

1SO 64000

1SO/Gain<H> défaut

1SO/Gain<H> défaut

1SO 80000

150 102400

150 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Flexible ISO

Base ISO

150 12800

1SO 800

1SO 320

1SO 400

1SO 500

1SO 640

1SO 800

1SO/Gain<L> défaut

1S0 1000

1501250

150 1600

1SO/Gain<M> défaut

1SO 2000

1SO 2500

1SO 3200

1SO/Gain<H> défaut

1SO 4000

1SO 5000

1SO 6400

1SO 8000

1SO 10000

1SO 12800

1SO/Gain<L> défaut

150 16000

1SO 20000

1SO 25600

1S0/Gain<M> défaut

1SO 32000

1SO 40000

1SO 51200

1SO/Gain<H> défaut

1SO 64000

1SO 80000

1SO 102400

1S0 128000

1S0 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Lorsque Mode est réglé sur dB

Plage de réglages

-3dB

0dB 1SO/Gain<L> défaut

2dB

4dB

5dB

6dB 1SO/Gain<M> défaut

7dB

8dB

9dB

10dB

11dB

12dB 1SO/Gain<H> défaut

13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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Réglages et valeurs par défaut de AGC Limit

surlignées en gris.

La plage des réglages et valeurs par défaut AGC Limit (page 81) varie selon les réglages Mode, Target Display, Base Look >Select, Base Sensitivity et Base ISO. Les options disponibles sont

Lorsque Mode est réglé sur 1SO

Custom
Target Display

Base Look >Select

SDR(BT.709)

HDR(HLG)

HDR(HLG)

Base Sensitivity

S-Cinetone / Standard / ITU709 / Still

HLG Live

HLG Natural

SDR(BT.709) et HDR(HLG) ordinaires

Userl a User16

1SO 400

Low High

Low

High

Low

High

Low

High

1SO 500

1SO 640

1SO 800

1SO 1000

150 1250

1SO 1600

1SO 2000

1SO 2500

Défaut

1SO 3200

1SO 4000

1SO 5000

1SO 6400

Défaut

Défaut

Défaut

1SO 8000

1SO 10000

1SO 12800

1SO 16000

1SO 20000

1SO 25600

1SO 32000

Défaut

1SO 40000

1SO 51200

1SO 64000

1SO 80000

1SO 102400

Défaut

Défaut

150 128000

Défaut

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Flexible ISO

Base ISO 150 12800 1SO 800

1SO 400

1SO 500

1SO 640

1SO 800

1S0 1000

1SO 1250

150 1600

1SO 2000

1SO 2500

150 3200

1SO 4000

1SO 5000 Défaut

1SO 6400

1SO 8000

1SO 10000

1S0 12800

150 16000

1SO 20000

1SO 25600

1SO 32000

1SO 40000

1SO 51200

1SO 64000

1SO 80000 Défaut

1SO 102400

1SO 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Lorsque Mode est réglé sur dB

Plage de réglages
3dB

6dB

9dB

12dB

15dB Défaut
18dB

21dB

24dB

27dB

30dB
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Réglages de qualité d'image sauvegardés pour chaque mode de prise de vue

L'état actuel des éléments de configuration liés a la qualité d'image est sauvegardé pour chacun des modes de prise de vue suivants (page 24). Lorsque vous changez de mode de prise de vue,
les réglages correspondants qui sont sauvegardés sont appliqués au mode de prise de vue cible.

® Mode de prise de vue Custom SDR(BT.709)

® Mode de prise de vue Custom HDR(HLG)

* Modes de prise de vue Log (Cine El, Cine El Quick, Flexible ISO)

Les éléments de configuration relatifs a la qualité d'image qui sont sauvegardés pour chaque mode de prise de vue sont indiqués ci-dessous.

Oui: L'élément est enregistré.

Non : L'élément n'est pas enregistré.

Elément de configuration Mode de prise de vue
Custom Flexible ISO Cine El Quick Cine El
SDR(BT.709) [HDR(HLG)
Menu Shooting 1SO/Gain/El 1SO/Gain Oui" Oui Non
Exposure Index Non Non Oui ‘ Oui
Base Sensitivity Oui Non
Base SO Non oui® Non?! [ oui®
White Preset White Oui Oui
Autre que ci-dessus Oui
White Setting Oui
Offset White Oui Non
LUT On/Off Non Oui
Noise Suppression Setting(Custom) Oui Oui Non
Level(Custom) Oui Oui Non
Setting (Cine El/Flex. ISO) Non Oui
Level (Cine EI/Flex. 1SO) Non Oui
Menu Paint/Look Base Look Select Oui Oui Oui
Input? Oui
Output? Oui
AE Level Offset? Oui
Black Oui Oui Non
Knee ‘Auto Knee Oui Non Non
‘Autre que ci-dessus Oui Oui Non
Detail Oui Oui Non
Matrix Oui Oui Non
Multi Matrix Oui Oui Non

1) Les réglages de sensibilité ISO distincts sont sauvegardés pour le mode de prise de vue Custom SDR(BT.709) et HDR(HLG).
2) Les réglages sont sauvegardés pour chaque Base Look, et ne dépendent pas du mode de prise de vue.

3) La sensibilité ISO de base change en lien avec Exposure Index.

4) Valeur de réglage commune aux modes de prise de vue Flexible ISO et Cine El.
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Enregistrement et chargement des données de configuration

Données de configuration

Vous pouvez enregistrer les réglages du menu
complet sur une carte mémoire insérée dans
le logement de carte CFexpress Type A/SD (B).
Vous pouvez également enregistrer un fichier
ALL sur un service Cloud. Cela vous permet de
rappeler rapidement un ensemble de réglages
de menu approprié a la situation actuelle.

Les données de configuration sont
sauvegardées dans les catégories suivantes.

Fichiers utilisateur

Les fichiers utilisateur enregistrent les
éléments et les données de réglage du menu
User personnalisable.

Vous pouvez enregistrer jusqu’a 64 fichiers sur
une carte mémoire.

En chargeant ce fichier dans la mémoire du
caméscope, vous pouvez personnaliser la
configuration du menu User.

Les fichiers ALL (tous les réglages)

Les fichiers ALL sauvegardent les données
de configuration de tous les menus. Vous
pouvez enregistrer jusqu'a 64 fichiers sur une
carte mémoire. Jusqu'a 120 fichiers peuvent
étre enregistrés sur C3 Portal (service Cloud),
comprenant jusqu'a 60 fichiers privés et

60 fichiers partagés.

[Remarque]

Pour plus de détails sur le contenu enregistré dans un
fichier ALL, consultez « Eléments enregistrés dans les
fichiers » (page 133).

Sauvegarde d'un fichier
utilisateur/fichier ALL

Enregistrement sur une carte mémoire

1 Insérez une carte mémoire dans le
logement de carte CFexpress Type A/SD
(page 6).

e Pour les cartes CFexpress, I'étiquette est
orientée vers la gauche.

® Pour les cartes SD, I'étiquette est
orientée vers la droite, avec le coin
biseauté en bas.

2 Pour un fichier utilisateur, sélectionnez
User File >Save to Media(B) (page 91)
>Execute dans le menu Project du menu
complet.

Pour un fichier ALL, sélectionnez All File
>Save to Media(B) (page 91) >Execute
dans le menu Project du menu complet.
Un écran de destination de sauvegarde de
fichiers apparait.

3 Sélectionnez une rangée « No File » dans
I'écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File
ID écrasera le fichier sélectionné.
L'identifiant de fichier attribué lors de la
sauvegarde peut étre modifié a I'aide du
menu. Pour plus de détails sur la
configuration, consultez « Modification de
I'identifiant de fichier » (page 120).

4 Sélectionnez Execute sur I'écran de
confirmation.

Enregistrement d'un fichier ALL sur un
service Cloud

1

4

Connectez-vous a 'appareil depuis
I'application pour smartphone « Creators'
App for enterprise » (page 68).

Sélectionnez All File >Save to
Cloud(Private) ou Save to Cloud(Share)
(page 91) >Execute dans le menu

Project du menu complet.

Un écran de destination de sauvegarde de
fichiers apparait.

Sélectionnez une rangée « No File » dans
I'écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File
ID écrasera le fichier sélectionné.
L'identifiant de fichier attribué lors de la
sauvegarde peut étre modifié a I'aide du
menu. Pour plus de détails sur la
configuration, consultez « Modification de
I'identifiant de fichier » (page 120).

Sélectionnez Execute sur I'écran de
confirmation.

Chargement d'un fichier
utilisateur/fichier ALL

Chargement depuis une carte mémoire

1 Insérez une carte mémoire sur laquelle un
fichier est enregistré dans le logement de
carte CFexpress Type A/SD (page 6).
® Pour les cartes CFexpress, I'étiquette est
orientée vers la gauche.

e Pour les cartes SD, I'étiquette est
orientée vers la droite, avec le coin
biseauté en bas.

2 Pour un fichier utilisateur, sélectionnez
User File >Load from Media(B)
(page 91) >Execute dans le menu
Project du menu complet.
Pour un fichier ALL, sélectionnez All File
>Load from Media(B) (page 91)
>Execute dans le menu Project du menu
complet.
Un écran de liste de fichiers s'affiche.

3 Sélectionnez un fichier a charger.
Un écran de confirmation apparait.

4 Sélectionnez Execute.

[Remarques]

e L'appareil redémarrera automatiquement aprés avoir
chargé les données de configuration.

Lorsque All File >Load Network Data dans le menu
Project du menu complet est réglé sur Off, tous les
réglages du fichier ALL sont chargés a I'exception des
réglages du menu Network.
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Chargement d'un fichier ALL depuis un
service Cloud

1

Connectez-vous a 'appareil depuis
I'application pour smartphone « Creators'
App for enterprise » (page 68).

Sélectionnez All File >Load from
Cloud(Private) ou Load from Cloud(Share)
(page 91) >Execute dans le menu

Project du menu complet.

Un écran de liste de fichiers saffiche.

Sélectionnez un fichier a charger.
Un écran de confirmation apparait.

4 Sélectionnez Execute.

[Remarques]

L'appareil redémarrera automatiquement aprés avoir
chargé les données de configuration.

Lorsque All File >Load Network Data dans le menu
Project du menu complet est réglé sur Off, tous les
réglages du fichier ALL sont chargés a I'exception des
réglages du menu Network.

6. Affichage et réglages de menu : Enregistrement et chargement des données de configuration

Modification de I'identifiant de
fichier

1 Pour un fichier utilisateur, sélectionnez
User File >File ID (page 91) dans le
menu Project du menu complet.

Pour un fichier ALL, sélectionnez All File
>File ID (page 91) dans le menu Project
du menu complet.

Un écran permettant de modifier
I'identifiant de fichier apparait.

2 Sélectionnez un caractere a l'aide du
sélecteur multiple (page 7) ou de la
molette multifonction (page 5), puis
appuyez sur la touche de mise en

application du sélecteur multiple ou sur la

molette multifonction.
3 Répétez I'étape 2 si nécessaire.

4 Lorsque vous avez saisi tous les
caracteres, sélectionnez Done.
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7. Connexion de dispositif externe

Connexion des moniteurs externes et des dispositifs d'enregistrement

Pour afficher les images enregistrées/lues sur
un moniteur externe, sélectionnez le signal
de sortie du caméscope et utilisez un cable
approprié pour le moniteur a raccorder.

Vous pouvez également raccorder des
dispositifs d'enregistrement, tels qu'un
magnétoscope, et enregistrer le signal de
sortie depuis le caméscope.

Vous pouvez afficher les mémes informations
qui sont visibles dans le viseur, telles que

les informations d'état et les menus, sur

un moniteur externe. Réglez Info. Disp.

(page 15) dans I'écran d'état Monitoring

ou Output Display (page 98) dans le menu
Monitoring du menu complet sur On en
fonction du signal a transmettre au moniteur.

[Remarque]
Veillez aux points suivants lors de la connexion d'un
moniteur externe ou d'un dispositif d'enregistrement
a l'appareil. Sinon, des courants importants peuvent
circuler dans les circuits internes de I'appareil et
endommager les composants électroniques.
1. A propos des cables CC
Utilisez des cables CC avec une faible impédance
de ligne GND pour connecter un moniteur externe,
des dispositifs d'enregistrement et tous les autres
dispositifs.
2. Vérification de la différence de potentiel
Avant I'utilisation, assurez-vous qu'il n'y a pas de
différence de potentiel entre tous les dispositifs
connectés et I'appareil.
(1) Déconnectez de I'appareil tous les dispositifs
connectés, tels qu'un moniteur externe et des
dispositifs d’enregistrement.

Vérifiez que le cable coaxial 75 Q, le cable HDMI et

les autres cables ne sont pas connectés.

(2) Connectez les cables CC de tous les dispositifs
connectés et de I'appareil, puis mettez sous
tension chaque dispositif connecté et I'appareil.

(3) Utilisez un testeur ou un autre dispositif pour

confirmer qu'il n'y a pas de différence de potentiel

entre I'appareil et chaque dispositif connecté.
S'ily a une différence de potentiel, il est possible
que lI'impédance de la ligne GND de I'un des cables
CC soit élevée. Remplacez ces cables par des
cables ayant une faible impédance de ligne GND,
si nécessaire, afin d'éliminer toute différence de
potentiel.

3. Connexion et séquence de mise sous tension
Connectez chaque cable et mettez 'appareil sous
tension dans I'ordre suivant.

(1) Mettez hors tension I'appareil, le moniteur
externe, les dispositifs d’enregistrement et tous
les autres dispositifs.

(2) Connectez les cables CC de tous les dispositifs.

(3) Connectez le cable coaxial 75 Q, HDMI et les autres
cables.

(4) Mettez sous tension tous les dispositifs connectés
et ensuite I'appareil.

Pour plus de détails, contactez un technicien Sony.

Connecteur SDI OUT (de type BNC)

Définissez le réglage d'activation/de
désactivation de la sortie, ainsi que le
format de sortie dans le menu Monitoring
(page 98).

Utilisez un cable coaxial de 75 Q disponible
dans le commerce pour le branchement.

Pour commencer I'enregistrement sur le
caméscope et sur le dispositif externe
de maniére simultanée

Lorsque la sortie de signal SDI est activée,
réglez SDI/HDMI Rec Control (page 88)
>Setting dans le menu Project du menu
complet sur SDI/HDMI Remote I/F ou Parallel
Rec pour activer la sortie d'un signal de
déclenchement REC vers le dispositif externe
raccordé au connecteur SDI OUT. Cela
permettra de synchroniser I'enregistrement
sur le dispositif externe avec le caméscope.

[Remarques]

Si un dispositif externe raccordé ne prend pas en
charge le signal de déclenchement REC, le dispositif
ne peut pas étre utilisé.

Seul le signal de déclenchement REC est émis
lorsqu’aucun support n'est inséré.

Connecteur HDMI OUT (connecteur
de type A)

Définissez le réglage On/Off de la sortie,
ainsi que le format de sortie dans le menu
Monitoring (page 98) du menu complet.

Pour commencer I'enregistrement sur le
caméscope et sur le dispositif externe
de maniére simultanée

Lorsque la sortie de signal HDMI est activée,
réglez HDMI TC Out >Setting (page 95)

dans le menu TC/Media du menu complet sur
On, et réglez SDI/HDMI Rec Control >Setting
(page 88) dans le menu Project sur SDI/

HDMI Remote I/F ou Parallel Rec pour activer
la sortie d'un signal de déclenchement

REC vers le dispositif externe raccordé au
connecteur HDMI OUT. Cela permettra de

synchroniser I'enregistrement sur le dispositif
externe avec le caméscope.

[Remarques]

« Siun dispositif externe raccordé ne prend pas en
charge le signal de déclenchement REC, le dispositif
ne peut pas étre utilisé.

Lorsqu'il est réglé sur SDI/HDMI Remote I/F, seul le
signal de déclenchement REC est émis lorsqu’aucun
support d'enregistrement n’est inséré.
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Synchronisation des codes temporels

Vous pouvez synchroniser le code temporel de
I'unité avec d'autres dispositifs.

Verrouillage du code temporel sur
d'autres dispositifs

Réglez I'appareil fournissant le code temporel
sur un mode dans lequel la sortie de code
temporel continue a défiler (comme Free Run
ou Clock).

1 Réglez Timecode (page 95) dans le
menu TC/Media du menu complet de la
maniere suivante.

Mode : Preset
Run : Free Run

2 Appuyez sur la touche personnalisable
(page 49) a laquelle la fonction
DURATION/TC/U-BIT consistant a afficher
le code temporel sur I'écran est attribuée.

3 Vérifiez que le commutateur de sélection
TC IN/OUT (page 4) est positionné sur
IN, puis envoyez un code temporel de
référence pour synchroniser la fréquence
du systéeme du caméscope au connecteur
TCIN/TC OUT.

Le générateur de code temporel du
caméscope acquiert le verrou avec le code
temporel de référence et « EXT-LK » apparait a
I'écran.

Une fois que 10 secondes environ se sont
écoulées apres le verrouillage du code
temporel, I'état de verrouillage externe

est maintenu, méme si la source de

code temporel de référence externe est
déconnectée.

[Remarques]

Lors de I'utilisation d'un verrou externe, le code
temporel acquiert instantanément le verrou avec

le code temporel externe et la valeur de code
temporel externe apparait dans la zone d'affichage
des données. Cependant, ne commencez pas
immédiatement I'enregistrement. Patientez quelques
secondes le temps que le générateur de code
temporel se stabilise avant I'enregistrement.

Sila fréquence du code temporel de référence et

la fréquence d'images du caméscope ne sont pas
identiques, un verrou ne peut pas étre acquis et le
caméscope ne fonctionnera pas correctement. Si cela
se produit, le code temporel n‘acquerra pas de verrou
correctement avec le code temporel externe.

Le code temporel peut changer d'une image par
heure par rapport au code temporel de référence.

Pour déverrouiller le verrou externe

Changez le réglage Timecode dans le menu
TC/Media du menu complet.

La synchronisation externe se déclenche
également en cas de modification de la
fréquence du systéme et lorsque vous
démarrez un enregistrement en mode
d'enregistrement spécial (Slow & Quick Motion
ou Interval Rec).

Synchronisation du code temporel
d’un autre dispositif avec le code
temporel du caméscope

Réglez I'appareil fournissant le code temporel
sur un mode dans lequel la sortie de code
temporel continue a défiler (comme Free Run
ou Clock).

1 Réglez le code temporel du caméscope en
utilisant Timecode (page 95) dans le
menu TC/Media du menu complet.

2 Vérifiez que le commutateur de sélection
TCIN/OUT (page 4) est réglé sur la
position OUT et connectez le connecteur
TC IN/TC OUT au connecteur d’entrée de
code temporel du dispositif que vous
souhaitez synchroniser.
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Gestion/Edition de plans grace a

Connexion a 'aide d'un cable USB

Utilisation d'un lecteur de carte (en
option)

Connectez un lecteur de carte CFexpress Type
Aou un lecteur de carte SD a un ordinateur a
I'aide d'un cable USB, puis insérez une carte
mémoire dans le logement du lecteur de
carte. La carte mémoire est reconnue comme
un lecteur d’extension de I'ordinateur. Sur

les ordinateurs compatibles, vous pouvez
importer des plans a haute vitesse a I'aide du
mode de stockage de masse du caméscope.

Utilisation du mode de stockage de
masse

[Remarque]

Le mode de stockage de masse ne peut pas étre utilisé
lorsque Modem >Setting dans le menu Network du
menu complet est réglé sur On ou lorsque Wired LAN
>Setting dans le menu Network est réglé sur On. Réglez
ces deux parametres sur Off.

Raccordez le caméscope a l'aide d'un cable
USB et insérez une carte mémoire dans le
logement de carte A ou B. La carte mémoire
est reconnue comme un lecteur d'extension
de l'ordinateur.

1 Raccordez le connecteur USB-C
(page 7) ou le connecteur USB/Multi
(page 7) a I'ordinateur a I'aide d'un
cable USB.

2 Placez le commutateur POWER du
caméscope sur ON.

Un message apparait sur I'écran du viseur,
vous demandant si vous souhaitez activer

la connexion USB.

[Remarque]

Le message de confirmation de connexion USB
n'est pas affiché tant qu’un autre message de
confirmation ou de progression est affiché, par
exemple, lors du formatage ou de la restauration
d’une carte mémoire.

Le message de confirmation est affiché lorsque
I'exécution du formatage ou de la restauration est
terminée. Le message de confirmation USB n'est
pas non plus affiché lorsque I'écran des propriétés
du plan est affiché. Le message est affiché lorsque
le traitement se termine ou lorsque vous revenez a
I'écran de miniatures.

3 Tournez la molette multifonction pour
sélectionner Execute.

4 Sous Windows, vérifiez que la carte est
ajoutée en tant que disque amovible dans
la fenétre « Poste de travail ».

Sous Mac, vérifiez que le dossier appelé
« NO NAME » ou « Untitled » (éditable) est
créé sur le bureau.

[Remarques]

o N'effectuez pas les opérations suivantes si I'indicateur
d'accés est allumé en rouge.
- Mise hors tension ou débranchement du cordon

d‘alimentation

- Retrait de la carte mémoire
- Déconnexion du céble USB

o Le fonctionnement n’est pas garanti avec tous les
ordinateurs.

un ordinateur

Utilisation d'un systéme de
montage non linéaire

Dans un systéme de montage non linéaire,
un logiciel de montage (en option) qui prend
en charge les formats enregistrés par le
caméscope est nécessaire.

Utilisez un logiciel d'application dédié pour
enregistrer au préalable les plans que vous
souhaitez éditer sur le disque dur de votre
ordinateur.
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Précautions d’utilisation

Concernant la condensation

Si I'appareil est soudainement déplacé

d’un endroit froid a un endroit chaud, ou

si la température ambiante augmente
brusquement, de I'humidité peut se former
sur la surface externe de I'appareil et/ou a
I'intérieur de I'appareil. Ce phénomeéne est
connu sous le nom de condensation. Si de
la condensation se produit, mettez I'appareil
hors tension et patientez le temps que la
condensation disparaisse avant d'utiliser
I'appareil. L'utilisation de I'appareil avec de la

condensation pourrait endommager I'appareil.

Concernant les écrans LCD

L'écran LCD intégré a cet appareil est fabriqué
avec une technologie de haute précision,

ce qui permet d'obtenir un taux d'au moins
99,99% de pixels qui fonctionnent. Ainsi,

un infime pourcentage de pixels peut étre

« bloqué », c'est-a-dire toujours éteint (noir),
toujours éclairé (rouge, vert ou bleu), ou
clignotant. En outre, aprés une longue période
d'utilisation, en raison des caractéristiques
physiques de I'afficheur a cristaux liquides,
de tels pixels « bloqués » peuvent apparaitre
spontanément. Ces problémes ne sont pas
graves. Notez que ces problémes n’ont aucun
effet sur les données enregistrées.

Phénomenes spécifiques aux capteurs
d'images CMOS de caméra

[Remarque]

Les phénomenes suivants, qui peuvent se produire
sur les images, sont propres aux capteurs d'images. lIs
n'indiquent en aucun cas un dysfonctionnement.

Taches blanches

Bien que les capteurs soient fabriqués a

I'aide de technologies de haute précision,

il peut arriver (dans de rares cas) que des

petites taches blanches apparaissent sur

I'écran, celles-ci sont causées par les rayons

cosmiques, etc.

Ce phénomeéne est inhérent a la technologie

des capteurs d'images et ne signale en aucun

cas un dysfonctionnement.

Les taches blanches sont surtout visibles dans

les cas suivants :

e Lors du fonctionnement a haute
température ambiante

e Lorsque vous avez augmenté le gain (la
sensibilité)

Scintillement

Si I'enregistrement est effectué sous un
éclairage fluorescent, des lampes au sodium,
a vapeur de mercure ou LED, I'écran peut
scintiller ou les couleurs peuvent varier.

Concernant les pieces consommables

o Le ventilateur et |a batterie sont

des consommables qui doivent étre
réguliérement remplacés.

Lorsque vous utilisez I'appareil a
température ambiante, le cycle de
remplacement est d’environ 5 ans. Mais,

ce cycle de remplacement ne représente
qu’une indication et ne garantit pas la durée
de vie de ces consommables. Pour plus de
détails sur le remplacement de ces piéces,
veuillez contacter votre revendeur.

La durée de vie I'adaptateur CA et du
condensateur électrolytique est de

5 ans environ, sous des températures de
fonctionnement normales et pour un usage
normal (8 heures par jour, 25 jours par
mois). Si I'utilisation dépasse la fréquence
d'utilisation normale, la durée de vie peut
étre réduite en conséquence.

e La borne de batterie de cet appareil
(le connecteur pour les packs batterie
et les adaptateurs CA) est une piéce
consommable.
L'appareil risque de ne pas étre alimenté
correctement si les broches de la borne de
batterie sont cintrées ou déformées par
les chocs ou les vibrations, ou si elles sont
touchées par la corrosion en raison d'une
utilisation prolongée en extérieur.
Des inspections périodiques sont
recommandées pour que I'appareil
continue a fonctionner correctement et
pour prolonger la durée de son utilisation.
Contactez un vendeur ou un technicien Sony
pour plus d'informations sur les inspections.

A propos de la batterie rechargeable
intégrée

Le caméscope possede une batterie
rechargeable intégrée afin de stocker la
date, I'heure et d'autres réglages, méme
lorsque le caméscope est éteint. La batterie
rechargeable intégrée sera chargée apres
24 h si I'unité est connectée a une prise
électrique grace a I'adaptateur CA, ou si un
pack batterie complétement chargé est fixé,
que le caméscope soit allumé ou éteint.

La batterie rechargeable sera entierement
déchargée aprés environ 2 mois si I'adaptateur
CA n’est pas branché ou si le caméscope
est utilisé sans que le pack batterie ne soit
fixé. Utilisez votre caméscope aprés avoir
chargé la batterie. Néanmoins, méme si la
batterie rechargeable n'est pas chargée, le
fonctionnement du caméscope n'est pas
affecté tant que vous n‘avez pas besoin
d’enregistrer la date.

Emplacements d'utilisation et de
stockage

Stockez dans un lieu aéré et de niveau.

Evitez d'utiliser ou de stocker I'unité dans les
endroits suivants.

® Les endroits excessivement chauds ou froids
(plage de température de fonctionnement :
0°Ca40°C(32°Fa104°F)

N'oubliez pas qu’en été, dans les climats
chauds, la température a l'intérieur d'un
véhicule aux vitres fermées peut facilement
dépasser 50 °C (122 °F).

Les endroits humides ou poussiéreux. Lieux
ou I'appareil pourrait recevoir la pluie

Lieux soumis a de violentes vibrations

A proximité de puissants champs
magnétiques

A proximité d'émetteurs radio ou de
télévision générant de puissants champs
magnétiques

Sous la lumiére directe du soleil ou a
proximité de chauffages pendant de
longues périodes

Remarque sur les faisceaux laser

Les faisceaux laser peuvent endommager le
capteur d'image CMOS. Si vous filmez une
scene comprenant un faisceau laser, veillez a
ce que celui-ci ne soit pas dirigé directement
vers |'objectif de I'appareil. En particulier, les
faisceaux laser haute puissance provenant de
dispositifs médicaux ou d'autres dispositifs
peuvent causer des dommages dus a la
lumiére réfléchie et a la lumiére diffuse.
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Pour empécher les interférences
électromagnétiques dues aux dispositifs
de communication portables

L'utilisation des téléphones portables et
d‘autres dispositifs de communication a
proximité de la caméra peut provoquer des
dysfonctionnements et des interférences avec
les signaux audio et vidéo. Il est recommandé
de désactiver les dispositifs de communication
portables a proximité de la caméra.

Mesures de sécurité

® SONY NE PEUT ETRE TENUE RESPONSABLE
DE TOUT DOMMAGE, DE QUELQUE NATURE
QUE CE SOIT, RESULTANT D'UNE INCAPACITE
A METTRE EN PLACE DES MESURES DE
SECURITE ADAPTEES POUR LES DISPOSITIFS
DE TRANSMISSION, DE FUITES DE DONNEES
INEVITABLES DUES AUX SPECIFICATIONS

DE TRANSMISSION OU DE TOUT AUTRE
PROBLEME DE SECURITE.

Selon I'environnement d'exploitation, il est
possible que des tiers non autorisés sur le
réseau puissent accéder a l'appareil. Avant
de connecter l'appareil au réseau, vérifiez
que le réseau est bien protégé.

Le contenu des communications peut étre
intercepté a votre insu par des tiers non
autorisés a proximité des signaux. Lors de
communications LAN sans fil, appliquez des
mesures de sécurité adaptées pour protéger
le contenu des communications.

Lorsque vous connectez ce produit a

un réseau, connectez-le via un systéme
fournissant une fonction de protection,

tel qu'un routeur ou un pare-feu. Si vous
Vous connectez sans cette protection, des
problémes de sécurité pourraient survenir.
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Formats de sortie et limites

Les réglages par défaut sont affichés en gras (par exemple, 1920x1080P (Level A)). Réglage de la Réglage de codec  Réglage du format Format de sortie (Output Format
[Remarques] fréquence de (Rec Format d'enregistrement/ dans le menu Monitoring)
e Larésolution du format de sortie est limitée par les réglages Rec Format >Frequency, Codec et Video Format dans systéme >Codec dans le RAW SDI HDMI
le menu Project du menu complet (page 85). (Rec Format menu Project) (Rec Format >RAW
* Larésolution du format de sortie est également limitée par I'association a la fréquence d'images S&Q. En plus du >Frequency dans Output Format/Video

tableau des formats de sortie du connecteur SDI OUT/HDMI OUT ci-dessous, la sortie HDMI passe en Full HD ou

. . le menu Project) Format dans le menu
inférieur lorsque toutes les conditions suivantes sont réunies. "
- S&Q Motion >Setting dans le menu Shooting est réglé sur On Project)
- S&Q Motion >Frame Rate dans le menu Shooting est supérieur & 60fps 50/59.94Hz XAVC-| 4096x2160(Video) 4096x2160P" 4096x2160P
- Rec Format >Codec dans le menu Project est réglé sur RAW ou RAW & XAVC-I, ou Output On/Off >SDI dans le XAVC-L 4096x2160P 1920x1080P
menu Monitoring est réglé sur On N
e Lorsque les conditions ci-dessus sont réunies, les options de sélection 4096x2160P et 3840x2160P de la sortie 4096x2160P 1920x1080i
HDMI pour Output Format >SDI/HDMI (page 98) dans le menu Monitoring sont grisées et ne peuvent pas étre 3840x2160P 3840x2160P
sélectionnées.

* L'image n'est pas émise si une résolution supérieure a celle de I'image de lecture est configurée. 3840x2160P 1920x1080P
3840x2160P 1920x1080i
1920x1080P 1920x1080P
(Level A)

Formats de sortie du connecteur SDI OUT/HDMI OUT 1920x1080P 1920x1080i
(Level A)
1920x1080P 1920x1080P

Réglage de la Réglage de codec Réglage du format Format de sortie (Output Format (Level B)
fréquence de (Rec Format d’enregistrement/ dans le menu Monitoring) 1920x1080P 1920x1080i
systéme >Codec dans le RAW sDI HDMI (Level B)
(Rec Format menu Project) (Rec Format >RAW 1920x1080i 1920x1080i
SC MY GENS QiU e 3840x2160(Video)  3840x2160P 3840x2160P
le menu Project) Format dans le menu
Project) 3840x2160P 1920><1()80!D
50/59.94Hz RAW 4096x2160(RAW) (40962160 RAW) 4096x2160P 3840x2160P 1920x1080i
RAW & XAVC-| 3840x2160P 132011280P 1920x1080P
19201080P s;zzewe)sop 1920x1080i
== »
1920x1080i St
(Level A)
3840x2160(RAW) (3840x2160 RAW) 3840x2160P 1920<1080P 1920<1080P
1920x1080P (Level B)
1920x1080i 1920x1080P 1920x1080i
RAW(HDMI) 4240x2392(RAW) 1920x1080P (4240%x2392 HDMI (Level B)
RAW(HDMI) & (Level A) RAW) 1920x1080i 1920x1080i
XAVC-| 1920x1080P

(Level B)
1920x1080i
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Réglage de la Réglage de codec Réglage du format Format de sortie (Output Format Réglage de la Réglage de codec Réglage du format Format de sortie (Output Format
fréquence de (Rec Format d’enregistrement/ dans le menu Monitoring) fréquence de (Rec Format d’enregistrement/ dans le menu Monitoring)
systeme >Codec dans le RAW SDI HDMI systeme >Codec dans le RAW SDI HDMI
(Rec Format menu Project) (Rec Format >RAW (Rec Format menu Project) (Rec Format >RAW
>Frequency dans Output Format/Video >Frequency dans Output Format/Video
le menu Project) Format dans le menu le menu Project) Format dans le menu
Project) Project)
50/59.94Hz XAVC-| 1920x1080(Video) 1920x1080P 1920x1080P 23.98Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096x2160P
XAVC-L (Level A) RAW & XAVC-| 3840x2160P
1920x1080P 1920x1080i 1920x1080P
(Level A) 3840x2160(RAW) (3840x2160 RAW) 3840x2160P
1920x1080P 1920x1080P 1920x1080P
(Level B) . RAW(HDMI) 4240x2392(RAW) 1920x1080P (4240%2392 HDMI
1920x1080P 1920x1080i RAW(HDMI) & RAW)
(Level B) XAVC-|
1920x1080i 1920x1080i XAVC-I 4096x2160(Video) 4096x2160P" 4096x2160P
(Sortie arrétée) ~ 720x480P"? XAVC-L 4096x2160P 1920x1080P
720<576P1Y 3840x2160P 3840x2160P
25/29.97Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096x2160P 3840%2160P 1920x1080P
RAW & xAVCH 3840x2160P 1920x1080P 1920x1080P
1920<1080P 3840x2160(Video)  3840x2160P 3840x2160P
1920x1080i 3840x2160P 1920x1080P
3840x2160(RAW) (3840x2160 RAW) 3840x2160P 1920x1080P 1920x1080P
1920080P 1920x1080(Video) 1920x1080P 1920x1080P
1920x1080i 24Hz RAW 4096x2160(RAW) (40962160 RAW) 4096x2160P
RAW(HDMI) 4240x2392(RAW) 1920x1080P (4240%x2392 HDMI RAW & XAVC-| 1920x1080P
RAW(HDMI) & RAW
« AVC(-I ) 1920x1080PsF ) XAVC-| 4096x2160(Video)  4096x2160P" 4096x2160P
XAVC 4096x2160(Video)  4096x2160P" _4096x2160P 19201080 1920x1080P
XAVC-L 4096x2160P 1920x1080P 1) L'affichage de I'écran ne peut pas étre intégré.
3840x2160P 3840x2160P 2) Lorsque la fréquence de systéme est de 59.94
3) Lorsque la fréquence de systéme est de 50
3840x2160P 1920x1080P
1920x1080P 1920x1080P
1920x1080PsF  1920x1080i
3840x2160(Video) 3840x2160P 3840x2160P
3840x2160P 1920x1080P
1920x1080P 1920x1080P
1920x1080PsF 1920x1080i
1920x1080(Video) 1920x1080P 1920x1080P
1920x1080PsF 1920x1080i
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Dépannage

Alimentation

Symptdéme

Cause

Solution

Symptome Cause

Solution

Le caméscope ne se met pas Le pack batterie n'est pas
mis en place et aucune
alimentation n'est fournie au
connecteur DCIN.

sous tension.

Mettez en place un pack batterie
(page 17) ou connectez-vous a une
source d'alimentation CA & l'aide d'un
adaptateur CA (page 18).

L'enregistrement audio
présente un niveau sonore
élevé.

Le niveau sonore est trop
bas.

Ajustez les niveaux d'enregistrement
audio avec les molettes AUDIO LEVEL
(CH1/CH2) (page 47).

Ajustez également le réglage INPUT
MIC Reference sous Audio Input dans le
menu Audio (page 101) lorsqu‘un
microphone externe est sélectionné.

Le pack batterie est
totalement déchargé.

Remplacez-le par un pack batterie
totalement chargé (page 17).

L'alimentation est
interrompue pendant le
fonctionnement.

Le pack batterie se décharge.

Remplacez-le par un pack batterie
totalement chargé (page 17).

Le pack batterie se décharge La température ambiante est
trés basse.

trés rapidement.

Cela est d{i aux caractéristiques de la
batterie et ne constitue pas une
anomalie.

La charge du pack batterie
est inadéquate.

Rechargez le pack batterie (page 17).
Si le pack batterie se décharge
rapidement méme apres avoir été
totalement chargé, il se peut que sa

durée de vie en service touche a sa fin.

Remplacez-le par un neuf.

Impossible de lire les plans.

Le plan est en cours de
modification.

La lecture des plans est impossible si
vous avez modifié les noms de fichiers
ou les dossiers ou si le plan est en cours
d'utilisation sur un ordinateur. Il ne
s'agit pas d'un dysfonctionnement.

Le plan est en cours
d’enregistrement sur un
autre appareil.

Il se peut que les plans enregistrés sur
d’autres appareils soient illisibles ou

s'affichent dans une taille incorrecte. Il
ne s'agit pas d'un dysfonctionnement.

Enregistrement/lecture

Dispositifs externes

Symptdéme

Solution

Symptdéme Cause

Solution

L'enregistrement ne démarre La carte mémoire est pleine.

pas lorsque vous appuyez
sur la touche

Remplacez la carte mémoire par une
autre possédant suffisamment
d'espace.

L'ordinateur ne reconnait pas le

caméscope.

correctement.

Débranchez le cable USB de I'ordinateur, puis rebranchez-le

Débranchez le cable USB de I'ordinateur, redémarrez votre
ordinateur, et suivez de nouveau les étapes dans le bon ordre.

Raccordez I'ordinateur et le caméscope en insérant un cable USB
dans le connecteur USB-C ou dans le connecteur USB/Multi.

d’enregistrement START/
STOP.

La carte mémoire nécessite
une restauration.

Restaurez la carte mémoire
(page 33).

Le chargement de plans sur
I'ordinateur est impossible.

Débranchez le cable USB de I'ordinateur, redémarrez le caméscope,

puis rebranchez-le.

Il faut installer un logiciel d’application pour charger des plans sur
votre ordinateur (page 123).

L'enregistrement audio est
impossible.

Les molettes AUDIO LEVEL
(CH1/CH2) sont réglées sur le
niveau minimal.

Ajustez les niveaux d'enregistrement
audio avec les molettes AUDIO LEVEL
(CH1/CH2) (page 47).

Le son enregistré est
déformé. élevé.

Le niveau sonore est trop

Ajustez les niveaux d'enregistrement
audio avec les molettes AUDIO LEVEL
(CH1/CH2) (page 47).
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Connexion LAN sans fil

[Remarque]

Les obstructions et les interférences électromagnétiques entre le caméscope et le point d'accés au réseau LAN
sans fil ou le terminal, ou I'environnement ambiant (comme les matériaux muraux) pourraient raccourcir la plage
de communication ou empécher complétement les connexions. Si vous rencontrez ces problémes, vérifiez I'état
de la connexion/communication aprés avoir déplacé le caméscope vers un nouvel emplacement ou rapproché le
cameéscope et le point d'accés/terminal.

Symptome Solution

Un terminal ne peut pas accéder
au caméscope.

® Vérifiez la connexion LAN sans fil (adresse IP, etc.).

® |l se peut que le réglage de la communication entre le point
d'acces et le client soit invalide. Pour plus de détails, consultez le
mode d’emploi du point d'acces.

Vous ne pouvez pas vous Vérifiez le nom d'utilisateur et le mot de passe que vous avez

connecter au caméscope. définis.

Connexion Internet

Symptome Solution

Echec de téléchargement du Il se peut que le nom d’utilisateur et le mot de passe du serveur ne
fichier. soient pas corrects.

Saisissez le nom d’utilisateur et le mot de passe corrects.

Le téléchargement du fichier
n'est pas disponible.

Il se peut que I'état du signal soit mauvais.
Déplacez-vous vers un autre emplacement, et réessayez.

Lors de I'utilisation du filtre ND

Symptome Solution

Le filtre ND ne se déplace pas. Vous pouvez positionner manuellement le filtre sur la position

Clear a l'aide de la procédure suivante.

1 Placez le commutateur POWER du caméscope en position off.

2 Retirez le capuchon rond situé sur le c6té inférieur.

3 Insérez un tournevis dans l'orifice et tournez-le dans le sens contraire des aiguilles d'une
montre.
e Le filtre ND se place en position Clear lorsque vous tournez dans le sens contraire des
aiguilles d’'une montre. Continuez a tourner jusqu'a atteindre la position Clear.
e Utilisez un tournevis de 2,4 mm de diameétre ou moins. La profondeur d'insertion du
tournevis est d’environ 3,0 cm (13/,; po.).

|

000000000000

i

QOrifice de tournevis
(avec le capuchon retiré)

4 Placez le commutateur ND PRESET/VARIABLE (page 5) en position PRESET et réglez les
touches haut/bas ND FILTER POSITION (page 5) sur la position CLEAR.

[Remarques]

o N'utilisez pas la procédure ci-dessus pendant le fonctionnement normal. Utilisez uniquement cette procédure
si le filtre ND ne se déplace pas. Le filtre ND peut étre endommagé si cette procédure est utilisée pendant le
fonctionnement normal.

e Aprés avoir utilisé la procédure ci-dessus, consultez un centre de service Sony pour faire réparer le caméscope.

* Siun message d'erreur apparait toujours aprés avoir utilisé la procédure ci-dessus, la prise de vue est toujours
possible.
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Avertissements de fonctionnement

Si le caméscope détecte un avertissement, une précaution ou une opération qui nécessite une
confirmation, un message s'affiche dans le viseur, le témoin d'enregistrement/de signalisation
commence a clignoter et un avertissement sonore est émis.

Le son d'avertissement est émis depuis les écouteurs connectés au connecteur pour casque.

Messages d'erreur

Le caméscope arrétera |'opération si I'un des écrans suivants s'affiche.

Message du viseur

Avertissement
sonore

Témoin
d’enregis-
trement/de
signalisa-
tion

Cause et solution

Media Temperature
High

Intermittent

Clignotement

La température de la carte CFexpress est élevée.
Remplacez la carte ou et laissez-la refroidir avant
de I'utiliser a nouveau.

Avertissement  Témoin

sonore d’enregis-
trement/de
signalisa-
tion

Message du viseur

Cause et solution

Voltage Low

Intermittent

Clignotement

La tension DC IN est faible (niveau 1). Vérifiez la
source d'alimentation.

Insufficient Voltage

Continu

Clignotement
rapide

La tension DC IN est trop faible (niveau 2).
L'enregistrement est désactivé.
Raccordez une source d'alimentation différente.

E + code d'erreur Continu Clignotement

rapide

Indique une anomalie dans le caméscope.
L'enregistrement s'arréte, méme lorsque @REC est
affiché dans le viseur.

Mettez le caméscope hors tension, et vérifiez si
vous détectez un probléme au niveau des
dispositifs, des cables ou du support raccordés. Si
I'erreur persiste aprés avoir remis le caméscope
sous tension, contactez votre technicien Sony.

(Si le caméscope ne peut pas étre mis hors
tension en réglant le commutateur POWER sur
OFF, retirez la batterie ou débranchez
I'alimentation DC IN.)

Il se peut qu'aucun affichage d’erreur ni aucune
alerte sonore d'avertissement ne survienne selon
I'état du caméscope.

Media Near Full

Intermittent

Clignotement

La capacité restante de la carte mémoire est
faible.
Remplacez-la dés que possible.

Media Full Continu Clignotement Les plans n‘ont pas pu étre enregistrés ni copiés
rapide car la capacité restante de la carte mémoire n’est

pas suffisante.
Remplacez-la immédiatement.

Clips Near Full Intermittent Clignotement Le nombre de plans supplémentaires pouvant
étre enregistrés sur la carte mémoire diminue.
Remplacez-la dés que possible.

Clips Full Continu Clignotement Le nombre maximal de plans pouvant étre

rapide

enregistrés sur la carte mémoire a été atteint.
L'enregistrement ou la copie de plus de plans est
impossible. Remplacez-la immédiatement.

Messages d'avertissement

Suivez les instructions fournies si I'écran suivant s'affiche.

Last Clip Recording

Intermittent

Clignotement

Le plan en cours d’enregistrement est le dernier
plan qui peut étre enregistré, étant donné que le
nombre maximum de plans a été atteint.
Préparez une nouvelle carte mémoire.

Media(A)" Life Near
End

Intermittent

Clignotement

La carte mémoire approche de la fin de sa durée
de vie. Remplacez-la dés que possible.

Avertissement Témoin

sonore d’enregis-
trement/de
signalisa-
tion

Message du viseur

Cause et solution

Media(A)" Life End

Continu

Clignotement
rapide

La carte mémoire a atteint la fin de sa durée de
vie. Remplacez-la immédiatement.

Media(A)" Near Full

Intermittent

Clignotement

Lorsque vous utilisez la fonction Simul Rec

Media(A)" Full

Continu

Clignotement
rapide

Lorsque vous utilisez la fonction Simul Rec

Battery Near End Intermittent  Clignotement

La capacité restante du pack batterie est faible.
Rechargez-le des que possible.

Media(A)" Clips Near
Full

Intermittent

Clignotement

Lorsque vous utilisez la fonction Simul Rec

Battery End Continu Clignotement

rapide

Le pack batterie est vide. L'enregistrement est
désactivé.

Arrétez les opérations et remplacez le pack
batterie.

Media(A)" Clips Full

Continu

Clignotement
rapide

Lorsque vous utilisez la fonction Simul Rec

Media(A)" Last Clip
Rec

Intermittent

Clignotement

Lorsque vous utilisez la fonction Simul Rec

Temperature High Intermittent  Clignotement

La température interne est élevée.
Mettez le caméscope hors tension et laissez-le
refroidir avant de le faire fonctionner a nouveau.

Transfer Jobs Near
Full

Le nombre de taches de transfert de fichiers FTP
pouvant étre enregistrées diminue.
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Avertissement Témoin

sonore d’enregis-
trement/de
signalisa-
tion

Message du viseur Cause et solution

Transfer Jobs Full - - Le nombre de taches de transfert de fichiers FTP
pouvant étre enregistrées a atteint la limite
supérieure. Pour ajouter une autre tache,

supprimez d'abord toute tdche non désirée.?

Messages de précaution concernant I'opération

Les messages de précaution et d'opération suivants peuvent apparaitre au centre de
I'écran. Suivez les instructions fournies pour résoudre le probléme.

Message du viseur

Cause et solution

1) «(B) » s'affiche pour la carte située dans le logement B.
2) Vous pouvez sélectionner et supprimer des taches a l'aide de File Transfer >View Job List (page 110) dans le
menu Network du menu complet. Vous pouvez également supprimer des taches depuis la liste de tdche CBM.

Battery Error
Please Change Battery

Une erreur a été détectée au niveau du pack batterie.
Remplacez-le par un pack batterie normal.

Backup Battery End
Please Change

La capacité restante de la batterie de secours est insuffisante.
Rechargez la batterie de secours.

Unknown Media (A) "
Please Change

Une carte mémoire qui a été divisée en plusieurs parts ou une
carte mémoire contenant plus de plans que ceux permis pour
la manipulation du caméscope a été insérée.

La carte ne peut pas étre utilisée dans le caméscope et doit
étre remplacée.

Cannot Use Media (A) "
Unsupported File System

Une carte utilisant un systéme de fichiers différent ou une
carte non formatée a été insérée.

La carte ne peut pas étre utilisée dans le caméscope et doit
étre remplacée ou formatée a I'aide du caméscope.

Media Error
Media (A) V Needs to be Restored

Une erreur s'est produite avec la carte mémoire et la carte doit
étre restaurée.
Restaurez la carte mémoire.

Media Error
Cannot Record to Media(A)

La carte mémoire peut étre endommagée et ne peut plus étre
utilisée pour I'enregistrement.

La lecture est possible, il est donc recommandé d'effectuer
une copie et de remplacer la carte mémoire.

Media Error
Cannot Use Media (A) "

La carte mémoire peut étre endommagée et ne peut plus étre
utilisée pour I'enregistrement ou la lecture.

La carte ne peut pas étre utilisée dans le caméscope et doit
étre remplacée.

Media (A) " Error
Recording Halted
Playback Halted

L'enregistrement et la lecture se sont arrétés parce qu'une
erreur s'est produite pendant I'utilisation de la carte mémoire.
Si le probléme persiste, remplacez la carte mémoire.

Media Reached Rewriting Limit
Change Media (A) "

La carte mémoire a atteint la fin de sa durée de vie.
Effectuez une copie de sauvegarde et remplacez la carte
immeédiatement. Si vous continuez a utiliser la carte, la carte
risque de ne plus pouvoir enregistrer ou lire.

Pour plus de détails, reportez-vous au mode d’emploi de la
carte mémoire.

The specified address is invalid.

L'adresse spécifiée est invalide.
Vérifiez que le réglage est correct.

Cannot Use Specified Port Number

Le numéro de port spécifié est invalide.
Vérifiez que le réglage est correct.
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Message du viseur

Cause et solution

Fan Stopped Le ventilateur intégré s'est arrété.
Evitez I'utilisation a des températures élevées, débranchez
I'alimentation et prenez contact avec votre technicien Sony.
LENS Error Une erreur d'objectif a été détectée dans la communication

I/F de I'objectif lors de la fixation d'un objectif a monture E.
Vérifiez I'état du raccordement a I'objectif & monture E.

This Multi Term. acc is not supported
by the device and cannot be used.
Please verify the compatibility.

Un accessoire incompatible a été détecté.
Le seul accessoire a terminaux multiples compatible avec
I'unité est la télécommande de grip fournie.

Failed

Cette erreur peut apparaitre si une adresse ne peut pas étre
obtenue avec DHCP réglé sur On.
Vérifiez les réglages du serveur DHCP.

Addition of auto upload job failed.

Le nombre maximum de taches de transfert a été atteint.
Effacez toute tdche non désirée. Il est possible que le réglage
de destination de téléchargement automatique pour les
fichiers originaux ou proxy soit également incorrect. Vérifiez
que le réglage est correct.

<SSID>Not found.

Le réseau (point d'acces) avec le <SSID> spécifié est
introuvable.
Vérifiez que le réglage est correct.

<SSID>Authentication Failed

L'authentification de connexion sur le réseau (point d'accés)
avec le <SSID> spécifié a échoué.

Vérifiez que le mot de passe et les autres réglages sont
corrects.

An IP address conflict has occurred.
Please check the network settings.

Il'y a un conflit entre les adresses réseau du LAN sans fil, du
LAN filaire ou du raccordement modem USB.

Changez I'adresse manuellement ou changez les réglages du
routeur réseau.

The IP address of the Wireless LAN
Access Point Mode has been
changed due to an IP address
conflict.

L'adresse IP du mode de point d’accés de LAN sans fil a été
modifiée en raison d'un conflit entre les adresses réseau du
mode de point d’accés de LAN sans fil, du LAN filaire ou du
raccordement modem USB.

Vérifiez le réglage de I'adresse IP.

1) «(B) » s'affiche pour la carte située dans le logement B.
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Eléments enregistrés dans les fichiers

Eléments configurés dans le menu complet LEVEL 1 LEVEL 2 LEVEL 3 AllFile  Scene File
Shooting Auto Exposure Level Oui Non
Oui : L'élément est enregistré. Mode Oui Non
Non : L'élément n'est pas enregistré. Speed Oui Non
- :non enregistré (réglage temporaire) AGC Oui Non
LEVEL1 LEVEL 2 LEVEL 3 All File Scene File AGC Limit Oui Non
Shooting 1SO/Gain/El Mode Oui Non AGC Point Oui Non
1SO/Gain<H> Oui Non Auto Shutter Oui Non
1SO/Gain<M> Oui Non A.SHT Limit Oui Non
1SO/Gain<L> Oui Non A.SHT Point Oui Non
Exposure Index<H> Oui Non Clip High light Oui Non
Exposure Index<M> Oui Non Detect Window Oui Non
Exposure Index<L> Oui Non Detect Window Indication Oui Non
Shockless Gain Oui Non Custom Width Oui Non
Base Sensitivity Oui Non Custom Height Oui Non
Base ISO Oui Non Custom H Position Oui Non
ND Filter Presetl Oui Non Custom V Position Oui Non
Preset2 Oui Non White Preset White Oui Non
Preset3 Oui Non Color Temp <A> Oui Non
Shutter Mode Oui Non Tint<A> Oui Non
Shutter Speed On/Off Oui Non R Gain <A> Oui Non
Shutter Speed Oui Non B Gain <A> Oui Non
Shutter Angle Oui Non Color Temp <B> Oui Non
ECS On/Off Oui Non Tint<B> Oui Non
ECS Frequency Oui Non R Gain <B> Oui Non
Iris Bokeh Control Non Non B Gain <B> Oui Non
White Setting Shockless White Oui Non
ATW Speed Oui Non
White Switch<B> Oui Non
Filter White Memory Oui Non
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LEVEL 2 LEVEL 3 All File Scene File LEVEL1 LEVEL 2 LEVEL 3 All File Scene File

Offset White Offset White <A> Oui Non Project Base Setting Shooting Mode Oui -
Offset Color Temp<A> Oui Non Target Display Oui -

Offset Tint<A> Oui Non Rec Format Frequency Oui Non

Offset White <B> Oui Non Imager Scan Mode Oui Non

Offset Color Temp<B> Oui Non Codec Oui Non

Offset Tint<B> Oui Non RAW Output Format Oui Non

Offset White<ATW> Oui Non Video Format Oui Non
Offset Color Temp<ATW> Oui Non Cine EI/Flex.ISO Set Color Gamut Oui -

Offset Tint<ATW> Oui Non Embed LUT File Oui Non

Focus AF Transition Speed Oui Non HDR Setting VF SDR Preview Oui Non

AF Subj. Shift Sens. Oui Non SDR Gain Oui Non

Focus Area Oui Non Simul Rec Setting Oui Non

Focus Area (AF-S) Oui Non Rec Button Set Oui Non

Face/Eye Detection AF Oui Non Proxy Rec Setting Oui Non

Push AF Mode Oui Non Audio Channel Oui Non

Touch Function in MF Oui Non Chunk Oui Non

AF Assist Oui Non Interval Rec Setting Non Non

S&Q Motion Setting Oui Non Interval Time Oui Non

Frame Rate Oui Non Number of Frames Oui Non

LUT On/Off SDI/HDMI Oui Non Pre-Lighting Oui Non

VF/Proxy/Stream Oui Non Picture Cache Rec Setting Oui Non

Internal Rec Oui Non Cache Size Oui Non
Noise Suppression Setting(Custom) Oui Non Cache Rec Time - -

Level(Custom) Oui Non SDI/HDMI Rec Control  Setting Oui Non

Setting (Cine EI/Flex. 1SO) Oui - Assignable Button <1> Oui Non

Level (Cine EI/Flex. 1SO) Oui - <2> Oui Non

Flicker Reduce Mode Oui Non <3> Oui Non

Frequency Oui Non <4> Oui Non

SteadyShot Setting Oui Non <5> Oui Non

<6> Oui Non

<7> Oui Non

<8> Oui Non

<9> Oui Non

Focus Hold Button Oui Non

Assignable Dial Grip/Remote Dial Oui Non

Grip Dial Direction Oui Non

Handle Dial Oui Non

Handle Dial Direction Oui Non

Multi Function Dial Default Function Oui Non




135 | 8.Annexe : Eléments enregistrés dans les fichiers

LEVEL1 LEVEL 2 LEVEL 3 All File Scene File LEVEL1 LEVEL 2 LEVEL 3 All File Scene File

Project User File Load from Media(B) - - Paint/Look Detail Setting Oui Oui

Save to Media(B) - - Level Oui Oui

File ID Non Non Manual Setting Oui Oui

Load Customize Data Oui Non V/H Balance Oui Oui

Load White Data Oui Non B/W Balance Oui Oui

All File Load from Media(B) - - Limit Oui Oui

Load from Cloud(Private) - - Crispening Oui Oui

Load from Cloud(Share) - - High Light Detail Oui Oui

Save to Media(B) - - Matrix User Matrix Oui Oui

Save to Cloud(Private) - - User Matrix Level Oui Oui

Save to Cloud(Share) - - User Matrix Phase Oui Oui

File ID Oui Non User Matrix R-G Oui Oui

Load Network Data Non Non User Matrix R-B Oui Oui

Paint/Look Scene File Recall - - User Matrix G-R Oui Oui

Store - - User Matrix G-B Oui Oui

Delete - - User Matrix B-R Oui Oui

Preset Recall - - User Matrix B-G Oui Oui

Base Look Select Oui Oui Multi Matrix Setting QOui Oui
Delete - - Reset - _

Delete All - - Axis Non Oui

Import from Media(B) - - Hue Oui Oui

Import from Cloud(Private) - - Saturation Oui Oui

Import from Cloud(Share) - - TC/Media Timecode Mode Oui Non

Input Oui Oui Run Oui Non

Output Oui Oui Setting Non Non
AE Level Offset Oui Oui Reset - -

Reset Paint Settings Reset without Base Look - - TC Format Oui Non

Black Master Black Oui Oui TC Display Display Select Oui Non

R Black Oui Oui Users Bit Mode Oui Non

B Black Oui Oui Setting Non Non

Knee Setting Oui Oui HDMI TC Out Setting Oui Non

Auto Knee Oui Oui Clip Name Format Auto Naming Oui Non

Point Oui Oui Camera ID Non Non

Slope Oui Oui Reel Number Non Non

Camera Position Non Non

Title Prefix Oui Non

Number Set Non Non
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LEVEL1 LEVEL 2 LEVEL 3 All File Scene File LEVEL1 LEVEL 2 LEVEL 3 All File Scene File
TC/Media Update Media Media(A) - - Monitoring Display On/Off Scene File Oui Non
Media(B) - - Focus Indicator Oui Non
Format Media Media(A) - - Auto Exposure Mode Oui Non
Media(B) - - Auto Exposure Level Oui Non
Monitoring Output On/Off SDI Oui Non Timecode Oui Non
HDMI Oui Non ND Filter Oui Non
Output Format SDI Oui Non Iris Oui Non
HDMI Oui Non 1SO/Gain/El Oui Non
De-Squeeze Ratio (HDMI/VF) Oui Non Shutter Oui Non
Output Display SDI Oui Non Level Gauge Oui Non
HDMI Oui Non Audio Level Meter Oui Non
Display On/Off Network Status Oui Non Video Level Warning Oui Non
File Transfer Status Oui Non Clip Number Oui Non
Rec/Play Status Oui Non Notice Message Oui Non
RAW Output Control Status Oui Non Marker Setting Oui Non
Tally Oui Non Color Oui Non
Battery Remain Oui Non Center Marker Oui Non
Focus Mode Oui Non Safety Zone Oui Non
Focus Position Oui Non Safety Area Oui Non
Focus Area Indicator Oui Non Aspect Marker Oui Non
Focus Area Ind.(AF-S) Oui Non Aspect Mask Oui Non
Face/Eye Detection Frame Oui Non Aspect Safety Zone Oui Non
Lens Info Oui Non Aspect Safety Area Oui Non
Imager Scan Mode Oui Non Aspect Select Oui Non
Rec Format Oui Non Custom Aspect Ratio Oui Non
Frame Rate Oui Non Guide Frame Oui Non
Zoom Position Oui Non 100% Marker Oui Non
UWP RF Level Oui Non User Box Oui Non
SteadyShot Oui Non User Box Width Oui Non
Base Look/Rec Look Oui Non User Box Height Oui Non
SDI/HDMI Rec Control Oui Non User Box H Position Oui Non
Monitoring Look Oui Non User Box V Position Oui Non
Proxy Status Oui Non VF Setting Brightness Oui Non
Base ISO/Sensitivity Oui Non Color Mode Oui Non
Media Status Oui Non Gamma Display Assist  Setting Oui Non
Video Signal Monitor Oui Non Peaking Setting Oui Non
Clip Name Oui Non Peaking Level Oui Non
White Balance Oui Non Color Oui Non
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LEVEL1 LEVEL 2 LEVEL 3 All File Scene File LEVEL1 LEVEL 2 LEVEL 3 All File Scene File
Monitoring Zebra Setting Oui Non Thumbnail Display Clip Properties - -
Zebral Level Oui Non Set Clip Flag Add OK - -
Zebral Aperture Level Oui Non Add NG - -
Zebra2 Level Oui Non Add KEEP - -
Audio Audio Input CH1 Input Select Oui Non Delete Clip Flag - -
CH2 Input Select Oui Non Lock/Unlock Clip Select Clip - -
CH3 Input Select Oui Non Lock All Clips - -
CH4 Input Select Oui Non Unlock All Clips - -
INPUT1 MIC Reference Oui Non Delete Clip Select Clip - -
INPUT2 MIC Reference Oui Non All Clips - -
Line Input Reference Oui Non Transfer Clip Select Clip - -
Reference Level Oui Non All Clips - -
CH1 Wind Filter Oui Non Transfer Clip (Proxy) Select Clip - -
CH2 Wind Filter Oui Non All Clips - -
CH3 Wind Filter Oui Non Filter Clips OK - -
CH4 Wind Filter Oui Non NG - -
CH3 Level Control Oui Non KEEP - -
CH4 Level Control Oui Non None - -
CH3 Input Level Oui Non All - -
CH4 Input Level Oui Non Customize View Thumbnail Caption Oui -
Audio Input Level Oui Non Technical Color Bars Setting Non Non
Limiter Mode Oui Non Type Oui Non
CH1&2 AGC Mode Oui Non ND Dial CLEAR with Dial Oui Non
CH3&4 AGC Mode Oui Non Tally Front Oui Non
AGC Spec Oui Non Rear Oui Non
1kHz Tone on Color Bars Oui Non HOLD Switch Setting with Rec Button Oui Non
CH1 Level Oui Non with Hand Grip Remote Oui Non
CH2 Level Oui Non Handle HOLD Switch Oui Non
CH3 Level Oui Non Touch Operation Setting Oui Non
CH4 Level Oui Non Rec Review Setting Oui Non
Audio Output Monitor CH Oui Non Zoom Zoom Type Oui Non
Volume Non Non Handle Zoom Setting Oui Non
Headphone Out Oui Non High Oui Non
Alarm Level Oui Non Low Oui Non
HDMI Output CH Oui Non Menu Settings User Menu Only Oui Non
User Menu with Lock Non Non
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LEVEL1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 3 All File Scene File
Technical Menu Page On/Off Main Oui Non Camera Remote Control Oui Non
Camera Oui Non Connected Network
Audio Oui Non SSID - -
Project Oui Non Security - -
Monitoring Oui Non Password - -
Assignable Button Oui Non DHCP - -
Battery Oui Non IP Address - -
Media Oui Non Subnet Mask - -
Network Oui Non Gateway - -
File Transfer Oui Non DNS Auto - -
Fan Control Setting Oui Non Primary DNS Server - -
Lens Zoom Ring Direction Oui Non Secondary DNS Server - -
Shading Compensation Oui Non Scan Networks
Chroma Aberration Comp. Oui Non SSID - -
Distortion Comp. Oui Non Security - -
Breathing Compensation Oui Non Password Non Non
Distance Display Oui Non DHCP Oui Non
Zoom Position Display Oui Non IP Address Oui Non
Video Light Set Video Light Set Oui Non Subnet Mask Oui Non
APR APR - - Gateway Oui Non
Camera Battery Alarm Low Battery Oui Non DNS Auto Oui Non
Battery Empty Oui Non Primary DNS Server Oui Non
Camera DC IN Alarm DC Low Voltagel Oui Non Secondary DNS Server Oui Non
DC Low Voltage2 Oui Non Manual Register
Network Setup for Mobile App Setup - - SSID Oui Non
Access Authentication User Name Non Non Security Oui Non
Input Password Non Non Password Non Non
Generate Password - - DHCP Oui Non
Show Settings - - IP Address Oui Non
Wireless LAN Setting Oui Non Subnet Mask Oui Non
WPS - - Gateway Oui Non
NFC - - DNS Auto Oui Non
MAC Address - - Primary DNS Server Oui Non
AP Mode Settings Channel Oui Non Secondary DNS Server Oui Non

Camera SSID & Password

Regenerate Password

IP Address

Subnet Mask
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LEVEL1 LEVEL 2 LEVEL 3 All File Scene File LEVEL1 LEVEL 2 LEVEL 3 All File Scene File
Network Wired LAN Setting Oui Non Maintenance  Language Select Oui Non
Camera Remote Control Oui Non Clock Set Time Zone Oui Non
Detail Settings Date Mode Oui Non
DHCP Oui Non 12h/24h Oui Non
IP Address Oui Non Date Non Non
Subnet Mask Oui Non Time Non Non
Gateway Oui Non All Reset Reset - -
DNS Auto Oui Non Reset without Network - -
Primary DNS Server Oui Non Hours Meter Hours(System) - -
Secondary DNS Server Oui Non Hours(Reset) - -
Modem Setting Oui Non Reset - -
Camera Remote Control Oui Non Version Version Number - -
Device Name - - Version Up - -
IP Address - - Lens Version Number - -
Subnet Mask - -
File Transfer Auto Upload Oui Non
Auto Upload (Proxy) Oui Non
Default Upload Server Oui Non

Clear Completed Jobs

Clear All Jobs - -
View Job List - -
Server Settings1/Server Settings2/Server Settings.
Display Name Oui Non
Service Oui Non
Host Name Oui Non
Port Oui Non
User Name Non Non
Password Non Non
Passive Mode Oui Non
Destination Directory Oui Non
Using Secure Protocol Oui Non
Root Certificate - -
Root Certificate Status - -
Reset - -
Network Reset Reset - -
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Eléments configurés avec les touches personnalisables

Oui : L'élément est enregistré.
Non : L'élément n'est pas enregistré.
- non enregistré (réglage temporaire)

Sélection de la touche personnalisable All File Scene File
ND Filter Position Oui Non

Auto Iris Oui Non

ATW Oui Non

Focus Setting Oui Non
Display Oui -

VF Adjust Oui -

Eléments configurés avec la molette personnalisable

Oui : L'élément est enregistré.
Non : L'élément n'est pas enregistré.
- non enregistré (réglage temporaire)

Sélection de la molette All File Scene File
personnalisable

IRIS Oui Non

ND Filter Oui Non

Audio Input Level Oui Non
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Diagrammes bloc

Consultez les éléments associés dans « Réglage de I'audio a enregistrer » (page 47) et « Menu User » (page 76).

Audio Input (CH1&CH2)

Le schéma suivant montre le bloc-diagramme avec la poignée attachée.

CONTROL>*  Audio Input Level 0-10
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T
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* Réglez sur Manual lorsque I'audio est entré par I'adaptateur XLR.
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N
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Audio Input (CH3&CH4)

Le schéma suivant montre le bloc-diagramme avec la poignée attachée.

1
L
1
1
—————— 1
1
1
1
T I
STTTTN (TTTTTT \ :
OFF [ 1 1 1 ——-==s
= ! | . P ‘
! | | ! |
T T —t Q
s : /I\ 1 1 /P [ —"—2 ;
"2 I I I
INPUT1 1 e i i [ |
! "y ! ] ] [ H
! velil | ] 1 1 !
1 1 1 [ | ! ! !
INPUT2 i s i i i [ i !
: : k= : ! ' 1 : 1 1 H
! 1 T T (] ™ | 1 ! |
[ J [ JivN PN o 1 : : : : H H
[CH3Level [cH3Levell | [CH3InputLevel] | [ ! !
L {gf};ﬁ Input Select] [gHE Wind Filter] Control]* Audio Input Level 0-99 H 1 1 I ! :
Internal MIC 9 n Auto CH3 Input Level I T T H
INPUT off H [ | |
Level+CH3 Input Level 1 1
R Internal MIC Manual Thiough 1 [ [ H 1
Shoe CH1 I [ [ I 1
1 ' ! 1 1
T T =T 1 I
. 1 1 ! 1
1
! [ i !
-———= -———— 1
- N 7 N ! b : !
: 1 : ! : I I !
A ! | H Il A é_‘
= RNGE T 8T
(=1 I 1 1
Shoe CH1 nEf ! ! P! i !
1 vel i 1 1 1 [ I
1 n2fat 1 [ 1 1 .
Shoe CH2 ! 1 B ! b i [ b
1 | I L i 1 i 1
Y L B T s !
N, ] N, N O ' b ,[c:zzcx AGC Mode] [
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INPUT1 off Auto CHa Input Leve H T | Bars]
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* Réglez sur Manual lorsque I'audio est entré par 'adaptateur XLR.
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MIX ALL
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Mise a jour du logiciel de I'objectif a monture E

Vous pouvez mettre a jour le logiciel d'un
objectif a monture E en utilisant le caméscope.
Consultez le site Web pour connaitre les
objectifs qui peuvent étre mis a jour, ainsi que
le logiciel correspondant.

Vérification de la version

1 Fixez un objectif a monture E sur le
caméscope (page 22).

2 Sélectionnez Version dans le menu
Maintenance du menu complet pour
afficher Lens Version Number
(page 1M1).

Le numéro de version du logiciel de
I'objectif a monture E est affiché sur le
coté.

Mise a jour du logiciel

Réglez le caméscope sur le mode de stockage
de masse (page 123).

Actualisez le logiciel en appliquant la
procédure fournie avec le logiciel de I'objectif.
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Licences

Licence MPEG-4 AVC Patent
Portfolio

CE PRODUIT EST SOUS LICENCE AVC

PATENT PORTFOLIO POUR L'UTILISATION

PERSONNELLE DU CONSOMMATEUR OU TOUT

AUTRE UTILISATION N'IMPLIQUANT PAS DE

REMUNERATION

(i) ENCODAGE VIDEO EN CONFORMITE AVEC LE
STANDARD AVC (« AVC VIDEO ») ET/OU

(ii) DECODAGE VIDEO AVC ENCODE PAR UN
CONSOMMATEUR ENGAGE DANS UNE
ACTIVITE PERSONNELLE ET/OU OBTENU
D’UN FOURNISSEUR VIDEO AYANT LA
LICENCE DE DISTRIBUTION AVC VIDEO.

AUCUNE LICENCE N'EST ATTRIBUEE OU

NE DOIT ETRE DESTINEE POUR TOUT

AUTRE USAGE. DES INFORMATIONS
SUPPLEMENTAIRES PEUVENT ETRE OBTENUES
DE MPEG LA, L.L.C. VOIR
HTTP://WWW.MPEGLA.COM

Obtention d"un logiciel sous
licence GPL/LGPL

Ce produit utilise le logiciel auquel s'applique
la licence GPL/LGPL. Ceci vous informe

que vous disposez d'un droit d'accés, de
modification et de redistribution du code
source de ces logiciels dans les conditions de
la GPL/LGPL.

Le code source est disponible sur Internet.
Reportez-vous a I'adresse URL suivante et
suivez les instructions de téléchargement.
https://0ss.sony.net/Products/Linux/

Nous préférerions que vous ne nous
contactiez pas au sujet du contenu du code
source.

Les licences (en anglais) sont enregistrées
dans la mémoire interne de votre produit.
Etablissez une connexion de stockage de
masse entre le produit et un ordinateur pour
lire les licences du dossier « PMHOME » -

« LICENSE ».

Si vous utilisez un Mac, le dossier « PMHOME »
- « LICENCE » peut ne pas étre accessible.
Pour visualiser les fichiers, utilisez un
ordinateur autre qu’un Mac ou visitez I'URL
suivante.
https://0ss.sony.net/License/ILME-FX6/

CONTRAT DE LICENCE
D'UTILISATEUR FINAL

IMPORTANT:

BEFORE USING THE SOFTWARE CONTAINED IN THE
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS
END USER LICENSE AGREEMENT (“EULA") CAREFULLY. BY
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony
Corporation (“SONY”). This EULA governs your rights
and obligations regarding the software of SONY and/or
itts third party licensors (including SONY's affiliates) and
their respective affiliates (collectively, the “THIRD-PARTY
SUPPLIERS") contained in the wireless adapter, together
with any updates/ upgrades provided by SONY, any
printed, on-line or other electronic documentation for
such software, and any data files created by operation of
such software (collectively, the “SOFTWARE").

Notwithstanding the foregoing, any software in
the SOFTWARE having a separate end user license

agreement (including, but not limited to, GNU General
Public license and Lesser/Library General Public License)
shall be covered by such applicable separate end user
license agreement in lieu of the terms of this EULA to
the extent required by such separate end user license
agreement (“EXCLUDED SOFTWARE").

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The SOFTWARE is
protected by copyright and other intellectual property
laws and international treaties.

COPYRIGHT

All right and title in and to the SOFTWARE (including,
but not limited to, any images, photographs, animation,
video, audio, music, text and “applets” incorporated into
the SOFTWARE) is owned by SONY or one or more of the
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE

SONY grants you a limited license to use the SOFTWARE
solely in connection with the wireless adapter and only
for your individual use. SONY and the THIRD-PARTY
SUPPLIERS expressly reserve all rights, title and interest
(including, but not limited to, all intellectual property
rights) in and to the SOFTWARE that this EULA does not
specifically grant to you.

REQUIREMENTS AND LIMITATIONS

You may not copy, publish, adapt, redistribute, attempt
to derive source code, modify, reverse engineer,
decompile, or disassemble any of the SOFTWARE,
whether in whole or in part, or create any derivative
works from or of the SOFTWARE unless such derivative
works are intentionally facilitated by the SOFTWARE.
You may not modify or tamper with any digital rights
management functionality of the SOFTWARE. You
may not bypass, modify, defeat or circumvent any of
the functions or protections of the SOFTWARE or any
mechanisms operatively linked to the SOFTWARE. You
may not separate any individual component of the
SOFTWARE for use on more than one wireless adapter
unless expressly authorized to do so by SONY. You
may not remove, alter, cover or deface any trademarks
or notices on the SOFTWARE. You may not share,
distribute, rent, lease, sublicense, assign, transfer or
sell the SOFTWARE. The software, network services

or other products other than SOFTWARE upon which

the SOFTWARE'S performance depends might be
interrupted or discontinued at the discretion of the
suppliers (software suppliers, service suppliers, or
SONY). SONY and such suppliers do not warrant that the
SOFTWARE, network services, contents or other products
will continue to be available, or will operate without
interruption or modification.

EXCLUDED SOFTWARE AND OPEN SOURCE
COMPONENTS

Notwithstanding the foregoing limited license grant,
you acknowledge that the SOFTWARE may include
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE
may be covered by open source software licenses
("Open Source Components”), which means any
software licenses approved as open source licenses by
the Open Source Initiative or any substantially similar
licenses, including but not limited to any license that,
as a condition of distribution of the software licensed
under such license, requires that the distributor make
the software available in source code format. If and to
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list
of applicable OPEN SOURCE COMPONENTS included in
the SOFTWARE from time to time, and the applicable
terms and conditions governing its use. Such terms
and conditions may be changed by the applicable
third party at any time without liability to you. To the
extent required by the licenses covering EXCLUDED
SOFTWARE, the terms of such licenses will apply in lieu
of the terms of this EULA. To the extent the terms of the
licenses applicable to EXCLUDED SOFTWARE prohibit
any of the restrictions in this EULA with respect to such
EXCLUDED SOFTWARE, such restrictions will not apply
to such EXCLUDED SOFTWARE. To the extent the terms
of the licenses applicable to Open Source Components
require SONY to make an offer to provide source code
in connection with the SOFTWARE, such offer is hereby
made.


https://oss.sony.net/Products/Linux/
https://oss.sony.net/License/ILME-FX6/
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USE OF SOFTWARE WITH COPYRIGHTED
MATERIALS

The SOFTWARE may be capable of being used by you

to view, store, process and/or use content created by
you and/or third parties. Such content may be protected
by copyright, other intellectual property laws, and/

or agreements. You agree to use the SOFTWARE only

in compliance with all such laws and agreements that
apply to such content. You acknowledge and agree

that SONY may take appropriate measures to protect
the copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are not
limited to, counting the frequency of your backup and
restoration through certain SOFTWARE features, refusal
to accept your request to enable restoration of data, and
termination of this EULA in the event of your illegitimate
use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE
DESIGNED TO BE USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT SERVICES
(“CONTENT SERVICE"). USE OF THE SERVICE AND THAT
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL

BE LIMITED. You acknowledge and agree that certain
content and services available through the SOFTWARE
may be provided by third parties over which SONY has
no control. USE OF THE CONTENT SERVICE REQUIRES AN
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY
SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet connection
for which you are solely responsible. Further, you are
solely responsible for payment of any third party fees
associated with your Internet connection, including

but not limited to Internet service provider or airtime
charges. Operation of the SOFTWARE may be limited

or restricted depending on the capabilities, bandwidth
or technical limitations of your Internet connection

and service. The provision, quality and security of such
Internet connectivity are the sole responsibility of the
third party providing such service.

EXPORT AND OTHER REGULATIONS

You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country
in which you reside, and not to transfer, or authorize

the transfer, of the SOFTWARE to a prohibited country

or otherwise in violation of any such restrictions or
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not designed,
manufactured or intended for use or resale as on-

line control equipment in hazardous environments
requiring fail-safe performance, such as in the
operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life
support machines, or weapons systems, in which the
failure of the SOFTWARE could lead to death, personal
injury, or severe physical or environmental damage
("HIGH RISK ACTIVITIES"). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates
specifically disclaim any express or implied warranty,
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE
is at your sole risk and that you are responsible for use
of the SOFTWARE. The SOFTWARE is provided “AS IS,"
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY, NONINFRINGEMENT AND
FITNESS FOR A PARTICULAR PURPOSE. SONY

DOES NOT WARRANT OR MAKE ANY CONDITIONS

OR REPRESENTATIONS (A) THAT THE FUNCTIONS
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B)
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL

NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER

THAN THE SOFTWARE) UPON WHICH THE SOFTWARE'S
PERFORMANCE DEPENDS WILL CONTINUE TO BE
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND
(E) REGARDING THE USE OR THE RESULTS OF THE USE
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE

GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE
OF SONY SHALL CREATE A WARRANTY, DUTY OR
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF
THIS WARRANTY. SHOULD THE SOFTWARE PROVE
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT
APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") SHALL NOT BE LIABLE FOR ANY INCIDENTAL
OR CONSEQUENTIAL DAMAGES FOR BREACH OF

ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE,
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE,
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE,
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA, DATA
SECURITY

You acknowledge and agree that SONY and its
affiliates, partners and agents may read, collect,
transfer, process and store certain information

collected from the SOFTWARE, including but not

limited to information about (i) the SOFTWARE and

(ii) the software applications, contents and peripheral
devices that interact with your wireless adapter and the
SOFTWARE (“Information”). Information includes, but

is not limited to: (1) unique identifiers relating to your
wireless adapter and its components; (2) performance
of the wireless adapter, the SOFTWARE and their
components; (3) configurations of your wireless adapter,
the SOFTWARE and the software applications, contents
and peripheral devices that interact with the wireless
adapter and the SOFTWARE; (4) use and frequency of
use of the functions of (x) the SOFTWARE, and (y) the
software applications, contents and peripheral devices
that interact with the SOFTWARE; and (5) location data,
as indicated below. SONY and its affiliates, partners
and agents may use and disclose Information subject
to applicable laws in order to improve its products and
services or to provide products or services to you. Such
uses include, but are not limited to: (a) administering
the functionalities of the SOFTWARE; (b) to improve,
service, update or upgrade the SOFTWARE; (c)
improving, developing and enhancing the current and
future products and services of SONY and other parties;
(d) to provide you with information about the products
and services offered by SONY and other parties; (e)
complying with applicable laws or regulations; and ()
to the extent offered, providing you with location-based
services of SONY and other parties, as indicated below.
In addition, SONY retains the right to use Information
to protect itself and third parties from illegal, criminal or
harmful conduct.

Certain services available through the SOFTWARE may
rely upon location information, including, but not limited
to, the geographic location of the wireless adapter. You
acknowledge that for the purpose of providing such
services, SONY, the THIRDPARTY SUPPLIERS or their
partners may collect, archive, process and use such
location data, and that such services are governed by
the privacy policies of SONY or such third party. By
reviewed the privacy policies applicable to such services
and consent to such activities.
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SONY, its affiliates, partners and agents will not
intentionally use Information to personally identify

the owner or user of the SOFTWARE without your
knowledge or consent. Any use of Information will be

in accordance with the privacy policies of SONY or such
third party.

Please contact applicable contact address of each area or
country for SONY's current privacy policy. Please contact
applicable third parties for privacy policies relating

to personally identifiable and other information you
provide when you use or access third party software or
services.

Information may be processed, stored or transferred

to SONY, its affiliates or agents which are located in
countries outside of your country of residence. Data
protection and information privacy laws in certain
countries may not offer the same level of protection

as your country of residence and you may have fewer
legal rights in relation to Information processed and
stored in, or transferred to, such countries. SONY will
use reasonable efforts to take appropriate technical and
organizational steps to prevent unauthorized access to
or disclosure of Information, but does not warrant it will
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY SUPPLIERS
may automatically update or otherwise modify the
SOFTWARE, including, but not limited to, for purposes
of enhancement of security functions, error correction
and improvement of functions, at such time as you
interact with SONY's or third parties’ servers, or
otherwise. Such updates or modifications may delete
or change the nature of features or other aspects of the
SOFTWARE, including, but not limited to, functions you
may rely upon. You acknowledge and agree that such
activities may occur at SONY's sole discretion and that
SONY may condition continued use of the SOFTWARE
upon your complete installation or acceptance of such
update or modifications. Any updates/modifications
shall be deemed to be, and shall constitute part of, the
SOFTWARE for purposes of this EULA. By acceptance of
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY's privacy policy, each as amended
and modified from time to time, together constitute the
entire agreement between you and SONY with respect
to the SOFTWARE. The failure of SONY to exercise or
enforce any right or provision of this EULA shall not
constitute a waiver of such right or provision. If any part
of this EULA is held invalid, illegal, or unenforceable,
that provision shall be enforced to the maximum extent
permissible so as to maintain the intent of this EULA,
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION

The United Nations Convention on Contracts for the
International Sale of Goods shall not apply to this EULA.
This EULA shall be governed by the laws of Japan,
without regards to conflict of laws provisions. Any
dispute arising out of this EULA shall be subject to the
exclusive venue of the Tokyo District Court in Japan, and
the parties hereby consent to the venue and jurisdiction
of such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this EULA to the
contrary, you acknowledge and agree that any violation
of or noncompliance with this EULA by you will cause
irreparable harm to SONY, for which monetary damages
would be inadequate, and you consent to SONY
obtaining any injunctive or equitable relief that SONY
deems necessary or appropriate in such circumstances.
SONY may also take any legal and technical remedies
to prevent violation of and/or to enforce this EULA,
including, but not limited to, immediate termination of
your use of the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to violate

this EULA. These remedies are in addition to any other
remedies SONY may have at law, in equity or under
contract.

TERMINATION

Without prejudice to any of its other rights, SONY may
terminate this EULA if you fail to comply with any of its
terms. In case of such termination, you must: (i) cease
all use, and destroy any copies, of the SOFTWARE; (ii)
comply with the requirements in the section below
entitled "Your Account Responsibilities”.

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND ANY OF THE
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED
BY YOU, BY PROVIDING NOTICE AS PART OF THE
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF
NOTICE. If you do not agree to the amendment, you
should promptly contact SONY for instructions. Your
continued use of the SOFTWARE after the effective date
of any such notice shall be deemed your agreement to
be bound by such amendment.

THIRD-PARTY BENEFICIARIES

Each THIRD-PARTY SUPPLIER is an express intended
thirdparty beneficiary of, and shall have the right to
enforce, each provision of this EULA with respect to the
SOFTWARE of such party.

Should you have any questions concerning this EULA,
you may contact SONY by writing to SONY at applicable
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licences de logiciels libres

Sur la base des contrats de licence entre Sony
et les détenteurs de copyright des logiciels, ce
produit utilise des logiciels libres.

Pour répondre aux exigences des détenteurs
de copyright des logiciels, Sony est dans
I'obligation de vous informer sur le contenu de
ces licences.

Les licences (en anglais) sont enregistrées
dans la mémoire interne de votre produit.
Etablissez une connexion de stockage de
masse entre le produit et un ordinateur pour
lire les licences du dossier « PMHOME » -

« LICENSE ».

Si vous utilisez un Mac, le dossier « PMHOME »
- « LICENCE » peut ne pas étre accessible.

Pour visualiser les fichiers, utilisez un
ordinateur autre qu’'un Mac ou visitez I'URL
suivante.
https://0ss.sony.net/License/ILME-FX6/


https://oss.sony.net/License/ILME-FX6/
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8. Annexe

Caractéristiques techniques

Généralités

Poids

Environ 890 g (1 Ib 15 oz) (boitier principal
uniquement)

Environ 2,59 kg (5 Ib 11 0z) (y compris
I'objectif SEL24105G, le pare-soleil,
la batterie (BP-U35), le viseur, la
poignée, le grip)

Dimensions
Consultez page 151.
Besoins en alimentation
19,5V CC(18,0V a20,5V)
Consommation électrique

Environ 18,0 W (boitier, objectif,
enregistrement XAVC-| QFHD
59.94P, viseur activé, aucun
dispositif externe connecté)

Environ 36,0 W (boitier, objectif,
enregistrement XAVC-1 QFHD
59.94P (S&Q 120 fps), viseur
activé, HDMI, SDI, aucun dispositif
externe connecté)

Température de fonctionnement
0°Ca40°C(32°Fa104°F)
Température de stockage
-20 °C a +60 °C (-4 °F a +140 °F)
Durée d'utilisation continue

Environ 105 minutes (avec BP-U35)

(boitier, objectif, enregistrement
XAVC-I QFHD 59.94P, viseur
activé, aucun dispositif externe
connecté)
Format d’enregistrement (vidéo)
XAVCIntra

Mode XAVC-1 4K/QFHD :
VBR, débit binaire 600 Mbps
(max), MPEG-4 AVC/H.264

Mode XAVC-I HD :
CBG, débit binaire 223 Mbps
(max), MPEG-4 AVC/H.264

XAVC Long
Mode XAVC-L QFHD :
VBR, débit binaire 150 Mbps
(max), MPEG-4 H.264/AVC
Mode XAVC-L HD 50 :
VBR, débit binaire 50 Mbps (max),
MPEG-4 H.264/AVC
Mode XAVC-L HD 35 :
VBR, débit binaire 35 Mbps (max),
MPEG-4 H.264/AVC
Format d’enregistrement (audio)
LPCM 24 bits, 48 kHz, 4 canaux
Fréquence d'enregistrement élevée
XAVCIntra
Mode XAVC-1 4K :
4096x2160/59.94P, 50P, 29.97P,
25P, 24P, 23.98P
Mode XAVC-1 QFHD :
3840x2160/59.94P, 50P, 29.97P,
25P, 23.98P
Mode XAVC-I HD :
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
XAVC Long
Mode XAVC-L QFHD :
3840%2160/59.94P, 50P, 29.97P,
25P, 23.98P
Mode XAVC-L HD 50 :
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
Mode XAVC-LHD 35 :
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
Durées d'enregistrement/de lecture
XAVC Intra
Mode XAVC-I QFHD :
59.94P
Environ 30 minutes
(avec CEA-G160T)
Mode XAVC-I HD :
59.94P

Environ 78 minutes
(avec CEA-G160T)
XAVC Long
Mode XAVC-L QFHD :
59.94P
Environ 115 minutes
(avec CEA-G160T)
Mode XAVC-L HD 50 :
59.94P
Environ 155 minutes
(avec CEA-G8OT)
Mode XAVC-LHD 35 :
59.94P
Environ 210 minutes
(avec CEA-G8OT)
[Remarque]
La durée d'enregistrement/lecture peut varier
en fonction des conditions d'utilisation et
des caractéristiques de mémoire. Les durées
d’enregistrement et de lecture concernent un
enregistrement continu en tant que plan unique. Les

durées réelles peuvent étre plus courtes selon le nombre
de plans enregistrés.

Section de caméra

Imageur (type)
Capteur d'image CMOS a puce unique,
équivalent a plein format 35 mm
Nombre de pixels
12,9M (total)
10,2M (effectif)
Auto focus
Méthode de détection : détection de phase/
détection de contraste
Filtres ND internes
CLEAR : OFF
1:1/4ND
2:1/16ND
3:1/64ND

ND variable linéairement : 1/4ND a 1/128ND
Sensibilité 1SO
1SO 800/12800 (Cine El Quick/Cine El, source
lumineuse D55)
Monture d'objectif
Monture E
Latitude
15+ arrét
Vitesse d'obturateur
64F 41/8000 sec (23.98P)
Angle d'obturateur
5,6°a360° 2 a 64 images
Ralenti et accéléré
XAVC QFHD : 1 fps a 120 fps
XAVC HD : 1 fps & 240 fps
XAVC 4K : 1 fps a 60 fps
XAVC HD (S35) : 1 fps & 120 fps
Equilibre des blancs
2000 K 415000 K
Gain
-3 dB a +30 dB (incréments de 1dB)
Base look
S-Cinetone, Standard, Still, ITU709, s709,
709(800%), S-Log3, HLG Live,
HLG Natural

Section audio

Fréquence d'échantillonnage
48 kHz
Quantification
24 bits
Réponse de fréquence
Mode MIC entrée XLR : 20 Hz a 20 kHz
(+3 dB ou moins)
Mode LINE entrée XLR : 20 Hz a 20 kHz
(£3 dB ou moins)
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Plage dynamique
Mode MIC entrée XLR : 80 dB (typique)
Mode LINE entrée XLR : 90 dB (typique)
Distorsion
Mode MIC entrée XLR : 0,08% ou moins
(niveau d’entrée -40 dBu)
Mode LINE entrée XLR : 0,08% ou moins
(niveau d’entrée +14 dBu)
Haut-parleur intégré
Monaural
Microphone interne
Monaural
Microphone interne de la poignée
Microphone a condensateur électret stéréo
omnidirectionnel
[Remarque]

Seul le microphone interne de la poignée est actif
lorsque vous fixez la poignée.

Section entrée/sortie

Entrées
INPUT 1/2:
Type XLR, 3 broches, femelle
Commutable LINE / MIC / MIC+48V
MIC : référence -30 dBu a -80 dBu
TCIN :
Type BNC

Sorties
SDI OUT :
Type BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level
A/B), HD-SDI
Casque (mini-prise stéréo) :
-16 dBu (sortie du niveau de référence,
volume maximal du moniteur,
charge de 16 Q)

HDMI :

Type A, 19 broches
TCOUT:

Type BNC

Autre
DCIN :
Conforme a la norme EIAJ,18 Va 20,5V CC
Griffe a interfaces multiples :
Dédié (21 broches)
REMOTE :
Type mini-sub a 3 pdles de 2,5 mm
Connecteur de la télécommande de grip :
Mini-prise stéréo de 3,5 mm et a 4 broches
(connecteur fourni pour la
télécommande de grip)
USB-C:
USB3.2Gen1
USB/Multi :
Conforme a la norme USB 2.0, type micro B
pour stockage de masse (1)
VF:
Dédié (40 broches)

Section de logement de support

Logement de carte CFexpress Type A/SD (2)

LAN sans fil

Normes prises en charge

IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

IEEE 802.11 b/g/n (ILME-FX6T/TK)
Bande de fréquences

2,4 GHz

5 GHz (ILME-FX6V/VK uniquement)
Protocoles de sécurité pris en charge

WEP/WPA-PSK/WPA2-PSK
Méthode de connexion

Wi-Fi Protected Setup™ (WPS)/Manuel
Méthode d'accés

Mode Infrastructure

Chargeur de batterie (BC-CU1)

Section d'affichage

Viseur (LCD)
Taille d’écran
8,8 cm (3,5 pouces) de diagonale
Rapport d'aspect
16:9
Nombre de pixels
1280 (H) x 720 (V)

Poids
Environ 60 g (2,1 0z)
Dimensions
Environ 57 x 26 x 101 mm
(2774 %17/+6 x 4 po)

(largeur / hauteur / profondeur)

Input
195V CC 26 W

Output
16,4V CC,14A

Température de fonctionnement
0°Ca40°C(32°Fa104°F)

Température de stockage
-20 °C a +60 °C (-4 °F a +140 °F)

Accessoires fournis

Adaptateur secteur (1)

Cordon d'alimentation (1)
Chargeur de batterie (1)

Pack batterie (1)

Poignée (1)

Moniteur LCD (1)

Cable USB-C (1)

Télécommande de grip (1)
Cache LCD (1)

Kit de griffe porte-accessoires (1)
(griffe porte-accessoires (1), plaque a ressort de la
griffe (1), vis (4))

Capuchon de la monture d'objectif (1)
Capuchon protecteur du connecteur de la
poignée (1)

Avant d'utiliser cet appareil (1)
Livret de garantie (1)

La conception et les caractéristiques
techniques sont sujettes a modification sans
préavis.
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Remarques

e Effectuez toujours un essai
d'enregistrement pour vérifier que
I'enregistrement s'est fait correctement.
SONY N'ASSUMERA PAS DE
RESPONSABILITE POUR LES DOMMAGES
DE QUELQUE SORTE QU'ILS SOIENT,
INCLUANT MAIS NE SE LIMITANT PAS A LA
COMPENSATION OU AU REMBOURSEMENT,
SUITE AU MANQUEMENT DE CET APPAREIL
OU DE SON SUPPORT D’ENREGISTREMENT,
OU DE TOUT AUTRE SUPPORT OU SYSTEME
DE MEMOIRE A ENREGISTRER UN CONTENU
DE TOUT TYPE.

Vérifiez toujours que I'appareil fonctionne
correctement avant |'utilisation. SONY

NE PEUT ETRE TENUE RESPONSABLE DE
TOUT DOMMAGE, DE QUELQUE NATURE
QUE CE SOIT, Y COMPRIS MAIS SANS
LIMITATION, LA COMPENSATION OU LE
REMBOURSEMENT SUITE A LA PERTE

DES BENEFICES PRESENTS ET A VENIR
RESULTANT D’UN DYSFONCTIONNEMENT
DE CET APPAREIL NI PENDANT LA PERIODE
DE GARANTIE OU UNE FOIS LE DELAI DE
GARANTIE EXPIRE OU POUR TOUTE AUTRE
RAISON QUE CE SOIT.

SONY N'ASSUMERA PAS DE RESPONSABILITE
POUR LES RECLAMATIONS, QUELLE
QU'ELLES SOIENT, EFFECTUEES PAR LES
UTILISATEURS DE CET APPAREIL OU PAR DES
TIERCES PARTIES.

SONY N’ASSUMERA PAS DE RESPONSABILITE
POUR LA PERTE, LA REPARATION OU LA
REPRODUCTION DE TOUTES DONNEES
ENREGISTREES SUR LE SYSTEME DE
MEMOIRE INTERIEUR, LE SUPPORT
D’ENREGISTREMENT OU TOUT AUTRE
SUPPORT OU SYSTEME DE MEMOIRE.

SONY N’ASSUMERA PAS DE RESPONSABILITE
POUR LA CESSATION OU L'INTERRUPTION
DE TOUT SERVICE LIE A CET APPAREIL,
RESULTANT DE QUELQUE CIRCONSTANCE
QUE CE SOIT.
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Dimensions externes
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Tous les autres noms d'entreprises ou de
produits sont des marques commerciales ou
des marques déposées de leurs détenteurs

Marques commerciales

o OC est une marque commerciale de Sony respectifs. Les éléments de marques
Corporation. commerciales ne sont pas indiqués par les
* XAVC et sont des marques déposées symboles ™ ou © dans ce document.

de Sony Corporation.

Les termes HDMI et High-Definition
Multimedia Interface ainsi que le logo
HDMI sont des marques commerciales ou
des marques déposées de HDMI Licensing
Administrator, Inc. aux Etats-Unis et dans
d‘autres pays.

Microsoft et Windows sont des marques
déposées ou des marques enregistrées de
Microsoft Corporation aux Etats-Unis et/ou
dans d'autres pays.

Mac et macOS sont des marques déposées
d'Apple Inc. aux Etats-Unis et dans d'autres
pays.

« Catalyst Browse », « Content Browser
Mobile » et le logo « Content Browser
Mobile » sont des marques commerciales ou
des marques déposées de Sony Corporation.
iOS est une marque déposée ou une
marque commerciale de Cisco Systems, Inc.
et/ou de ses filiales aux Etats-Unis et dans
certains autres pays.

Android et Google Play sont des marques
commerciales de Google Inc.

Wi-Fi, le logo Wi-Fi et Wi-Fi PROTECTED
SETUP sont des marques commerciales ou
des marques déposées de Wi-Fi Alliance.
N-Mark est une marque commerciale ou
une marque déposée de NFC Forum, Inc.,
aux Etats-Unis et dans d'autres pays.

Le logo SDXC est une marque commerciale
de SD-3C, LLC.

CFexpress et le logo CFexpress Type

A sont des marques commerciales de

CompactFlash Association. E N
QR Code est une marque commerciale de ﬁMr,q’;'Z,,E!,r K

Denso Wave Inc. express
USB-C est une marque déposée d'USB S» Vo
Implementers Forum. Hnml X<c 4A



